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Welcome to The Media Streaming Journal

Greetings,

Businesses or organizations that want to remain fiscally viable need to maintain thorough and accurate
financial records. Not only does this provide detailed information regarding the financial condition of the
business  or  organization,  but  it  can also  furnish essential  information for  tax  preparation.  Accurate
financial data management can ensure continued success, or the lack thereof can guarantee a very
short lived existence.

GNUCash provides an Open Source software application that can be used to input, retrieve, and manage
many forms of financial records for both small or large businesses or organizations.

http://www.  sourceforge.net/projects/gnucash/  

Please feel free to contact either the Publication Director (Derek Bullard) or myself if  you have any
questions or comments regarding The Media Streaming Journal.
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David Childers

The Grand Master of Digital Disaster
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www.radiosolution.info
Our Mission

Let our friendly, knowledgeable staff assist you to build your project, such as an online radio station
using our high end reliable video and audio streaming technologies. We want to become your partner for
all your hosting needs, as well as your one stop shop for radio products such as custom DJ drops and
radio ID’s.

Start An Internet Radio Station

Whatever you need to start Internet radio station, we will deliver! We provide high quality Internet Radio
services to make your music radio project a success. We can provide Wowza, Icecast, SHOUTcast hosting
and internet  radio  services to hobbyists,  deejays,  amateurs  and established professionals.  No radio
station client is too big or too small for Radiosolution.

Choose between complete hassle-free service packages or new features to add to start internet radio
station. Benefit from customized services and the latest in internet radio technology. You will receive
professional, personalized and better Internet Radio Station services than you have received up till now.
If you already have an Icecast or SHOUTcast hosting provider, we can still help you transfer your radio
server over to us with no hassle and at no charge.

Internet Radio Station Services

Launch your internet, digital, satellite or AM/FM radio station anywhere in the world with all of the right
tools.  A broadcasting specialist  is on standby to help you get started with an SHOUTcast or Icecast
hosting package. We have servers ready for reliable streaming in North America and Europe. Our hosting
packages  have  all  the  features  you  need  to  make  your  radio  station  project  a  success.

If you stream live or with an Auto DJ, we can provide you with the latest in web-based Cloud technology.
You will love the simple to use control panel. Discover how easy it is to manage live deejays, upload
fresh music and create custom scheduled programming. You will  be able to track your listeners by
getting real time statistics.

Starting your own Internet radio has never been easier.  Get in touch with us anytime to start  your
Internet radio station.

Radiosolution is a SHOUTcast hosting provider located in Quebec Canada. We also offer Icecast, Wowza
and Web Hosting services. Contact us to discuss the best option available as you start internet radio
station.  Radiosolution  can  provide  personalized  service  in  English,  Dutch,  and  French.  Starting  an
internet radio station can be intimidating, many people want to start one, but have no idea where to
start.  Radiosolution will  be there for you every step of  the way. Everyday people are searching the
internet for free SHOUTcast servers. With Radiosolution SHOUTcast hosting we will allow you to try our
services for FREE. By trying our services, you can be confident that you have chosen the best radio
server hosting provider. You have nothing to loose because we offer a 30 day satisfaction guarantee.
What are you waiting for? Contact us now! Radiosolution offers everything you need to start internet
radio station. You will not need to go anywhere else. We can create your website, market your station
and help you submit your station to online directories. We also feature the voice of Derek Bullard aka
Dibblebee He can create affordable commercials, DJ intros, sweepers, jingles, ids and so much more.

http://www.radiosolution.info/


Scenic Television is an Internet television station that broadcasts the sights and sounds of nature 24
hours a day. Savor exotic tropical beaches, or relax in a remote rain forest.  Meditate at a bubbling
stream, or relish the view of soft rolling waves at a lake. We have beautiful nature video from locations
all around the world.

Scenic Television originates from the Gulf coast of South Alabama and broadcasts to a global audience.
The television broadcast is accessible on any device with an Internet connection. Such electronic devices
include  desktop  computers,  laptops,  tablets,  smartphones,  game platforms,  and  Internet-connected
televisions.

http://www.scenictelevision.com
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We Are Your Information Resource

Are you looking for specialized data?

Are you swamped with information overload?

Do you need help finding the right information?

We Can Help You 
Find The Information 

That You Need

Our experienced data research analysts can wade through the vast information wasteland and find the
information that you need.

We can save you both time and money.

We can streamline data requirement planning.

We can provide business critical information acquisition.

Contact us today

info@radiosolution.info

http://all-free-download.com/free-vector/download/magnifying_glass_clip_art_23181.html
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GnuCash Tutorial and Concepts Guide
The GnuCash Documentation Team

GnuCash Help Manual
The GnuCash Documentation Team

GnuCash is the personal finance software package is versatile enough to keep track of all your financial
information, from the simple to the very complex.

Hey You! Yes, You!
Why Should Anyone Listen to You?!

Do you need compelling, clever copy or catchphrases for
your Internet station?  If you do, please visit and lets talk!

http://www.ielectrify.com/work-with-me/

I am a professional writer with 15+ years of experience
creating high-converting copy, for a variety of radio,

broadcasting and marketing applications.
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GnuCash Tutorial and Concepts Guide
by The GnuCash Documentation Team

This Guide contains a tutorial for using GnuCash and describes the concepts behind GnuCash.
Copyright © 2009-2019 GnuCash Documentation Team
Copyright © 2010-2011 Yawar Amin
Copyright © 2010 Tom Bullock
Copyright © 2010-2011 Cristian Marchi
Copyright © 2006 Chris Lyttle
Copyright © 2003-2004 Jon Lapham
Copyright © 2002 Chris Lyttle
Copyright © 2001 Carol Champagne and Chris Lyttle

Permission is granted to copy, distribute and/or modify this document under the terms of the GNU Free Documentation License (GFDL), Version
1.1 or any later version published by the Free Software Foundation with no Invariant Sections, no Front-Cover Texts, and no Back-Cover Texts.
You can find a copy of the GFDL at this link [ghelp:fdl] or in the file COPYING-DOCS distributed with this manual.

This manual is part of a collection of GNOME manuals distributed under the GFDL. If you want to distribute this manual separately from the
collection, you can do so by adding a copy of the license to the manual, as described in section 6 of the license.

Many of the names used by companies to distinguish their products and services are claimed as trademarks. Where those names appear in any
GNOME documentation, and the members of the GNOME Documentation Project are made aware of those trademarks, then the names are in
capital letters or initial capital letters.

DOCUMENT AND MODIFIED VERSIONS OF THE DOCUMENT ARE PROVIDED UNDER THE TERMS OF THE GNU FREE DOCU-
MENTATION LICENSE WITH THE FURTHER UNDERSTANDING THAT:

1. DOCUMENT IS PROVIDED ON AN “AS IS” BASIS, WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING, WITHOUT LIMITATION, WARRANTIES THAT THE DOCUMENT OR MODIFIED VERSION OF THE DOCUMENT IS
FREE OF DEFECTS MERCHANTABLE, FIT FOR A PARTICULAR PURPOSE OR NON-INFRINGING. THE ENTIRE RISK AS TO THE
QUALITY, ACCURACY, AND PERFORMANCE OF THE DOCUMENT OR MODIFIED VERSION OF THE DOCUMENT IS WITH YOU.
SHOULD ANY DOCUMENT OR MODIFIED VERSION PROVE DEFECTIVE IN ANY RESPECT, YOU (NOT THE INITIAL WRITER,
AUTHOR OR ANY CONTRIBUTOR) ASSUME THE COST OF ANY NECESSARY SERVICING, REPAIR OR CORRECTION. THIS
DISCLAIMER OF WARRANTY CONSTITUTES AN ESSENTIAL PART OF THIS LICENSE. NO USE OF ANY DOCUMENT OR MOD-
IFIED VERSION OF THE DOCUMENT IS AUTHORIZED HEREUNDER EXCEPT UNDER THIS DISCLAIMER; AND

2. UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL THEORY, WHETHER IN TORT (INCLUDING NEGLIGENCE), CONTRACT,
OR OTHERWISE, SHALL THE AUTHOR, INITIAL WRITER, ANY CONTRIBUTOR, OR ANY DISTRIBUTOR OF THE DOCUMENT
OR MODIFIED VERSION OF THE DOCUMENT, OR ANY SUPPLIER OF ANY OF SUCH PARTIES, BE LIABLE TO ANY PERSON
FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY CHARACTER INCLUDING,
WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION,
OR ANY AND ALL OTHER DAMAGES OR LOSSES ARISING OUT OF OR RELATING TO USE OF THE DOCUMENT AND MOD-
IFIED VERSIONS OF THE DOCUMENT, EVEN IF SUCH PARTY SHALL HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH
DAMAGES.

Feedback

To report a bug or make a suggestion regarding the program or this documentation, follow the instructions at the Bugzilla page of the GnuCash
wiki [https://wiki.gnucash.org/wiki/Bugzilla] and use the GnuCash Bug Tracking System [https://bugs.gnucash.org/]. At first you want to browse
[https://bugs.gnucash.org/describecomponents.cgi] or search [https://bugs.gnucash.org/query.cgi] it for already existing bugs. Select the product
GnuCash for the program or Documentation for any parts of this documentation.

ghelp:fdl
ghelp:fdl
https://wiki.gnucash.org/wiki/Bugzilla
https://wiki.gnucash.org/wiki/Bugzilla
https://wiki.gnucash.org/wiki/Bugzilla
https://bugs.gnucash.org/
https://bugs.gnucash.org/
https://bugs.gnucash.org/describecomponents.cgi
https://bugs.gnucash.org/describecomponents.cgi
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Chapter 1. Overview
Introduction

GnuCash is the personal finance software package made for you. It is versatile enough to keep track of
all your financial information, from the simple to the very complex. It is one of the few financial software
packages that supports global currencies, and it is the only open-source program of its kind. Best of all,
GnuCash is easy to learn and use!

So, what can GnuCash do for you? It can keep track of your personal finances in as much detail as you
prefer. If you are just starting out, use GnuCash to keep track of your checkbook. You may then decide
to track cash as well as credit card purchases to better determine where your money is being spent. When
you start investing, you can use GnuCash to help monitor your portfolio. Buying a vehicle or a home?
GnuCash will help you plan the investment and track loan payments. If your financial records span the
globe, GnuCash provides all the multiple-currency support you need.

This image shows a Chart of Accounts with multiple currencies and investments.

While GnuCash is well suited for personal finances, it is also powerful enough for business use. There are
many business features, from integrated accounts receivable and payable systems, to tax table construction.
You will find these and the many other business features surprisingly powerful and easy to use.

Features

Easy to Use
Within a matter of minutes you will be able to enter your personal finance information and generate color
graphs that represent your financial status. If you can use the register in the back of your checkbook - you
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can use GnuCash! Type directly into the register, tab between fields, and use quick-fill to automatically
complete transactions. The interface is customizable from within the application itself.

• Easy to Use Menus: GnuCash menus conform to the GNOME Human Interface Guidelines. This means
that they are simple and similar in appearance to many other GNOME applications.

• Documentation: GnuCash has built-in Help and extensive User’s Guide documentation.

• Import Methods: GnuCash supports many ways to input transactions besides manual entry. If you can
access your bank accounts on-line, this is especially useful, as most banks and credit card companies
support one of the following import methods. You will spend less time entering data and more time
analyzing results.

• Quicken Import File (QIF): Import Quicken QIF style files, a popular file format with many com-
mercial personal finance software packages.

• Open Financial Exchange (OFX): GnuCash has been the first free software application to support the
Open Financial Exchange protocol. Many financial institutions are moving towards this format.

• Home Banking Computer Interface (HBCI): GnuCash has been the first free software application to
support the German Home Banking Computer Interface protocol. This protocol includes statement
download, initiates bank transfers, and makes direct debits possible.

• Reports: GnuCash comes with over 30 prebuilt reports, including Account Summary, Income, Expenses,
Transaction Report, Balance Sheet, Profit&Loss, Portfolio Valuation, and many others. Reports support
graphical views of the data, including pie charts, bar charts, and scatter plots. The reports can be exported
to HTML files, and are easily customized.

• Scheduled Transactions: GnuCash now has the ability to automatically create and enter transactions, or
remind you when these transactions are due, giving you the choice of entering, postponing or removing
the automated transaction.

• Mortgage and Loan Repayment Assistant: Used to set up a variable payment loan scheduled transaction.

• Easy Account Reconciliation: Integrated reconciliation makes reconciling your GnuCash accounts with
statements simple and effective.

• Multi-platform Compatibility: GnuCash is supported on a variety of platforms and operating systems.
The list of fully supported operating systems (and platforms) is for

GnuCash 3.7 GNU/Linux (x86, x86_64), FreeBSD (x86,
x86_64), OpenBSD (x86, x86_64), Apple
MacOS (64-bit Intel), and Microsoft Win-
dows (Windows 7 and later).

GnuCash ≤ 2.6.21 Apple MacOS (32-bit Intel, PPC) and Mi-
crosoft Windows (XP and Vista).

GnuCash ≤ 2.2.9 Microsoft Windows (2000).

Previous versions of GnuCash have been known to work with SGI
IRIX (MIPS), IBM AIX 4.1.5 (RS/6000),
Unixware 7 (Intel), SCO OpenServer 5.0.4
(Intel), and Solaris (Sparc) but their current
status is unknown.
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Tracks Your Investments
GnuCash includes a number of investment features that allow you to track all your investments. With
GnuCash you can track stocks individually (one per account) or in a portfolio of accounts (a group of
accounts that can be displayed together).

GnuCash supports online stock and mutual fund quotes. This means you no longer need to look up stock
prices one at a time. The process can be automated, and you can see the latest value of your stocks.

International Support
GnuCash is truly an application that works with and understands users from all around the world. There
are many built-in features to facilitate interaction with the international world we live in today.

• Native Languages: GnuCash has been fully translated into 12 languages: Chinese, Czech, Dutch, Eng-
lish, French, German, Italian, Portuguese, Russian, Slovak, Spanish and Swedish. More than 25 other
languages are partially supported.

• International Format Handling: GnuCash understands that different countries display the date and num-
bers differently. You are able to work with the date and number formats you are accustomed to.

• Multiple Currencies and Currency Trading: Multiple currencies are supported and can be bought and
sold (traded). Currency movements between accounts remain fully balanced if "Trading Accounts" is
enabled.

• On-line exchange rates: With GnuCash, you no longer need look up your exchange rates one at a time.
The process can be automated, to always present you with the account values converted to your preferred
currency using the latest exchange rates.

Business Support
GnuCash has many features to support the needs of the business accounting community.

• Accounts Receivable/Payable: GnuCash has an integrated Accounts Receivable and Accounts Payable
system. You can track Customers, Vendors, Invoicing and Bill Payment, and use different Tax and
Billing Terms in a small business.

• Depreciation: GnuCash can track depreciation of capital assets.

• Reports: GnuCash offers a wide variety of ready-to-use business reports.

Accounting Features
For those knowledgeable in accounting, here is a list of GnuCash’s accounting features.

• Double Entry: Every transaction must debit one account and credit others by an equal amount. This
ensures the “books balance” - that the difference between income and expense exactly equals the sum
of all bank, cash, stock and other assets.

• Split Transactions: A single transaction can be split into several pieces to record taxes, fees, and other
compound entries.

• Chart of Accounts: A master account can have a hierarchy of detail accounts underneath it. This allows
similar account types such as Cash, Bank, or Stock to be grouped into a master account such as “Assets”.
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• General Journal: One register window can display multiple accounts at the same time. This eases the
trouble of tracking down typing/entry errors. It also provides a convenient way of viewing a portfolio
of many stocks, by showing all transactions in that portfolio.

• Income/Expense Account Types (Categories): These categorize your cash flow and, when used properly
with the double-entry feature, will provide an accurate Profit&Loss statement.

About this Book
This manual’s goal is to save you time. It will get you started using GnuCash as quickly as possible.

Each chapter follows a simple format. A chapter begins with a “Concepts” discussion which introduces
general themes and terminology, addressed and used within that chapter. “How-To” sections, which ad-
dress specific procedures follow. Finally, a “Putting It All Together” section ends the chapter by giving
detailed, concrete examples.

Beginning users will find the “Concepts” sections very helpful. They provide a reference for good ways
to track your finances, and serve as a general introduction to financial background and terminology. Ex-
perienced users can flip to the “How-To” sections to quickly scan procedures. These sections provide to-
the-point steps for accomplishing specific tasks. The “Putting It All Together” sections present real-world
examples in the form of a tutorial. Beginning with creation of a file in Chapter 2, The Basics, each succes-
sive chapter builds on the previous chapter’s tutorial.

This manual is organized into 3 main parts:

• Getting Started

• Managing Personal Finances

• Managing Business Finances

Getting Started provides you with the most basic information needed to begin using GnuCash. The chapters
in this section explain concepts that are fundamental to using GnuCash. New users of GnuCash should
familiarize themselves with the information in these chapters to get you up and running:

• Chapter 1, Overview - (this chapter) gives a general overview of GnuCash

• Chapter 2, The Basics - gives users a very brief introduction to accounting principles, and then provides
information about how GnuCash structures its data. There is also information on basic interface elements
in GnuCash. Finally, this chapter explains how GnuCash stores and manages your data.

• the section called “Accounts” - gives further information about accounts and how to organize them.

• the section called “Transactions” - gives basic information about transactions and how to enter them.

Managing Personal Finances addresses common applications and features of GnuCash in greater detail.
You will see more specific cases, based on frequently asked questions about applying GnuCash to everyday
situations. Here are the applications and features covered in this part:

• Chapter 5, Checkbook

• Chapter 7, Credit Cards

• Chapter 8, Loans

• Chapter 9, Investments

• Chapter 11, Capital Gains
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• Chapter 12, Multiple Currencies

Managing Business Finances discusses the use of GnuCash in business accounting:

• Chapter 13, Business Features

• Chapter 14, Budgets

• Chapter 15, Other Assets

• Chapter 16, Depreciation

• Chapter 17, Python Bindings

• Chapter 18, Importing Business Data

This manual also includes several appendices, which contains extra information you might want to know:

• GnuCash Glossary - Glossary of terms used in GnuCash

• Appendix A, Migration Guide - Guide for former Quicken®, MS Money or other QIF users

• Appendix B, Frequently Asked Questions

• Appendix C, Contributed Account Trees

• Appendix D, Auxiliary File Formats

• Appendix E, GNU Free Documentation License

Last, but not least, a glossary and index help you quickly locate topics.

Getting More Help
GnuCash offers help in many ways, including the  Tip of the Day, context help, a website, a wiki, the
mailing lists, and IRC chat.

Context Help
The context help provides detailed instructions for using GnuCash's menus, windows, and controls. To
open online help, select Help → Contents.

The GnuCash Help window also acts as a simple web browser, so you can pull up a website for additional
information. You can open any website under this window by clicking the Open Toolbar button and then
typing in the URL. Use the Back, Forward, Reload, Stop, and Print buttons as you would in a standard
browser.

GnuCash Website
The GnuCash [http://www.gnucash.org] website contains helpful information about the program and about
any updates to it. It also contains links to other online resources.

GnuCash Wiki
An immense amount of less-formal documenation, both of GnuCash itself and its maintenance and devel-
opment may be found in the GnuCash Wiki [https://wiki.gnucash.org/wiki]; the Frequently Asked Ques-
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tions [https://wiki.gnucash.org/wiki/FAQ] page should be a first stop whenever you encounter difficulty
using GnuCash.

GnuCash On-line Assistance

Mailing List

The primary source of user support is the user mailing list [mailto:gnucash-user@gnucash.org]. If you pre-
fer a web forum-like presentation, you can use it via Nabble [http://gnucash.1415818.n4.nabble.com/Gnu-
Cash-User-f1415819.html]. One must subscribe [https://lists.gnucash.org/mailman/listinfo/gnucash-user]
before posting, even if using Nabble.

IRC

Several of the developers monitor the #gnucash channel at irc.gnome.org. They're usually doing something
else, too, and of course aren't always at their computers. Log in, ask your question, and stay logged in;
it may be several hours before your question is noticed and responded to. To see if you missed anything
check the IRC logs [https://code.gnucash.org/logs].

The GnuCash website  [http://www.gnucash.org] has more details on these channels. You will also find
pointers there to additional useful resources such as the GnuCash wiki and bug tracking system.

Topic Search
The online manual also provides a search function. To search for a particular topic, click the Search tab
at the bottom of the help window and type in your topic in the field provided. Click the Search button to
complete your search. A list of choices should appear in the box below, clicking a choice will bring up
its text on the right.

Installation
Installation of GnuCash is usually simple.

The GnuCash download page [http://www.gnucash.org/download.phtml] contains detailed instructions on
how to install GnuCash for each operating system supported.
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Chapter 2. The Basics
This chapter will introduce some of the basics of using GnuCash. It is recommended that you read through
this chapter, before starting to do any real work with GnuCash. Next chapters will begin to show you
hands on examples.

Accounting Concepts
GnuCash is easy enough to use that you do not need to have a complete understanding of accounting
principles to find it useful. However, you will find that some basic accounting knowledge will prove to be
invaluable as GnuCash was designed using these principles as a template. It is highly recommended that
you understand this section of the guide before proceeding.

The 5 Basic Accounts
Basic accounting rules group all finance related things into 5 fundamental types of “accounts”. That is,
everything that accounting deals with can be placed into one of these 5 accounts:

Account types

Assets Things you own

Liabilities Things you owe

Equity Overall net worth

Income Increases the value of your accounts

Expenses Decreases the value of your accounts

It is clear that it is possible to categorize your financial world into these 5 groups. For example, the cash
in your bank account is an asset, your mortgage is a liability, your paycheck is income, and the cost of
dinner last night is an expense.

The Accounting Equation
With the 5 basic accounts defined, what is the relationship between them? How does one type of account
affect the others? Firstly, equity is defined by assets and liability. That is, your net worth is calculated by
subtracting your liabilities from your assets:

Equation 2.1. The static accounting equation

Assets - Liabilities = Equity

Furthermore, you can increase your equity through income, and decrease equity through expenses. This
makes sense of course, when you receive a paycheck you become “richer” and when you pay for dinner
you become “poorer”. This is expressed mathematically in what is known as the Accounting Equation:

Equation 2.2. The (dynamic) accounting equation

Assets - Liabilities = Equity + (Income - Expenses)

This equation must always be balanced, a condition that can only be satisfied if you enter values to multiple
accounts. For example: if you receive money in the form of income you must see an equal increase in your
assets. As another example, you could have an increase in assets if you have a parallel increase in liabilities.
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Figure 2.1. The basic accounts relationships

Income Expenses

Equity
( Assets - Liabilities )

Positive Value
Assets

Negative Value
Liabilities

A graphical view of the relationship between the 5 basic accounts. Net worth (equity) increases through income and
decreases through expenses. The arrows represent the movement of value.

Debits and Credits
The use of debits and credits in accounting and their effect on accounts of different types is often con-
fusing when first encountered in acccounting. The accounting equation introduced above is the key to
understanding which accounts types are debited or credited and when. First of all we need to rearrange the
expanded form a little bit with Assets on the left hand side of the equal sign and transposing any account
type with a negative sign to the other side to obtain:

Equation 2.3. The rearranged accounting equation

Assets + Expenses = Liabilities + Equity + Income

With the accounting equation in this form, the accounts on the left hand side of the equal sign are known
as debit balance accounts in accounting practice, that is the normal positive balance for these accounts is
increased by debit entries to accounts of these types. Conversely credit entries to accounts of these types
will decrease the balance of accounts of these types.

Similarly, the account types on the right hand side of the equal sign are known as credit balance accounts,
that is the normal positive balance for these account types is increased by credit entries to the accounts of
these types. Again debit entries to accounts of these types will reduce the balance in the account.

Table 2.1. Summary of effect of debits (Dr) and credits (Cr) on the balance of
accounts of the 5 account types

Account Type Effect on Account Balance

Debit (Dr) Credit (Cr)

Assets

Expenses
Increase Decrease

Liabilities

Equity

Income

Decrease Increase

Double Entry
The accounting equation is the very heart of a double entry accounting system. For every change in value
of one account in the Accounting Equation, there must be a balancing change in another. This concept
is known as the Principle of Balance, and is of fundamental importance for understanding GnuCash and
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other double entry accounting systems. When you work with GnuCash, you will always be concerned with
at least 2 accounts, to keep the accounting equation balanced.

Balancing changes (or transfers of money) among accounts are done by debiting one account and simul-
taneously crediting another. Accounting debits and credits do not mean “decrease” and “increase”. Debits
and credits each increase certain types of accounts and decrease others as described in the previous section.
In asset and expense accounts, debits increase the balance and credits decrease the balance. In liability,
equity and income accounts, credits increase the balance and debits decrease the balance.

In traditional double-entry accounting, the left column in the register is used for debits, while the right
column is used for credits. Accountants record increases in asset and expense accounts on the debit (left)
side, and they record increases in liability, revenue, and equity accounts on the credit (right) side. GnuCash
follows this convention in the register.

Note

This accounting terminology can be confusing to new users, which is why GnuCash allows you
to use the common terms Deposit and Withdrawal. If you prefer the formal accounting terms,
you can change the account register column headings to use them in the Accounts tab under
Preferences (see the GnuCash Help Manual for more information on setting preferences).

Warning

Common use of the words debit and credit does not match how accountants use these words. In
common use, credit generally has positive associations; in accounting, credit means affecting the
right column of the ledger sheet of an account. This is associated with a decrease in asset and
expense, but an increase of income, liability and equity accounts.

For more details see http://en.wikipedia.org/wiki/Debits_and_credits.

Data Entry Concepts
When entering data in GnuCash, you should be aware of the 3 levels of organization in which GnuCash
divides your data: files, accounts and transactions. These levels are presented in their order of complexity,
one file contains many accounts and one account contains many transactions. This division is fundamental
to understanding how to use GnuCash.

Files
GnuCash stores information at the highest level in files. A file can be stored on your computer either as a
single XML file (in all versions of GnuCash), or in a SQL database (in GnuCash version 2.4 and higher).

Note

SQL is pronounced “sequel”, so in spoken and written language we would say “a SQL database”.

With the XML file format, GnuCash stores your data in an XML data file, usually in compressed format
(although this can be changed in the General tab of the GnuCash Preferences).

With SQL storage, GnuCash stores your data in a SQL database under the database application you select
(SQLite3, MySQL or PostgreSQL).

You will need one main file or database for each set of accounts you are maintaining. To learn how to
create and manage GnuCash files, see the section called “Storing your financial data”.
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Note

If you think you might need more than one set of accounts, you might want to consult a profes-
sional accountant or bookkeeper before proceeding. Most users will probably have only one data
file.

Backup files and log files are automatically generated by GnuCash when appropriate. Backup and log files
are described in the section called “Backing Up and Recovering Data”.

Accounts
An account keeps track of what you own, owe, spend or receive. Each GnuCash file can contain any
number of accounts, and each account can contain many sub-accounts up to an arbitrary number of levels.
This simple feature gives GnuCash much of its power in managing your finances, as you will see in later
chapters.

Examples of accounts include: checking accounts, savings accounts, credit card accounts, mortgages, and
loans. Each GnuCash account tracks the activity for that “real” account, and can inform you of its status.

In addition, accounts are also used to categorize the money you receive or spend. For example, you can
create expense accounts to track the money you pay on utilities or groceries. Even though these are not
accounts that receive statements, they allow you to determine how much money is being spent in each
of these areas.

Accounts will be covered in more detail in the section called “Accounts”.

Transactions
A transaction represents the movement of money among accounts. Whenever you spend or receive money,
or transfer money between accounts, that is a transaction.

Examples of transactions are: paying a phone bill, transferring money from savings to checking, buying
a pizza, withdrawing money, and depositing a paycheck. the section called “Transactions” goes more in
depth on how to enter transactions.

In double entry accounting, transactions always involve at least two accounts–a source account and a
destination account. GnuCash manages this by inserting a line into the transaction for every account that
is affected, and recording the amounts involved in each line. A line within a transaction that records the
account and amount of money involved is called a split. A transaction can contain an arbitrary number
of splits.

Note

Splits in transactions will be covered in the section called “Split Transaction Example”

Running GnuCash
GnuCash can be run from your desktop main menu by selecting the associated menu entry.

Alternatively it can be run from a command line prompt with the command gnucash.

During start up, GnuCash will display the Splash Screen, where some information about the program
(version number, build, etc.) and the loading process are displayed.
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Welcome to GnuCash dialog
The very first time you open GnuCash, you will see the Welcome to GnuCash! screen. This dialog includes
three choices:

• Create a new set of accounts - Runs the New Account Hierarchy Setup assistant (see the section called
“New Account Hierarchy Setup”). Select this option if you want to be assisted in creating a set of
accounts.

• Import my QIF files - Runs the Import QIF Files assistant (see the section called “Import QIF”). Select
this option if you already have Quicken files (.qif files) and wish to import them into GnuCash.

• Open the new user tutorial - Opens the GnuCash Tutorial and Concepts Guide. Select this option if you
are completely new to GnuCash and accounting concepts.

Note

It is possible to access each of these items after you have left this screen, but the Welcome to
GnuCash! screen will not reappear. To create a new set of accounts, see the section called “New
Account Hierarchy Setup”. To import QIF files, see the section called “Import QIF”.

New Account Hierarchy Setup
The New Account Hierarchy Setup assistant helps you to create a set of GnuCash accounts. It will appear
if you choose Create a new set of accounts in the Welcome to GnuCash! menu, or when you select File
→ New.

This assistant will create a new blank GnuCash file and guide you through the creation of a Chart of
Accounts. There are several steps in the assistant, which are outlined below.

1. The first screen briefly describes what this assistant does.

2. New Book Options allows you to set different attributes for your file that affect the file as a whole.
This screen has four tabs: Accounts, Budgeting, Business, and Counters. These items are explained
elsewhere in the Guide, and can be changed at a later point.

3. Choose Currency sets the default currency for new accounts. This is based on the computer locale set-
tings, and can be modified later in the Accounts tab under Preferences (see the section called “Prefer-
ences: Accounts Tab”).

4. Choose accounts to create allows you to create an initial set of accounts. These can be edited as needed
afterward. The screen is divided into three parts.

• The left upper portion has a list of Categories for commonly used hierarchies of accounts. Select
from this list the types of accounts you wish to use. You can select as many of the categories of
accounts as you wish.

• The left lower section has a Category Description that displays a detailed description of the category
currently highlighted.

• The right side has a list of the Accounts that will be created from a selected category. Note that the
accounts listed here are only the selected category; your final data file will include all of the accounts
for all of the selected Categories.

5. Setup selected accounts lists all the accounts you selected on Choose accounts to create, and allows you
to enter opening balances and to designate Placeholder accounts.
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Note

Equity accounts do not have opening balances, so the opening balance value for this kind of
account is locked and set to zero.

Note

Placeholder accounts are used to create a hierarchy of accounts and normally do not have
transactions or opening balances.

• The left side of the screen has a list of Account Names. Select an account by "clicking" once in the
Account Names column with the account highlighted. This will open the account name for changes.

• The right side of the screen has a check-box to make an account a Placeholder and a box to add the
Opening Balance for the selected account. Again a single click in the Opening Balance or Placeholder
column will open the field for changes.

6. Finish account setup is the last screen and gives you a final option to cancel the process.

Warning

If you choose to cancel, any selections you have made up to this point will be lost.

Tip of the Day

GnuCash provides a Tip of the Day screen to give helpful hints for using the program:

This image shows the Tip of the Day.
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These tips provide useful information for beginning users. To view more of the tips, click Forward to
continue. If you do not wish to see this screen box on start-up, deselect the box next to Show tips at startup.
When you have finished viewing the helpful tips, click Close to close the Tip of the Day screen.

Account Tree Window
You should now see the Accounts window, which appears as shown below. The exact layout of the account
tree will depend on which default accounts you selected during the New Account Hierarchy Setup. In this
example, the Common Accounts are shown.

This image shows the Accounts window.

The Account Tree window (also known as a Chart of Accounts, or CoA) provides an overview of the data
contained in the current file. It contains a list of account names and their current balances.

From this window, you can open the register of any account either by double-clicking the account name,
right clicking the account name and selecting Open Account from the menu, or by using the Open button on
the toolbar. GnuCash allows you to have as many account registers open as you wish. For more information
on using account registers, see the section called “Account Register Window”.

Tip

Clicking the small triangle to the left of an account that has children will expand the tree view
showing child accounts.

At the top of this window is the Titlebar, which displays the file name for this set of accounts (once you
have saved the file.) Below that is the Menubar. You can access the menu options by either clicking on
these menu headings or by using shortcuts and access keys (see the section called “Menu Shortcuts”). Next
is the Toolbar, which contains buttons for the most common functions.

The account tree appears below the Toolbar. Once you have started creating accounts, the account names
will appear in the account tree. You can customize which headings show up by using the small down-
arrow at the far right just above the account tree.

At the bottom is the Statusbar, which tells you information about what you own (Net Assets) and how
much money you have made (Profits).

16



The Basics

Account Register Window
Account Register windows are used to enter and edit your account data. As the name suggests, they look
similar to a checkbook register.

This image shows the Checking Account - Register with several transactions.

the section called “Transactions” explains more about account register windows and how to enter data
into them. For now, note that the parts of an account register window are similar to the parts of the ac-
count tree window described earlier. The Titlebar at the top contains the account name. Below that, the
Menubar contains menu options related to the account register. Toolbar buttons simplify common data
entry functions. The Statusbar at the bottom of the window, displays some account balances covered in the
section called “Transactions”. At the bottom of the account register window, information appears about
the current location of the cursor.

Note

In the register windows, you can resize the various columns that GnuCash displays, but keep in
mind that the Description and Balance columns behave differently from other columns.

The Description column is designed to expand automatically to fill all unused horizontal screen
space. Therefore you should set the widths of all your other columns before setting the Description
column width.

The Balance column must be resized by double-clicking on the column heading.

Toolbar Buttons
Both the account tree window and the account register window contain Toolbar buttons. These buttons
provide quick access to common functions such as Save and Open in the account tree window and Record
and Delete in the account register window. If you are not sure what a button does, move the mouse pointer
over that button, and you should see a description of the function appear.

Here is a summary of the account tree window buttons:

Account tree window buttons

Save Save the current file to disk

Close Close the current notebook page

Open, Edit, New and Delete These are functions related to accounts. They
are discussed in the section called “Ac-
counts”.
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Register-specific buttons are discussed in the section called “Transactions”.

Tab Bar
GnuCash uses a tabbed model that allows you to open multiple account registers and reports simultaneous-
ly. Each open window (which can include account registers, reports, or Scheduled Transactions windows)
is given a tab on this bar that you can click to view that window. Tabs can be configured in Preferences
to appear along any side of the GnuCash window.

To see the full name for a tab, hover the mouse pointer over an account window tab.

If more screens are open than can be displayed across the screen, some tabs will not display. You can move
through all tabs by clicking the arrows on either end of the tab bar. A complete list of tabs can be viewed
by right-clicking the Tab Bar and any tab can be selected by clicking it.

Menu Items
The account tree window and the account register window both contain menu headings in a Menubar.
Clicking on a menu heading brings up the menu items for that heading.

You can click on the account tree menu headings and then move the mouse pointer over the menu items
to see what they do. As the pointer moves over a menu item, a description of the item appears in the lower
left-hand corner of the window (inside the Statusbar). To select a menu item, click on it.

You can also access the most common menu items in a window by right-clicking the mouse anywhere in
that window. In the account tree window, this will bring up a list of account items. In the account register
window, this will bring up a list of transaction items.

Other ways of accessing menu items are through keyboard shortcuts and access keys, described next.

Menu Shortcuts
All of the menu items have access keys which are marked by underlined characters in the menu names.
Pressing the Alt key with the underlined character in the menu heading will bring up the menu items for
that heading. Once the menu items are displayed, type the underlined character in the menu item to activate
it. For example, typing Alt+F in the main window brings up the File menu, then typing S will save the
file. Access keys are fixed and cannot be changed by users.

Some of the more commonly used menu items also have shortcut keys that directly activate the command
without having to traverse the menu structure. These shortcuts typically use the Ctrl key, although they
can use any key combination. Menu shortcuts are displayed at the end of each menu item.

Storing your financial data
Overview

GnuCash offers several formats for storing your financial data. The default file storage format is XML,
while SQL storage is available in SQLite, MySQL, and PostgreSQL formats. Users can choose a file
format for new files from File → Save and for existing files from File → Save As... dialogs.

The XML storage format is a text file that by default is compressed, which is a preference that is set at Edit
→ Preferences General Compress files. SQLite storage is also available, and stores your data in a single
file on your system, like the XML format. However, internally, an SQLite file is managed as a database.
The MySQL and PostgreSQL storage options require access to a MySQL or PostgreSQL database server
and the installation of additional database drivers on your machine.
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Tip

Users can change the format at any time by using File → Save As.... This will create a copy of
the data file in the selected format.

Storage Comparison and Recommendations
Each storage format has benefits and shortcomings that users should consider for their needs and abilities.
See the Storage Comparison below for further details.

The XML format is the most stable and established, and for this reason, it is recommended for most users.
SQL storage was added for the 2.4 release and has become an increasingly popular choice for users. The
SQLite format allows users to realize the benefits of SQL storage without the overhead of installing or
managing a full DBMS. MySQL and PostgreSQL require the installation of MySQL and PostgreSQL
DBMS, respectively, and are best maintained only by experienced database administrators.

Note

Use of a SQL back end for storage implies to many that GnuCash has fully implemented DBMS
features, including multi-user and incremental data manipulation. However, GnuCash does not
currently implement these features, although it is a long term goal of the development team.

Storage Comparison Table

Table 2.2. Storage Comparison

XML SQLite MySQL PostgreSQL

Availability Built-in Depends on packaginga

File extension gnucash N/Ab

Additional software None MySQL PostgreSQL

Additional exper-
tise

None Database Administrator

Compression gzip N/A

File Save On command On commit

Multi-user No No No No
aSQLite relies on an additional package and driver (called libdbi and libdbd-sqlite3, respectively), which are installed by default on
Mac OS and Windows. Linux users may need to manually install these for SQLite.

MySQL and PostgreSQL may require the installation of additional software drivers (libdbd-mysql and libdbd-pgsql).
bMySQL and PostgreSQL place data within their own storage system.

Creating a file
To create a new GnuCash file do the following:

1. From the GnuCash Menubar, choose File → New File. The New Account Hierarchy setup assistant will
start.

Note

If you are running GnuCash for the first time, you will be presented with the Welcome to
GnuCash! screen. This screen is described in detail in the GnuCash manual.
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2. Set your preferences in the assistant and move through the screens with the Forward, Cancel and Pre-
vious buttons.

Saving data

Follow these steps to save the file under your preferred name:

1. Choose File → Save As... from the Menubar or select the Save Toolbar button. GnuCash will bring up
the save window.

2. Select the Data Format of the file you are saving from the drop down list. The default selection is XML
but if you have set up a database back end you can change to that format.

Depending on the selected Data Format the window can change as described in the following.

3.
• If you selected XML or sqlite3 you will see a screen like this:

Figure 2.2. Save screen when XML or sqlite3 is selected.

This image shows the Save screen when the selected Data Format is XML or sqlite3.

Type your chosen filename in the Name field. It is not necessary to specify an extension when you
write the file name. GnuCash will automatically add the extension .gnucash to the file.
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Note

The .gnucash extension was introduced in the 2.3 series of GnuCash. For already existing
files, the extension will never be changed. So if you open an existing file named Myold-
file, that name won’t be changed if the file is saved. You might use the Save As... com-
mand and give the file a new name in order to have it saved with the extension .gnucash.

Select the path where the file will be saved by browsing the tree in the lower panes.

Tip

Click on the Create Folder button to create a new folder with a custom name in the selected
path.

• If you selected mysql or postgres Data Format you will see a screen like this:

Figure 2.3. Save screen when mysql or postgres is selected.

This image shows the Save screen when the selected Data Format is mysql or postgres.

Enter in this window the Database Connection information: Host, Database, Username and Password.

Warning

Saving to mysql or postgres requires the proper permissions in that database, that is you
need to have the permissions to create a new database with the given database name, or you
need to have write access to an existing database with the given database name.

4. Click the Save As button to save the file.

If you are keeping track of finances for a single household, you need only one file. But if you are also
tracking business finances or want to keep data separate for some reason, then you will need more than
one file.

Before ending each GnuCash session, be sure to save your data changes using File → Save or the Save
Toolbar button.
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Note

As it is very important to save your data frequently to avoid losing them for whatever reason,
GnuCash is able to automatically save the opened file every a certain amount of time. This interval
can be set in the General tab under Edit → Preferences (GnuCash → Preferences on MacOS). Keep
in mind that this option is relevant only if you are saving in XML format. If you are working
with a database, the Save button and the Save menu entry will be grayed out because changes
are stored right away.

Opening data
To open an existing file or database, select File → Open from the menu. In the window that will open,
select the Data Format. If you selected File choose the file you want to open by browsing the folders in
the lower panes. Else, enter the required Database Connection information.

Tip

GnuCash keeps a list of the recently opened files. Open the File menu and you will see listed the
names of recently opened files. Click on the one you want to load to open it.

Duplicating an Account Hierarchy
In some cases, it might be useful to duplicate the structure of an existing data file in a new file. For example,
you might want to try out new accounting techniques without corrupting your actual accounting data, or
you might need to follow accounting guidelines that require you to close your books at the end of the year
and begin each year with a fresh set of books.

GnuCash allows you to create an empty copy of your Chart of Accounts simply by selecting File → Export
→ Export Accounts. When you select this command, you are asked to provide the name for the new empty
file, and GnuCash creates a new data file that contains only your account hierarchy (that is, there is no
transaction data). Once saved, the new file can be opened like any other GnuCash data file as described
above.

Backing Up and Recovering Data
GnuCash creates several types of files to help ensure that your data is not lost. If you look in the folder
where your saved file resides, you may see other files generated by GnuCash with the following extensions:
.gnucash, .log, .LCK, .LNK in the same directory as your primary data file. What each of these files
does is presented below.

Note

The following sections are relevant only if you are saving your financial data in the XML format

      $ ls
      myfile.gnucash
      myfile.gnucash.20100414185747.gnucash
      myfile.gnucash.20100414223248.log
      myfile.gnucash.20100415114340.gnucash
      myfile.gnucash.20100415154508.log
      myfile.gnucash.20100415173322.gnucash
      myfile.gnucash.20100415194251.log
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      myfile.gnucash.7f0982.12093.LNK
      myfile.gnucash.LCK
    

Backup file (.gnucash)
Each time you save your data file, a backup copy will also be saved with the extension .YYYYMMDDHH-
MMSS.gnucash. This backup file is a complete copy of your previous data file, and the filename format
refers to the data file, year, month, day and time of the backup. For example, the filename myfile.gnu-
cash.20100414185747.gnucash indicates this is a backup copy of the file myfile saved in the
year 2010, April 14, at 6:57:47 p.m.

To restore an old backup file, simply open the .YYYYMMDDHHMMSS.gnucash file with the date to
which you wish to return. Be sure to save this file under a different name.

Note

.YYYYMMDDHHMMSS.xac instead of the actual extension .YYYYMMDDHHMMSS.gnucash.
So if you upgrade from the 2.2 series to the 2.4 series, you may end up with both .YYYYMMD-
DHHMMSS.xac and .YYYYMMDDHHMMSS.gnucash backup files in your directory.

Log file (.log)
Each time you open and edit a file in GnuCash, GnuCash creates a log file of changes you have made to
your data file. The log file uses a similar naming format as the backup files: .YYYYMMDDHHMMSS.log.
Log files are not a full backup of your data file - they simply record changes you have made to the data
file in the current GnuCash session.

In case you exit GnuCash inadvertently, possibly due to a power outage or a system wide crash, it is
possible to recover most of your work since the last time you saved your GnuCash file using this log file.
This is the procedure:

1. Open the last saved GnuCash file.

2. Go to File → Import → Replay GnuCash .log file and select the one .log file with the same date as the
saved file you just opened. Make sure that you picked the right .log file, or you will possibly wreak
havoc in your accounts.

Log replaying will recover any transaction affecting the balance entered since the last save, including those
created from scheduled transactions and business features (invoices, bills, etc.).

Warning

Changes to the scheduled transactions, invoices or bills themselves are NOT recovered, and their
transactions that were recovered may not be properly associated with them, and should thus be
double-checked. Especially for business transactions, you may have to delete and re-create some
of them. If you do not, although the balance will be correct, some reports may not.

Lock files (.LNK and .LCK)
You may occasionally see .LNK and .LCK files appear. These do not store any data, but they are created
to prevent more than one user from opening the same file at the same time. These files are automatically
created when you open the file, to lock it so no one else can access it. When you close your GnuCash
session or open another file, GnuCash unlocks the first data file by deleting the .LCK and .LNK files.
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If GnuCash crashes while you have a data file open, the .LCK and .LNK files are not deleted. The next
time you try to open GnuCash, you will get a warning message that the file is locked. The warning message
appears because the .LNK and .LCK files are still in your directory. It is safe to choose Yes to open the
file, but you should delete the .LNK and .LCK files (using a terminal window or your file manager). Once
those files are deleted, you will not get the warning message again unless GnuCash crashes.

File Management
So which files should you keep around? Keep your main data file, of course. It’s a good idea to keep some
of the more recent .YYYYMMDDHHMMSS.gnucash backup files, but you can safely delete the .log
files since they are not complete copies of your data.

Note

If you upgraded from a GnuCash version prior to 2.4, you may also have backup files in the old
.xac format. For these files you can apply the same principle described above for .YYYYMMD-
DHHMMSS.gnucash backup files.

You should also delete any .LCK and .LNK files that you see after closing GnuCash. If you decide to back
up your data file to another disk manually, it’s enough to back up the main data file - not the .YYYYM-
MDDHHMMSS.gnucash backup files.

Note

By default GnuCash will automatically delete any .log and .YYYYMMDDHHMMSS.gnucash
backup files that are older than 30 days. You can change this behavior in the GnuCash preferences
in the General tab under Edit → Preferences (GnuCash → Preferences on MacOS).

Migrating GnuCash data
Sometimes you may need to move your financial data and GnuCash settings to another machine. Typical
use cases are when you buy a new computer or if you want to use the same settings over two different
operating systems in a dual boot configuration.

Migrating financial data
Migrating GnuCash financial data is a as simple as copying .gnucash files with a file manager if you
know where they are saved. If you can’t remember where a file is stored but you can open it directly within
GnuCash, save it in the desired path from within GnuCash.

All other files in the folder are either backups or log files. It won’t do any harm to copy them too, but it’s
not likely to do any good, either.

Migrating preferences data
Preferences are stored in three different locations: one for GnuCash preferences, one for reports, and one
for online banking settings. Preferences are managed by gsettings, reports are managed by GnuCash itself,
and online banking is managed by aqbanking. If you do not use online banking, then you will not have
this folder on your machine.

Where the GnuCash preferences are stored varies depending on your operating system (see Table 2.3,
“Application Settings Locations”, Table 2.4, “Saved Reports Locations”, and Table 2.5, “Online Banking

24



The Basics

Settings Locations”). To back up and transfer your entire installation, you must copy these preferences
as well.

Table 2.3. Application Settings Locations

Operating system folder

Unix GnuCash preferences are stored in dconf. You can
use the commands dconf dump /org/gnu-
cash/ on the old machine and dconf load /
org/gnucash/ on the new machine to migrate
your preferences.

Mac OSX ~/Library/Preferences/gnu-
cash.plist

Windows The preferences are stored in the Windows
registryHKEY_CURRENT_USER/soft-
ware/GSettings

Table 2.4. Saved Reports Locations

Operating system folder

Unix ~/.gnucash

Mac OSX ~/Library/Application Support/gnu-
cash

Windows Documents and Settings/User-
name/.gnucash or Users/User-
name/.gnucash

Table 2.5. Online Banking Settings Locations

Operating system folder

Unix ~/.aqbanking

Mac OSX ~/.aqbanking

Windows Documents and Settings/User-
name/.aqbanking

Note

On Unix and Mac OSX, these folders will generally not display in the file manager. You must
set the file manager to show hidden files and folders to see them.

Tip

On Unix and Mac OSX, the ~ symbol means the home folder.

Putting It All Together
Note

This section begins a tutorial that will continue throughout this book. At the end of each chapter,
you will see a Putting It All Together section that walks you through examples to illustrate con-
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cepts discussed in that section. Each Putting It All Together section builds on the previous one,
so be sure to save your file for easy access.

Let’s get started!

1. First, let’s create a file to store your real data. Open GnuCash and select File → New File from the
Menubar. This will start the New Account Hierarchy Setup assistant that allows you to create several
accounts at once.

Note

If you are running GnuCash for the first time, you will be presented with the Cannot find
default values screen which is described in details in the GnuCash manual.

This image shows the first screen of the New Account Hierarchy Setup assistant.

The first screen of the assistant gives you a description of what the assistant does. Click the Forward
button to proceed to the next screen.

2. In the second screen, select the currency to use for the new accounts from the dropdown list. Then press
the Forward button.

Note

The currency you select here, will be assigned to all the accounts created in this assistant.
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This image shows the second screen of the New Account Hierarchy Setup assistant where you select
the currency.

3. In the third screen, set the New Book Options, then press the Forward button. You can also update
these options later using File  → Properties. For details of these options, see the GnuCash Help manual,
chapter Customizing GnuCash, Book Options.

This image shows the third screen of the New Account Hierarchy Setup assistant where you select the
book options.
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4. In the fourth screen select the Common Accounts group in the Categories pane. Then press the Forward
button to proceed.

Note

If you want, you can select one or more of the predefined account-groups here. For more
information on account types, see the section called “GnuCash Accounts”.

This image shows the fourth screen of the New Account Hierarchy Setup assistant where you choose
the various accounts.

5. In the fifth screen you will be able to set an Opening Balance on each of the accounts, as well as indicate
if the account should be a Placeholder. As these features will be described in next chapters, leave all as
configured by GnuCash and click Forward to open the last screen of the assistant.
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This image shows the fifth screen of the New Account Hierarchy Setup assistant where you can set
Opening Balance.

6. In the last screen of the assistant, click Apply to create all the accounts and leave the assistant.

This image shows the last screen of the New Account Hierarchy Setup assistant.

7. After pressing Apply in the previous window, you will be presented with the save dialog. Select the
XML Data Format, Name the file as gcashdata_1, select the folder where to save the file (remember
it as the data file will be used in the tutorials throughout this manual), and finally press the Save as
button.
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Your main window should now look something like this:

Accounts
This section discusses some useful concepts for organizing your accounts. Since GnuCash does not im-
pose any specific account tree layout, you are free to design your account structure in any manner you
wish. However, there are a few basic accounting concepts which you will probably want to follow when
designing your accounts to maximize their utility.

Basic Accounting Concepts

As we saw in the previous chapter, accounting is based on 5 basic account types: Assets, Liabilities, Equity,
Income and Expenses. We will now expand on our understanding of these account types, and show how
they are represented in GnuCash. But first, let’s divide them into 2 groups, the balance sheet accounts
and the income and expense accounts. As the name says the balance sheet accounts can be summarized
in the balance of what you own and owe at a point in the time, while the income and expense accounts
can be summarized in the Profit & Loss report, which shows the change of values in a period of time like
the economic year

Let’s have a quick look at the Accounting Equation (Assets - Liabilities = Equity + (Income - Expenses))
again as a reminder, before we go deeper into each account type.

Income Expenses

Equity
( Assets - Liabilities )

Positive Value
Assets

Negative Value
Liabilities

A graphical view of the relationship between the 5 basic accounts. Net worth (equity) increases through
income and decreases through expenses. The arrows represent the movement of value.

Balance Sheet Accounts

The three so-called Balance Sheet Accounts are Assets, Liabilities, and Equity. Balance Sheet Accounts
are used to track the things you own or owe.
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Assets is the group of things that you own. Your assets could include a car, cash, a house, stocks, or
anything else that has convertible value. Convertible value means that theoretically you could sell the item
for cash.

Liabilities is the group of things on which you owe money. Your liabilities could include a car loan, a
student loan, a mortgage, your investment margin account, or anything else which you must pay back at
some time.

Equity is the same as "net worth." It represents what is left over after you subtract your liabilities from
your assets. It can be thought of as the portion of your assets that you own outright, without any debt.

Income and Expense Accounts

The two Income and Expense Accounts are used to increase or decrease the value of your accounts. Thus,
while the balance sheet accounts simply track the value of the things you own or owe, income and expense
accounts allow you to change the value of these accounts.

Income is the payment you receive for your time, services you provide, or the use of your money. When
you receive a paycheck, for example, that check is a payment for labor you provided to an employer. Other
examples of income include commissions, tips, dividend income from stocks, and interest income from
bank accounts. Income will always increase the value of your Assets and thus your Equity.

Expense refers to money you spend to purchase goods or services provided by someone else for early
consumption. Examples of expenses are a meal at a restaurant, rent, groceries, gas for your car, or tickets
to see a play. Expenses will always decrease your Equity. If you pay for the expense immediately, you
will decrease your Assets, whereas if you pay for the expense on credit you increase your Liabilities.

GnuCash Accounts
This section will show how the GnuCash definition of an account fits into the view of the 5 basic accounting
types.

But first, let’s begin with a definition of an account in GnuCash. A GnuCash account is an entity which
contains other sub-accounts, or that contains transactions. Since an account can contain other accounts,
you often see account trees in GnuCash, in which logically associated accounts are grouped together within
a common parent account.

A GnuCash account must have a unique name (that you assign) and one of the predefined GnuCash “ac-
count types”. There are a total of 12 account types in GnuCash. These 12 account types are based on the
5 basic accounting types; the reason there are more GnuCash account types than basic accounting types
is that this allows GnuCash to perform specialized tracking and handling of certain accounts. There are
6 asset accounts (Cash, Bank, Stock, Mutual Fund, Accounts Receivable, and Other Assets), 3 liability
accounts (Credit Card, Accounts Payable, and Liability), 1 equity account (Equity), 1 income account
(Income), and 1 expense account (Expenses).

These GnuCash account types are presented in more detail below.

Balance Sheet Accounts

The first balance sheet account we will examine is Assets, which, as you remember from the previous
section, refers to things you own.

To help you organize your asset accounts and to simplify transaction entry, GnuCash supports several
types of asset accounts:
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1. Cash Use this account to track the money you have on hand, in your wallet, in your piggy bank, under
your mattress, or wherever you choose to keep it handy. This is the most liquid, or easily traded, type
of asset.

2. Bank This account is used to track your cash balance that you keep in institutions such as banks, credit
unions, savings and loan, or brokerage firms - wherever someone else safeguards your money. This is
the second most liquid type of account, because you can easily convert it to cash on hand.

3. Stock Track your individual stocks and bonds using this type of account. The stock account’s register
provides extra columns for entering number of shares and price of your investment. With these types
of assets, you may not be able to easily convert them to cash unless you can find a buyer, and you are
not guaranteed to get the same amount of cash you paid for them.

4. Mutual Fund This is similar to the stock account, except that it is used to track funds. Its account register
provides the same extra columns for entering share and price information. Funds represent ownership
shares of a variety of investments, and like stocks they do not offer any guaranteed cash value.

GnuCash treats account types Stock and Mutual Fund the same.

5. Accounts Receivable (A/Receivable) This is typically a business use only account in which you place
outstanding debts owed to you. It is considered an asset because you should be able to count on these
funds arriving.

Transactions involving an Accounts Receivable account should not be added, changed or deleted in
any way other than by using

• post/unpost bill/invoice/voucher or

• process payment

6. Asset No matter how diverse they are, GnuCash handles many other situations easily. The account type
“Asset”, covers all assets not listed above.

GnuCash treats account types Cash, Bank and Asset the same.

Accounts are repositories of information used to track or record the kinds of actions that occur related
to the purpose for which the account is established.

For businesses, activities being tracked and reported are frequently subdivided more finely than what
has been considered thus far. For a more developed treatment of the possibilities, please read the de-
scriptions presented in Chapter 15, Other Assets of this Guide.

For personal finances a person can follow the business groupings or not, as they seem useful to the
activities the person is tracking and to the kind of reporting that person needs to have to manage their
financial assets. For additional information, consult Chapter 15, Other Assets of this Guide.

The second balance sheet account is Liabilities, which as you recall, refers to what you owe, money you
have borrowed and are obligated to pay back some day. These represent the rights of your lenders to obtain
repayment from you. Tracking the liability balances lets you know how much debt you have at a given
point in time.

GnuCash offers three liability account types:

1. Credit Card Use this to track your credit card receipts and reconcile your credit card statements. Credit
cards represent a short-term loan that you are obligated to repay to the credit card company. This type
of account can also be used for other short-term loans such as a line of credit from your bank.
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2. Accounts Payable (A/Payable) This is typically a business use only account in which you place bills
you have yet to pay.

Transactions involving an Accounts Payable account should not be added, changed or deleted in any
way other than by using

• post/unpost bill/invoice/voucher or

• process payment

3. Liability Use this type of account for all other loans, generally larger long-term loans such as a mortgage
or vehicle loan. This account can help you keep track of how much you owe and how much you have
already repaid.

GnuCash treats account types Credit Card and Liability the same.

Tip

Liabilities in accounting act in an opposite manner from assets: credits (right-column value en-
tries) increase liability account balances and debits (left-column value entries) decrease them.
(See note later in this chapter)

The final balance sheet account is Equity, which is synonymous with “net worth”. It represents what is
left over after you subtract your liabilities from your assets, so it is the portion of your assets that you
own outright, without any debt. In GnuCash, use this type of account as the source of your opening bank
balances, because these balances represent your beginning net worth.

There is usually only a single GnuCash equity account, called naturally enough, Equity. For companies,
cooperatives etc. you can create a subaccount for each partner.

Tip

In equity accounts, credits increase account balances and debits decrease them. (See note later
in this chapter)

Note

The accounting equation that links balance-sheet accounts is Assets = Liabilities + Equity or
rearranged Assets - Liabilities = Equity. So, in common terms, the things you own minus the
things you owe equals your net worth.

Income and Expense Accounts

Income is the payment you receive for your time, services you provide, or the use of your money. In
GnuCash, use an Income type account to track these.

Tip

Credits increase income account balances and debits decrease them. As described in the section
called “Accounting Concepts”, credits represent money transferred from an account. So in these
special income accounts, when you transfer money from (credit) the income account to another
account, the balance of the income account increases. For example, when you deposit a paycheck
and record the transaction as a transfer from an income account to a bank account, the balances
of both accounts increase.

Expenses refer to money you spend to purchase goods or services provided by someone else. In GnuCash,
use an Expense type account to track your expenses.
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Tip

Debits increase expense account balances and credits decrease them. (See note later in this chap-
ter.)

Note

When you subtract total expenses from total income for a time period, you get net income. This net
income is then added to the balance sheet as retained earnings, which is a type of Equity account.

Below are the standard Income and Expense accounts after selecting Common Accounts in the assistant
for creating a new Account Hierarchy (Actions → New Account Hierarchy...).

This image shows the standard Income accounts

This image shows some standard Expenses accounts
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Other Account Types

There are some special other account types.

Trading Multiple currency transactions have splits in “Trading” accounts to make the transaction balance
in each currency as well as in total value. See Chapter 12, Multiple Currencies for more information.

Money Market and Credit Line are used only in the OFX importer, apparently for completeness with the
specification.

Putting It All Together

Let’s go through the process of building a common personal finance chart of accounts using the informa-
tion we have learned from this chapter. A chart of accounts is simply a new GnuCash file in which you
group your accounts to track your finances. In building this chart of accounts, the first task is to divide the
items you want to track into the basic account types of accounting. This is fairly simple, let’s go through
an example.

Simple Example

Let us assume you have a checking and a savings account at a bank, and are employed and thus receive
a paycheck. You have a credit card (Visa), and you pay monthly utilities in the form of rent, phone, and
electricity. Naturally, you also need to buy groceries. For now, we will not worry about how much money
you have in the bank, how much you owe on the credit card, etc. We want to simply build the framework
for this chart of accounts.

Your assets would be the bank savings and checking account. Your liabilities are the credit card. Your
Equity would be the starting values of your bank accounts and credit card (we do not have those amounts
yet, but we know they exist). You have income in the form of a salary, and expenses in the form of
groceries, rent, electricity, phone, and taxes (Federal, Social Security, Medicare) on your salary.

The Basic Top Level Accounts

Now, you must decide how you want to group these accounts. Most likely, you want your Assets grouped
together, your Liabilities grouped together, your Equity grouped together, your Income grouped together,
and your Expenses grouped together. This is the most common way of building a GnuCash chart of ac-
counts, and it is highly recommended that you always begin this way.

Start with a clean GnuCash file by selecting File → New File from the menu. The New Account Hierarchy
Setup assistant will start. Press Cancel to close the assistant as we don’t want to use one of the predefined
accounts structure; instead we will build a basic starting account structure from scratch. In the empty
GnuCash window select View → New Accounts Page from the menu: the Accounts tab will open. Finally
select Actions → New Account....

Now you are ready to build this basic starting account structure

1. Account name Assets (account type Asset, parent account New top level account)
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This image shows the dialog to create an assets account

2. Account name Liabilities (account type Liability, parent account New top level account)

3. Account name Equity (account type Equity, parent account New top level account)

4. Account name Income (account type Income, parent account New top level account)

5. Account name Expenses (account type Expenses, parent account New top level account)

When you have created the top-level accounts, the main Account page in GnuCash should look like below.
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This image shows the basic top-level accounts.

Making Sub-Accounts

You can now add to this basic top-level tree structure by inserting some real transaction-holding sub-
accounts. Notice that the tax accounts are placed within a sub-account named Taxes. You can make sub-
accounts within sub-accounts. This is typically done with a group of related accounts (such as tax accounts
in this example).

Tip

Instead of selecting Actions → New Account... from the menu, you can alternatively create a new
sub-account of an account by right clicking on the main account’s name and selecting the New
Account... entry. This will open a dialog similar to the one depicted in the section called “The
Basic Top Level Accounts” where the new sub-account will be already set as a child of the main
account.

1. Account name Cash (account type Cash, parent account Assets)

2. Account name Checking (account type Bank, parent account Assets)

3. Account name Savings (account type Bank, parent account Assets)

4. Account name Visa (account type Credit Card, parent account Liabilities)

5. Account name Salary (account type Income, parent account Income)

6. Account name Phone (account type Expense, parent account Expenses)

7. Account name Electricity (account type Expense, parent account Expenses)

8. Account name Rent (account type Expense, parent account Expenses)

9. Account name Groceries (account type Expense, parent account Expenses)

10.Account name Taxes (account type Expense, parent account Expenses)

11.Account name Federal (account type Expense, parent account Expenses:Taxes)

12.Account name Social Security (account type Expense, parent account Expenses:Taxes)
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13.Account name Medicare (account type Expense, parent account Expenses:Taxes)

14.Account name Opening Balance (account type Equity, parent account Equity)

After you have created these additional sub-accounts, the end result should look like below

This image shows a simple chart of accounts.

Save this chart of accounts with the name gcashdata_3, as well as gcashdata_3emptyAccts, as
we will continue to use them in the later chapters.

You have now created a chart of accounts to track a simple household budget. With this basic framework
in place, we can now begin to populate the accounts with transactions. The next chapter will cover this
subject in greater detail.

Transactions
This chapter will give you the basic information you need to understand and use transactions in GnuCash.
Whereas accounts are the framework and structure of a chart of accounts, transactions are the data which
fills each account.

Basic Concepts
A transaction in a double entry accounting system such as GnuCash is an exchange between at least 2
accounts. Thus, a single transaction must always consist of at least two parts, a from and a to account. The
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from account is transferring value to the to account. Accountants call these parts of a transaction Ledger
Entries. In GnuCash, they are called Splits.

A split identifies the account to which it refers, the amount of money specifically moved to or from that
account, and can contain a few other specific pieces of information if needed. GnuCash supports multiple
splits in a single transaction, and the splits can move money into or out of the involved accounts arbitrarily.

For example, you receive a paycheck and deposit it into your savings account at the bank. The transaction
that occurs is that your bank savings account (an asset) received money from your income account. Two
accounts are affected, and in this case there is a net increase in your equity.

Working with transactions in GnuCash is performed using what is known as the account register. Every
account you create has an account register. It will appear familiar to you as it looks very similar to the
log used to track checkbooks.

The account register is explained in the upcoming section, the section called “The Account Register”.

The Account Register
The account register is the window that allows you to view or edit preexisting transactions, or add new
transactions for a particular account. To open an account register from the Account Tree, double-click the
account name, right click the account name and select Open Account from the menu, or use the Open
button on the toolbar. GnuCash will display the account register window.

Features of the Account Register

The Titlebar of the account register displays the account name. Below the Titlebar, the Menubar displays
the menu items available within the account register, and the Toolbar contains handy buttons that help
you work with the account register.

At the bottom left of the register window, GnuCash displays helpful messages as you move about the
register. To the right, you can see the current account balance and the total of cleared splits.

Choosing a Register Style

GnuCash offers several options for viewing your registers. The default style is Basic Ledger mode, which
displays only the summary of splits affecting the current account. This is the style that most closely resem-
bles other popular personal financial packages. You can choose a different register style from the View
menu. There are two other view modes:

• View → Auto-Split Ledger style expands the current transaction automatically. As you highlight a new
transaction in the register, the transaction automatically expands to show all splits.

• View → Transaction Journal style shows all splits for all transactions in the register, which is more like
an accounting journal.

All styles permit you to view your data in either single-line or double-line format. Select View → Double
Line, and you will see your transaction line expand to two register lines. Double-line mode will also display
the transaction-level Notes field.

Below are screenshots that demonstrate how the Basic Ledger and Transaction Journal views differ.

For this example, let’s assume that you have purchased 3 pair of Jeans for $1,000, and have recorded the
purchase as a split transaction with each pair entered on a separate split.

The below screenshots illustrate the different view modes.
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First let’s view the Jeans transaction from your checking account:

This image shows one split transaction with 3 Jeans purchases

Now, let’s open the Expenses:Clothes account, and look at it in Basic view.

This image shows Expenses:Clothes account in Basic Ledger mode.

Three entries appear here, but there was only the single split entry in the checking account. Further exam-
ination shows that each row has a different amount, $200, $300, and $500. This demonstrates that each
row in this view reflects a single split from the original transaction.

Changing to Transaction Journal mode will display only the original split transaction.

This image shows Expenses:Clothes account in Transaction Journal mode.

Using Entry Shortcuts

GnuCash provides several time-saving shortcuts for entering your data. When you type the first few char-
acters of a description that you have used before, the QuickFill feature automatically fills in the rest of
the transaction as you last entered it. When you type in the first characters of an account name in either
the Transfer field of the transaction line or the Account field of the split line, QuickFill will automatically
complete the name from your account list. It also helps you with entering sub-accounts in these fields:
simply type the first characters of the parent account name followed by a : (colon) and the first characters
of the sub-account name. For example, to enter Assets:Checking, you might type A:C and let GnuCash
fill in the rest.

Warning

Because : is the account separator symbol, you can not use it in your account names.

40



The Basics

Tip

If you really need the colon in your account names, you can select another symbol by Edit →
Preferences → Accounts+Character.

Register keyboard shortcuts also save you time, and GnuCash provides several of them. In the date field,
you can type:

• + or = to increment the date and - or _ to decrement the date

• ] or } to increment the month and [ or { to decrement the month

• M or m to enter the first date of the month

• H or h to enter the last date of the month

• Y or y to enter the first date of the year

• R or r to enter the last date of the year

• T or t to enter today’s date

Tip

These date shortcuts not only work in the account register but everywhere you can enter a date.

Tip

Specifically for dates there's another way you can save time: you can enter partial dates. For
example if you only enter one number, GnuCash will interpret it as the day in the current month
of the current year. If you only enter a day and month, GnuCash will automatically append the
year. The default this to take such a date in a sliding window starting 11 months before the current
month. This means that if you enter 1/5 (January 5th) as date while the current date is in December
2015, the date will be completed as 1/5/16. This default can be changed via Edit → Preferences
→ Date/Time+Date Completion. You can change it to either always evaluate a date in the current
calendar year or change the start of the sliding window.

In the Num field of the transaction line, you can type + to increment the transaction number from the last
one you typed in. Typing - will decrement the number. This will also work in the Action field of the split
line, if you choose to enter split numbers there. The Action field also supports QuickFill - if you type the
first characters of a common action (such as Deposit), GnuCash will fill in the rest.

The Transfer field supports QuickFill of account names. You can start typing an account name and Gnu-
Cash will fill in the remaining part of the name. Typing the separator character at any time will complete
the current level of the account name, leaving the cursor positioned to start the next level of account name.
For example, typing A:C the standard set of account names will complete to the Assets:Checking account.
You can also type the Menu or Ctrl+Down keys in this field to pop up a list of all account names.

In any of the amount fields, you can use a built-in calculator. Simply type in the first value, followed by
+, -, *, or /, then type in the second value. GnuCash will perform the calculation and return the resulting
value to the amount field when you press the Tab key.

All of the menu items have access keys defined, and these are marked by underlined characters in the menu
names. Press Alt + [underlined character] to bring up the menu, then select an item by typing its underlined
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character. For example, typing Alt+A brings up the Actions menu, then typing P will split the transaction.
A few of the menu items also have shortcut keys that immediately invoke the command (typically using
the Ctrl key). These shortcuts are listed next to the item.

To move around the register, use these keys to save time:

• Tab to move to the next field, Shift+Tab to move to the previous field

• Home to move to the beginning of the field, End to move to the end of the field

• Enter or ↓ to move to the next transaction, ↑ to move to the previous transaction

• Page Up to move up one screen, Page Down to move down one screen

• Shift+Page Up to go to the first transaction, Shift+Page Down to go to the last transaction

In the Reconcile window you can use these keyboard shortcuts:

• Tab moves to the next box and Shift+Tab moves to the previous box

• Space bar toggles the status between reconciled and not reconciled

• ↑ and ↓ navigate through the entries within the current box

Simple vs. Split Transactions

Every transaction in GnuCash has at least two splits, but a transaction can have more than two splits. A
transaction with only two splits is called a simple transaction, since it only involves the current account
and a single remote account. A transaction with three or more accounts is called a split transaction.

When the register is in Basic view, you will see a summary of the splits affecting the current account. For
a simple transaction, the Transfer column will display the other account from which money is transferred.
For a split transaction, the Transfer column will display -- Split Transaction --. You can see the individ-
ual splits of each transaction by clicking the Split button in the Toolbar while selecting the appropriate
transaction.

For split transactions, the first line of the transaction is the transaction line. It contains a Date, optional
Num (such as a check number), transaction Description, total amount affecting the current account (Tot
Deposit here), and updated account Balance after the current transaction. Note that in the expanded view,
the Transfer column heading disappears, and there is no account name listed in that field. This line shows
you only a summary of the transaction’s effect on the current account. For more detailed information, you
need to look at the individual splits that make up the transaction.

Note

Note: An account register displays a transaction when that transaction has a split assigned to the
account. If a given transaction has more than one split assigned to the account, then in Basic and
Auto-Split views, that transaction will appear in the register one time for each split assigned to
that account. In Transaction Journal view, such a transaction will only appear once in the register.

The partial lines below the transaction line are the split lines, and they are separated by gray lines. As you
highlight one of the split lines, the column headings change to show the split-related fields:
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This image shows how split headings change.

Each split contains an optional Action, or type of split, which you can either type in or choose from a
pull-down list. The split also contains an optional Memo which describes the split. Each split affects an
Account, which can be selected from a pull-down list of your accounts. The R field indicates whether the
split has been reconciled. The last two columns show the amount of the split and whether money is coming
into or going out of the account.

As we discussed in the section called “Accounting Concepts”, total debits (left-column entries) must equal
total credits (right-column entries) for each transaction. In the example shown above, the total debits equal
the total credits, so this transaction is balanced. If you notice, the transaction line contains the same debit
amount as the Checking split line. Why is this shown twice? Because the transaction line is merely a
summary of the transaction’s effect on the current account. The same transaction in a different account
will have a different transaction line, one that shows the effect on that particular account. You can see this
by highlighting another split line and clicking the Jump button on the Toolbar.

In this example, if you jump to the Income:Salary account, GnuCash brings up the same transaction in
the Income:Salary - Register:

This image shows a jump to the Income:Salary account.

Note that the transaction line total now summarizes the effect on the Income:Salary account instead of the
Checking Account, because you are looking at the Income:Salary account register. The splits are exactly
the same, but the transaction line now reflects the credit to the Income:Salary account.

Simple Transaction Example

Starting with the chart of accounts we created in the previous chapter gcashdata_3, double click on
the Checking asset account. Let’s add a simple transaction to the checking account. When you first create
your accounts in GnuCash, it is common to start them off with an initial balance.

In the first transaction row, enter a date (eg: March, 1, 2006), a description (eg: “Opening Balance”), click
on the Transfer pop-up menu and select Equity:Opening Balances, add a deposit value of $1000, and press
the Enter key. The account register should now appear similar to this figure:
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This image shows Assets:Checking - Register after inserting a starting value transaction.

Setting the starting balances of an account is an example of a simple two account transaction. In this case,
affecting the Assets:Checking and the Equity:Opening Balances accounts.

As another example of a simple 2 account transaction, add another transaction to describe the purchase of
$45.21 worth of groceries. From within the Assets:Checking account, you would set Transfer to Expens-
es:Groceries. The account register should now appear:

This image shows Assets:Checking - Register after adding a transaction for groceries.

Split Transaction Example

The need for 3 or more splits in a transaction occurs when you need to split either the “from” or the “to”
account in a transaction into multiple accounts. The classic example of this is when you receive a paycheck.
Your take home pay from a paycheck will typically be less than your net pay, with the difference being due
to taxes, retirement account payments, and/or other items. Thus, the single transaction of you receiving a
paycheck involves other accounts besides simply Assets:Checking and Income:Salary.

To add the paycheck split transaction from the Assets:Checking account register window, click on a new
transaction line and click Split. Note that if you have set your register view to Auto-Split or Transaction
Journal, the splits will be opened for you. Enter the description of this transaction on the first line(e.g.
“Employers R Us”). In the split lines below this, enter the various splits that make up this transaction,
one by one. To enter the splits, first choose the account, then enter the amount by which to change the
account. Keep in mind that when in an asset account register, amounts entered in the left column increase
the account balance, while amounts entered in the right column decrease the balance (for more about this,
see the section called “Transactions”). Tab or click the next split line and repeat the process. Note that if
you are using the keyboard to navigate the transaction, use Tab to move from field to field, as using Enter
will commit the transaction and create splits to an Imbalance account.

Note

When creating a transaction in GnuCash, splits can be entered in any order. However, when the
transaction is closed (either when leaving the transaction, or when pressing the Enter key), all
debit splits will jump ahead of all credit splits.

In this example, choose the deposit account (Assets:Checking) and then enter the amount that is being
deposited into it (e.g. $670). Follow this by entering the amounts for the various taxes: Expenses:Tax-
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es:Federal account, $180; Expenses:Taxes:Medicare account, $90; and Expenses:Taxes:Social Security
account, $60. Finally, enter the gross total of your paycheck ($1,000 in this example) as a withdrawal
transfer from Income:Salary.

The final split should look like Figure 2.4, “Entering a split transaction”. Remember to press Enter after
finishing the entry. But you should also know that when you press Enter, the split view will be “folded”
back into a simplified transaction view. The splits are still there; you just have to click Split to view them.
See the section called “Features of the Account Register” for details.

Figure 2.4. Entering a split transaction

Reconciliation
Once transactions have been entered into GnuCash, it is important to verify that they agree with the records
of your financial institution. This verification process is known as reconciliation, and it is key to determine
whether your records are accurate. Most commonly, you will check transactions against bank statements,
although you can use this process to verify any transaction.

GnuCash keeps track of the reconciliation status of each transaction. The reconciliation status of a trans-
action is shown by the reconciliation R field in a register: y indicates that a transaction has been reconciled,
n indicates that it has not, and c indicates that it has been cleared, but not reconciled. A split marked cleared
signifies that you got some kind of confirmation that the institution accepted the order (e.g. you have the
restaurant's receipt for your credit card purchase). You can toggle the reconciliation status between n and
c by clicking in the R field; you can set it to y by using the section called “Reconcile windows”.

At the bottom of the account window, there are (among others) two running balances (the cleared and
reconciled balance), and the total balance. The former balances should correspond to how much money
the bank thinks you have in your account, while the latter includes outstanding transactions.

For example, when you write a check for something, you should enter the transaction into GnuCash. The
reconciliation R field of the transaction will initially contain n (new). Your new entry will contribute to
the total balance, but not to the cleared and reconciled balance. Later, if you got some confirmation that
the check has been cashed, you might click on the transaction’s R field to change it to c (cleared). When
you do this, the cleared balance will change to include this amount. When the bank statement arrives, you
can then compare it to what you’ve recorded in GnuCash by opening the reconciliation window. There,
you will be able to change the R field to y (reconciled).

Note

You cannot reconcile directly in a register window by clicking in the R field. You must use the
reconciliation window. Once a transaction has been marked reconciled, it can no longer be easily
changed without breaking the Starting Balance of the next reconciliation.
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Warning

It is important to understand that reconciliation is done for a given date, and when you reconcile
an account based on a statement from a given date, you are reconciling all transactions prior
to that date. Therefore, if you add or modify transactions that predate your last reconciliation,
your reconciled balances will be thrown off.

Reconcile windows

The reconciliation windows are used to reconcile a GnuCash account with a statement that a bank or other
institution has sent you. Reconciliation is useful not only to double-check your records against those of
your bank, but also to get a better idea of outstanding transactions, e.g. uncashed checks.

To use the reconciliation windows, select an account from the account tree and click on Actions → Recon-
cile. A window like the one below will appear in which you can enter the reconcile information.

The initial reconcile window.

In the initial reconcile window, some Reconcile Information need to be entered.

Statement Date The date of the statement you will be reconciling
against.

Tip

Click on the down arrow in the right of
this field to open a calendar

Starting Balance This is a non-editable item which displays the bal-
ance from the previous reconciliation. It should
match the starting balance in your statement.

Warning

Sometimes, the opening balance in Gnu-
Cash does not match that found on your
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statement. This can happen the first time
you reconcile your account or when a pre-
viously-reconciled transaction is de-rec-
onciled or deleted.

Note

The first time you reconcile your account,
the starting balance will be 0.00, thus
probably not the opening balance of your
account. When you reconcile the account,
the opening balance for the account will
be included in the reconciliation, and the
result should balance.

Tip

In the case when a previously-reconciled
transaction is accidentally de-reconciled,
you can simply re-reconcile the transac-
tion along with the transactions on the
current statement, and the result should
balance.

The case of accidentally deleting a pre-
viously-reconciled transaction presents
more of a challenge; if you cannot de-
termine what was deleted and restore it
to the register, you will have to create a
dummy transaction to get the reconcilia-
tion to finish.

Caution

While the latter case does not matter for
your private accounting, you should have
a really good explanation for your audi-
tors, if you are the accountant of a club or
a company.

Ending Balance This field should be filled with the ending balance
as it appears in the statement.

Note

GnuCash automatically fills this field
with the Present balance as shown in the
lower part of the account’s register.

Include Sub-accounts Check this option if you want to include in the rec-
onciliation the transactions that belongs to the sub-
accounts of the currently selected account. Note
that all sub-accounts must be in the same commod-
ity as the parent for the option to be enabled.
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Enter Interest Payment Clicking this button opens a new window that al-
low you to enter an interest transaction to the ac-
count to be reconciled.

Tip

The Interest Payment window might be
opened automatically when you start a
reconciliation for an account of the type
Bank, Credit, Mutual, Asset, Receivable,
Payable, and Liability. If you want to dis-
able this behavior for any of the previ-
ous accounts, go to the Register tab of the
GnuCash Preferences and uncheck the
Automatic interest transfer option. Alter-
natively, to disable this behavior only for
the selected account, press the No Auto
Interest Payments for this Account button
in the Interest Payment window.

Then, click on the Ok button, and you will see the transactions listing reconcile window:

The transactions listing in the reconcile window.

The two panes called Funds In and Funds Out, lists all the unreconciled transactions that belongs to the
account that is going to be reconciled. The R columns show whether the transactions have been reconciled.

Now, examine each item on the bank statement, and look for the matching item in the Reconcile window.

If you cannot find a transaction, then perhaps you forgot to enter it, or did not know that the transaction had
happened. You can use the New button on the Toolbar, or the Transaction → New menu item in the menu,
to open a register window and enter the missing transaction. The new item will appear in the Reconcile
window when you press the Enter button in the register after entering the transaction.

When you find the item in the Reconcile window, compare the amount in the item to the amount on the
statement. If they disagree, you may have made an error when you entered the transaction in GnuCash.
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You can use the Edit button on the Toolbar, or the Transaction → Edit item, to open a register window
and correct the transaction.

If the amounts agree, click on the item in the Reconcile window. A check mark wil appear in the R column
aside the selected transaction. GnuCash will automatically update the amounts in the lower right summary
pane.

Tip

You can use the up/down arrow keys to scroll to the item, the space key to mark the item as
reconciled and the Tab key to switch panes.

You then repeat this for each item that appears on the bank statement, verifying that the amounts match
with the amounts in GnuCash, and marking off transactions in GnuCash as they are reconciled.

Tip

You can check or uncheck the reconcile status of all transactions in either pane by clicking on
a transaction in the required pane then clicking Ctrl-A followed by space. This will toggle the
reconcile status of all transactions in the pane to either checked or unchecked state. This procedure
can be repeated to achieve the desired status for the transactions in the pane.

At the bottom of the Reconcile window there is a Difference field, which should show 0.00 when you are
done reconciling. If it shows some other value, then either you have missed transactions, or some amounts
may be incorrect in GnuCash. (Or, less likely, the bank may have made an error.)

Note

Under some circumstances, it may be difficult or impossible to determine why an account will
not reconcile. If you are unable to correct the discrepancy between your books and a statement,
GnuCash includes a Balance button on the Toolbar that will automatically create a balancing
entry for you in the amount that cannot be reconciled.

To use this, carry out the full reconciliation (marking all transactions that you can identify) and
then click this button. GnuCash will create a balancing entry for the remaining discrepancy that
uses the Special Accounts:Orphan-XXX account (where "XXX" represents your currency). The
Reconcile window will close; re-opening it will allow you to check the newly-created balancing
entry and finish the process.

When you have marked off all the items on the bank statement and the difference is 0.00, press the Finish
button on the Toolbar or select Reconcile → Finish from the menu. The Reconcile window will close. In
the register window, the R field of the reconciled transactions will change to y.

In this case, we have not received all the information yet, so we simply press the Postpone button, so we
can continue at a later stage. Observe that the R column indicates we cleared (c) two transactions. They
have not been reconciled yet, but we have verified these two transactions so they have been marked as
cleared. If you look at the Statusbar at the bottom of the account register, you will see a summary of what
has been reconciled and what has been cleared (Cleared:USD 954.79 Reconciled:USD 0.00)
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The Checking account after postponing the reconciliation.

Scheduled Transactions

Scheduled transactions are made to help entering repetitive money operations, like subscriptions, insur-
ances or taxes. By using scheduled transactions, you only have to enter the concerned transaction once,
set a few parameters like start date, frequency and a little description, and then GnuCash will tell you
whenever a scheduled transaction is ready to be created, and create it for you.

In this howto, we’ll take a monthly Internet subscription of 20 USD as example, which is taken on the
28th of each month.

In GnuCash, there are two ways of creating scheduled transactions, from the ledger or from the Scheduled
Transactions Editor.

Creating from the Ledger

Enter the first occurrence of your to-schedule transaction in the ledger. In the Transfer field for this trans-
action, type Expenses:Internet as shown in the next screenshot.

Step one creating scheduled transaction from the ledger

Note

Since we did not create the Expenses:Internet account, GnuCash will prompt us to create it.

Then you right click on your transaction and select Schedule...
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Step two creating scheduled transaction from the ledger

A window like this will appear:

Step three creating scheduled transaction from the ledger

Let’s fill the values, we know that the subscription is taken on the 28th each month, and the next one is
for next month (since we entered the one for this month manually) :
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Filling in data to a scheduled transaction

Click the OK button, and the transaction will be scheduled. GnuCash now has memorized this scheduled
transaction and on the 28th of next month, it will pop up a window asking if it should create it (see far
below for a screenshot of this window).

Creating from the Editor

Another way of entering a scheduled transaction is from the Scheduled Transaction Editor, it may be faster
if we have several scheduled transactions to create at once.

From the main accounts windows, select Actions → Scheduled Transactions → Scheduled Transaction Ed-
itor from the Menubar. A new Scheduled Transactions tab will be opened in the current GnuCash window
as shown above:
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Empty Scheduled Transactions tab

This tab contains a list, now empty, of all the scheduled transactions. Let’s create a new one by clicking
on the New button in the Toolbar. A window like the one below will pop up:
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Edit Scheduled Transaction window, Overview tab

First, let’s enter a name for this new scheduled transaction in the top of the window.

Note

This name will only identify the transaction in the Edit Scheduled Transaction window, it will
never appear in the ledger.

In the Options pane of the Overview tab you have four options:

Enable Sets the status of the scheduled transaction.

Create automatically If enabled, will insert this transaction in the ledger with-
out asking you before (see below). If needed, you can
be advised when the transaction is entered by checking
the Notify me when created option.

Create in advance Sets how many days in advance the transaction will be
created.

Remind in advance Sets how many days in advance a reminder is presented.
This can be used, for example, when you have to pay
something by check, and a reminder one week before
allows you to send your check before the deadline.

The Occurences pane allows you to tell GnuCash that this scheduled transaction won’t last for ever. For
example if you are repaying a loan, you can enter the loan end date or the number of occurences left.

Select now the Frequency tab in the Edit Scheduled Transaction window. Here you can set the time-related
options of the transaction.
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Edit Scheduled Transaction window, Frequency tab

Frequency Sets the basic frequency of the transaction,
with options for once, daily, weekly, se-
mi-monthly and monthly. In this example,
this is set to monthly.

Note

It is possible to set a transaction
to occur at intervals other than
those listed in the Frequency list,
by changing the setting in the Every
control (see below).

Start Date Sets when the transaction will begin. In the
example, this would be set to the start of the
next month.

Every This option allows you to schedule transac-
tions by multiplies of the value in Frequency.
For example, to create a transaction that runs
every 3 weeks, set Frequency to Weeks and
Every to 3.

On the and Except on weekends Sets the day of the month that the transaction
is scheduled, and controls what GnuCash will
do when the day occurs on a weekend day.
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Note

We know that the subscription is taken on the 28th each month, so the Start date will be November
1, 2003 (assuming November is the next month), the Frequency will be Monthly, it will be taken
every month on the 28th. Since in our example the internet subscription is automatically taken
from the account, we have no need to create it in advance, nor give an end date.

When the elements on this tab are filled in, GnuCash will highlights the calendar below to indicate when
future transactions will be run.

Finally select the Template Transaction tab and enter your transaction in the lower part as you would do
in the ledger, with the only difference of having no date.

Now, you should have a window like this:

Edit Scheduled Transaction window, Template Transaction tab

Remember to click on the Enter icon, to validate and enter the transaction.

Now click OK, it takes you to the Scheduled Transactions tab, now showing one item in the Transactions
list:
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Entered scheduled transaction

Tip

If you click in the calendar part on the first day of one month, a small window, following your
mouse, will show you what is planned for this day. To make the small window disappear again,
just click in it one more time.

You can now close the Scheduled Transaction tab, and save your work.

Note

What comes below is just an illustration, and is not meant to be entered into the GnuCash database
at this stage. As per this example, the below dialogs will appear when the scheduled transaction
is supposed to run.

From now on, when GnuCash is launched and a scheduled transaction is scheduled or need to be entered,
you may see a Since Last Run... window summarizing the scheduled transactions operations (Reminder,
To-Create etc... a better description of each option can be found in the GnuCash manual):
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Scheduled transaction popup reminder

You can click on the Status column to change the scheduled transaction status if needed. Then just click
on Ok to close the Since Last Run... window and to apply the pending operations. Select Cancel to skip
entering in the ledger the pending operations.

If the Status field was set to To-Create, then if you take a look in your bank account register, you’ll see
the transaction has been created:

Tip

If you enable the Review created transactions option in the lower right of the Since Last Run...
window, GnuCash will open, after pressing Ok, the register tab of each account where the sched-
uled transactions were entered automatically.

Note

If you entered the transaction for 28 of April at this stage, then please revert back to the last
saved GnuCash file by selecting File → Open and choosing the previously saved gcashdata_3
GnuCash file.

Putting It All Together
In the previous sections of this chapter the concepts and mechanics of working with transactions in Gnu-
Cash have been discussed. This section will expand upon the chart of accounts initially built in the previous
chapter, by setting some opening balances, adding transactions and a scheduled transaction.

Open GnuCash file

Start with opening the previous datafile we stored, gcashdata_3emptyAccts, and store it as gcash-
data_4 directly. The main window should look something like this:
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This image shows the starting point for this section.

Opening Balances

As shown earlier in the section called “Simple Transaction Example” with the Assets:Checking account,
the starting balances in an account are typically assigned to a special account called Equity:Opening Bal-
ance. To start filling in this chart of account, begin by setting the starting balances for the accounts. As-
sume that there is $1000 in the savings account and $500 charged on the credit card.

1. Open the Assets:Savings account register. Select View from the menu and check to make sure you are
in Basic Ledger style. You will view your transactions in the other modes later, but for now let’s enter
a basic transaction using the basic default style.

2. From the Assets:Savings account register window, enter a basic 2 account transaction to set your starting
balance to $1000, transferred from Equity:Opening Balance. Remember, basic transactions transfer
money from a source account to a destination account. Record the transaction (press the Enter key,
or click on the Enter icon).

3. From the Assets:Checking account register window, enter a basic 2 account transaction to set your
starting balance to $1000, transferred from Equity:Opening Balance.

4. From the Liabilities:Visa account register window, enter a basic 2 account transaction to set your start-
ing balance to $500, transferred from Equity:Opening Balance. This is done by entering the $500 as
a charge in the Visa account (or decrease in the Opening Balance account), since it is money you bor-
rowed. Record the transaction (press the Enter key, or click on the Enter icon).

You should now have 3 accounts with opening balances set. Assets:Checking, Assets:Savings, and Liabil-
ities:Visa.
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This image shows the opening balances.

Additional Transaction Examples

Now add some more transactions to simulate a month’s expenses. During the month, $78 is spent on
electricity, $45 on phone, and $350 on rent. All paid by check. We also spent $45.21 on groceries, received
$670 as salary, and paid our Internet bill this month. Finally, let’s move $100 from the savings account
to the checking account.

1. Open the Expenses:Electricity account register and enter a simple 2 account transaction to pay the
$78 electrical bill at the end of the current month (eg: March 28, 2006). Enter a description (eg: Light
Company) and the check number (eg: 102). The Transfer account should be Assets:Checking.

2. Open the Assets:Checking account register and enter a simple 2 account transaction to pay the $45
phone bill at the end of the current month (eg: March 28, 2006). Enter a description (eg: Phone Company
Name) and the check number (eg: 103). The Transfer account should be Expenses:Phone. Notice that
you can enter expense transactions from either the credit side (the expense accounts) or the debit side
(the asset account).

3. Open the Expenses:Rent account register and enter a simple 2 account transaction to pay the $350 in
rent at the end of the current month (eg: March 28, 2006). Enter a description (eg: April Rent) and the
check number (eg: 104). The Transfer account should be Assets:Checking.

4. Duplicate this transaction using the Duplicate button in the Toolbar. Start by clicking on the current
rent transaction, and click on the Duplicate icon. Enter the transaction date a month out in the future
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(eg: April 28, 2006), and notice the blue line separator that GnuCash uses to separate future transactions
from current ones. In this way, you can enter transactions before they occur.

You could also set up a scheduled transaction to pay your rent, since the value of the rent is likely to
be constant for the foreseeable future.

• Start by clicking on the current (April 28) rent transaction, and click on the Schedule icon

• Change to Monthly, change description if needed and press OK

5. To transfer money from your savings account to your checking account, open the Assets:Savings ac-
count register, add a new transaction setting the Transfer to Assets:Checking in the amount of $100
(date 6 March, 2006).

6. As another example of a simple 2 account transaction, add another transaction to describe the purchase
of $45.21 worth of groceries on 5 of March. From within the Assets:Checking account, you would set
Transfer to Expenses:Groceries. The account register should now appear:

7. To add a paycheck transaction from the Assets:Checking account register window, click on a new trans-
action line, and click on Split. First enter the description of this transaction on the first line (eg: “Em-
ployers R Us”), as well as the date (14 March). In the “split” line below this, enter the deposit into
Assets:Checking (eg:$670). Follow this with the various tax deposits (Assets:Checking (eg: $670), Ex-
penses:Taxes:Federal account (eg: $180), Expenses:Taxes:Medicare account (eg: $90), and Expens-
es:Taxes:Social Security account (eg: $60)) and lastly the gross total of your paycheck (eg: $1000) as
a withdrawal transfer from Income:Salary.

8. You also need to pay for your Internet subscription of 20 USD on the 28th.
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This image shows the ending balances after the section called “Transactions”.

Save file

Before we go to the report section, let’s save the GnuCash data file (gcashdata_4).

Reports

But only having data available on the computer screen will not make your accountant happy, therefore
GnuCash comes with a large number of highly customizable reports.

Let’s have a look at a Cash Flow, and a Transaction Report.
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1. First let’s have a look at the Cash Flow report for the month of March.

Select the cash flow report from Reports → Income & Expense → Cash Flow.

This image shows the Cash Flow report after the section called “Transactions”.

To get this customized report, right click in the report and choose Report Options. Then set the time
period, and specify which accounts you want in the report.

2. Now let’s have a look at corresponding transaction report for the Checking account.

Select the transaction report from Reports → Transaction Report.
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This image shows the Transaction Report for the Checking account during March.

3. Now let’s change the transaction report to only show the various Expenses accounts.

This image shows the Transaction Report for the various Expense accounts during March.
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Chapter 3. Importing Data into
GnuCash

This chapter will detail procedures for importing data into GnuCash.

Importing Transactions from Files
Imported transactions will generally be to a specific account in your account tree. In the following this will
be referred to as the import or base account. It may or may not be specified in the data being imported,
depending on the import format. It is usually the first split of a transaction being imported.

All transactions will also must have a destination account for at least matching splits. This may or may not
be supplied in the imported data. If it is not, an account can be assigned on the basis of the previous import
history by matching to infomation in the imported data. The user may always over-ride this assignment.

Multi-split data previously exported from GnuCash may have both the import and destination accounts
for transaction splits specified in the data file.

File Import Formats
Gnucash allows transactions to be imported in the following formats:

• QIF (.qif) Quicken Interchange format - import data from Quicken financial software;

• OFX/QFX (.ofx,.qfx) Open Financial eXchange format (QXF is an Intuit/Quicken proprietary version
of OFX);

• CSV (.csv) Comma Separated Values;

• MT940 MT940

• MT942 MT942

• DTAUS DTAUS

These import methods can be accessed from File → Import ....

Import Matcher
Several of the Import Assistants use an Import Matcher to implement a Bayesian approach to assign des-
tination accounts, if such accounts are not specified in the imported data, to each imported transaction
based on the previous import history of the import account. It also attempts to match the transactions being
imported to any existing transactions based on the date and the description fields.

Transaction rows which match existing transactions already in the import account are flagged not to be
imported. They will have a light green background and the A and U+R checkboxes will be unchecked and
the R checkbox will be checked. To override and import the transaction, check the A checkbox. The U and
R boxes will be unchecked automatically. The reliability of the match is indicated by a bar display in the
Info column. If a destination account for the second split is assigned by the matcher if will be appended
to the info column.
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Transaction rows which do not match existing transactions in the import account, for which an assignment
of a destination account cannot be made on the basis of the previous import history to the account, will be
displayed with an orange-yellow background and the A box will be checked and U+R and R unchecked.
A destination account must be specified for these transactions.

Assign a Destination Account to a Single Transaction

The currently selected row is selected by Left-clicking it. It is displayed with a mid dark green background.

Double click on a row. This will select it and open an Account Selection dialog. Select the desired des-
tination account in the dialog and click OK. The row background will change to a light green and the
assigned destination account will be displayed in the Info column.

or alternatively, Left-click on a row to select it followed by a Right-click to bring up a popup menu then
select "Assign a transfer account" to display the Account Selection dialog, select the destination account
and click the OK button.

Assign a Destination Account to Multiple Transactions

Sometimes you will have several transactions which will have the same destination account. Gnucash
allows you to select multiple transactions and apply the same destination account to all transactions in
the selection.

Rows in a selection are displayed with a mid dark green background.

Multiple rows may be selected to have the same destination account assigned to them.

To select rows either:

• Left click on first row and then Ctrl-Left click on other rows to add to the selection or

• Left-click on a first row and then Shift-Left-click on another row to select all rows between them.

then Right-click to display a popup menu and then select "Assign a transfer account" to open the Ac-
count Selection dialog. Select the desired destination account and click the OK button in the Account
Selection dialog.

Completing the Import

Once you have assigned destination accounts for all the imported transactions using the above methods (all
row backgrounds will be a light green colour), check that the assigned destination acounts are correct and
then press the OK button at the bottom of the Generic Import Matcher window. The transactions selected
for import will have their splits added to the selected source and destination accounts.

The choices made for the destination accounts and description/memo fields are remembered and stored and
used for future imports to the same account to automatically assign a destination account for transaction
records not containing destination account information.

Import QIF
To import data from Quicken®, MS Money, or other programs that use QIF(Quicken® Interchange For-
mat), you must first export your data to a QIF file. One way to do this is to export each account as a separate
QIF file. An easier way, available in Quicken® 98 and beyond, is to export all accounts at once into a
single QIF file. Check your program's manual to determine if this option is available.
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To import QIF files:

Load all of the QIF files containing data you wish to import

To do this, select File -> Import -> Import QIF... from the menu. When the QIF Import dialog box
appears, click Next and follow the instructions to guide you through the process of loading your files.

This image shows the start of the QIF Import assistant.

You will be prompted for a filename to load. Use the Select button to select your QIF file and click Next
to load it. Once the file is loaded, select Load another file if you have more files to load. When you have
loaded all your QIF files, click Next to continue with the import process.

Review the GnuCash accounts to be created.

The importer then matches up your QIF accounts and categories with GnuCash accounts and gives you
a brief description of the matching process. Clicking Next will bring you to a view comparing your QIF
accounts with the corresponding GnuCash accounts created. To change an account name, select the row
containing that account name and edit the name in the dialog box provided. Click Next when you have
finished making changes, and proceed through a similar category matching process. QIF income and ex-
pense categories import as GnuCash income and expense accounts Make changes to these account names
if necessary, and click Next to continue.

Note: If you are not sure what changes are needed, it is safe to accept the GnuCash account names. It is
easy to edit the accounts later if you find you need to make a change.

From the drop-down list, select a standard currency to be used for the imported accounts and click Next
to continue. If you have stocks, mutual funds, or other securities, you will be prompted for additional
information. The importer dialog will ask for the exchange or listing (i.e. Nasdaq), the security's full name,
and the ticker symbol. If you do not have this information handy, you can edit the account information
later, once the import is complete. Click Next to continue.

Tell GnuCash to import the data.

The last step is the import. Once you have verified your account names and investment information, click
Finish in the Update your GnuCash accounts page to complete the import process. Depending upon the
size of your file, the import might take a few minutes to complete, so a progress bar displays the percentage
finished. When the import process is complete, GnuCash will return you to the main window, which should
now display the names of the accounts you imported.

Import OFX/QFX
This opens a file selection dialog. Navigate to the file you wish to import, select a file with the appropriate
extension (.ofx or .qfx), then press the Import button.

Gnucash opens an Account Selection dialog to select an account in your CoA corresponding to data source.
Select the appropriate account from the account tree and press the OK button. On subsequent import
of files from the same source (identified by tags in the file), the source is remembered and the account
selection dialog is not displayed.

The generic import transaction matcher dialog is opened next. See the  Import Matcher section (common
to both OFX/QFX and CSV import formats) following the Import CSV section to continue the import
process.
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Import CSV
Clicking on Import CSV in the Import menu will bring up the Import Assistant dialog. The first step
brings up a file selection dialog. Navigate to the location where the file you wish to import is located and
select the file to import then click the OK button.

The next window will allow you to set parameters for the importing of the file. All widgets have tooltips
which explain what the setting affects and the options for the setting.

Load and Save Settings

If this import is a regular occurrence, once you have set the other import paramters, you can save these
settings by typing in a setting name in the Load and Save Settings Entry combo box and pressing the Save
button just to the right of the box. Previously defined settings can be retrieved by selecting the appropriate
setting name from the dropdown list activated by the down arrow at the right end of the text box. The trash
can button to the right of the Save button can be used to remove the settings selected from the drop down
list for the box. The settings group "GnuCash Export Settings" define a setting group for the export and
reimport of GnuCash transaction data - use this if importing data previously exported from GnuCash.

Account

This combo box allows you to select the base or import account into which the transactions will be im-
ported. It may be left unset if the imported data contains a column listing the accounts associated with each
split or the import data specifies the account for first split of the transaction.

File Format

This section allows you to define whether the file has:

• Fixed width columns Selecting this radio button will allow you to define column boundaries by double
clicking at the appropriate positions in the sample records displayed in the panel below. Single clicking
in a column will narrow, widen or merge the column.

• Separators Selecting this radio button will allow you to define characters which will be used to distin-
guish columns in the input file. The default is comma separated however spaces, tabs,colons or semi-
colons or any combination of them may be used to separate columns in the input file by selecting the
appropriate check boxes. You may also define custom separators by typing the required characters into
the text box and selecting the Custom checkbox. This may be used in combination with any of the
predefined separators.

• Multi-split Selecting this check box allows the splits for a single transaction to be defined on consecutive
lines within the file with each line defining a single split. If not selected each line is assumed to contain
the information for a single transaction including one or two splits.

Miscellaneous

The miscellaneous settings allow you to set:

• EncodingThis is usually the UTF-8 variant for your locale;

• Date Format This does not default to the Locale setting so check it matches the data you are importing;

• Currency Format;

• Leading Lines to Skip;
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• Trailing Lines to Skip;

• Skip alternate lines;

to match the settings for the file you are importing. Tooltips may also contain information on the setting
and options.

Import Panel

The import panel shows the data being imported as it is interpreted using the settings chosen to define
columns and formats. The dropdown lists in the headers for each column of the import allow you to
associate a specific column in the imported data with a specific field in the display of a transaction in an
account register. At a minimum to import data, columns in the imported data containing the following
information must be specified:

• Date of transaction;

• Account into which transaction is to be imported (or alternatively set the base account as above);

• Description of the transaction;

• Deposit or Withdrawal column.

The Skip Errors check box will skip trying to import any rows with errors in matching the columns.

When you are happy with all the import settings, save them if you will use the same settings again, then
press the Next button. This will bring up a window which allows you to map the accounts identified in the
account column (Account Id) with accounts in the GnuCash account tree (Account name). Double click
on a row to bring up a dialog to select the matching GnuCash account. When you have selected a match
for all accounts, click on the Next button.

The Transaction Information panel allows review of data entry settings so far.

Clicking on Match Transactions will then bring up the main Import Matcher window described in the next
section.

Import MT940
Use this option to import MT940 data.

Import MT942
Use this option to import MT942 data.

Import DTAUS
Use this option to import DTAUS data.
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Chapter 4. Configuring GnuCash
This chapter will detail preference settings for GnuCash.

Overview
Configuring is fun.

Main Configuration Screens
GnuCash stores settings in two main locations.

Preferences: Accounting Period Tab
Stuff about the Accounting Period tab

Preferences: Accounts Tab
Stuff about the Accounts tab. Need this stub for the link in The Basics. More later.

Preferences: Online Banking
Stuff about the Accounts tab. Need this stub for the link in The Basics. More later.
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Chapter 5. Checkbook
This chapter will give you all the specific information you need to manage your checkbook with GnuCash.
Managing your checkbook register is the first step of tracking your finances, and GnuCash makes it much
easier to manage than the traditional paper register does.

For one thing, as discussed in the section called “Transactions”, data entry of common transactions is
practically done for you in GnuCash, because of its auto-completion feature. GnuCash keeps a running
balance of each account, and it makes reconciling these accounts easy. And the double-entry method helps
you account for your spending by requiring a transfer account for withdrawals, so you can easily find out
how much money you spend in different areas.

Once you are comfortable with using GnuCash for your checking and other bank accounts, you may wish
to continue on with tracking other financial accounts. Chapters 6 through 9 examine methods to manage
your other accounts.

Setting up Accounts
The first step in managing your checkbook is to set up the necessary accounts. You can either use the
default GnuCash accounts or set up your own. For more detail on how to set up a new account, refer to the
section called “The Basic Top Level Accounts”. For instructions on importing your accounts from another
program, refer to the GnuCash manual.

Let’s start with the bank accounts you’ll need. You need one GnuCash bank type account for each physical
bank account you wish to track. If you are setting up your own accounts or using the default GnuCash
accounts, make sure that you have an opening balance transaction for each bank account you own. The
easiest way to get this number is to use the balance from your last bank statement as your opening balance.
You can enter this in the account information window automatically as part of the New Account Hierarchy
Setup assistant, or you can enter a manual transaction directly in the account. To enter the transaction
manually, enter a transfer from an Opening Balances account (type equity) to the bank account.

The typical bank accounts you might track include:

• Checking - any institutional account that provides check-writing privileges.

• Savings - an interest-bearing institutional account usually used to hold money for a longer term than
checking accounts.

Common transactions that affect these bank accounts are payments and deposits. Payments are transfers
of money out of the bank account, usually to an expense account. Deposits are transfers of money into the
bank account, usually from an income account. You will need to set up income and expense accounts to
track where that money comes from and where it goes. Remember that a balanced transaction requires a
transfer of an equal sum of money from at least one account to at least one other account. So if you deposit
money in your checking account, you must also enter the account that money comes from. If you pay a
bill from your checking account, you must also enter the account where that money goes.

Entering Deposits
Most deposit transactions are entered as a transfer from an income account to a bank account. Income
may come from many sources, and it’s a good idea to set up a separate income type account for each
different source. For example, your income may come mainly from your paychecks, but you may also
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receive interest on your savings. In this case, you should have one income account for salary and another
income account for interest income.

Tip

Be sure to check the Tax-Related box and assign an appropriate tax category in the Income Tax
Information Dialog (Edit → Tax Report Options) when you set up taxable income accounts. Some
types of income, such as gift income, may not be considered taxable, so check the appropriate tax
rules to determine what is taxable. For ways to track capital gains income, refer to Chapter 11,
Capital Gains.

Before you start entering paycheck deposits, decide how much detail you want to track. The basic level
of detail is to enter your net pay, just like you would in your paper register. This is easiest, but you can
get even more information out of GnuCash if you enter your gross pay with deductions. It takes a bit
more effort to enter the deductions, but entering your tax withholding information throughout the year
allows you to run useful tax status reports in GnuCash at any time. These reports can help you determine
whether you are withholding enough tax, and they can help you estimate your tax bill ahead of time. If
you are unsure about the level of detail, start by entering net pay. You can always go back and edit your
transactions later if you decide you want more detail.

Entering Withdrawals
When you withdraw money from your bank account, for whatever reason, you are transferring money
from your bank account to some other location. In GnuCash, this other location is tracked as an account.
The more detailed accounts you create and use for your spending, the more information you will get about
where your money goes.

Withdrawals take many forms. ATM withdrawals are one of the most common transactions. Writing
checks is one way to withdraw money to pay bills, to buy purchases, or to give to charity. Depending on
your bank, you might also have service charges, where the bank withdraws the money from your account.
Transfers of money out to another account are also withdrawals. We will take a look at each of these types
of withdrawals and how to record them in GnuCash.

ATM/Cash Withdrawals

Cash withdrawals are handled as a transfer from a bank account to a cash account. GnuCash provides
special Cash type accounts for tracking your cash purchases, so you should set up a cash account to record
your ATM and other cash withdrawals.

Cash accounts can be used for different levels of detail. On a basic level of detail, you simply transfer
money to it from your checking account. That tells you how much money you took out of checking on a
given day, but it doesn’t tell you where that cash was spent. With a little more effort, you can use the cash
account to record your cash purchases as well, so that you can see where that cash went. You record these
purchases as a transfer from the cash account to expense accounts.

Some people record every cash purchase, but this takes a lot of work. An easier way is to record the
purchases for which you have receipts, but then adjust the balance of the account to match what is in your
wallet.

It’s a good idea to at least set up a cash account for your withdrawals. Then if you decide to track where
your cash goes, you can enter transactions for the money you spend. You determine what level of detail
you want to use.
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Reconciling Your Accounts
GnuCash makes reconciliation of your bank account with your monthly bank statement much easier. the
section called “Reconciliation” gives instructions on how to reconcile your transactions with the monthly
bank statement. This is the main reconciliation task that should be done every month.

But what about all those other accounts you created? Should those be reconciled too? If you receive a
statement for the account, then you should consider reconciling that account. Examples include the check-
ing account statement, the savings account statement, and the credit card statement. Credit card statements
and credit card transactions are covered in the Chapter 7, Credit Cards, so if you are interested in tracking
your credit cards in GnuCash, take a look at the instructions provided there.

Income and expense accounts are usually not reconciled, because there is no statement to check them
against. You also don’t need to reconcile cash accounts, for the same reason. With a cash account, though,
you might want to adjust the balance every once in a while, so that your actual cash on hand matches the
balance in your cash account. Adjusting balances is covered in the next section.

Putting It All Together
In the section called “Transactions”, you entered some transactions in your checking account. In this chap-
ter, we will add more transactions and then reconcile them.

Opening Balances
So, let’s get started by opening the gcashdata file you saved in the last chapter (gcashdata_4). Your
chart of accounts should look like this:

This image shows the Chart of Accounts.
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Add some transactions

1. Now open the Checking account from the main window. In the last chapter, you entered some paycheck
transactions as deposits into Checking. Now we will enter another kind of deposit - a transfer of money
from Savings into Checking. On a blank line, enter a transaction to transfer $500 from Savings to
Checking (In this case, the last transaction date was March 28, but this transfer transaction took place
on the March 24). Your Transfer account will be Savings, since you are in the Checking account. Your
Checking account should now look like this:

This image shows the Checking Account Register.

2. Now let’s write some checks on this account. First, write a check to HomeTown Grocery for $75 (5th
of March). Your transfer account is Groceries, since all of this money is going to buy groceries. Next,
write a check to ABC Hardware for $100 (6 of March), and split this amount between two expenses:
Household $50 and Tools $50. You will need to create an Expense type account for each of these, then
enter splits for them. Your checking account should now look like this;

This image shows the Checking Account Register after registering some more checks.

3. Suppose you now need to withdraw some money. You don’t have a cash account set up in your chart of
accounts, so you will need to create one. Create the account as Cash as a top-level account of type Asset.
From your Checking account register, enter an ATM type withdrawal to transfer $100 from Checking
to Cash on the 25 of March.
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This image shows the Checking Account Register with an ATM withdrawal.

Opening Balances

Now we are ready to reconcile this Checking account, using this sample bank statement:

This image shows a sample Bank Statement.

1. Select Actions → Reconcile from the menu, and fill in the Closing balance as $1451.79. Click OK to
begin reconciling the account. Check off the entries as they appear on the sample statement. When you
have checked off all your entries, the reconcile window should look like this:

This image shows the reconcile window with a $5 difference.

Notice that your reconciled balance differs from your ending balance by $5.00. If you look at the sample
bank statement, you will see there is a $5.00 service charge that has not been added to your Checking
account.
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2. So click on the Checking register and add the $5.00 service charge to your Checking account. On a blank
line of the Checking register, enter a transaction to transfer $5.00 from Checking to a Service Charges
account. (You will need to create the Service Charges account as type Expense.) Use the transaction
date printed on the sample statement as the date you enter for this transaction. Your Checking account
should now look like this:

This image shows the Checking Account Register with service charge added.

3. Click back on the Reconcile window, and you should see the service charge now under Funds Out.
Click on it to mark it as reconciled, and note that the difference amount below now becomes 0.00.
Click the Finish button on the Toolbar to complete the reconciliation. The Reconcile R column in your
Checking register should now show y for each transaction you just reconciled. Also observe the bottom
status row that now indicates Reconciled: USD 1451.79

This image shows the reconciled Checking Account Register.

Save file

Go back to the main window and save your file with the new gcashdata_5 name. Your chart of accounts
is steadily growing, and it should now look like this:
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This image shows the Chart of Accounts.

Reports

As we did in the previous chapter, let’s have a look at a Cash Flow, and a Transaction Report.

1. First let’s have a look at the Cash Flow report for the month of March.

Select the cash flow report from Reports → Income & Expense → Cash Flow.
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This image shows the Cash Flow report after Chapter 5, Checkbook.

2. Now let’s have a look at corresponding transaction report for the various Asset accounts.

Select the transaction report from Reports → Transaction Report.
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This image shows the Transaction Report for the Assets accounts during March.

3. Now let’s change the transaction report to only show the various Expenses account.
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This image shows the Transaction Report for the various Expense accounts during March.

Notice that you have not yet used one of the accounts listed in your chart, the Credit Card account. Now
that you know how to keep track of your bank and cash accounts in GnuCash, you may want to start
tracking your credit cards as well. GnuCash provides a special type of account for credit cards, and this
is discussed in the next chapter.
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Chapter 6. Expense Accounts
If managing your checkbook is the first step in tracking your finances, then using expense accounts to see
where you are expending money is a close second step. This chapter will give you an understanding of
how GnuCash uses expense accounts to help you keep track of many different categories of transactions.

Concepts
An expense type account is used to allow you to track how much you spend on specific expenses. Many
people's first experience with tracking expenses comes from Quicken(tm), where transactions can be as-
signed to one or more categories. In GnuCash, these categories are set up as separate accounts, which are
designated as Expense type accounts. This allows GnuCash to apply the rules of double-entry accounting
consistently. Expense accounts can be as detailed or as general as you need. Some users need only a few
accounts for personal expense tracking. Others use GnuCash expense accounts to manage their expenses in
great detail. The level of detail you choose is up to you. Keep in mind that with GnuCash, you can change
accounts for transactions, so if your needs change later on, it is possible to move transactions around.

Setting Up Accounts

Simple Expense Account Setup

For many users, the easiest way to set up expense accounts is to check the "Common Accounts" when
you create a new Account Hierarchy. This will establish many of the most common expense accounts that
users need. See "New Account Hierarchy Setup" in Chapter 3 of the Help guide for more information.

Complex Expense Account Setup

If you have different expense accounting needs, you can refer to the section called “Transactions”, or
Chapter 5.4 in the Help manual for instructions on how to create accounts.

Typical reasons for adding new or different expense accounts include: to track expenses for particular
business purposes (e.g., specific types of supply expenses), to track expenses for particular tax purposes
(e.g., tax expenses that must be reported to others), or simply to track expenses that are meaningful to you
(e.g., payments made to a particular charity).

Entering Expense Transactions
While it is possible to enter transactions directly into expense accounts, it is not normally how these are
entered. For most people, transactions for an expense account are added when the user is entering data into
the other account in the transaction. In other words, if you have an expense account for Charitable Dona-
tions (e.g., Expenses:Charity), you will typically add a transaction to the expense account by assigning a
check in your checking account register to the Charity account.

If you open an expense account, you will see a register similar to most others you find in GnuCash. The
informal column headings for the transaction amounts are slightly different, however. The left (debit)
column will read Tot Expense, while the right (credit) column will read Tot Rebate.
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Other Considerations for Expense Accounts
Because expense accounts are generated entirely by you, there are no statements against which you would
reconcile your data. Therefore, there is technically nothing to reconcile. You can, of course use the recon-
cile process for expense accounts, which will lock the transactions for future editing.

One point to consider is that as your use of GnuCash continues, the balances in these accounts will grow,
since there are usually very few credit transactions that reduce the balances. There is nothing wrong with
this situation, but some users may wish to clear the balances in their expense accounts periodically. Zeroing
transactions can be entered that transfer the balance of the account to an Equity account. GnuCash includes
a Closing Books procedure that includes zeroing out expense accounts. Keep in mind that this is not
necessary, and that if you need to gather information on a given expense account, you can use various
reports to extract that data without zeroing the account out.
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Chapter 7. Credit Cards
This chapter will show you how to manage your credit cards using GnuCash.

Concepts
Since you probably write a check or make an electronic payment to the credit card company each month,
you may think of your credit card bill as an expense - but it really is not an expense. Why? A credit card
account is a short-term loan - you buy things on that loan account, and then you eventually have to pay
back the money, often with interest (your finance charge). The purchases you make with that credit card
are your expenses.

You have a couple of options when entering credit card transactions, so choose the one that fits your desired
level of detail. The simplest method is to simply track monthly payments to the credit card company. From
your bank account, you enter a transfer of money each month to the credit card expense account. This will
show you the amount of money you are paying each month to the credit card company, but it won’t show
you any information about your credit card balance or credit card purchases.

A more complete way to track your credit card in GnuCash is to enter each purchase and payment as a
separate transaction. Using the credit card account register, you enter your receipts throughout the month.
When your credit card statement arrives, you reconcile the credit card account to the statement, and you
enter your payment as a transfer of money from your checking account to your credit card account. This
method gives you more information about your balance during the month and points out any discrepancies
during reconciliation, but you will have to do more data entry.

Setting Up Accounts
To begin managing your credit cards in GnuCash, you should set up a Liability top level account and under
this parent account create credit card type accounts for each credit card you use. If you are tracking only
the payments you make to the credit card company, then all you need is a bank account and a credit card
account to enter your transactions.

The charges you make on your credit card are expenses, so you will have to set up these accounts under
the top-level account called Expenses. If you decide to keep a more detailed records of your purchases,
you will need to create expense accounts for each kind of purchase you make. Since you will also be
reconciling the balance to your credit card statements, you should also enter an opening balance in each
credit card account. The easiest way to do this is to use your last statement balance as the opening balance.

Simple Setup
If you do not want to track each expense made on the credit card, you can set up a simple account hierarchy
like this:

-Assets
   -Bank
-Liabilities
   -Credit Card
-Expenses
   -Credit Card
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In this example, if you enter your total amount charged per month as a transaction between Liabili-
ties:Credit Card and Expenses:Credit Card. When you make a payment, you would enter a transaction
between Assets:Bank and Liabilities:Credit Card.

The obvious limitation of this simple credit card setup is that you cannot see where your money is going.
All your credit card expenses are being entered in the Credit Card expense account. This is, however, very
simple to set up and maintain.

Complete Setup
If you want to track your expenses more completely, you should set up multiple expense accounts named
for the various kinds of expenses you have. Each charge on your credit card is then entered as a separate
transaction between your Credit Card liability account and a specific expense account. Below is an example
of an account hierarchy for this:

-Assets
    -Bank
-Liabilities
    -Credit Card
-Expenses
    -Food
    -Car
    -Clothes
    -Entertainment
    -Interest
    -Service
   

Clearly, you should enter specific expense accounts which fit your spending habits. The only difference
with this setup as compared to the simple setup is that the expenses have been subdivided by groups. Also
notice that there is an “Interest” expense, this is used for when your credit card charges interest on your
monthly unpaid balance. The “Service” expense account is used to track service expenses associated with
the credit card, such as the yearly usage fee if it exists. With this setup, you will be able to see where your
money goes every month, grouped according to the expense accounts.

The rest of this chapter will assume you are using the complete setup.

Entering Charges
Entering your charges provides you with a more complete picture of your spending habits. Charges on
a credit card are tracked as a transaction between the credit card liability account and the appropriate
expense account.

When you pay for goods or services with your credit card, you are telling the credit card company to
pay the merchant for you. This transaction will increase the amount of money you owe the credit card
company, and the credit card balance will increase. The other side of these transactions will in most cases
be an expense account. For example, if you buy clothing from a store with your credit card for $50, you
would be transferring that money from the credit account into Expenses:Clothing.

Entering these transactions into GnuCash allows you to track how much you owe the credit card company,
as well as provides you a better picture of your overall accounts. It also allows you to monitor your account
and ensure that fraud is avoided.
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Adding transactions to a credit card account is similar to entering transactions in other accounts. You can
enter them manually, or import them from your credit card company using a compatible import format.

For assistance with entering transactions, see Chapter 6 of the Help manual and the section called “Trans-
actions”.

Entering Payments
Most payments to your credit card bill are entered as transfers from a bank account (asset) to the credit
card account (liability). When you pay the monthly bill, you are withdrawing money from a bank account
to pay down the credit card balance. This transaction decreases both your bank account balance and the
amount of credit card debt you owe.

When you return a purchase, you receive a refund on your credit card. This is another type of payment in
that it decreases the amount of credit card debt you owe. If you recorded the original purchase transaction
as a transfer from the credit card account to the expense, you now simply reverse that transaction: transfer
the money back from the expense to the credit card account. This transaction decreases both the expense
account balance and the credit card account balance. For example, if you originally recorded a credit card
purchase of clothing, the transaction is a transfer from the credit card account to the clothing expense
account. If you then return that clothing for a refund, you simply transfer the money back from the clothing
expense account to the credit card account.

Note

A common mistake is to enter a refund as income. It is not income, but rather a “negative ex-
pense”. That is why you must transfer money from the expense account to your credit card when
you receive a refund.

To clarify this, let’s run through an example. You bought some jeans for $74.99 on your VISA card, but
realized one day later that they are too big and want to return them. The shop gracefully agrees, and refunds
your credit card.

1. Start with opening the previous datafile we stored (gcashdata_5), and store it as gcashdata_6.

2. Open the Liabilities:Visa account register and enter a simple 2 account transaction to pay the $74.99
jeans purchase. The Transfer account should be Expenses:Clothes and you Charge your Visa account
with the $74.99.

Note

Since we had not created the Expenses:Clothes account previously, GnuCash will prompt us
to create it. Just remember to create it as an Expense account

3. Enter the refund in one of the following way.

• Enter the same transaction as the purchase transaction, but instead of a “Charge” amount, use a
“Payment” amount in the Credit Card account register.

• Select the purchase transaction you want to refund (that is the Jeans transaction in our case), and
selecting Transaction → Add Reversing Transaction. Modify the date as needed.

After reversing the transaction, your credit card account should look something like this:
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This image shows Liability:Credit Card - Register after reversing a purchase transaction.

And the Expenses:Clothes register should look something like this:

This image shows Expenses:Clothes register after reversing a purchase transaction.

4. Save the GnuCash data file.

Putting It All Together
Now that we have covered the basic ideas behind the various transactions you must make to successfully
track your credit card in GnuCash, let’s go through an example. In this example, we will make credit card
purchases, refund two of the purchases, get charged interest on the unpaid balance, reconcile the credit
card account, and finally make a partial payoff of the credit card.

Open GnuCash file

Start with opening the previous datafile we stored, gcashdata_5, and store it as gcashdata_6 di-
rectly. The main window should look something like this:
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Starting account structure for tracking a credit card in the putting it all together example.
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Purchases

Let’s make some purchases on our visa card. Start by buying $25 worth of food from the Greasy Spoon
Cafe, $100 worth of clothing from Faux Pas Fashions, $25 worth of gasoline from Premium Gasoline,
$125 worth of groceries and household items from Groceries R Us (split between $85 in groceries and $40
in household items) and finally, $60 worth of household items from CheapMart.

We also redo the exercise in previous chapter, with purchasing a pair of Jeans for $74.99 on April 3, and
refund them two days later.

The register window for the credit card liability should look like this:

Initial credit card purchases.

Refund

Now suppose that on April 15th you return the clothes you bought on April 11th from Faux Pas Fashions
and they give you credit back on your credit card. Enter a transaction for the credit card refund for the full
$100 amount. Remember to use the same transfer account you used for the original purchase, and enter the
amount under the Payment column. GnuCash will automatically complete the name and transfer account
for you, but it will also automatically enter the $100 in the Charge column. You will need to reenter the
amount in the Payment column. The transaction looks like this:

Returning clothes to Faux Pas Fashions, refund to credit card.

Interest Charge

After the month of spending, unfortunately, the credit card bill arrives in the mail or you access it on-line
through the internet. You have been charged $20 in interest on the last day of April because of the balance
you carried from the previous month. This gets entered into the credit card account as an expense.
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Interest charge.

Reconciliation

When your credit card bill arrives you should reconcile your credit card account to this document. This
is done using GnuCash’s built-in reconciliation application. Highlight the credit card account and click
on Actions → Reconcile.... This reconciliation procedure is described in detail in the the section called
“Reconciliation”, but we will step through the process here as well. For this example, let’s assume that
the credit card statement is dated May 1st, with a final balance of $455. Enter these values in to the initial
Reconcile window as shown here.

Initial account reconciliation window.

During the reconciliation process, you check off each transaction in the account as you confirm that the
transaction appears in both your GnuCash account and the credit card statement. For this example, as
shown in the figure below, there is a $300 difference between your GnuCash accounts and the credit card
statement.
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Main account reconciliation window, demonstrating a discrepancy of $300.

Some investigation uncovers that you forgot to record a payment you made on March 5th to the credit card
company for $300, you must enter this payment transaction from your bank account to the credit card.
Now the credit card statement and your GnuCash account can be reconciled, with a balance of $455.

Payment

Assuming you have completed reconciliation of your credit card account, you need to make a payment to
the credit card company. In this example, we owe $455 but will make a partial payment of $300 again this
month. To do so, enter a transaction from your bank account to the credit card account for $300, which
should reduce your credit card balance to $155. Your credit card account register should now appear like
this:

Account register after account reconciliation and payment.

Go back to the main window and save your file (gcashdata_6). Your chart of accounts is steadily
growing, and it should now look like this:
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GnuCash Chart of Accounts after account reconciliation and payment.
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Save file

Last, save the GnuCash data file (gcashdata_6).

Reports

As we did in the previous chapters, let’s have a look at a Cash Flow, and a Transaction Report.

1. First let’s have a look at the Cash Flow report for the liability account Visa during the month of March.

Select the cash flow report from Reports → Income & Expense → Cash Flow.

This image shows the Cash Flow report after Chapter 7, Credit Cards.

2. Now let’s have a look at corresponding transaction report for the Visa account.

Select the transaction report from Reports → Transaction Report.
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This image shows the Transaction Report for the Visa account during March/April.

3. Now let’s change the transaction report to only show the various Expenses accounts.
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This image shows the Transaction Report for the various Expense accounts during April.
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Chapter 8. Loans
This chapter explains how to manage your loans with GnuCash.

Basic Concepts
A loan is defined as a financial transaction in which someone pays for the use of someone else’s money.
There are many familiar examples of loans: credits cards, auto loans, house mortgages, or a business loan.

Terminology

Before discussing tracking loan in GnuCash specifically, it will be helpful to present a glossary of termi-
nology. The terms presented below represent some of the basic concepts found concerning loans. It is
a good idea to become familiar with these terms, or at least, refer back to this list if you encounter an
unfamiliar word in the later sections.

• Amortization - the repayment plan which will insure that a loan is eventually paid off, typically utilizing
equal valued monthly payments. These payments are usually split into principal and interest, where the
amount of principal per payment increases (and interest decreases) as the amortization period elapses.

• Borrower - the person or company that receives the money from a loan.

• Default - when a borrower fails to repay a loan according to the terms agreed upon with the lender.

• Deferment - a temporary delay in the repayment of a loan.

• Delinquency - is the term that refers to late payments.

• Disbursement - amount of the loan paid to the borrower. Some loans have multiple disbursements,
meaning the borrower does not receive the full amount of the loan at one time.

• Interest - the expense charged by the lender to the borrower for the use of the money loaned. This is
typically expressed in terms of a yearly percentage charged on the principal borrowed, known as the
Annual Percentage Rate or APR.

• Lender - the company or person who lends money to a borrower.

• Loan Fee - a processing fee removed from the principal at the time the borrower receives a loan.

• Principal - the original amount of the loan, or the amount of the original loan that is still owed. When
you make a monthly payment on a loan, part of the money pays the interest, and part pays the principal.

• Promissory Note - the legal agreement between the borrower and lender concerning the loan.

Setting Up Accounts
When a borrower obtains a loan, it is usually with the intention to make a purchase of something of value.
In fact, most loans require the borrower to buy some predetermined asset, such as a house. This asset is
insurance against the borrower defaulting on the loan. There are, of course, examples of loans which do
not necessarily have an associated high value asset, such as educational loans.
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For the account structure presented here, we will assume the loan was used to purchase a compensating
asset.

A loan is a liability, the interest you accrue on the loan is an on-going expense, and any administrative
fees you may have to pay would be another expense. The thing purchased with the money from a loan is
an asset. With these parameters, we can now present a basic loan account structure:

Basic Loan Account Structure

-Asset
    -Current Assets
        -Savings Account
    -Fixed Assets
        -Asset Purchased
-Liability
   -Loans
       -Mortgage Loan
-Expenses
   -Interest
       -Mortgage Interest
   -Mortgage Adm Fees
  

GnuCash has a number of predefined loan account hierarchies available, including Car Loans and Home
Mortgage Loans. To access these predefined account structures, click on Actions → New Account Hierar-
chy... and select the loan types in which you are interested.

Calculations
Determining loan amortization schedules, periodic payment amounts, total payment value, or interest rates
can be somewhat complex. To help facilitate these kinds of calculations, GnuCash has a built-in Loan
Repayment Calculator. To access the calculator, go to Tools → Loan Repayment Calculator.

The GnuCash Loan Repayment Calculator.
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The Loan Repayment Calculator can be used to calculate any one of the parameters: Payment Periods,
Interest Rate, Present Value, Periodic Payment, or Future Value given that the other 4 have been defined.
You will also need to specify the compounding and payment methods.

• Payment Periods - the number of payment periods.

• Interest Rate - the nominal interest rate of the loan, ie: the yearly interest rate.

• Present Value - the present value of the loan, ie: current amount owed on the loan.

• Periodic Payment - the amount to pay per period.

• Future Value - the future value of the loan, ie: the amount owed after all payment periods are over.

• Compounding - two interest compounding methods exist, discrete or continuous. For discrete com-
pounding select the compounding frequency from the popup menu with a range from yearly to daily.

• Payments - the popup menu allows you to select the payment frequency with a range from yearly to
daily. You can also select whether your payments occur at the beginning or end of the period. Payments
made at the beginning of the payment period have interest applied to the payment as well as any previous
money paid or money still owed.

Example: Monthly Payments
What is your monthly payment on a $100000 30 year loan at a fixed rate of 4% compounded monthly?

This scenario is shown in the example image above. To perform this calculation, set Payment Periods to
360 (12 months x 30 years), Interest Rate to 4, Present Value to 100000, leave Periodic Payment empty and
set Future Value to 0 (you do not want to owe anything at the end of the loan). Compounding is Monthly,
Payments are Monthly, assume End of Period Payments, and Discrete Compounding. Now, click on the
Calculate button next to the Periodic Payment area. You should see $-477.42.

Answer: You must make monthly payments of 477.42.

Example: Length of Loan
How long will you be paying back a $20000 loan at 10% fixed rate interest compounded monthly if you
pay $500 per month?

To perform this calculation, leave Payment Periods empty, set Interest Rate to 10, Present Value to 20000,
Periodic Payment is -500, and Future Value is 0 (you do not want to owe anything at the end of the
loan). Compounding is Monthly, Payments are Monthly, assume End of Period payments, and Discrete
Compounding. Now, click on the Calculate. You should see 49 in the Payment Periods field.

Answer: You will pay off the loan in 4 years and 1 month (49 months).

Advanced: Calculation Details
In order to discuss the mathematical formulas used by the Loan Repayment Calculator, we first must define
some variables.

 n  == number of payment periods
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 %i  == nominal interest rate, NAR, charged
 PV  == Present Value
 PMT == Periodic Payment
 FV  == Future Value
 CF == Compounding Frequency per year
 PF == Payment Frequency per year

Normal values for CF and PF are:
   1   == annual
   2   == semi-annual
   3   == tri-annual
   4   == quaterly
   6   == bi-monthly
   12  == monthly
   24  == semi-monthly
   26  == bi-weekly
   52  == weekly
   360 == daily
   365 == daily

Converting between nominal and effective interest rate

When a solution for n, PV, PMT or FV is required, the nominal interest rate (i) must first be converted
to the effective interest rate per payment period (ieff). This rate, ieff, is then used to compute the selected
variable. When a solution for i is required, the computation produces the effective interest rate (ieff). Thus,
we need functions which convert from i to ieff, and from ieff to i.

To convert from i to ieff, the following expressions are used:
Discrete Interest:     ieff = (1 + i/CF)^(CF/PF) - 1
Continuous Interest: ieff = e^(i/PF) - 1 = exp(i/PF) - 1

To convert from ieff to i, the following expressions are used:
Discrete Interst:      i = CF*[(1+ieff)^(PF/CF) - 1]
Continuous Interest: i = ln[(1+ieff)^PF]

Note

NOTE: in the equations below for the financial transaction, all interest rates are the effective
interest rate, “ieff”. For the sake of brevity, the symbol will be shortened to just “i”.

The basic financial equation

One equation fundamentally links all the 5 variables. This is known as the fundamental financial equation:

PV*(1 + i)^n + PMT*(1 + iX)*[(1+i)^n - 1]/i + FV = 0

  Where: X = 0 for end of period payments, and
         X = 1 for beginning of period payments

From this equation, functions which solve for the individual variables can be derived. For a detailed expla-
nation of the derivation of this equation, see the comments in the file src/calculation/fin.c from the Gnu-
Cash source code. The A, B, and C variables are defined first, to make the later equations simpler to read.
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A = (1 + i)^n - 1
B = (1 + iX)/i
C = PMT*B

n = ln[(C - FV)/(C + PV)]/ln((1 + i)
PV = -[FV + A*C]/(A + 1)
PMT = -[FV + PV*(A + 1)]/[A*B]
FV = -[PV + A*(PV + C)] 

The solution for interest is broken into two cases.
The simple case for when  PMT == 0 gives the solution:
i = [FV/PV]^(1/n) - 1

The case where PMT != 0 is fairly complex and will not be presented here. Rather than involving an exactly
solvable function, determining the interest rate when PMT !=0 involves an iterative process. Please see
the src/calculation/fin.c source file for a detailed explanation.

Example: Monthly Payments

Let’s recalculate the section called “Example: Monthly Payments”, this time using the mathematical for-
mulas rather than the Loan Repayment Calculator. What is your monthly payment on a $100000 30 year
loan at a fixed rate of 4% compounded monthly?

First, let’s define the variables: n = (30*12) = 360, PV = 100000, PMT = unknown, FV = 0, i =
4%=4/100=0.04, CF = PF = 12, X = 0 (end of payment periods).

The second step is to convert the nominal interest rate (i) to the effective interest rate (ieff). Since the
interest rate is compounded monthly, it is discrete, and we use: ieff = (1 + i/CF)^(CF/PF) - 1, which gives
ieff = (1 + 0.04/12)^(12/12) - 1, thus ieff = 1/300 = 0.0033333.

Now we can calculate A and B. A = (1 + i)^n - 1 = (1 + 1/300)^360 - 1 = 2.313498. B = (1 + iX)/i = (1
+ (1/300)*0)/(1/300) = 300.

With A and B, we can calculate PMT. PMT = -[FV + PV*(A + 1)]/[A*B] = -[0 + 100000*(2.313498 +
1)] / [2.313498 * 300] = -331349.8 / 694.0494 = -477.415296 = -477.42.

Answer: You must make monthly payments of 477.42.

House Mortgage (How-To)
A house mortgage can be setup using the account structure present in the section called “Setting Up Ac-
counts”.

As an example, assume you have $60k in you bank account, and you buy a $150k house. The mortgage is
charging 6% APR, and has administrative fees (closing costs, etc) of 3%. You decide to put $50k down, and
thus will need to borrow $103k, which will give you $100 after the closing costs are paid (3% of $100k).

Your accounts before borrowing the money:
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Accounts Before Receiving Loan

The purchase of the house is recorded with a split transaction in the Assets:House account, with $50k
coming from the bank (IE: your down payment), and $100k coming from the Mortgage. You can place
the $3k closing costs in the same split, and we increase the house loan to $103k to include the closing
costs as well.

Table 8.1. Buying a House Split Transaction

Account Increase Decrease

Assets:Fixed Assets:House $150,000

Assets:Current Assets:Bank $50,000
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Liabilities:Loans:Mortgage Loan $103,000

Expenses:Mortgage Adm Fees $3000

The split will look like this in the Assets:Fixed Assets:House Account:

Mortgage Split Transaction

Which will give a Chart of Accounts like this:
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Mortgage Account

A Personal Loan to a friend (How-To)
It is not always you are borrowing money from the bank, sometimes you borrow money from your family,
or perhaps even lend money to a friend. This How-To chapter will describe one way to handle lending
money to a friend.

We are basing this How-To on the following generic account structure.

-Asset
   -Bank
        -Bank Account
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   -Money owed to you
        -Person
-Income
   -Interest Income
        -Person
  

This example will show how to track a personal loan of 2,000 USD (default currency) to your friend Peter

Loan Specifications
Peter wants to borrow $2,000 dollars from you and plans to pay you back monthly for the next 18 months.
Since he is your friend, (but not that close) you both agree on a yearly interest rate of 5%.

In summary we have the below details. Peter’s loan details:

• Pinciple Amount - $2,000

• Term - 18 months with 12 payments per year

• Annual Percentage Rate: 5%

• Monthly Payment : ??

So how do you calculate the Monthly Payment?

You have a number of different options, like paper and pen, Linux Calculator, Open Office’s Calc module,
but the easiest is to use GnuCash Loan Repayment Calculator. This tells you that the Monthly Payment
should be $115.56.

But you need to know how much of this is Interest and how much is Principal to be able to do a proper
bookkeeping. For this you need a more powerful tool, something like the Calc module in OpenOffice.org,
and in particular the PMT function.

Detailed view over the private loan to Peter

Accounts for the loan
Let’s start with the following accounts (all accounts have the same currency, in this case USD)
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Assets:Bank:USD
Assets:Money owed to you:Peter
Income:Interest Income:Peter
Equity:Opening Balances:USD
  

Lending the money
When you have lent money to your friend, you have in fact moved money from an Asset account (like Bank,
Checking or similar) to your Asset account Money owed to you. To record this you enter the following
transaction into the Assets:Money owed to you:Friend account.

Table 8.2. Personal loan to a Friend

Account Increase Decrease

Assets:Money owed to
you:Friend

$2,000

Assets:Bank:USD $2,000

Chart of Accounts after lending money

Receiving first payment
When the first payment ($115.56) is received, you will need to determine how much is for the principal
loan, and how much is for the loan interest.
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• Outstanding loan amount this period = $2,000

• Payment per month = $115.56

• Payment breakdown

• 5%/12 * $2,000 = $8.33 Interest

• $115.56 - $8.33 = $107.23 Principal

This can be translated to the following GnuCash entry

Detailed view over first payment

The balance on Peter’s loan is now $2,000 - $107.23 = $1,892.77

Receiving second payment
When the second payment ($115.56) is received, you will again need to determine how much is for the
principal loan, and how much is for the loan interest.

• Outstanding loan amount this period = $1,892.77

• Payment per month = $115.56

• Payment breakdown

• 5%/12 * $1,892.77 = $7.89 Interest

• $115.56 - $7.89 = $107.67 Principal

This can be translated to the following GnuCash entry

Detailed view over the second payment

The balance on Peter’s loan is now $1,892.77 - $107.67 = $1,785.10
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The Chart of accounts looks now like this

Chart of Accounts after second payment

As you can see, the interest varies for every month, as well as the principal amount. So for every payment
you receive you need to calculate the proper amounts for your various split entries.

The interest amount will be less and less for every payment (since it is calculated on a smaller loan amount
all the time), until the last payment where it is more or less 0. Please review the Figure of Detailed view
over private loan to Peter for more details

Automobile Loan (How-To)
The Automobile Loan, or in common terms, Car Loan, is treated more or less exactly as the House loan.
The only difference is different accounts, and different interest rates.

Basic Car Loan Account Structure

-Asset
    -Current Assets
        -Savings Account
    -Fixed Assets
        -Car
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-Liability
   -Loans
       -Car Loan
-Expenses
   -Interest
       -Car Loan Interest
   -Car Loan Adm Fees

For more information, please check the section called “House Mortgage (How-To)”

Reconciling with the Loan Statements (How-
To)

Reconciling a loan statement is no different from reconciling a bank or credit card statement.

During the period you should have recorded all the various loan related transactions, and every one of them
are touching the Liability:Loans:Loan account. For instance, paying off a bit of the loan decreases your
Bank Account, and increases the Loan account, Loan Interest as well as perhaps Loan administration fee.

With the loan statement in your hands, open the Loan account, start the reconcile assistant, and tick of all
the various transaction you have recorded. When you have finished, the reconciling difference should be
0, and if it is not, then you will have to go through the account and compare it with the loan statement to
find the difference. When you have reached a 0 in difference, then your loan account is reconciled and
you can finish the Reconcile assistant.

For more information on how to Reconcile, please check the section called “Reconciliation”

Selling a house or a car (How-To)
When you will record the selling of your house in GnuCash you have some different options. Here we
will go through two of them, one in which you only recorded the purchase amount, and now the selling
amount. The other where you have followed the ups and downs on the property market and registered
various Unrealized gains over the time.

Simple Transaction
In this way you only record the proper sale amount.

Let’s work through two samples of selling a house, one with a profit, and one with a loss. If you want to
sell a car instead, just substitute the house account with a car account.

-Assets
  -Fixed Assets
    -House
  -Current Assets
    -Saving
-Income
  -Capital Gains Long
    -House
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• You bought a house for $300,000 once upon a time, and now managed to sell it for $600,000. How
do you record this?

To record this you need to increase our bank account with the $600k, and decrease some other accounts
with $600k. The house account only contains $300k which is what you bought it for, so you move
this amount to your bank account. That means you are lacking $300k. This amount you fetch from
the Income:Captial Gains Long:House account. The split transaction you enter into your bank account
(Assets:Current Assets:Saving) should look like this.

Table 8.3. Selling an asset (house) with a profit

Account Increase Decrease

Assets:Current Assets:Saving $600,000

Assets:Fixed Assets:House $300,000

Income:Capital Gains
Long:House

$300,000

• You bought a house for $300,000 once upon a time, but due to a newly created airport, could only sell
it for $230,000. How do you record this?

To record this you need to increase your bank account with the $230k, and decrease some other accounts
with $230k. The house account contains $300k which is more than what you sold it for. So let’s move
$230k of it to your bank account. After this you have $70k remaining in your house account which needs
to be removed. You move it to our Income:Capital Gains Long:House account, which will indicate a
loss. The split transaction you enter into your house account (Assets:Fixed Assets:House) should look
like this.

Table 8.4. Selling an asset (house) with a loss

Account Increase Decrease

Assets:Fixed Assets:House $300,000

Assets:Current Assets:Saving $230,000

Income:Capital Gains
Long:House

$70,000

A More Complex Transaction
In this example, we will touch a little on some more complicated accounting principles. For more details
on this subject, please check Chapter 11, Capital Gains

Here we will only touch on the case when you have accurately estimated the current value of your house.
For the other cases (over-, and under-estimated), please check Chapter 11, Capital Gains.

-Assets
    -Fixed Assets
        -House
            -Cost
            -Unrealized Gain
    -Current Assets
        -Saving
-Income
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    -Realized Gain
        -House
    -Unrealized Gain
        -House
    

You bought a house for $300,000 once upon a time, and over the years kept a close look on the market
and updated your records with the estimated current value of your house. At the time you want to sell it,
you have determined that the current market value is $600,000.

The difference between $600,000 (estimated market value) and $300,000 (purchase value) is the current
Unrealized Gain value. Therefore you have a total of $300,000 in your Assets:Fixed Assets:House:Unre-
alized Gain account

How do you record this sell transaction?

To record this you need to increase your bank account with the $600k, and decrease some other accounts
with $600k. You must first change from unrealized gain to realized gain for your Income accounts. Lastly
you need to transfer the full amounts from the Assets:Fixed Assets:House sub-accounts.

The transaction you enter into your Income:Realized Gain:House account account should look like this.

Table 8.5. Selling an asset (house) with a profit

Account Increase Decrease

Income:Realized Gain:House $300,000

Income:Unrealized Gain:House $300,000

The transaction you enter into your Assets:Current Assets:Saving account should look like this.

Table 8.6. Selling an asset (house) with a profit 2

Account Increase Decrease

Assets:Current Assets:Saving $600,000

Assets:Fixed Assets:House:Cost $300,000

Assets:Fixed Assets:House:Unre-
alized Gain

$300,000

After having recorded these transactions you see that your House Asset have a value of 0, your Savings
account have increased with $600,000, and lastly, the Income:Realized Gain have increased to $300,000.
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Chapter 9. Investments
This chapter explains how to manage your investments with GnuCash. Most people have an investment
plan, whether its just putting money into a CD account, investing through a company sponsored plan at
your workplace or buying and selling stocks and bonds through a brokerage. GnuCash gives you tools to
help you manage these investments such as the Price Editor  which allows you to record changes in the
prices of stocks you own.

Basic Concepts
An investment is something that you purchase in the hopes of generating income, or that you hope to
sell in the future for more than you paid. Using this simple definition, many things could be considered
investments: the house you live in, a valuable painting, stocks in publicly traded companies, your savings
account at the bank, or a certificate of deposit. These many types of investments will be discussed in this
chapter in terms of how to track them using GnuCash.

Terminology

Before discussing investments specifically, it will be helpful to present a glossary of investment terminol-
ogy. The terms presented below represent some of the basic concepts of investing. It is a good idea to
become familiar with these terms, or at least, refer back to this list if you encounter an unfamiliar word
in the later sections.

Capital gains The difference between the purchase and sell-
ing prices of an investment. If the selling price
is lower than the purchase price, this is called
a capital loss. Also known as realized gain/
loss.

Commission The fee you pay to a broker to buy or sell se-
curities.

Common stock A security that represents a certain fraction-
al ownership of a company. This is what you
buy when you “buy stock” in a company
on the open market. This is also sometimes
known as capital stock.

Compounding The concept that the reinvested interest can
later earn interest of its own (interest on in-
terest). This is often referred to as compound
interest.

Dividends Dividends are cash payments a company
makes to shareholders. The amount of this
payment is usually determined as some
amount of the profits of the company. Note
that not all common stocks give dividends.

Equities Equities are investments in which the investor
becomes part (or whole) owner in something.
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This includes common stock in a company, or
real estate.

Interest What a borrower pays a lender for the use
of their money. Normally, this is expressed
in terms of a percentage of the principal per
year. For example, a savings account with 1%
interest (you are the lender, the bank is the
borrower) will pay you $1 for every $100 you
keep there per year.

Liquidity A measure of how easily convertible an in-
vestment is to cash. Money in a savings ac-
count is very liquid, while money invested in
a house has low liquidity because it takes time
to sell a house.

Principal The original amount of money invested or
borrowed.

Realized vs Unrealized Gain/Loss Unrealized gain or loss occurs when you’ve
got a change in price of an asset. You realize
the gain/loss when you actually sell the asset.
See also capital gain/loss.

Return The total income plus capital gains or losses
of an investment. See also Yield.

Risk The probability that the return on investment
is different from what was expected. Invest-
ments are often grouped on a scale from low
risk (savings account, government bonds) to
high risk (common stock, junk bonds). As a
general rule of thumb, the higher the risk the
higher the possible return.

Shareholder A shareholder is a person who holds common
stock in a company.

Stock split Occurs when a company offers to issue some
additional multiple of shares for each exist-
ing stock. For example, a “2 for 1” stock split
means that if you own 100 shares of a stock,
you will receive an additional 100 at no cost
to you. The unit price of the shares will be ad-
justed so there is no net change in the value,
so in this example the price per share will be
halved.

Valuation The process of determining the market value
or the price the investment would sell at in a
“reasonable time frame”.

Yield A measure of the amount of money you earn
from an investment (IE: how much income
you receive from the investment). Typically
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this is reported as a percentage of the prin-
cipal amount. Yield does not include capital
gains or loses (see Return). Eg: A stock sells
for $100 and gives $2 in dividends per year
has a yield of 2%.

Types of Investments
Below is presented some of the broad types of investments available, and examples of each type.

• Interest-bearing account or instrument

This type of investment usually allows you immediate access to your money, and will typically pay you
interest every month based on the amount of money you have deposited. Examples are bank savings
accounts (and some interest bearing checking accounts) and cash accounts at your brokerage. This is a
very low risk investment, in the US these accounts are often insured against loss, to a specified limit.

Sometimes an interest bearing investment is time-locked. This type of investment requires you to commit
your money to be invested for a given period of time for which you receive a set rate of return. Usually,
the longer you commit the higher the interest rates. If you withdraw your money before the maturity
date, you will usually have to pay an early withdrawal penalty. This is a relatively lower risk investment.
Examples are certificates of deposit or some government bonds. Other types of Bonds may have higher
yields based on the higher risks from the quality of the issuer’s “credit rating”.

• Stocks and Mutual Funds

This is an investment you make in a company, in which you effectively become a part owner. There is
usually no time lock on publicly traded stock, however there may be changes in the tax rates you pay
on capital gains depending on how long you hold the stock. Thus, stocks are typically quite liquid, you
can access your money relatively quickly. This investment is a higher risk, as you have no guarantee
on the future price of a stock.

A mutual fund is a group investment mechanism in which you can buy into many stocks simultaneously.
For example, a "S&P 500 index fund" is a fund which purchases all 500 stocks listed in the Standard
and Poor’s index. When you buy a share of this fund, you are really buying a small amount of each of
the 500 stocks contained within the fund. Mutual funds are treated exactly like a single stock, both for
tax purposes and in accounting.

• Fixed Assets

Assets that increase in value over time are another form of investment. Examples include a house, a plot
of land, or a valuable painting. This type of investment is very difficult to determine the value of until
you sell it. The tax implications of selling these items is varied, depending on the item. For example,
you may have tax relief from selling a house if it is your primary residence, but may not receive this
tax break on an expensive painting.

Fixed asset investments are discussed in Chapter 11, Capital Gains and Chapter 16, Depreciation. Typ-
ically, there is not much to do in terms of accounting for fixed asset investments except recording the
buying and selling transactions.

Setting Up Accounts
To setup investment accounts in GnuCash you can either use the predefined investment account hierarchy
or create your own. The minimum you need to do to track investments is to setup an asset account for each
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type of investment you own. However, as we have seen in previous chapters, it is usually more logical to
create a structured account hierarchy, grouping related investments together. For example, you may want
to group all your publicly traded stocks under a parent account named after the brokerage firm you used
to buy the stocks.

Note

Regardless of how you setup your account hierarchy, remember that you can always move ac-
counts around later (without losing the work you’ve put into them), so your initial account hier-
archy does not have to be perfect.

Using Predefined Investment Accounts
The Investment Accounts option of the New Account Hierarchy Setup assistant will automatically create
a basic investment account hierarchy for you. To access the predefined investment accounts hierarchy,
you must make sure your GnuCash file is open, switch to the Accounts tab, and choose Actions → New
Account Hierarchy. This will run the New Account Hierarchy Setup assistant and allow you to select
additional accounts to add to your account hierarchy. Choose the Investment Accounts option (along with
any others you are interested in). Assuming only investment accounts were selected, this will create an
account hierarchy as shown below.

Tip

You can also run the New Account Hierarchy Setup assistant by creating a new GnuCash file.

This is a screen image of the Accounts tab after creating a new file and selecting only the default investment
accounts.

You will probably at least want to add a Bank account to the Assets and probably an Equity:Opening
Balances account, as we have done in previous chapters. Don’t forget to save your new account file with
a relevant name!
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Creating Investment Accounts Manually
If you want to set up your own investment accounts hierarchy, you may of course do so. Investments usually
have a number of associated accounts that need to be created: an asset account to track the investment
itself; an income account to track dividend transactions; and expense accounts to track investment fees
and commissions.

In a typical account structure, security accounts are sub accounts of an asset account representing an ac-
count at a brokerage firm. The brokerage account would be denominated in your local currency and it
would include sub accounts for each security that you trade there.

Related purchases, sales, income and expense accounts should also be in the same currency as the broker-
age account.

The security sub accounts would each be configured to contain units of a single security selected from the
master (user defined) security list and they are expected to use the same currency as the brokerage account.

Security prices are kept in a separate area of GnuCash (the Price Database - Tools  → Price Editor). This
contains prices for individual securities (not security accounts). All prices for an individual security are
in a single currency. If a security is traded in multiple currencies, then a separate security and separate
accounts should be set up for each currency.

Custom Accounts Example
The following is a somewhat more complicated example of setting up GnuCash to track your investments,
which has the advantage that it groups each different investment under the brokerage that deals with the
investments. This way it is easier to compare the statements you get from your brokerage with the accounts
you have in GnuCash and spot where GnuCash differs from the statement.

 Assets
    Investments
       Brokerage Accounts
          I*Trade
             Stocks
                ACME Corp
             Money Market Funds
                I*Trade Municipal Fund
             Cash
          My Stockbroker
             Money Market Funds
                Active Assets Fund
             Government Securities
                Treas Bond xxx
                Treas Note yyy
             Mutual Funds
                Fund A
                Fund B
             Cash
 Income
    Investments
       Brokerage Accounts
          Capital Gains
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             I*Trade
             My Stockbroker
          Dividends
             I*Trade
                Taxable
                Non-taxable
             My Stockbroker
                Taxable
                Non-taxable
          Interest Income
             I*Trade
                Taxable
                Non-taxable
             My Stockbroker
                Taxable
                Non-taxable
 Expenses
    Investment Expenses
       Commissions
          I*Trade
          My Stockbroker
       Management Fees
          I*Trade
          My Stockbroker
 

Tip

There really is no standard way to set up your investment account hierarchy. Play around, try
different layouts until you find something which divides your investment accounts into logical
groups which make sense to you.

Interest Bearing Accounts
Investments which have a fixed or variable rate of interest are one of the simplest and most common form
of investments available. Interest bearing investments include your bank account, a certificate of deposit,
or any other kind of investment in which you receive interest from the principal. This section will describe
how to handle these kinds of investments in GnuCash.

Account Setup
When you purchase the interest bearing investment, you must create an asset account to record the purchase
of the investment, an income account to record earnings from interest, and an expense account to record
bank charges. Below is an account layout example, in which you have an interest bearing savings account
and a certificate of deposit at your bank.

Assets
   Bank ABC
      CD
      Savings
Expenses
   Bank ABC
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      Charges
Income
   Interest Income
      CD
      Savings
  

As usual, this account hierarchy is simply presented as an example, you should create your accounts in a
form which best matches your actual situation.

Example

Now let’s populate these accounts with real numbers. Let’s assume that you start with $10000 in your
bank account, which pays 1% interest and you buy a $5000 certificate of deposit with a 6 month maturity
date and a 2% yield. Clearly, it is much better to keep your money in the CD than in the savings account.
After the initial purchase, your accounts should look something like this:

This is an image of the account register after creating and investing in a CD investment.

Now, during the course of the next 6 months, you receive monthly bank statements which describe the
activity of your account. In our fictional example, we do nothing with the money at this bank, so the only
activity is income from interest and bank charges. The monthly bank charges are $2. After 6 months, the
register window for the CD and for the savings account should look like these:
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This is an image of the register of the CD account after 6 months.

This is an image of the register of the Savings account after 6 months.

And this is the main GnuCash account window:
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This a screen capture of the accounts after 6 months.

From the above image of the main GnuCash account window you see a nice summary of what happened
to these investments over the 6 months. While the yield on the CD is double that of the savings account,
the return on the CD was $50.21 versus $13.03 for the savings account, or almost 4 times more. Why?
Because of the pesky $2 bank charges that hit the savings account (which counted for $12 over 6 months).

After this 6 month period, the CD has reached maturity which means you may sell it with no early with-
drawal penalty. To do so, simply transfer the $5050.21 from the CD account into the savings account.

Setup Investment Portfolio
Now that you have built an account hierarchy in the previous section, this section will show you how to
create and populate the accounts with your investment portfolio. After this initial setup of your portfolio,
you may have shares of stock purchased from before you started using GnuCash. For these stocks, follow
the instructions in the Entering Preexisting Shares section below. If you have just purchased your stocks,
then use the Buying New Shares  section.
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Setup Accounts for Stocks and Mutual Funds

This section will show you how to add stocks and mutual fund accounts to GnuCash. In this section, we
will assume you are using the basic account setup introduced in the previous section, but the principles
can be applied to any account hierarchy.

You should have within the top level Asset account, a few levels down, an account entitled Stock. Open the
account tree to this level by clicking on the “right facing triangle marker” signs next to the account names
until the tree is opened to the depth of the new account. You will need to create a sub-account (of type
stock) under the Stock account for every stock you own. Every stock is a separate account. The naming
of these stock accounts is usually done using the stock ticker abbreviation, though account names may
be anything that is clear to you and other users. So, for example, you could name your accounts AMZN,
IBM and NST for your Amazon, IBM and NSTAR stocks respectively. Below is a schematic model of the
layout (only showing the Assets sub-accounts).

 Assets
    Investments
       Brokerage Accounts
          Bond
          Mutual Funds
          Market Index
          Stock
             AMZN
             IBM
             NST
 

Note

If you want to track income (dividends/interest/capital gains) on a per-stock or fund basis, you
will need to create an Income:Dividends:STOCKSYMBOL, Income:Cap Gain (Long):STOCK-
SYMBOL, Income:Cap Gain (Short):STOCKSYMBOL and Income:Interest:STOCKSYMBOL ac-
count for each stock you own that pays dividends or interest.

Example Stock Account

As an example, let’s assume that you currently own 100 shares of Amazon stock. First, create the stock
account AMZN by selecting the Stock account and click on the menu Actions+New Account.... The New
Account dialog will appear, follow the steps, in the sequence below to setup your new stock account.
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New Account Window

1. Account Name - Usually, use the stock ticker abbreviation, IE: “AMZN”

2. Account Code - Optional field, use CUSIP, the newspaper listing symbol, mutual fund family ID or
code of your own choosing.

3. Description - Optional field for detailed description of the commodity/stock. Note this field by default
is displayed in the Account tab tree.

4. Account Type - Select the type of account you are creating from the lower left-hand list.

5. Parent Account - Select the parent account for the new account from the right hand listing. Expand list
of accounts if necessary.

6. Create the New Security - To use a new stock, you must create the stock as a new commodity

Note

Be sure to first select Account Type Stock  or Mutual Fund so that the Select... button brings
up the list of securites rather than currencies.

• Select Security/Currency - Click on the Select ... button next to the security/currency line. We must
change the security from the default (your default currency) to this specific stock. This will bring
up the Select Security dialog.

• Type - Select the exchange where the security/commodity is traded (in this example NASDAQ).
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Select the New button to open the New Security window.

Select Security Window

• Create the Security - Click on the New... button and enter the appropriate information for this stock
on the new form New Security.

• The Full name: is “Amazon.com”.

• The Symbol/abbreviation: is “AMZN”. The symbol is the stock ticker used in your quote source
several lines down on the form. Note that different symbols will be utilized on different price
sources for the same stock, an example is Ericsson on the Stockholm Exchange is ERIC-B while
on Yahoo it is ERRICB.ST

• The Type: should already be NASDAQ, because this is what was selected in the security selector,
but you can change it here, including adding more categories. More information about this can be
found in the Help Manual in section 7.7, “Security Editor”.

• The ISIN, CUSIP or other code is where you can enter some other coding number or text (leave
it blank in this example).

• The Fraction traded should be adjusted to the smallest fraction of this security which can be traded,
usually 1/100 or 1/10000.

• The checkbox “Get Online Quotes”, the quote source and the timezone should be selected to define
the sources for updating prices on-line. See Also  “Setting Stock Price Automatically”.

Note

If the Get Online Quotes button is not highlighted, and it is not tickable, then the Fi-
nance::Quote package is not installed. See the section on  “Installing Finance::Quote”.

Below is what this window should look like when finished:
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New Security Window

• Save Security - Click on the OK button to save this new security, this will close the New Security
window and return to the New Account window.

7. Select the Security - you should now see the newly created security available in the pull down menu for
Security/Currency. Select it (it is probably already selected) and click on OK.

8. Smallest Fraction - Specify the smallest fraction of the security/commodity that is traded.

9. Notes - Enter any notes or messages related to this security/commodity.

10.Tax Related - Go to Edit → Tax Report Options to check this box if this account’s transactions will
relate to Income Taxes.

11.Placeholder - Check box if this account is a “Placeholder”, that is it will contain no transactions.

12.Finished - You should now have been automatically returned to the New Account dialog, with the
symbol/abbreviation: line set to “AMZN (Amazon.com)”. Click on OK to save this new stock account.

You have now created the Amazon stock account, your main account should look something like this
(notice that there are a few extra accounts here, a bank account, and an equity account):
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This image is after the creation of the first stock account (AMZN)

Open the account register window for this AMZN stock account (double click on it). Here you see the
Commodity view. This gives you an overview of the transactions in this commodity including the number
of units (shares for a stock or mutual fund) bought or sold, the net price per unit, and the total amount.
Obviously, we have not bought or sold any shares of AMZN yet, so the register should not contain any
transactions.

Buying Shares

Entering Preexisting Shares
The examples in this section use Transaction Journal view.

To register the initial 100 shares of this stock that you purchased previously, on the first (transaction) line,
enter the date of the purchase (eg: Jan. 1 2005) and Description (eg: Opening Balance). On the first split
line, enter 100 in Shares , delete the (unit) Price (it will be calculated when you Tab out of the split) and
enter 2000 in the Buy column.

Note

It is also possible to use GnuCash to calculate Shares or Buy from the other 2 columns but to
avoid rounding errors, it is better to automatically calculate Price.

Tab to the second split line, enter transfer from account Equity:Opening Balances. For simplicity, this
example assumed there were no commissions on this transaction. Your AMZN Commodity view should
now appear like this:
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This image is of the transaction register of the AMZN account after the first stock “purchase”.

Notice that the Balance (last column) is in the units of the commodity (AMZN shares) not in currency
units. Thus, the balance is 100 (AMZN units) rather than $2000. This is how it should be.

Buying New Shares
The main difference between setting up a new stock purchase versus the setup for preexisting stocks as
described in the previous section is that instead of transferring the money used to purchase the stock from
the Equity:Opening Balances account, you transfer from your Assets:Bank ABC or  Assets:Brokerage
Account account.

Handling Commissions and Fees

For conciseness, this document will refer to the money you pay to a broker for buying and selling securities
as Commissions . Government fees may also be payable. Unless otherwise stated, fees are handled in a
similar way.

In GnuCash there are 2 alternate ways to handle commissions (for simplicity this document section will
refer to these ways as net pricing and gross pricing):

• Net Pricing: You enter a net price (adjusted by commissions) when buying and selling securities. You do
not also record commissions in a specific commissions account in order to later claim it as an expense,
as this would be claiming commissions twice. This way is compatible with using the section called
“Selling Shares with Automatic Calculation of Capital Gain or Loss Using Lots”. This results in a
slightly misleading price being added to the price database (the effective price you paid) but is not
usually of any concern.

OR

• Gross Pricing: You enter the price not adjusted by commissions and enter the commissions expense
on a separate split in the transaction. This enables the tracking of commissions but is not compatible
with using the section called “Selling Shares with Automatic Calculation of Capital Gain or Loss Using
Lots”. Scrubbing doesn't know to deduct commissions and fees from the gains, so capital gains or losses
must be manually calculated (see the section called “Selling Shares with Manual Calculation of Capital
Gain or Loss ”).

Please get professional advice if you are unsure which of these ways are applicable to your jurisdiction.
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Example: Buying Shares with Gross Pricing

In this example you will purchase $5000 of IBM stock, with a commission of $100. First step will be to
create the stock account for IBM. The existing Expenses:Commission account will be used. If you wish
to track commissions to the individual stock level an additional sub-account would be necessary. E.g.
Expenses:Commission:IBM.

Now for the transaction, on the first (transaction) line, enter the Date of the purchase (eg: Jan. 3 2005)
and Description (eg: Initial IBM Purchase). On the first split line, enter 50 in Shares, delete Price (leave
it empty so it will be calculated)), and enter 5000 in Buy. You do not need to fill in the Price column,
as it will be calculated for you when you Tab to the next split. The next line in the split transaction will
be Expenses:Commissions  and fill in Buy ($100). The third line will be to transfer $5100 from account
Assets:Bank ABC to balance the transaction. Your IBM Commodity view should now appear like this:

This image is of the transaction register of the IBM account after the first stock “purchase” with a com-
mission.

Example: Buying Shares with Net Pricing

Repeating the previous example using Net Pricing instead of Gross Pricing, in Transaction Journal view:

Purchase $5000 of IBM stock being 50 Shares for $100.00 each, plus a commission of $100.

Now for the transaction, on the first (transaction) line, enter the Date of the purchase (eg: Jan. 3 2005) and
a Description (eg: Initial IBM Purchase). On the first split line, optionally enter more details in Memo ,
then 50 in Shares, delete anything in Price (so it will be calculated by dividing Buy by Shares when you
Tab out of the split), 5100 in Buy (50 * $100.00 + $100). Alternatively use GnuCash to calculate Buy by
entering the formula 5000+100 or  (50 * 100) + 100  in Buy ( Buy will be calculated when you Tab  out
of the column. Use the Tab key as many times as needed to proceed to the next split.

Do not enter a separate split for Commission as it has already been included in the Buy value. The second
split line will be to transfer from  Assets:Bank ABC $5100 to balance the transaction. After the splits are all
correct, use the Enter  key to save the transaction. Your IBM Commodity view should now appear like this:
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This image is of the transaction register of the IBM account after the first stock “purchase” with a com-
mission.

Setting Share Price
The value of a commodity, such as a stock, must be explicitly set. The stock accounts track the quantity of
stocks you own, but the value of the stock is stored in the Price Editor. The values set in the Price Editor
can be updated manually or automatically.

Initial Price Editor Setup

To use the Price Editor to track a stock value, you must initially insert the stock. To do so, open the Price
Editor (Tools → Price Editor) and click on Add button. The first time a Commodity/Stock is entered this
window will be blank except for the control buttons on the bottom. Select the appropriate Commodity
you want to insert into the Price Editor. At this point, you can input the price of the commodity manually.
There are 6 fields in the New Commodity window:

Namespace The exchange market where the security/commodity is traded (in this example
NASDAQ)

Security The name of the commodity, must be chosen from the Select... list

Currency The currency in which the Price is expressed.

Date Date that the price is valid

Type One of: Bid (the market buying price), Ask (the market selling price), Last (the
last transaction price), Net Asset Value (mutual fund price per share), or Unknown.
Stocks and currencies will usually give their quotes as one of bid, ask or last. Mutual
funds are often given as net asset value. For other commodities, simply choose Un-
known. This option is for informational purposes only, it is not used by GnuCash.

Price The price of one unit of this commodity.

As an example of adding the AMZN commodity to the price editor, with an initial value of $40.50 per share.
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Adding the AMZN commodity to the price editor, with an initial value of $40.50 per share.

Click OK when finished. Once you have performed this initial placement of the commodity into the Price
Editor, you will not have to do it again, even if you use the same commodity in another account.

Note

If you have online retrieval of quotes activated (see the section called “Configuring for Automatic
Retrieval of Quotes”), you can initialize a commodity without manually making an entry. When
you initially add the security in the Security Editor, check Get Online Quotes and save the security.
Then, in the Price Editor, click Get Quotes, and the new security will be inserted into the price
list with the retrieved price.

Setting Stock Price Manually

If the value of the commodity (stock) changes, you can adjust the value by entering the Price Editor,
selecting the commodity, clicking on Edit and entering the new price.
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The main price editor window, showing the list of all known commodities.

Configuring for Automatic Retrieval of Quotes
If you have more than a couple of commodities, you will tire of having to update their prices constantly.
GnuCash has the ability to automatically download the most recent price for your commodities using the
Internet. This is accomplished through the Perl module Finance::Quote, which must be installed in order
to activate this feature.

To determine if the Perl module Finance::Quote is already installed on your system, type perldoc Fi-
nance::Quote in a terminal window and check to see if there is any documentation available. If you see
the documentation, then the module is installed, if you do not see the documentation, then it has not been
installed.

Installing Finance::Quote

Microsoft Windows:

• Close GnuCash.

• Run Install Online Price Retrieval which can be found in the GnuCash “Start” menu entry.

MacOS: You need to have XCode installed. XCode is an optional item from your MacOS distribution
DVD. Run the Update Finance Quote app in the GnuCash dmg. You can run it from the dmg or copy it
to the same folder to which you copied GnuCash. It will open a Terminal window and run a script for you
which will ask lots of questions. Accept the default for each unless you know what you’re doing.

Linux:

• Close any running GnuCash instances.

• Locate the folder where GnuCash is installed by searching for gnc-fq-update

• Change to that directory, open a root shell

• Run the command gnc-fq-update
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This will launch a Perl CPAN update session that will go out onto the internet and install the Finance::Quote
module on your system. The gnc-fq-update program is interactive, however, with most systems you should
be able to answer “no” to the first question: “Are you ready for manual configuration? [yes]” and the
update will continue automatically from that point.

After installation is complete, you should run the “gnc-fq-dump” test program, in the same directory,
distributed with GnuCash to test if Finance::Quote is installed and working properly.

Note

If you feel uncomfortable about performing any of these steps, please either email the Gnu-
Cash-user mailing list (<gnucash-user@gnucash.org>) for help or come to the GnuCash
IRC channel on irc.gnome.org. You can also leave out this step and manually update your stock
prices.

Configuring Securities for Online Quotes

With Finance::Quote installed and functioning correctly, you must configure your GnuCash securities to
use this feature to obtain updated price information automatically. Whether creating new securities or
modifying securities that have already been setup, use the Tools → Security Editor, to edit the security and
check the Get Online Quotes box. You will now be able to modify the radio buttons for Type of quote
source, the pull-down menus to specify the specific source(s) and The timezone for these quotes. When
finished editing, Close the Security Editor to return to the Price Editor and click on the Get Quotes button
to update your stock prices on the Internet.

The command gnucash --add-price-quotes $HOME/gnucash-filename can be used to fetch the current
prices of your stocks. The file specified $HOME/gnucash-filename will depend on the name and
location of your data file. This can be determined by the name displayed in the top frame of the GnuCash
window, before the “-”. The file name can also be found under File in the recently opened file list; the first
item, numbered 1, is the name of the currently open file.

This can be automated by creating a crontab entry. For example, to update your file every Friday evening
(16:00) after the relevant exchange markets close (modify the time accordingly for your time zone), you
could add the following to your personal crontab:

0 16 * * 5 gnucash --add-price-quotes $HOME/gnucash-filename > /dev/null 2>&1

Remember that Mutual Fund “prices” are really “Net Asset Value” and require several hours after the
exchange closes before being available. If NAVs are downloaded before the current days NAVs are de-
termined, yesterday’s NAVs are retrieved.

Displaying Share Value

The main account window, by default, only shows the quantity of each commodity that you own, under
the column heading Total. In the case of stocks, this commodity is the number of shares. Often, however,
you will want to see the value of your stocks expressed in terms of some monetary unit. This is easily
accomplished by entering the main window, selecting the Accounts tab, by clicking on the Titlebar Op-
tions button (the small down pointing arrow on the right side of the main account window titles bar), and
selecting the option to display the account total field “Total (USD)”. You will see a new column in the
main window entitled Total (USD) that will express the value of all commodities in the report currency.
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Viewing the value of a stock commodity in the main window using the Total in Report Currency option.

The “Price Source” in Reports
Most GnuCash reports have options to set/modify a number of parameters for the report. The Options
dialog box is displayed by selecting the report tab then clicking on either the Options icon in the Menubar
or selecting Edit → Report Options. Price Source determines how accounts denominated in commodities
different from the report currency are converted to the report currency. Depending on the report the selector
may appear in either the General, the Commodities, or the Display tab of the Report Options dialog box.

Note

In the example below, the report is a customization of the Average Balance report in the Assets
& Liabilities reports submenu.
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Determining the value of a stock commodity or a currency other than the report currency in a report by
setting the Price Source option.

• Weighted Average: Calculates the price by summing the absolute value of the amount and the absolute
value of every split in every account denominated in the commodity, excluding those splits with a zero
amount, and dividing the sum of values by the sum of amounts to obtain a price. For example, if you
had a buy transaction for 200 shares of XYZ for a total of 2000 and a sell of 100 for 1300 the weighted
average would be 3300/300 or 11/share.

Note

Gain/Loss splits have an amount of 0 and are not included in this calculation.

• Average Cost: Calculates the price by summing the amounts and values of every split in every account
denominated in the commodity, including the zero amount splits. In the example above, with an addi-
tional split (either part of the sale transaction or in a separate transaction) booking the gain at 0 shares
and a 300 gain, the average cost is 1000/100 (2000 original cost - 1300 proceeds from the sale + 300
gain)/(200 - 100) shares or 10/share.

Note

Gain/Loss splits are included in this calculation.

Note

This is the only Price Source that will balance the Trial Balance Report and in order for it to
balance you must correctly book your gains and losses.

• Most Recent: Uses the latest price from the price database.

• Nearest in time: Uses the price nearest in time to the report date—the datum date for time series reports
like Assets Over Time—from the price database.

Note

The nearest date isn’t necessarily before the date in question.
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Tracking what value your stocks would’ve had on the stock exchanges.

Selling Shares
Entering an investment sale transaction is done in a similar way to entering a buy transaction (see the
section called “Buying New Shares”) except the amount entered in the Shares column is negative and
the proceeds of the transaction is entered in the Sell  column. The net proceeds from the sale should be
transferred from the shares account to your bank or brokerage account.

For information on handling commissions and the use of Net Pricing or Gross Pricing, please see the
section called “Handling Commissions and Fees”.

If you will be recording a capital gain or loss on the sale, please see Chapter 11, Capital Gains and Chap-
ter 16, Depreciation for more information on this topic.

To use the GnuCash Automatic Calculation of Capital Gain or Loss Using Lots feature, please see the
section called “Selling Shares with Automatic Calculation of Capital Gain or Loss Using Lots” otherwise
continue to the next section.

Selling Shares with Manual Calculation of Capital Gain
or Loss

Note

In order for GnuCash to commit the zero-share, zero-price split for account Assets:Stock:SYM-
BOL  to the transaction in the following schemes, you *must* Tab out of that split. If you use
the Enter key, GnuCash will convert the split into shares of the commodity.

In the schemes of transaction splits presented below, the following symbols are used:

• NUM_SHARES: number of shares you are selling

• COMMISSION: brokerage commissions or fees
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• GROSS_SELL_PRICE: unit price for which you sold the shares, not reduced by COMMISSION

• NET_SELL_PRICE: unit price for which you sold the shares, reduced by COMMISSION

• GROSS_BUY_PRICE: unit price for which you bought the shares, not increased by COMMISSION

• NET_BUY_PRICE: unit price for which you bought the shares, increased by COMMISSION

• GROSS_BUY: total price for which you bought shares, excluding COMMISSION, equal to
NUM_SHARES * GROSS_BUY_PRICE

• NET_BUY: amount of money for which you bought shares including COMMISSION, equal to
GROSS_BUY + COMMISSION.

• GROSS_SALE: total price for which you sold shares, equal to NUM_SHARES * GROSS_SEL-
L_PRICE

• NET_SALE: amount of money received from the sale, equal to GROSS_SALE − COMMISSION

• GROSS_PROFIT: amount of money you made on the sale, not reduced by COMMISSION

• NET_PROFIT: amount of money you made on the sale, reduced by COMMISSION

There are 2 ways of manually recording the capital gain or loss. The capital gain/loss can be combined
with the sale in one transaction or it can be entered in a separate transaction.

Combine the Sale and Capital Gain/Loss in One Transaction

This has the advantage that all parts of the sale event are kept together. This is not compatible with using
scrubbing (see the section called “Selling Shares with Automatic Calculation of Capital Gain or Loss
Using Lots”). If you may in future use scrubbing on a specific security, save some work later by entering
the capital gain/loss splits in a separate transaction now.

When the capital gain/loss splits are combined with the sale splits in one transaction, there are 2 splits for
the security account in the same transaction, so the transaction must be entered with the security register
in Auto-Split Ledger or Transaction Journal view. One of the splits for the security account is for the sale
and the other is for the capital gain or loss. The security account split for the capital gain or loss must be
entered with 0 number of shares and 0 price per share to stop the automatic recalculation of these fields.

Account for the profit or loss as coming from an Income:Capital Gains or Expenses:Capital Loss account.

Combined, Gross Pricing

Table 9.1. Selling Shares Split Scheme, Sale and Capital Gain/Loss Are Combined,
Gross Pricing

Account Number of
Shares

Share Price Total Buy Total Sell

Assets:Bank ABC NET_SALE

Assets:Stock:SYMBOL 0 0 GROSS_PROFIT(Loss)

Expenses:Commission COMMISSION

Assets:Stock:SYMBOL #NUM_SHARESGROSS_SEL-
L_PRICE

GROSS_SALE

Income:Capital Gains (Loss) GROSS_PROFIT
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Combined, Net Pricing

Table 9.2. Selling Shares Split Scheme, Sale and Capital Gain/Loss Are Combined,
Net Pricing

Account Number of
Shares

Share Price Total Buy Total Sell

Assets:Bank ABC NET_SALE

Assets:Stock:SYMBOL 0 0 NET_PROFIT (Loss)

Assets:Stock:SYMBOL #NUM_SHARESNET_SEL-
L_PRICE

NET_SALE

Income:Capital Gain (Loss) NET_PROFIT

Separate the Capital Gain/Loss Transaction from the Sale Transac-
tion.

This is required if using scrubbing  to automatically calculate and create capital gain/loss transactions
(otherwise scrubbing will not detect them and will create an incorrectly valued gain/loss transaction).

Separated, Gross Pricing

Table 9.3. Selling Shares Split Scheme, Sale and Capital Gain/Loss Are Separate
Transactions, Sale Transaction

Account Number of
Shares

Share Price Total Buy Total Sell

Assets:Bank ABC NET_SALE

Expenses:Commission COMMISSION

Assets:Stock:SYMBOL #NUM_SHARESGROSS_SEL-
L_PRICE

GROSS_SALE

Table 9.4. Selling Shares Split Scheme, Sale and Capital Gain/Loss Are Separate
Transactions, Capital Gain/Loss Transaction

Account Number of
Shares

Share Price Total Buy Total Sell

Assets:Stock:SYMBOL 0 0 GROSS_PROFIT(Loss)

Income:Capital Gain (Loss) GROSS_PROFIT

Separated, Net Pricing

Table 9.5. Selling Shares Split Scheme, Sale and Capital Gain/Loss Are Separate
Transactions, Sale Transaction

Account Number of
Shares

Share Price Total Buy Total Sell

Assets:Bank ABC NET_SALE
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Assets:Stock:SYMBOL #NUM_SHARESNET_SEL-
L_PRICE

NET_SALE

Table 9.6. Selling Shares Split Scheme, Sale and Capital Gain/Loss Are Separate
Transactions, Capital Gain/Loss Transaction

Account Number of
Shares

Share Price Total Buy Total Sell

Assets:Stock:SYMBOL 0 0 NET_PROFIT (Loss)

Income:Capital Gain (Loss) NET_PROFIT

Examples of Selling Shares with Manually Entry of Capi-
tal Gain or Loss

In these examples we will use the AMZN account created in the previous section.

Example: Sale of Shares with Profit, Manual Profit/Loss Calculation,
Sale & Profit Combined, Gross Pricing

In this example you bought 100 shares of AMZN for $20 per share, then later sell them all for $36 per
share with a commission of $75. In the split transaction scheme above, GROSS_BUY_PRICE is $20
(the original buying price), NUM_SHARES is 100, GROSS_BUY is $2000 (the original buying cost),
GROSS_SALE is $3600, and finally GROSS_PROFIT is $1600 (GROSS_SALE − GROSS_BUY).

Table 9.7. Selling Shares Split Scheme, Sale & Gain Combined, Gross Pricing

Account Shares Price Buy Sell

Assets:Bank ABC 3525.00

Assets:Brokerage Account:S-
tock:AMZN

0 0 1600.00

Expenses:Commission 75.00

Assets:Brokerage Account:S-
tock:AMZN

−100 36.00 3600.00

Income:Capital Gain (Long Ter-
m):AMZN

1600.00
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An example of selling shares for gain. You bought 100 shares of AMZN for $20 per share, and sold for $36.

Note

In the above screenshot, it appears there are 2 transactions for Mar 21st 2006. This is because
the register is in Auto-Split Ledger view and there are 2 splits for the register account in the 1
transaction. Transaction Journal view may be clearer. Refer to the section called “Simple vs. Split
Transactions”. As there are 2 splits for the register account in the sale transaction, this transaction
must be entered in Auto-Split Ledger or Transaction Journal view. It cannot be entered in Basic
Ledger view.

An image of the account tree after the example of selling shares for gain.

Example: Sale of Shares with Profit, Manual Profit/Loss Calculation,
Sale & Profit Combined, Net Pricing

In this example you bought 100 shares of AMZN for $20 per share (including commissions), then later sell
them all for $36 per share with a commission of $75. In the split transaction scheme above, NUM_SHARES
is 100, NET_BUY_PRICE is $20 (the original buying price), NET_BUY is $2000 (the original buying
cost), NET_SELL_PRICE is $35.25 (($3600 − $75) / 100)), GROSS_SALE is $3600, NET_SALE is
$3525, and finally NET_PROFIT is $1525 (NET_SALE − NET_BUY).

Table 9.8. Selling Shares Split Scheme, Sale & Gain Combined, Net Pricing

Account Shares Price Buy Sell

Assets:Bank ABC 3525.00

Assets:Brokerage Account:S-
tock:AMZN

0 0 1525.00
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Assets:Brokerage Account:S-
tock:AMZN

−100 35.25 3525.00

Income:Capital Gain (Long Ter-
m):AMZN

1525.00

An example of selling shares for gain using net pricing in transaction journal view. You bought 100 shares
of AMZN for $20 per share, and sold for $36.

Example: Sale of Shares with Profit, Manual Profit/Loss Calculation,
Sale & Profit Separated, Gross Pricing

You bought 100 shares of AMZN for $20 per share and commissions $20, then later sell them all for $36
per share with a commission of $75. In the split transaction scheme above, GROSS_BUY_PRICE is $20
(the original buying price), NUM_SHARES is 100, GROSS_BUY is $2000 (the original buying cost),
GROSS_SALE is $3600, and finally GROSS_PROFIT is $1600 (GROSS_SALE − GROSS_BUY).

Table 9.9. Selling Shares Split Scheme, Sale Transaction, Gross Pricing

Account Shares Price Buy Sell

Assets:Bank ABC 3525.00

Expenses:Commission 75.00

Assets:Brokerage Account:S-
tock:AMZN

−100 36.00 3600.00

Table 9.10. Selling Shares Split Scheme, Gain Transaction, Gross Pricing

Account Shares Price Buy Sell

Assets:Brokerage Account:S-
tock:AMZN

0 0 1600.00

Income:Capital Gain (Long Ter-
m):AMZN

1600.00
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An example of selling shares for gain where the sale and gain are recorded in separate transactions, in
Transaction Journal view. You bought 100 shares of AMZN for $20 per share, and sold for $36.

Example: Sale of Shares with Profit, Manual Profit/Loss Calculation,
Sale & Profit Separated, Net Pricing

You bought 100 shares of AMZN for $20 per share (including commissions), then later sell them all for
$36 per share with a commission of $75. In the split transaction scheme above, NUM_SHARES is 100,
NET_BUY_PRICE is $20 (the original buying price), NET_BUY is $2000 (the original buying cost),
NET_SELL_PRICE is $35.25 (($3600 − $75) / 100)), GROSS_SALE is $3600, NET_SALE is $3525,
and finally NET_PROFIT is $1525 (NET_SALE − NET_BUY).

Table 9.11. Selling Shares Split Scheme, Sale Transaction, Net Pricing

Account Shares Price Buy Sell

Assets:Bank ABC 3525.00

Assets:Brokerage Account:S-
tock:AMZN

−100 35.25 3525.00

Table 9.12. Selling Shares Split Scheme, Gain Transaction, Net Pricing

Account Shares Price Buy Sell

Assets:Brokerage Account:S-
tock:AMZN

0 0 1525.00

Income:Capital Gain (Long Ter-
m):AMZN

1525.00
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An example of selling shares for gain where the sale and gain are recorded in separate transactions, in
Transaction Journal view. You bought 100 shares of AMZN for $20 per share, and sold for $36.

Selling Shares with Automatic Calculation of Capital
Gain or Loss Using Lots

Introduction

Wikipedia [https://en.wikipedia.org/wiki/Lot] includes the following definition of a lot

“a set of goods for sale together in an auction; or a quantity of a financial instrument”.

GnuCash has a built-in lot management facility that can be used to keep track of capital gains or losses
resulting from security sales. Buy and sell transactions are put into lots for the purpose of calculating the
cost of the sale. More specifically, a lot is used to link particular buy and sell transaction splits. Lots can
be automatically or manually created and linked. Capital gain or loss can be automatically calculated and
transaction(s) created for the difference between the sale value and the cost of the securities sold. GnuCash
refers to this process as scrubbing.

The term scrub is used because security accounts need to be cleaned after sales to ensure the difference
between the cost paid for securities, and value received from selling them, is accounted for as capital gain
or loss. If the capital gain/loss is not correct, the Trial Balance (Reports → Income & Expense → Trial
Balance) bottom line total debits will not balance to total credits.

Note

If you make an error, you can delete the lot(s) and capital gain/loss transaction(s) and retry. Ensure
you delete the lot, or at least unlink sale transactions from the lot, before you delete a capital
gain/loss transaction. Otherwise, the Lots in Account screen will recreate the capital gain/loss
transaction when you select the lot.

If you are not familiar with FIFO, LIFO or Average costing, please see Wikipedia  FIFO and LIFO ac-
counting [https://en.wikipedia.org/wiki/FIFO_and_LIFO_accounting] and  Average cost method [https://
en.wikipedia.org/wiki/Average_cost_method].

If you are not familiar with the difference between GnuCash transactions and splits, please see the section
called “Simple vs. Split Transactions”.

143

https://en.wikipedia.org/wiki/Lot
https://en.wikipedia.org/wiki/Lot
https://en.wikipedia.org/wiki/FIFO_and_LIFO_accounting
https://en.wikipedia.org/wiki/FIFO_and_LIFO_accounting
https://en.wikipedia.org/wiki/FIFO_and_LIFO_accounting
https://en.wikipedia.org/wiki/Average_cost_method
https://en.wikipedia.org/wiki/Average_cost_method
https://en.wikipedia.org/wiki/Average_cost_method


Investments

The GnuCash lot management facility can be a useful feature, reducing manual calculation, especially if
dividends have been reinvested over years and there are many different costs involved. It can automatically
link buy transactions to sell transactions using FIFO cost method and one can manually link specific buy
transactions to sell transactions in order to use LIFO. Advanced Portfolio Report basis costs and gains/
losses will agree with the costs and gain/loss transactions created by scrubbing if either the FIFO or LIFO
cost methods are used.

Lots in Account Window

The Lots in Account SSSS window, where SSSS is a security account, is used to manually or automatically
link security transaction splits to lots and create capital gain/loss transactions to account for the difference
between the costs of buying a security and the value received by selling it.

To open the Lots in Account window, open the security account register, then select Actions → View Lots.

Figure 9.1. Selling Shares - Capital Gains - Lots in Account window

An image of the Lots in Account  window.

Refer to the Help Manual, Chapter 8 Tools & Assistants,  Lots in Account  [https://www.gnucash.org/docs/
v3/C/gnucash-help/tool-lots.html] for details of the Lots in Account screen elements.

Procedure Summary

Using the lot management facility for the automatic calculation of capital gain or loss typically follows
these steps:

1. Record the sale transaction using Net Pricing (but stop short of entering the Capital Gain transaction as
it will be created by scrubbing). See the section called “Example: Sale of Shares with Profit, Manual
Profit/Loss Calculation, Sale & Profit Separated, Net Pricing”.

2. the section called “Manual Lot Creation and Linking” (Optional depending on cost method)

3. the section called “Automatic Creation of Capital Gain Or Loss Transactions”

4. the section called “Change Orphaned Gains-CCC to Gain/Loss Account”

5. the section called “Run a Trial Balance” report to ensure total debits balance to total credits

Manual Lot Creation and Linking

Before using this feature, ensure you have read the section called “Considerations”.

This functionality allows the manual linking of specfic buy and sell transactions. It may be used in the case
where a user wishes to use a different cost method than the automatic linking method (FIFO). Effectively,
if one wishes the cost basis and capital gains in the Advanced Portfolio Report to be consistent with the
capital gains transactions created by scrubbing, manual lot creation only needs to be used when using LIFO
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or “sale of designated lots” (the same thing for securities as far as US personal tax law is concerned). This
is because the scrub function can automatically do FIFO linking so there is no need to do it manually and
scrubbing cannot be used for average costing.

See the section called “Example 1: Manual Lot Creation and Linking”.

Automatic Creation of Capital Gain Or Loss Transactions

Note

Do NOT do this unless you are using FIFO or LIFO to cost sales. See the section called “Con-
siderations”

GnuCash can automatically calculate and create security sale capital gain/loss transactions. Lots are used
to link buy transaction splits with sell transaction splits so the correct cost of the securities sold can be
determined. GnuCash will use any existing lots, and create new lots for any buy transaction splits not
already linked to a lot. Buy and sell transaction splits are linked to lots using FIFO method.

See:

the section called “Example 2: Automatic Creation of Capital Gain Or Loss Transactions”

the section called “Example 3: Automatic Creation of Capital Gain Or Loss Transactions, 2 Sales at Once”

the section called “Example 4: Automatic Creation of Capital Gain Or Loss Transactions - After a Simple
Stock Split”

Change Orphaned Gains-CCC to Gain/Loss Account

The capital gain/loss transaction(s) created by scrubbing uses an automatically created generic Orphaned
Gains-CCC account (where CCC is the security currency) because GnuCash doesn't know which capital
gain or loss account should be used. After scrubbing, the user should edit the  Orphaned Gains-CCC
transaction split to re-assign the income account to a more meaningful income (or expense) gain or loss
account (e.g. Income:Long Term Capital Gain:IBM).

See the section called “ Example 5: Changing the Orphaned Gains-CCC to Gain/Loss Account ”.

Run a Trial Balance

Running a Trial Balance report (Reports → Income & Expense → Trial Balance) after creating capital gain/
loss transactions, is a basic check that capital gains/losses are correctly accounting for the difference be-
tween the cost paid for securities, and value received from selling them. At the end of the report, total
debits should equal total credits.

Tip

A Trial Balance may not balance due to some other problem. To determine if the cause of an
imbalance is from incorrectly accounting for capital gain/loss:

If necessary, temporarily change the date of the sell transaction and the capital gain/loss transac-
tion, so they are the only transactions for a particular date, then run the Trial Balance as at the
day before. If the Trial Balance is still out by the same amount, it is not the capital gain/loss that
is causing the problem.

If you find a prior out of balance  Trial Balance, keep running the Trial Balance report with dif-
ferent dates until you find the date it starts being out of balance. Temporarily change the trans-
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action dates for each transaction on the problem date to the following day, then change the dates
back to the correct date 1 at a time, running the Trial Balance each time, until you identify the
problem transaction. When you change the date of a security sell transaction, you also need to
change the date of the corresponding capital gain transaction as it is only the sum of these that
will balance in the Trial Balance.

Considerations

There are some points that should be considered before using the lot management facility.

1. GnuCash implements only the First In/ First Out (FIFO) cost method when automatically linking buy
transactions to sell transactions. I.e. The oldest securities are always sold first. The Last In First Out
(LIFO) cost method may be used by manually linking the most recent buy security splits to the sell
split before scrubbing.

2. The Advanced Portfolio Report does not use lot information when calculating costs, just the security
transaction splits. It calculates the cost basis and gains or losses using the selected Basis calculation
method report option (Average, FIFO or LIFO). If one wishes the Advanced Portfolio Report costs and
gains/losses to be consistent with the capital gain/loss transactions created by scrubbing, the same cost
model must be used in both places.

3. Scrubbing does not recognize commissions or fees so makes no allowance for them in the calculation of
gain or loss. Therefore you must use Net Pricing rather than Gross Pricing if you wish to use scrubbing.
See the section called “Handling Commissions and Fees”.

4. Scrubbing does not recognize capital gain/loss transaction splits if they have been manually entered as
part of the sale transaction. Therefore ensure previous sales are recorded as 2 transactions:

Table 9.13. Transaction 1 dealing with value received and the reduction of the
number of shares

Account Tot Shares (Unit) Price Buy (Debit) Sell (Credit)

Brokerage or Bank Debit

Security #NumSold SaleUnitPrice SaleValue

Table 9.14. Transaction 2 capital gain/loss (loss in this example)

Account Tot Shares (Unit) Price Buy (Debit) Sell (Credit)

Capital Loss Debit

Security 0 0 Credit

5. The automatic capital gains calculations can handle straightforward buy, sell, and return of capital
transactions but any transaction that affect the number of shares, even simple splits, will cause it to
produce wrong answers so those cases must be handled manually.

Example 1: Manual Lot Creation and Linking

Here is an example of selling part of a security holding using the LIFO method. In this example, the most
recent buy transaction (dated 01/07/2016, a reinvested dividend), is linked to a lot, along with the sell
transaction, and the GnuCash scrub function is used to calculate capital gain or loss and create the capital
gain/loss transaction.

1. Open the security account's register.
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Figure 9.2. Selling Shares - Capital Gains - Security register before scrubbing a single lot

An image of the Security Account register in transaction journal view, before lot scrubbing.

2. Ensure all previous capital gain/loss transactions are separate transactions to the sell transactions which
record the reduction in the number of shares and the value received.

3. Select Actions → View Lots to open the Lots in Account SSSS window where SSSS is the security
account.

Figure 9.3. Selling Shares - Capital Gains - Lots before scrubbing a single lot

An image of the Lots in Account  window before lot scrubbing.

4. Create a new lot using the New Lot button. Initially this lot is not linked to any buy or sell split.

5. Highlight the new lot in the Lots in This Account panel.

6. Highlight the buy split (dated 01/07/2016) of the security to be sold in the Splits free panel.

7. Click the >> button to link the buy split with the highlighted lot. The split moves from the Splits free
panel to the Splits in Lot panel.

8. Repeat the previous 2 steps for any other buy splits that should be included in the lot (in this example,
there is only 1 buy split in the sale).
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9. Highlight the sell split in the Splits free panel.

10.Click the >> button to link the sell split with the highlighted lot.

11.Check the lot Balance is as expected. I.e. in this example the lot balance should be zero as the number
of securities sold in the lot, is matched with the same number of security buys.

Figure 9.4. Selling Shares - Capital Gains - Lots before scrubbing a single lot, after manual
linking

An image of the Lots in Account  window before scrubbing a single lot.

12.Click the Scrub button (NOT  the Scrub Account button).

The Lots in Account window has not changed after using the Scrub button so no example screen image
is supplied.

13.Close the Lots in Account SSSS window and return to the security account register.

Figure 9.5. Selling Shares - Capital Gains - Register after manual linking and scrubbing a
single lot

An image of the Register after scrubbing a single lot.

14.Continue to the section called “Change Orphaned Gains-CCC to Gain/Loss Account”
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Example 2: Automatic Creation of Capital Gain Or Loss Transac-
tions

Create the capital gains transaction by following these steps:

1. Open the security account's register.

2. Ensure any previous manually entered capital gain/loss transaction splits have been entered in separate
transactions to the the sell transactions.

3. Select Actions → View Lots to open the Lots in Account SSSS window where SSSS is the security
account.

4. If using LIFO, use the above procedure the section called “Manual Lot Creation and Linking” to create
a lot for each sell transaction, link the lot with the sell transaction and each of the buy transactions that
make up the sale.

5. Click the Scrub Account button which:

• Creates lots for any buy transactions that are not already linked to a lot and links them to sell trans-
actions splits using the FIFO method. As a transaction split can only be linked to 1 lot, if a sell trans-
action needs to be linked to multiple lots, the sell transaction split is itself split into multiple subsplits.
In the case of multiple subsplits, it is possible to have different splits from the same transaction in
both the Splits free and Splits in lot panels.

• Creates a separate transaction per lot for capital gain/loss.

6. Continue to the section called “Change Orphaned Gains-CCC to Gain/Loss Account”

Example 3: Automatic Creation of Capital Gain Or Loss Transac-
tions, 2 Sales at Once

Here is an example of FIFO scrubbing without manual lot creation. In this example, the transactions for
2 sales are scrubbed at once but usually scrubbing would be performed after each sale. One reason for
scrubbing 2 sales at once, could be because there were multiple sales on the same day.
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Figure 9.6. Selling Shares - Capital Gains - Register before Scrub Account

An image of the Security Account register in transaction journal view, before Scrub Account is used.

1. Select Actions → View Lots to open the Lots in Account SSSS window where SSSS is the security
account.

Figure 9.7. Selling Shares - Capital Gains - Lots before Scrub Account

An image of the Lots in Account  window before Scrub Account is used.

2. Click the Scrub Account button.
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Figure 9.8. Selling Shares - Capital Gains - Lots after Scrub Account

An image of the Lots in Account  window after using Scrub Account.

Note

After using the Scrub Account button only the last lot is shown, so the above image is after
the Lots in Account window has been closed and reopened so all the lots show.

3. Close the Lots in Account SSSS window and return to the security account register.
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Figure 9.9. Selling Shares - Capital Gains - Register after Scrub Account

An image of the security register  after using Scrub Account.

Note

The security splits in the sell transactions have been split into subsplits, one subsplit per lot, and
a capital gain transaction has been created for each security subsplit of each sell transaction.

4. Continue to the section called “Change Orphaned Gains-CCC to Gain/Loss Account”

Example 4: Automatic Creation of Capital Gain Or Loss Transac-
tions - After a Simple Stock Split

Here is an example of FIFO scrubbing without manual lot creation/linking, where the Stock Split Assistant
has been used for a simple stock split. In this example, 100 shares of security XYZ were bought for $10.00
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each, there was a simple 2 for 1 stock split for zero cost (so the holding was then 200 shares @ $5.00
each), then all 200 shares were sold for $6.00 each.

Figure 9.10. Selling Shares - Capital Gains - Register after Scrub Account

An image of the Security Account register in transaction journal view, after Scrub Account is used.

Figure 9.11. Selling Shares - Capital Gains - Lot 0 after Scrub Account

An image of the Security Account register in transaction journal view, after Scrub Account is used.
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Figure 9.12. Selling Shares - Capital Gains - Lot 1 after Scrub Account

An image of the Security Account register in transaction journal view, after Scrub Account is used.

The above screen shots show that scrubbing created:

2 lots. A separate lot for each buy (it essentially treats the stock split as a buy of 100 for no cost)

2 capital gain transactions (one for each lot) on the date of the sale:

• Lot 0: 1/7/2009 loss $400 (sale $600 − cost $1000)

• Lot 1: 1/7/2009 gain $600 (sale $600 − cost $0)

Total gain $200 is correct. Whether the gain is a single long-term one or one each of long-term and short-
term or whether there's even a distinction depends on the user's tax jurisdiction and the way the split is
structured. If the user needs help figuring it out they should consult a professional.

Example 5: Changing the Orphaned Gains-CCC to Gain/Loss Ac-
count

1. Close the Lots in Account SSSS window if open and return to the security account register.
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Figure 9.13. Selling Shares - Capital Gains - Register after scrubbing a single lot

An image of the security register  after scrubbing a single lot.

2. Find each new Realized Gain/Loss transaction in the security account register (they will have the same
date as the sell transactions). Edit the  Orphaned Gains-CCC transaction split to re-assign the income
account to a more meaningful income (or expense) gain or loss account (e.g. Income:Long Term Capital
Gain:IBM).

Tip

You may like to split the capital gain/loss into taxable and non taxable parts if that is in accord
with your tax laws.

Dividends
Some companies or mutual funds pay periodic dividends to shareholders. Dividends are typically given
in one of two ways, either they are automatically reinvested into the commodity or they are given as cash.
Mutual funds are often setup to automatically reinvest the dividend, while common stock dividends usually
pay cash.

Dividends in Cash

If the dividend is presented as cash, you should record the transaction in the asset account that received the
money, as income from Income:Dividends. Additionally if you want to tie the cash dividend to a particular
stock holding then add a dummy transaction split to the stock account with quantity 0 price 1 value 0.

As an example consider the following; the dividends deposited as cash into the Broker Account with a
tie to the stock account.
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An image of the Brokerage Account register after a series of cash dividends.

Note

If you want to track dividends on a per-stock basis, you would need to create an Income:Divi-
dends:STOCKSYMBOL account for each stock you own that pays dividends.

Dividends Re-Invested

If you receive the dividend in the form of an automatic reinvestment, the transaction for this should be
handled within the stock or mutual fund account as income from “Income:Dividend” for the appropriate
number of reinvested shares. This type of reinvest account is often referred to as a DRIP (Dividend Re-
Investment Program).

As an example consider the following purchase of NSTAR (NST) stock with the dividends reinvested into
a DRIP Account. Mutual fund re-investments would be the same.

Starting with the purchase of 100 shares on Jan. 3, 2005, all dividends will be reinvested and an account is
created to track the dividend to the specific stock. GnuCash simplifies the entry by allowing calculations
within the cells of the transaction. If the first dividend is $.29/share, enter $53.28 (purchase price + divi-
dend) in the share Price cell and 100*.29 in the Buy cell. GnuCash will calculate for you the corresponding
numer of Shares

An image of the NST Stock Account register after a dividend reinvestment.

Return of Capital
This refers to a transaction where an investment returns capital to the investor and doesn't have any ac-
counting implications other than reducing the cost basis. The number of shares held is not changed.
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A Return of Capital transaction can be entered in the stock register by entering the stock split with

Shares 0

Price 0

Sell Return of Capital value

The other side of the double entry would usually be a debit to the brokerage bank account.

An image of the Stock Account register after a return of capital.

Note

It is not possible to use the Stock Split Assistant to do this type of transaction.

Tip

If you accidentally entered a non-zero price in the stock split, GnuCash may have created an
unwanted price database entry which could cause reports to be wrong. Check for and remove
such an unwanted entry from the price database using Tools  → Price Editor.

Splits and Mergers
Companies may split their stock for many reasons but the most common is that the price has risen higher
than management thinks is a reasonable price for many investors. Some of these splits are simple exchanges
(eg 2 for 1 or 3 for 2) and some are complex exchanges with cash distributions. Splits may also result in
fewer shares if the exchange rate is a reverse split (1 for 3 or .75 for 1).

Simple Stock Split

As an example, our holding of NST stock declared a 2 for 1 stock split effective June 6, 2005. The process
for entering this transaction is; select Actions → Stock Split to start the assistant.
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An image of the selection of the stock split assistant.

The first screen is an Introduction, select Forward to display the selection of the account and stock for the
split. You will need to create an entry for each Account:Stock combination you hold.

An image of the stock split assistant at step 2 - Selection of Account/Stock.

Select the Assets:Investments:DRIPs:NST and click on Forward.

The next screen presents 5 fields in the Stock Splits Details window:

• Date - Enter the date of the split.

• Shares - The number of shares increased (or decreased) in the transaction.

In our example it is a 2 for 1 split so the number of additional shares is the number of shares currently
in the register.

• Description - The Description should give a brief explanation of the transaction.

• New Price - If desired the new price of the stock, after the split, may be entered.

• Currency - The currency of the transaction is required. This should be the same as the stock purchase
currency.
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Click on the Forward button.

An image of the stock split assistant at step 3 - Split Details.

The next screen will be skipped in this example as there was no “Cash in Lieu”.

An image of the stock split assistant at step 4 - Cash in Lieu.

A final Finish screen will give a last option to; Cancel, Back to modify any data entered or Apply to
complete the stock split with the data entered.
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An image of the Assets:Investments:DRIPs:NST register after a simple stock split transaction.

Moderately Complex Stock Merger
As an example, assume you held AT&T stock during the Nov. 18, 2005 merger of SBC with AT&T. For
this example you will have purchased AT&T on April 1, 2005, any dividends will have been paid in cash,
therefore not entered into the AT&T stock register.

The conditions of the merger were .77942 share of SBC stock were exchanged for each share of AT&T
stock. The merged company continued to use the symbol “T” from AT&T.

AT&T paid a “dividend” of $1.20/share on the transaction date, however this will not appear in the stock
account as it was a cash distribution.

The process for entering this transaction is identical to the simple split until the “Details” screen. You
will need to create an split entry in each Investment Account:Stock account combination that has shares
splitting.

An image of the stock split assistant at step 2 - Selection of Account/Stock (Investment Account:T).

Select the Assets:Investments:Brokerage Account:Stock:T and click on Forward.

The next screen presents 5 fields in the Stock Splits Details window:
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• Date - Enter the date of the split. Here we’ll enter November 18, 2005.

• Shares - The number of shares increased (or decreased) in the transaction.

In our example it is a .77942 for 1 split so the number of shares will decrease from the number of shares
currently in the register. You may use GnuCash’s ability to perform calculations on an entry form by
entering data directly (E.g. “(.77942*100)#100”) to calculate the decrease in shares from the split.

• Description - The Description should give a brief explanation of the transaction.

• New Price - If desired the new price of the stock, after the split, may be entered.

• Currency - The currency of the transaction is required. This should be the same as the stock purchase
currency.

Click on the Forward button.

An image of the stock split assistant at step 3 - Split Details.

The next screen will be skipped in this example as there was no “Cash in Lieu”.

A final “Finish” screen will give a last option to Back to modify any data entered or Apply to complete
the stock split with the data entered.
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An image of the Investment Account:T register after a stock split transaction that decreases the shares.
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Chapter 10. Reports
GnuCash is a powerful double entry accounting software package that allows users to enter and track
their money in a reliable manner. However, putting this information into GnuCash is only a part of the
process. To be truly helpful, you need to be able to extract this information in meaningful ways. GnuCash's
reporting features allow you to just that.

GnuCash's reporting features allow you to display nearly any group of transactions in a wide variety of
formats. This makes it easy to answer questions about your finances, such as "How much did I spend on
groceries last month?" or "How much did I earn in the previous six months?"

GnuCash includes a number of common report types, which can be modified to meet your specific needs.
If these common reports are insufficient, it is possible to modify or even write your own custom reports
(although this is not recommended for beginners).

Overview
There are many standard reports pre-built in GnuCash, all available from the Reports pulldown menu in
the main account window.

When you select a report from the list of reports, that report is first run with its default settings. Once you
have opened the report, you can modify its parameters by clicking on the Options button on the toolbar.
Under Options, you will see the different settings that you can change for each report. Note that for different
reports, the options will be different.

Saved Reports Configurations Concepts
Once you have modified a report to meet your needs, you may wish to save that report for reuse at a later
point. GnuCash allows custom reports to be saved, using the Save Report Configuration command.

To save a report configuration:

• Go to the Reports Menu and choose the desired report.

• Change the settings on the report until it includes what is needed.

• Go to the General tab of the report's options and change the Report Name to something meaningful (Do
not confuse this with the Report Title).

• Apply the changes and close the dialog.

• Click the Save Report Configuration or Save Report Configuration As... button

This will store the report options in a file in your home directory.

The first time you save a report with a name that has not already been saved, you can use either the Save
Report Configuration or the Save Report Configuration As... button. You can modify the report name
before saving it.

Once a report has been saved with the current name, the Save Report Configuration button will immediately
update the saved report configuration. Use the Save Report Configuration As button to save the current
report configuration with a new name.

Saved report configurations are available for use under the Reports->Saved Report Configurations entry.
They will also be available for use on multicolumn reports.
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Saved report configurations can be deleted in the Saved Report Configurations dialog by clicking the
trashcan icon.

To edit saved report configurations, open the report via Reports->Saved Report Configurations, edit and
apply the new options, and click Save Report Configuration.

Standard Reports Overview
The standard reports that are included in GnuCash are presented in this chapter. For each report, a short
description is given, which explains what the report is intended to show and its primary purpose. We begin
with a description of the Transaction Report, which is an all-purpose report with many features and settings
that allow sophisticated examination of the data in a file.

Transaction Report
The Transaction Report is a fundamental report that allows users to retrieve a wide variety of useful in-
formation from the financial records. The report includes many features that allow powerful and flexible
reporting from the single basic report.

• Debit and Credit subtotals can be displayed, and within a grouping section, if debit totals > credit totals,
the group subtotal will be displayed in the debit column.

• Multiple data columns enable display of transaction amounts in report currency and original currency
in separate columns.

• Additional sortkeys e.g. sort by reconcile status (unreconciled -> cleared -> reconciled), sort by weeks,
allow additional views into the financial records.

• Full text filter enabled for description, notes and memo, and for account full names. This allows easier
selection of source account names and tailored reporting. Filters can optionally use full POSIX regular
expressions.

• Indenting of columns will indent the report columns for easier understanding of grouping and sorting.
(This is now enabled by default for Gnucash 3.0 onwards)

• Subtotal table is useful to understand the relationship in the data. This feature compiles the primary and
secondary subtotals into a table view, allowing additional insight into financial records, e.g. account
subtotals in different time series.

For further ideas on how to use the Transaction Report to produce common reports, see Using the Trans-
action Report.

Assets & Liabilities Group
Reports in this group provide general information about assets and liabilities.

Advanced Portfolio

The Advanced Portfolio produces a report on commodity accounts (stock and mutual fund type accounts)
using price information stored in the GnuCash price database and within the GnuCash transaction data. If
you do not have stock price information in your file, the report will indicate an error. This report includes
extended information about commodity holdings, including information about the basis, gain, and return
of individual commodities.
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Advanced Portfolio Capital Gains

The Advanced Portfolio report doesn’t use the capital gain splits to calculate capital gains. It calculates
the gains from the various buy and sell transactions in the account without regard to whether the gains
and losses are recorded or not. Any realized gain splits are ignored. Realized gain splits are recognized as
two splits, one in the stock’s account with a zero number of shares and a non-zero value, the other in an
income or expense account with a value that is the negative of the split in the stock account. These two
splits can be in a separate transaction (as created by scrubbing) or in the same transaction as the sale (this
will cause incorrect future scrubbing). The income or expense split can be split into multiple splits, say for
taxable/non-taxable or short/long term gains, without affecting this report.

Asset Barchart

The Asset Barchart presents the value of assets on a monthly basis in barchart form. By default, the report
displays the eight largest accounts that have specific asset types assigned to them, and it displays bars for
the current financial period.

Several settings on this report can greatly affect the information included.

• On the Accounts tab, the "Show Accounts until level" option changes how the report aggregates account
totals. Change this value to see information at deeper levels of the account structure.

• On the Display tab, the "Maximum Bars" option will display more bars in the chart, allowing informa-
tion for more accounts to display. Additionally, the "Show table" option enables the display of chart
information in tabular form below the chart.

• On the General tab, the "Price Source" option can significantly affect the reported value of various
commodities included in the report.

Asset Piechart

The Asset Piechart presents the value of assets on a monthly basis in piechart form. By default, the report
shows the seven largest accounts, that have specific asset types assigned to them, arranged in descending
order by value as of the end of the current accounting period.

Several settings on this report can greatly affect the information included.

• On the Accounts tab, the "Show Accounts until level" option changes how the report aggregates account
totals. Change this value to see information at deeper levels of the account structure.

• On the Display tab, the "Maximum Slices" option will display more slices in the chart, allowing infor-
mation for more accounts to display.

• On the General tab, the "Price Source" option can significantly affect the reported value of various
commodities included in the report.

Average Balance

The Average Balance report displays monthly averages for the current accounting period.

Balance Sheet

The Balance Sheet lists Asset, Liability, and Equity account balances for all such accounts, and provides
totals as of a given date. Balance sheets are commonly run for the last day of each fiscal year to give an
overall sense of the financial condition of the entity.
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General Journal

The General Journal produces a register of all transactions (beginning to end) in order by date, showing
the accounts and the amounts involved, and totals the Net Change by all currencies and assets.

This report is not customizable by date or account, though you can include more or fewer details about
the individual transactions, and whether to include running balances and totals for the credits and debits.
If you need a report restricted to particular accounts, consider the Transaction Report or open a particular
account and choose the Account Transaction Report.

General Ledger

The General Ledger produces information about all transactions for a selected set of accounts. When first
run, this report loads no data, and the report options must be changed to retrieve information from the file.

Investment Portfolio

The Investment Portfolio produces a report of commodity accounts (that is, accounts with type "Stock" or
"Mutual Fund"), giving holdings, price and value information about commodities in the file.

Liability Barchart

The Liability Barchart presents the value of liabilities on a monthly basis in barchart form. By default, the
report displays the eight largest accounts that have specific asset types assigned to them, and it displays
bars for the current financial period.

Several settings on this report can greatly affect the information included.

• On the Accounts tab, the "Show Accounts until level" option changes how the report aggregates account
totals. Change this value to see information at deeper levels of the account structure.

• On the Display tab, the "Maximum Bars" option will display more bars in the chart, allowing informa-
tion for more accounts to display. Additionally, the "Show table" option enables the display of chart
information in tabular form below the chart.

• On the General tab, the "Price Source" option can significantly affect the reported value of various
commodities included in the report.

Liability Piechart

The Liability Piechart presents the value of liabilities on a monthly basis in piechart form. By default,
the report shows the seven largest accounts, that have specific asset types assigned to them, arranged in
descending order by value as of the end of the current accounting period.

Several settings on this report can greatly affect the information included.

• On the Accounts tab, the "Show Accounts until level" option changes how the report aggregates account
totals. Change this value to see information at deeper levels of the account structure.

• On the Display tab, the "Maximum Slices" option will display more slices in the chart, allowing infor-
mation for more accounts to display.

• On the General tab, the "Price Source" option can significantly affect the reported value of various
commodities included in the report.
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Net Worth Barchart

The Net Worth Barchart summarizes Asset accounts, Liability accounts, and overall Net Worth as bars
on a graph on a monthly basis for the current financial period. This report provides a graphic overview
of the file over time.

Net Worth Linechart

The Net Worth Linechart summarizes Asset accounts, Liability accounts, and overall Net Worth as a line
graph on a monthly basis for the current financial period. This report provides a graphic overview of the
file over time.

Price Scatterplot

The Price Scatterplot displays the value of one commodity relative to another commodity, for example
the value of a stock relative to a currency. When first run, this report loads no data, and the report options
must be changed to retrieve information from the file. Specifically, the "Price of Commodity" setting on
the Price options tab must be changed to a specific commodity.

Budget Group

Budget reports in GnuCash allow you to gather summary information related to budgets you may have
created. In order for these reports to work, you must first create a budget. The reports in this group are
specifically based on budget information. To use these reports, you need to have a budget saved in your file.

Budget Balance Sheet

Budget Barchart

Budget Flow

Budget Income Statement

Budget Profit & Loss

Budget Report

Business Group

Reports in this group provide general information about activities related to a business.

Customer Report

167



Reports

Customer Summary

Customer Summary is a customer profit report that can help with job analysis by comparing the income
and expenses for a specific customer.

All invoices have an Owner in GnuCash, so invoices that are made will show a customer and show in the
report. When creating a Bill, the Default Chargeback Customer is blank. To use the profit report, this field
needs an entry, since this is the tag that decides the line to which to attach the expense. Left blank, the
bill will be assigned to "No Customer." Similarly, when income is entered directly in a register rather than
creating an invoice, it will also be assigned to "No Customer."

Thus, if this report includes an entry for "No Customer", this means that the report may be inaccurate, as
the results are not all properly labeled.

Possible use scenarios include:

• Tracking retail sales from different cities

• Tracking rental properties

• Tracking types of business

• Tracking commission sales

Each of these scenarios assumes that the account structure includes breakdowns for individual tracked
categories. Changing settings on the Income and Expense tabs under Options can hone the information
displayed. By default all income and expense accounts are included; however, since GnuCash can't really
predict the names and classification of income and expense accounts, it must group them all into the "No
Customer" entry.

Note that inventory-based businesses won't benefit from this report because of its nature.

Useful options:

• The Expense Accounts tab allows the selection of one or more expense accounts.

• The Income Accounts tab allows the selection of one or more income accounts.

• The Display tab allows sorting by name, profit percentage, or amount of profit.

Easy Invoice

Employee Report

Fancy Invoice

Payable Aging

Printable Invoice
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Receivable Aging

This report provides a listing of all customers, their current balance, and how much they have outstanding
from invoices over different time periods&mdash;how much they owe from 0-30 days, from 31-60 days,
from 61-90 days, and over 90 days. The report also contains links to each customer and to their current
customer report.

Vendor Report

Income and Expense Group
Reports in this group provide information about Income and Expense

Cash Flow

This report shows the change in value for a set of accounts (the flow of cash) over a given period of time.
By default, this report is based on accounts in Assets and Special Accounts, and covers the current financial
period. The report enumerates all money coming in to and going out of the base accounts, broken down
by the other account.

Equity Statement

This report can be seen as extension of the Balance Sheet report. The Balance Sheet states the balance
of Assets, Liabilities and Equity at a specific point of time. The Equity Statement focuses on the Equity
Accounts by showing the cash flow to and from them for a given period of time.

By balancing this cash flow with income, the report shows the available capital at the beginning and end
of the selected time period.

Expense Barchart

The Expense Barchart presents the value of expenses on a monthly basis in barchart form. By default, the
report displays the eight largest accounts that have specific expense types assigned to them, and it displays
bars for the current financial period.

Several settings on this report can greatly affect the information included.

• On the Accounts tab, the "Show Accounts until level" option changes how the report aggregates account
totals. Change this value to see information at deeper levels of the account structure.

• On the Display tab, the "Maximum Bars" option will display more bars in the chart, allowing informa-
tion for more accounts to display. Additionally, the "Show table" option enables the display of chart
information in tabular form below the chart.

• On the General tab, the "Price Source" option can significantly affect the reported value of various
commodities included in the report.

Expense Piechart

The Expense Piechart presents the value of expenses on a monthly basis in piechart form. By default, the
report shows the seven largest accounts, that have specific expense types assigned to them, arranged in
descending order by value as of the end of the current accounting period.

Several settings on this report can greatly affect the information included.
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• On the Accounts tab, the "Show Accounts until level" option changes how the report aggregates account
totals. Change this value to see information at deeper levels of the account structure.

• On the Display tab, the "Maximum Slices" option will display more slices in the chart, allowing infor-
mation for more accounts to display.

• On the General tab, the "Price Source" option can significantly affect the reported value of various
commodities included in the report.

Expenses vs. Day of Week

Expenses vs. Day of Week presents a pie chart showing the totals for selected expense accounts totaled by
the day of the week of the transaction. The report options enable you to make some adjustments (such as
accounts, display options, and the date range) but the account selector only allows expense accounts to be
chosen. The report aggregates expense transactions by day of week, not by any other period or category.
Due to these limitations, the report may be considered a demonstration or an example to someone wanting
to examine the source code for composing a useful custom report.

Income Barchart

The Income Barchart presents the value of income on a monthly basis in barchart form. By default, the
report displays the eight largest accounts that have specific income types assigned to them, and it displays
bars for the current financial period.

Several settings on this report can greatly affect the information included.

• On the Accounts tab, the "Show Accounts until level" option changes how the report aggregates account
totals. Change this value to see information at deeper levels of the account structure.

• On the Display tab, the "Maximum Bars" option will display more bars in the chart, allowing informa-
tion for more accounts to display. Additionally, the "Show table" option enables the display of chart
information in tabular form below the chart.

• On the General tab, the "Price Source" option can significantly affect the reported value of various
commodities included in the report.

Income & Expense Chart

Income Piechart

The Income Piechart presents the value of income on a monthly basis in piechart form. By default, the
report shows the seven largest accounts, that have specific income types assigned to them, arranged in
descending order by value as of the end of the current accounting period.

Several settings on this report can greatly affect the information included.

• On the Accounts tab, the "Show Accounts until level" option changes how the report aggregates account
totals. Change this value to see information at deeper levels of the account structure.

• On the Display tab, the "Maximum Slices" option will display more slices in the chart, allowing infor-
mation for more accounts to display.

• On the General tab, the "Price Source" option can significantly affect the reported value of various
commodities included in the report.
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Income Statement

This report lists Income and Expense account totals for a set period. By default, it shows all Expense and
Income accounts down to 3 levels of sub-accounts for the current financial period.

An Income Statement is also called a "Profit and Loss" report or "Revenue Statement."

In earlier versions of GnuCash, this report was called "Profit & Loss," but with version 2, the report was
renamed "Income Statement" to use more common accounting terminology.

The Income Statement helps show where money is coming from and where it is going for a given time
period.

Income vs. Day of Week

Income vs. Day of Week presents a piechart showing the totals for selected income accounts totaled by
the day of the week of the transaction. The report options enable you to make some adjustments (such as
accounts, display options, and the date range) but the account selector only allows income accounts to be
chosen. The report aggregates income transactions by day of week, not by any other period or category.
Due to these limitations, the report may be considered a demonstration or an example to someone wanting
to examine the source code for composing a useful custom report.

Trial Balance

Trial Balance lists the ending balances in all accounts as of a particular date. It is typically run at the end of
an accounting period and is primarily used to ensure that the total of all debits equals the total of all credits.

Income and GST Statement

The Income and GST Statement is a specialised Transaction Report designed to print Business-related
Sales and Receipts, as well as their GST or VAT components. This report is designed for use in Australia,
but is also usable in any jurisdictions implementing value-added taxes (or goods and services taxes) during
regular business sales and receipts; and the business owner is expected to submit periodic reports of total
sales, purchases, and taxes collected on sales from clients or paid to a supplier.

This report makes some assumptions upon the accounts used for sales, purchases, and taxes collected on
sales, and paid on purchases.

• Net Sales must be an Income-type account

• Net Purchases must be an Expense-type account

• GST/VAT on Sales must be a Liability-type account

• GST/VAT on Purchases must be an Asset-type account

• There may be multiple GST accounts, e.g. reduced GST, standard GST etc. The GST accounts can be
printed individually, or summarised for sales and purchases.

• There may be multiple sales and expenses accounts, e.g. Income:Sales, Income:Grants, Expenses:Sup-
pliers, Expenses:Marketing, Expenses:Insurance. These amounts may be reported individually, or sum-
marised for sales and purchases.

• The transactions may be entered manually as a multi-split transaction, or they may be entered via the
Business Invoices and Bills tools.
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As an example, consider a business has the following transactions: It incurs sales of $1,000 plus 5% GST,
receiving $1,050. It also incurs GST-exempt sales of $600. It purchases goods/services worth $400 plus
5% = $420. The following transactions will record the business activities:

Table 10.1. Sample Chart of Accounts for Income and GST Statement

Date Description Account Debit Credit

Income:Sales  $1,000

GST on Sales [Lia-
bility]

 $50

01/01/2018 Sales $1,000 + 5%
GST

Asset:Bank $1,050  

Income:Sales  $60002/01/2018 GST-Free Sales
$600 Asset:Bank $600  

Expenses:Purchas-
es

$400  

Asset:Bank  $420

03/01/2018 Purchase $400 +
5% GST

GST on Purchases
[Asset]

$20  

For the Income and GST Statement, the Accounts selected will be the Income and Expense Accounts,
and the Tax accounts are used to select the GST accounts. The GST period is selected via the General
tab. The resulting report is shown as follows:

Table 10.2. Income and GST Statement

Date Descrip-
tion

Total Sales Net Sales Tax on
Sales

Total Pur-
chases

Net Pur-
chases

Tax on
Purchases

01/01/2018 Sales
$1,000 +
5%

$1,050 $1,000 $50    

02/01/2018 GST-Free
Sales $600

$600 $600     

03/01/2018 Purchase
$400 + 5%
GST

   $420 $400 $20

Totals $1,650 $1,600 $50 $420 $400 $20

This report would indicate that there was a total of $50 GST collected, and $20 GST on purchases, therefore
a $30 GST liability is payable to the authorities.

Sample & Custom Group
The reports in this group offer examples on how reports can be customized or podified to suit personal need.

Custom Multicolumn Report

This report provides a base that allows several standard and custom reports to be combined into one view.
Note that this report opens with an empty window; you must open the options and designate which reports
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to include for display. Once the reports have been selected, the settings for individual reports in the mul-
ticolumn display can be edited.

Sample Report with Examples

This is a sample report that users can examine to learn how to write their own reports.

Welcome Sample Report

This report demonstrates how the Multicolumn Report can be use to create custom dashboard-type reports.

Other Reports
Several reports are included on the main Reports menu. These are described below.

Account Summary

This lists the balances of all accounts and subaccounts as of a particular date. By default, this report shows
accounts and totals down to third-level subaccounts.

This report gives effectively the same information as the Chart of Accounts. You can use this report to
export and print the Chart of Accounts.

Note: To generate a report of account totals over a particular time period (especially if you do not close
your books at regular intervals), you might consider using the Income Statement, or Cash Flow reports.

Balance Forecast

This creates a balance chart which aims to track asset (or any other account type) balances, including
amounts from future scheduled transactions. The balances will include all regular booked amounts and
future amounts from numeric scheduled transaction templates.

This report can also add additional data charts to forecast future minimum balances. Reserve line can be
displayed to confirm if future minimum will dip below the reserve amount. A target line may also be
displayed above the reserve line for financial planning.

Future Scheduled Transactions Summary

Tax Report & TXF Export

Generates a report and a downloadable .txf file of taxable income and deductible expenses for a particu-
lar accounting period. To download the report data, choose the Export button on the toolbar and choose
between html and .txf downloadable versions.

To use this report, you must use Edit --> Tax Options to identify which form the taxing authority uses
for each income or expense account. Note that you can see but not modify the "Tax related" checkbox
in Edit --> Edit Account.

Saved Report Configurations

Selecting this will open a dialog with a list of available Saved Report Configurations. "Saved Report
Configurations" means sets of customized settings for standard reports.
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These sets must be saved by the user before they appear here. See Report Concepts above for instructions
on how to save report configurations.

Account Report

The Account Report menu entry only appears when an account register is the active tab. This report pro-
duces a list of all transactions in the open register.

Note that if you conduct a search that retrieves several transactions, the results are displayed in a new
search register, which can then be used to create a report for just those transactions.

Account Transaction Report

This report also only appears when an account register is the active tab. However, this report only lists
transactions that have been selected (e.g. by mouse click) in the current register. If no transactions are
selected, an empty report will be generated.

Using the Transaction Report
The Transaction Report can be heavily customised to produce most reports appropriate for personal finance
and business bookkeeping purposes. It aims to retrieve and filter information from the database, and present
transactions and totals, useful for the user and the accountant.

The following guide to the Transaction Report will assume the user has set up the chart of accounts ac-
cording to conventional bookkeeping practice. For example, the following describes a typical household
book with skeleton accounts. Further accounts will undoubtedly be necessary.

Table 10.3. Sample Chart of Accounts for the Transaction Report

Account Name Account Type

Asset ASSET (placeholder)

Asset:Bank BANK

Asset:Property ASSET

Liability LIABILITY (placeholder)

Liability:Credit Card CREDIT CARD

Liability:Home Loan LIABILITY

Income INCOME (placeholder)

Income:Salary INCOME

Income:Interest INCOME

Expense EXPENSE (placeholder)

Expense:Groceries EXPENSE

Expense:Auto EXPENSE

Expense:Medical EXPENSE

Equity EQUITY (placeholder)

Equity:Opening Balances EQUITY

Conventionally, the oldest transaction would be equity transfers from Equity:Opening Balances to Asset
and Liability Accounts. Most subsequent transactions would be transfers from Income/Expense accounts
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to Assets/Liability accounts (representing day-to-day activity e.g. receiving salary, paying utility bill), or
transfers between assets and liability accounts (representing movements between loans and assets, e.g.
paying credit card bill, receiving a loan).

The following use cases will be illustrated, and the options to be selected explained:

Using the Transaction Report to show previous year expenses

The Transaction Report can show how much was spent on expense accounts last year. This will usually
be the most useful basic transaction report format. To create this report:

1. Open the report options, from the Accounts tab, click the Expense placeholder account and Select
Children.

2. From the General tab, Choose relative dates “Start of Previous Year” and “End of Previous Year”.

3. From the Sorting tab, set Primary Key to Accounts, and enable Primary Key Subtotal.

4. Set the Secondary Key to Date, and set the Secondary Key Subtotal to None.

Secondary level grouping

The following will modify the above Transaction Report to use a secondary grouping strategy. The first
grouping (i.e. Primary Key = Accounts, Subtotal = enabled) will group transactions from the same ac-
counts, whereas the secondary grouping (i.e. Secondary Key = Date, Subtotal = Monthly) will also calcu-
late monthly sums within each account.

1. Select options as above

2. From the Sorting tab, set Secondary Key Subtotal to Monthly

Using secondary grouping for periodic comparison

The Display / Subtotal Table adds a subtotal summary table, which will ease comparison of accounts across
date periods. This displays the same subtotal calculations as the main table, presented in a grid structure.

In addition, if there are multiple primary-key groups (e.g. Date grouping with monthly subtotals, across
multiple months) the subtotal table will also compute and display the primary-key grouping Average. The
average is computed as the total amount per row, divided by the number of columns. This may cause
confusion when computing monthly spend averages, for instance, if a month has no transactions and is not
displayed in the table, it will not create a corresponding column in the table, therefore the average amount
will not reflect a true monthly average.

1. Select options as above

2. From the Display tab, enable the Subtotal Table.

Use filtering to limit accounts and transactions

Accounts and transactions can be filtered for reporting according to account full name (e.g. ":Business:"
will select account structure Income:Business:Sales, Income:Business:Grants, Expenses:Business:Rent,
Expenses:Business:Utilities) or transaction description/notes/memo (select transactions tagged #gift). The
filtering text may be either a standard string, or a POSIX regular expression.

1. From the Filter tab, complete the Account Name Filter, or Transaction Filter. Optionally toggle the
regular expression check boxes to toggle full POSIX regex matching. Regular expressions will allow
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more complex queries e.g. the transaction filter can be set to (#gift|#travel) which will filter transactions
with either #gift or #travel. They can be complicated and are best learned from external guides.

Using the Transaction Report to generate a reconciliation state-
ment.

This sortkey 'reconcile status' will separate reconciled, cleared and unreconciled transactions. This report
may be useful in producing a printable reconciliation report.

Alternatively, the Reconciliation Report will preset these defaults and requires only the Accounts selection.

1. From the Accounts tab, select the relevant bank or credit card account

2. From the General tab, choose an appropriate date range e.g. past 3 months

3. From the Sorting tab, set the Primary Key to Reconcile Status, Primary Key Subtotal to enabled, and
set the Secondary Key to Date. The Secondary Date Subtotal is left to None
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Chapter 11. Capital Gains
This chapter will present some of the techniques used to keep track of the unrealized and realized gains
and losses, better known as capital gains and losses.

Basic Concepts
This chapter will present some of the techniques used to keep track of the unrealized and realized gains
and losses, better known as capital gains and losses.

Certain resellable assets can change value over time, such as stocks, bonds, houses, or cars. Some assets
(eg: a stock) could increase in value, some (eg: a car) could decrease in value. It is important to be able to
track some of these time-dependent asset valuations, this chapter will show you how.

Probably everything you own will increase or decrease in value over time. So, the question is for which
of these assets should you track this changing value? The simple answer is that you only need to track this
for items which could be sold for cash in the future or which relate to taxation.

Consumable and disposable items (eg: food, gas for your car, or printer paper) are obviously not involved.
Thus, even though the new clothes you recently bought will certainly depreciate, you would not want to
track this depreciation since you have no intention of reselling the clothes and there is no tax implications
to the depreciation on clothing. So, for this example, the purchase of new clothes should be recorded as
a pure expense... you spent the money, and it is gone.

Asset appreciation occurs when something you own increases in value over time. When you own an asset
which has increased in value, the difference between the original purchase price and the new value is
known as unrealized gains. When you sell the asset, the profit you earn is known as realized gains or
capital gains. An example of an asset from which you could have unrealized gains, and eventually capital
gains, is stock in a publicly traded company.

Estimating Valuation
As mentioned in the introduction to this chapter, capital gains are the profits received from the sale of an
asset. This section will describe how to record capital gains in GnuCash.

The accounting methods for handling asset appreciation differs somewhat from depreciation because typ-
ically you are only concerned with the moment you sell the asset and realize the capital gains. This is
opposed to the continuous nature of tracking depreciation. Capital gains are an important subject in the
world of taxation, because governments tend to be quite interested in taxing capital gains in one manner
or another.

Note

As always, there are exceptions. If you hold a bond that pays all of its interest at maturity, tax
authorities often require that you recognize interest each year, and refuse this to be treated as a
capital gain. Consult the appropriate tax codes to determine the preferred treatment for each type
of asset you have which may be affected by capital gains taxes.

Estimating the increasing value of assets is generally not simple, because often it is difficult to know its
exact value until the moment it is sold.
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Securities traded daily on open markets such as stock exchanges are possibly the easiest type of asset
to predict the value of, and selling the asset at market prices may be as simple as calling a broker and
issuing a Market Order. On the other hand, estimating the value of a house is more difficult. Homes are
sold less often than stocks, and the sales tend to involve expending considerable effort and negotiations,
which means that estimates are likely to be less precise. Similarly, selling a used automobile involves a
negotiation process that makes pricing a bit less predictable.

Values of collectible objects such as jewelry, works of art, baseball cards, and “Beanie Babies” are even
harder to estimate. The markets for such objects are much less open than the securities markets and less
open than the housing market. Worse still are one-of-a-kind assets. Factories often contain presses and
dies customized to build a very specific product that cost tens or hundreds of thousands of dollars; this
equipment may be worthless outside of that very specific context. In such cases, several conflicting values
might be attached to the asset, none of them unambiguously correct.

The general rule of thumb in accounting for estimating unrealized gains (or loses) is that you should only
revalue assets such as stocks which are readily sellable and for which there are very good estimates of the
value. For all other assets, it is better to simply wait until you sell them, at which time you can exactly
determine the capital gains. Of course, there is no hard rule on this, and in fact different accountants may
prefer to do this differently.

Account Setup
As with most accounting practices, there are a number of different ways to setup capital gains accounts.
We will present here a general method which should be flexible enough to handle most situations. The
first account you will need is an Asset Cost account (GnuCash account type Asset), which is simply a place
where you record the original purchase of the asset. Usually this purchase is accomplished by a transaction
from your bank account.

In order to keep track of the appreciation of the asset, you will need three accounts. The first is an Unre-
alized Gains asset account in which to collect the sum of all of the appreciation amounts. The Unrealized
Gains asset account is balanced by a Unrealized Gains income account, in which all periodic appreciation
income is recorded. Finally, another income account is necessary, called a Realized Gains in which you
record the actual capital gains upon selling the asset.

Below is a generic account hierarchy for tracking the appreciation of 2 assets, ITEM1 and ITEM2. The
Assets:Fixed Assets:ITEM1:Cost accounts are balanced by the Assets:Current Assets:Savings Account ac-
count, the Assets:Fixed Assets:ITEM1:Unrealized Gains accounts are balanced by the Income:Unrealized
Gains account (similar for ITEM2).

-Assets
    -Current Assets
        -Savings Account
    -Fixed Assets
        -ITEM1
            -Cost
            -Unrealized Gain
        -ITEM2
            -Cost
            -Unrealized Gain
-Income
    -Realized Gains
    -Unrealized Gains
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Example
Let’s suppose you buy an asset expected to increase in value, say a Degas painting, and want to track this.
(The insurance company will care about this, even if nobody else does.)

Start with an account hierarchy similar to that shown in the section called “Account Setup”, but replace
“ITEM1” with “Degas” and you can remove the “ITEM2” accounts. We will assume that the Degas paint-
ing had an initial value of one hundred thousand dollars. Begin by giving your self $100,000 in the bank
and then transferring that from your bank account to your Assets:Fixed Assets:Degas:Cost account (the
asset purchase transaction). You should now have a main account window which appears like this:

The asset appreciation example main window

Unrealized Gains

A month later, you have reason to suspect that the value of your painting has increased by $10,000 (an
unrealized gain). In order to record this you transfer $10,000 from your Accrued Gains income account
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(Income:Unrealized Gains) to your asset Unrealized Gains account (Assets:Fixed Assets:Degas:Unreal-
ized Gain). Your main window will resemble this:

Chart of Accounts after unrealized gain

Selling
Let’s suppose another month later prices for Degas paintings have gone up some more, in this case about
$20,000, you estimate. You duly record the $20,000 as an unrealized income like above, then decide to
sell the painting.

Three possibilities arise. You may have accurately estimated the unrealized gain, underestimated the un-
realized gain, or overestimated the unrealized gain.

1. Accurate estimation of unrealized gain.

Your optimistic estimate of the painting’s value was correct. First you must record that the profits made
are now realized gains, not unrealized gains. Do this by transferring the income from the Income:Un-
realized Gains to the Income:Realized Gains account.

Secondly, you must credit your bank account with the selling price of the painting. This money
comes directly from your Assets:Fixed Assets:Degas sub-accounts. Transfer the full Assets:Fixed As-
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sets:Degas:Cost value into Assets:Current Assets:Savings Account, and the full Assets:Fixed Asset-
s:Degas:Unrealized Gain into Assets:Current Assets:Savings Account.

These transactions should now appear as follows:

Table 11.1. Turning an Accrued Gain into a Realized Gain - Accurate Estimation

Account Transfer to Transaction Amount Account Total

Income:Unrealized
Gains

Income:Realized Gains $30,000 $0

Assets:Fixed Assets:De-
gas:Cost

Assets:Current Asset-
s:Savings Account

$100,000 $0

Assets:Fixed Assets:De-
gas:Unrealized Gains

Assets:Current Asset-
s:Savings Account

$30,000 $0

This leaves the Assets:Current Assets:Savings Account account with a total of $130000 and Income:Re-
alized Gains with a total of $30000.

Chart of Accounts after realized gain

2. Under estimation of unrealized gain.

You were over-optimistic about the value of the painting. Instead of the $130000 you thought the paint-
ing was worth you are only offered $120000. But you still decide to sell, because you value $120000
more than you value the painting. The numbers change a little bit, but not too dramatically.
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The transactions should now appear as follows (observe the last transaction which balances the Unre-
alized Gains accounts):

Table 11.2. Turning an Accrued Gain into a Realized Gain - Underestimation

Account Transfer to Transaction Amount Account Total

Income:Unrealized
Gains

Income:Realized Gains $20,000 $10,000

Assets:Fixed Assets:De-
gas:Cost

Assets:Current Asset-
s:Savings Account

$100,000 $0

Assets:Fixed Assets:De-
gas:Unrealized Gains

Assets:Current Asset-
s:Savings Account

$20,000 $10,000

Assets:Fixed Assets:De-
gas:Unrealized Gains

Income:Unrealized
Gains

$10,000 $0

This leaves the Assets:Current Assets:Savings Account account with a total of $120000 and Income:Re-
alized Gains with a total of $20000.

3. Over estimation of unrealized gain.

You manage to sell your painting for more than you thought in your wildest dreams ($150,000). The
extra value is, again, recorded as a gain, i.e. an income.

The transactions should now appear as follows (observe the last transaction which balances the Unre-
alized Gains accounts):

Table 11.3. Turning an Accrued Gain into a Realized Gain - Overestimation

Account Transfer to Transaction Amount Account Total

Income:Unrealized
Gains

Income:Realized Gains $50,000 $-20,000

Assets:Fixed Assets:De-
gas:Cost

Assets:Current Asset-
s:Savings Account

$100,000 $0

Assets:Fixed Assets:De-
gas:Unrealized Gains

Assets:Current Asset-
s:Savings Account

$50,000 $-20,000

Income:Unrealized
Gains

Assets:Fixed Assets:De-
gas:Unrealized Gains

$20,000 $0

This leaves the Assets:Current Assets:Savings Account account with a total of $150,000 and Income:Re-
alized Gains with a total of $50,000.

Taxation
Taxation policies vary considerably between countries, so it is virtually impossible to say anything that
will be universally useful. However, it is common for income generated by capital gains to not be subject
to taxation until the date that the asset is actually sold, and sometimes not even then. North American
home owners usually find that when they sell personal residences, capital gains that occur are exempt
from taxation. It appears that other countries treat sale of homes differently, taxing people on such gains.
German authorities, for example, tax those gains only if you owned the property for less than ten years.
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Chris Browne has a story from his professional tax preparation days where a family sold a farm, and
expected a considerable tax bill that turned out to be virtually nil due to having owned the property before
1971 (wherein lies a critical “Valuation Day” date in Canada) and due to it being a dairy farm, with some
really peculiar resulting deductions. The point of this story is that while the presentation here is fairly
simple, taxation often gets terribly complicated...
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Chapter 12. Multiple Currencies
This chapter will show how to set up GnuCash accounts to use multiple currencies.

Basic Concepts
GnuCash supports over a hundred currencies, from the Andorran Franc to the Zimbabwe Dollar. For ex-
ample, you can have a bank account set up in Euros, and another using Hong Kong Dollars.

Some of the issues which arise when using multiple currencies are, how do you transfer funds between
accounts with different currencies? How do you calculate the overall value when you have mixed currency
accounts? How do reports deal with mixed currencies?

Note

An alternative way to manage multiple currency accounts from the one presented in the next
sections, is to use the trading accounts capabilities of GnuCash. This feature, which was intro-
duced with GnuCash version 2.3.14, can be enabled by going to the Accounts tab under File →
Properties.

For a complete guide on trading accounts, see  this tutorial by Peter Selinger [http://www.math-
stat.dal.ca/~selinger/accounting/tutorial.html].

Account Setup
Your default account currency is set in the Account tab under Edit → Preferences (GnuCash → Preferences
on MacOS).

Similarly, GnuCash offers an option to set your preferred currency for displaying reports (like the balance
sheet and income statement). The option is called Default Report Currency, and is in the Reports tab of
the GnuCash Preferences screen. You’ll want to set both options when you start using GnuCash because
if (for example) your accounts are all in Canadian Dollars but the generated reports are all in US Dollars,
the reports will just say that there are “no data/transactions (or only zeroes) for the selected time period”.

When you create a new account, you have the option to define the commodity in which that account is
denominated. For accounts denominated in a currency, you can specify any of the currencies supported by
GnuCash by simply selecting it from the currency commodity list. You will notice that the default currency
is the currency that is defined for the parent account of the new account.

As an example, let’s set up a bank account scenario where you mostly work in US Dollars, but do also
have a European bank account using the Euro currency, as well as one bank account in Hong Kong using
Hong Kong Dollars. So, set up 3 bank accounts, one denominated in US Dollars, one using Euros, and the
third in Hong Kong Dollars. One possible account structure for this would be:

-Assets (USD)
   -Current Assets (USD)
      -US Bank (USD)
      -European Bank (EUR)
      -HK Bank (HKD)
-Equity (USD)
   -Opening Balances (USD)
      -USD (USD)
      -EUR (EUR)
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      -HKD (HKD)

Note: the currency of each account is shown in parenthesis.
 

Since in this example you mostly work in USD, all of the parent accounts are set to USD. Of course, if you
mostly work in Euros, you could change the currency of these parent accounts to EUR. The totals shown
in the account tree window will always be converted to the currency of each particular account. Notice,
we also set up 3 Starting Balances equity accounts, used to initially populate the 3 banks.

Note

You could also set up just a single Starting Balance account and use a currency transfer to populate
the “different currency” accounts. However, this is more advanced option, which is explained in
a later section (the section called “Purchase of an Asset with Foreign Currency”).

Below you see the result of this example, in which you start with USD 10,000, EUR 10,000 as well as
HKD 10,000 in the three bank accounts. Notice that the total of the parent accounts only shows the value
of the currency of sub-accounts with matching currencies. In other words, the Total Assets and Total
Equity values only reflect USD amounts, because GnuCash has no way of evaluating the value of EUR
or HKD yet. Once you set up exchange rates between the currencies, the parent accounts will calculate
the converted value of all sub-accounts. See the later section (the section called “Recording and Updating
Currency Exchange Rates”) on ways to do this.

Initial setup of 3 bank accounts with different currencies.

Notice that the "Total (Report)" column is being displayed. This is configured in the column header row,
select Arrow down and select “Total(USD)”.

User-Defined Currencies
Usually when we talk about currencies, we mean government-backed currencies (or more precisely, cur-
rencies defined in ISO 4217 [http://en.wikipedia.org/wiki/ISO_4217]). GnuCash does not allow you to cre-
ate your own currencies. If you want to track non-ISO currencies, you can use either of two workarounds,
depending on which fits your needs better.
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The first method is to treat these as if they were a security—that is, like a stock or mutual fund. The
second method is to use one of the “dummy” currencies for them.

Let’s say for example that you want to track loyalty points you’ve earned by buying from a certain group of
businesses. The account which tracks your loyalty points will be Assets:Other:LoyaltyGroupRewardMiles.

In the first method, you define a new security, of type FUND, called RewardMiles. This is pretty straight-
forward—when you create the new LoyaltyGroupRewardMiles account, just set the account type to Stock
or Mutual Fund, click the Select... button next to the Security/currency: box, and click New to define a
new security of type FUND.

This is not really what the stock and mutual fund account types are meant for, but GnuCash will allow it.
The downside is that you’ll have to enter a “price” for every transaction involving this account, because
GnuCash needs the prices to figure out the monetary value of the points and treat them as one of your assets.

In the second method, you use one of the dummy currencies to track the loyalty points. These currencies
are “XTS (Code for testing purposes)” and “XXX (No currency)”. If you use one of these for your Loy-
altyGroupRewardMiles account, you can enter transactions into the account without having to enter share
prices for every transaction. And, you can keep using the same two dummy currencies to track all sorts
of amounts—vacation dollars earned and used so far this year, vacation hours earned and used, health
insurance benefits allowance used and remaining, and so on.

The drawback with this second method is that you cannot define exchange rates for the dummy currencies
to convert them to ISO currencies. If you want to do that, you really should use the first method.

Recording and Updating Currency Exchange
Rates

GnuCash allows you to update the Currency Exchange Rates both manually and automatically. This
process is essentially the same as setting share prices for investments (see the section called “Setting Share
Price”). In the following two sections we will work through both methods.

Before we start, let’s have a quick look at the Chart of Accounts

Initial set up of 3 bank accounts with different currencies.
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As you see, the overall balances do not yet reflect any value for EUR or HKD holdings. Adding currency
exchange rates will fix this.

Manually Updating Exchange Rates

Open the Price Editor by going to Tools → Price Editor.

Price Editor Window.

Click on the Add button to add a new currency exchange rate. A window will appear in which you can set
up a new exchange rate. This window should appear like this:

Add Price Editor Window

Set the Namespace to Currency and the Security to EUR (Euro). Then set the exchange rate between the
selected security and the selected currency. The price box defines how many units of currency are required
to purchase one unit of the security. In this case, how many dollars it will take to purchase on Euro. In this
example, you will set the exchange rate to 1 EUR for 1 USD.
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The Price Editor window after setting the exchange rate between Euros and US Dollars

Chart of Accounts after setting the exchange rate between Euros and US Dollars.

Observe that since you have no exchange rate for HKD, GnuCash doesn’t convert the HKD accounts to
USD. This will be added in the next section.

Automatic Updating Exchange Rates (How-To)

In the previous section you saw how to manually define a new currency exchange rate, but GnuCash
includes an automatic price update feature, which will now be described.

Open the Price Editor by going to Tools → Price Editor.

Price Editor Window before you obtain online quotes.

Click on the Get Quotes button to automatically load the various exchange rates you need.

Note

If the Get Quotes button is disabled, that means that the Perl module Finance::Quote is not in-
stalled. For information on how to install it, please see the section called “Configuring for Auto-
matic Retrieval of Quotes”
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Price Editor Window after we obtained online quotes.

GnuCash downloads exchange rates for all currencies that are in use in your various accounts. This will
happen every time you click on Get Quotes or request GnuCash to download quotes as per the section
called “Configuring for Automatic Retrieval of Quotes”

Now when you check the main Chart of Accounts you will see that GnuCash has automatically converted
the HKD amount to USD amount on the parent accounts that are in USD, as well as on the Total (USD)
column. Also the Euro accounts have been been updated with the latest exchange rate.

Chart of Accounts after we obtain online quotes.

Disabling Exchange Rate Retrieval
Whenever you create an account that uses a non-default currency, exchange rate retrieval will be automat-
ically enabled for that currency. However, if you later delete that account, GnuCash will not automatically
disable exchange rate retrieval for that currency.

If you have deleted the last account for a particular currency, and you do not wish to retrieve exchange
rates for that currency anymore, do the following:

• Open the Securities window by selecting Tools → Security Editor.

• Make sure the Show National Currencies box is selected.

• Expand the CURRENCY row.
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• Double click on the currency for which you want to disable exchange rate retrieval.

• Deselect the Get Online Quotes box and click OK.

Recording Purchases in a Foreign Currency
Purchases in a foreign currency can be managed in two different ways.

1) Use GnuCash's built-in currency exchange functions when you do your transactions. This is mainly
used for one-time transactions, and nothing which happens regularly.

2) Use separate accounts to track transactions, where all involved accounts use the same currency. This
is the recommended method, since it allows much better tracking and follow up. In this way, you do one
currency exchange transaction, and after that you do normal transactions in the native currency.

The rest of this section will explain more based upon option 2).

Purchase of an Asset with Foreign Currency
You are using USD as your default currency. But, you decide to purchase a boat in Jamaica. To do this,
you opened a bank account in Jamaica, moved some money from the US, and then purchased your boat.

To record this in GnuCash we use the following basic account structure:

-Assets (USD)
   -Current Assets (USD)
      -US Bank (USD)
      -Jamaican Bank (JMD)
   -Fixed Assets (USD)
      -Boat (JMD)
-Equity (USD)
   -Opening Balances (USD)
      -USD (USD)

Note: the currency of each account is shown in parenthesis.
 

First you need to transfer some money ($10,000) to Jamaica, and you use your US bank account (with
a balance of $100,000) for that. The bank gives you an exchange rate of USD 1 = JMD 64, but charges
you USD 150 to transfer the money.

Transfer money to Jamaica

Select the Jamaica transaction line ($9,850.00), right click and select Edit Exchange Rate
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A dialog window where the exchange rate in a currency transaction is specified

As Exchange Rate, you enter 1 USD = 64 JMD, since this is the rate your bank gave. Press ok in the
Transfer Funds (Edit Exchange Rate) window, and then save this split transaction. Below is how it now
looks in the main Chart of Accounts.

Chart of Accounts before purchasing the boat

You choose to buy a boat for JMD 509,000. To record this transaction in GnuCash, you will need to enter
a simple transaction in Assets:Current Assets:Jamaican Bank withdrawing JMD 509,000 and transferring
it to Assets:Fixed Assets:Boat
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Chart of Accounts after purchasing the boat

The Chart of Accounts now reflects that your bank account has been reduced by JMD 509,000, and that
your Fixed Assets boat account has been increased by the same amount. If you also have turned on the
CoA (Column Choice) "Total (USD)" you will see the corresponding value in USD. The USD value will
always reflect the latest currency exchange rate you have either automatically or manually retrieved.

Purchasing Foreign Stocks

This example will show how to purchase stocks that are priced in a currency other than your primary
currency.

Assume that you live in New York and therefore you have set the default currency to USD. You decide
to purchase a stock traded in Hong Kong that is priced in HKD. You would also like to be able to track
the various income and expense amounts per stock and broker.

You decide to purchase stock in the Beijing Airport (Hong Kong). The ticker for this stock is 0694.HK on
Yahoo! Since you wanted to track all various income and expense amounts, here is the necessary account
structure:

Assets:Investments:Brokerage Accounts:Boom:0694.HK (0694.HK)
Assets:Investments:Brokerage Accounts:Boom:Bank (HKD)
Equity:Opening Balances:HKD (HKD)
Expenses:Commissions:Boom.0694.HK (HKD)
Income:Investments:Dividend:Boom:0694.HK (HKD)
      

The Chart of Accounts looks like this after creating all the needed accounts:
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Chart of Accounts for international stocks

The stock definition can be seen in the Security Editor. (Tools+Security Editor)

International securities

If you have not moved money (HKD 50,000) into the brokerage cash account (Assets:Investments:Broker-
age Account:Boom:Bank), do so now, either using the Equity (HKD) account, or an existing bank account
(Currency Transfer).

There are two ways to enter the actual purchase transaction: you can enter it from the cash account (shown
below), or you can enter it from the stock account. If entered from the stock account, the stock is assumed
to be priced in the currency of the parent account.

Let’s assume that the stock price is HKD 3 per share. To record the purchase, open the brokerage’s HKD
cash account (Assets:Investments:Brokerage Account:Boom:Bank), and enter the following:

Buy Stocks

Assets:Investments:Brokerage Account:Boom:Bank Withdrawal 50,000
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Expenses:Investments:Commission:Boom_HKD Deposit 500

Assets:Investments:Brokerage Account:Boom:0694 Deposit 49,500 (16,500
shares)

If the exchange rate dialog box does not appear automatically, right-click on the stock row, and select Edit
Exchange Rate. Enter the number of shares (16,500) as the To Amount.

Setting the number of shares in the Transfer Funds dialog

When you return to the Chart of Accounts, you will see the purchased shares reflected in the stock account’s
total.

Chart of Accounts with some international stocks
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However, as you can see, the USD totals may be zero if GnuCash doesn’t have an exchange rate between
USD and HKD. To fix this, go to Tools → Price Editor and click the Get Quotes button to automatically
retrieve the exchange rates you need.

Note

To reiterate, this example shows how stock can be purchased in any currency by entering the
transaction in the register of the cash account used to make payment. It is also possible to enter
the purchase in the stock account’s register, but be aware that the stock is assumed to be priced
in the currency of the stock account’s parent.

In this example, the stock account’s parent (Assets:Investments:Brokerage Account:Boom) is de-
nominated in HKD. Since this is same currency as the stock price, the purchase can be safely
entered in the stock account’s register.

Tracking Currency Investments
Currency investment is when you decide to invest in a different country's currency, and hope that it will
rise in value relative your own currency.

When you enter these transactions into GnuCash, you will have to decide on how much detail you would
like to have.

If you are not interested in detail at all, a very simple account structure would suffice:

    Assets:Investments:Currency:Bank (USD)
    Assets:Investments:Currency:XXX (XXX)
    

You would simply enter transfers between the two accounts, noting exchange rates as you went.

But, if you do want to be able to track capital gains or losses, as well as any fees, you do need a more
complex account structure, such as:

    Assets:Investments:Currency:Bank (USD)
    Assets:Investments:Currency:Currency Bank:XXX (XXX)
    Expenses:Investments:Currency:Currency Bank:XXX (XXX)
    Income:Investments:Currency Bank:Capital Gains:XXX (XXX)
    

Purchasing Currency
When purchasing another currency, you will buy a certain number of units of foreign currency with your
own currency, at a particular rate. For example, you might buy USD 10,000 worth of Andorran Francs, at
5 Francs to the dollar, with a transaction fee of $150.

Buy Currency

Assets:Investments:Currency:Bank Withdrawal 10,000

Expenses:Investments:Currency:Currency Bank:ADF Deposit 150

Assets:Investments:Currency:ADF Deposit 49,250

195



Multiple Currencies

The Exchange Rate window should pop up when you leave the last row in the split above (Currency
Transaction). If this window does not pop up, right click on the row or select Actions, and select Edit
Exchange Rate. In the Exchange Rate window you specify the exchange rate you got from the bank.

Selling a currency investment
Entering a currency sale is done in the same way as a currency buy except that you are now transferring
money from the Currency account to your Savings account (very similar to the section called “Selling
Shares”).

The proper recording of the currency sale *must* account for realized gains or losses. This can be done
using a split transaction. In the split transaction, you must account for the profit (or loss) as coming from
an Income:Capital Gains account (or Expenses:Capital Loss). To balance this income, you will need to
enter the Currency asset twice in the split—once to record the actual sale (using the correct amount and
correct exchange rate), and once to balance the income profit (setting the amount to 0).

In short, a selling Currency transaction should look something like below, seen again from the Assets:In-
vestments:Currency:Bank.

Table 12.1. Selling a currency with a Split Transaction Scheme

Account Deposit Withdrawal

Assets:Investments:Currency:Bank Sold Amount -
Exchange Fee

 

Expenses:Investments:Currency:Currency Bank:XXX Exchange Fee  

Assets:Investments:Currency:XXX  Sold Amount

Income:Investments:Currency Bank:Capital Gains:XXX [LOSS] PROFIT

Assets:Investments:Currency:XXX PROFIT (with
To Amount = 0)

[LOSS (with To
Amount = 0) ]

Reconciling Statements in a Foreign Currency
Reconciling foreign statement are done in the same manner as when you reconcile your local bank state-
ment. If you have created a Chart of Accounts structure which allows you to have the same currency per
account as your statement, it is actually exactly the same as reconciling your local bank statement.

If you have different currencies you might have to manually convert the amounts from one currency to
another while you reconcile the accounts.
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Chapter 13. Business Features
Introduction to Business Features

The accounting needs of a business are quite different from that of a person. Businesses have customers
that owe money, vendors which are owed money, employee payroll, more complex tax laws, etc. GnuCash
offers business oriented features to facilitate these needs.

Accounts Receivable (A/R) are used by businesses to record sales for which they are not immediately
paid. This is represented on the balance sheet as an asset, because the expectation is that you will receive
payment soon.

Accounts Payable (A/P) record bills that businesses have received, but may not pay until later. This is
represented on the balance sheet as a liability because you will have to pay for them.

A/R and A/P accounts are used primarily when you have a lot of bills and receipts flowing in and out, and
do not want to lose track of them just because you do not pay or get paid right away. For most home users,
A/R and A/P are too complicated to be worthwhile.

Business Setup
To set up GnuCash to handle accounts receivable or accounts payable for a company, these preliminary
steps must be done.

• Build an appropriate Account Hierarchy.

• Set up Sales Tax Tables.

• Enter the company information in GnuCash.

• Set Business Preferences.

• Set up Billing Terms.

Account Setup
There are many different ways to set up a business account hierarchy. You can start with the Business
Accounts setup which is available from the New Account Hierarchy assistant, or you could build one
manually. To access the prebuilt Business Accounts, start GnuCash and click on File → New File and
proceed until you see the list of available accounts, select Business Accounts.

The prebuilt Business Account hierarchy will not meet your needs exactly. You will need make adjust-
ments to the hierarchy so that it will meet your particular needs. It should be close enough, however, that
it is recommended you begin with it.

To use GnuCash’s integrated accounts receivable system, you must first set up a special account (usually a
sub-account under Assets) to hold transactions for receivables. This account must be defined with account
type A/Receivable. GnuCash will use this account to place transactions related to the integrated accounts
receivable system.

To use GnuCash’s integrated accounts payable system, you must first set up an account (usually a sub-
account under Liabilities) to hold transactions for payables. This account must be defined with account
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type A/Payable. GnuCash will use this account to place transactions related to the integrated accounts
payable system.

Basic A/R and A/P Account Hierarchy:

-Assets
   -Accounts Receivable
   -Checking
-Expenses
  ...(as required)
-Income
   -Sales
-Liabilities
  -Accounts Payable
  -Tax
      -Tax on Purchases
      -Tax on Sales
  

You need to add additional accounts to this hierarchy for it to be useful.

Note

You do not need to create an individual A/R account for each customer. GnuCash keeps track of
customers internally and provides per-customer reports based on the internal tracking. The same
applies to A/P and vendors.

Note

If you deal with customers in more than one currency you will need a separate Accounts Receiv-
able account for each currency.

If you deal with vendors in more than one currency you will need a separate Accounts Payable
account for each currency.

Note

Transactions involving an Accounts Receivable or Accounts Payable account should not be
added, changed or deleted in any way other than by using Post/Unpost Bill/Invoice/Voucher or
Process Payment!

Setting up Sales Tax Tables
Sales Tax Tables can used to determine the tax for customer invoices (or vendor bills).

A tax table entry can be assigned to an invoice line or bill line.

Set up distinct tax tables for customers and vendors.

The default invoice tax table entry can be assigned to each customer and the default bill tax table entry
can be assigned to each vendor.

The default tax table entry for new customers or new vendors can be specified in the Book Options  window
which can be accessed by File → Properties → Business tab.
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Sales Tax Tables are maintained using the Sales Tax Table editor which is accessed via menu Business
→ Sales Tax Table.

Figure 13.1. Sales Tax Tables Editor

Figure 13.2. New Sales Tax Table Entry

• Name This is the tax table name.

• Type Either Percent % or Value $.

• Value This is the percentage or value depending on Type.

• Account This is the account to which tax will be posted. For tax collected from customers, this should
probably be a Liability account as it must be payed to the government. For tax paid to vendors, if tax
laws allow tax paid to vendors to offset tax collected from customers, this should probably also be
a Liability account (even though it will usually have a debit balance) so that the net tax owed to the
government can be easily observed.

If you set up Tax on Purchases and Tax on Sales as subaccounts of Liabilities:Tax then the net tax will
be rolled up and can be seen in the GnuCash Accounts tab.

202



Business Features

If unsure about tax law requirements, get professional advice.

The following charts illustrate sample tax tables and may be used as starting points to determine the setup
appropriate for a particular jurisdiction.

Table 13.1. Sample Tax Table Entries for EU country (e.g. 21% / 6% / 0% Belgium,
20% / 5% / 0% UK etc.) (2017)

Tax Table Tax Table Entries [Asset/Lia-
bility]

Percentage or Amount

Standard VAT Sales VAT:Sales:Standard [L] 21%

Reduced VAT Sales VAT:Sales:Reduced [L] 6%

Zero-Rated VAT Sales VAT:Sales:Zero [L] 0%

VAT:Sales:EC [L] 21%EC Sales

VAT:Sales:Reverse EC [L] -21%

Standard VAT Purchases VAT:Purchases:Standard [A] 21%

Reduced VAT Purchases VAT:Purchases:Reduced [A] 6%

Zero-Rated VAT Purchases VAT:Purchases:Zero [A] 0%

Table 13.2. Sample Tax Table Entries for Australia (2017)

Tax Table Tax Table Entries [Asset/Lia-
bility]

Percentage or Amount

Standard GST Sales GST:Sales:Standard [L] 10%

GST-free Sales GST:Sales:Zero [L] 0%

Standard GST Purchases GST:Purchases:Standard [A] 10%

GST-free Purchases GST:Purchases:Zero [A] 0%

Table 13.3. Sample Tax Table Entries for Cook County, Illinois (2017)

Tax Table Tax Table Entries [Asset/Lia-
bility]

Percentage or Amount

Taxes:Sales:State [L] 6.25%

Taxes:Sales:City [L] 1.25%

Taxes:Sales:County [L] 1.75%

Chicago Sales Taxes

Taxes:Sales:Region [L] 1%

Enter Company Information

After you have built the account structure and defined your tax tables, designate your company in the
GnuCash file. To do this, select the Business tab in the Book Options window, which can be accessed
from File → Properties.
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Figure 13.3. Entering Company Information

Here you can:

• Enter the name of your company along with contact information such as your phone number, fax number,
e-mail address and website URL.

• Enter your company’s tax payer id number in the Company ID field.
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• Select default tax tables applicable to your most common customers and vendors.

Setting Business Preferences

Set options on the Business tab of the GnuCash preferences, which is accessed via Edit → Preferences
(GnuCash → Preferences on MacOS). See Help manual chapter 10.3.3 Business Book Options Tab.

Setting Billing Terms

Billing Terms can be used to determine the payment due date and be a guide for determining discount for
early payment of invoices (or vendor bills).

Note

As of GnuCash 2.6.7, Billing Terms are only partially supported. Date due is calculated using the
Billing Terms but discount amount is not.

Discount for early invoice payment is not implemented. There are 2 ways this may be done, al-
though neither is recommended, and professional advice should be used to confirm that regula-
tions are being complied with:

• After creating and posting a payment which pays the invoice in full, manually edit the payment
transaction (usually strongly discouraged) and split the payment to reduce it by the amount of
the discount and create a compensating split in an income (discount) account.

• Alternatively, after creating and posting a payment for the discounted amount, create a credit
note for the discount using a specific negative sales income (discount) account for the transfer
account.

You can specify the billing terms on each invoice/bill. Invoice billing terms will default from the customer
billing terms. Bill billing terms will default from the vendor billing terms.

Billing Terms are maintained using the Billing Terms Editor which is accessed via menu Business →
Billing Terms Editor.

Figure 13.4. Billing Terms Editor
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Figure 13.5. New Billing Term

• Name The internal name of the billing term. For some examples of billing term names and descriptions
see http://wiki.gnucash.org/wiki/Terms.

• Description The description of the billing term, printed on invoices

• There are 2 types of billing terms, with different information to be entered

• Type Days

• Due Days The invoice or bill is due to be paid within this number of days after the post date

• Discount Days The number of days after the post date during which a discount will be applied for
early payment

• Discount % The percentage discount applied for early payment

• Type Proximo

• Due Day The day of the month bills are due

• Discount Day The last day of the month for the early payment discount

• Discount % The discount percentage applied if paid early

• Cutoff Day The cutoff day for applying bills to the next month. After the cutoff, bills are applied
to the following month. Negative values count backwards from the end of the month.

Accounts Receivable
Accounts Receivable (or A/R) refers to products or services provided by your company for which payment
has not yet been received.
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System Components

Transactions generated by the A/R system are recorded within the Accounts Receivable account. You
should not work directly with this account. Instead, you will work with the four integrated GnuCash A/R
application components available through the Business → Customer sub-menu. These four components are:

• Customers are people or companies to whom you sell products or services on credit.

• Invoices represent the physical invoice you send to a customer to request payment. This invoice contains
an itemized list of things you sold.

In addition, GnuCash also has support for Credit Notes which represent the inverse of Invoices. A credit
note is usually handed to a customer to correct items that were incorrectly invoiced or returned.

Both document types will be set up using the same menu items. Credit notes were introduced starting
with GnuCash stable release 2.6.0.

• Jobs (optional) is where you register Customer Jobs. Jobs are a mechanism by which you can group
multiple invoices to a particular customer.

• Process Payments is used to register payments you received from a customer.

Customers

Customers are people or companies to whom you sell goods or services. They must be registered within
the A/R system.

New

To register a new customer, enter the menu Business → Customer → New Customer. Fill in customer in-
formation, such as Company Name, Address, Phone, Fax, etc.
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Figure 13.6. New Customer Registration Window

Find and Edit

To search for an existing customer, use the Business → Customer → Find Customer window. You select a
customer to View/Edit from the results of the search. This window is also used to look up customers when
creating invoices and processing payments.
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Figure 13.7. Find Customer Window

If many customers match the search criteria you provide, the search can be refined by running an additional
search within the current results. The current result set is searched when the Refine Current Search radio
button is selected. In fact, GnuCash selects this option for you after you run the initial search.

If the customer you are searching for does not match the supplied search criteria, change the search criteria,
click the New Search radio button and then the Find button. The relevant step is the New Search selection.
If the customer is not in the result of the original search, and you only search within this set, the customer
cannot be found, regardless of new search criteria.

Note

To return a list of all registered active customers, set the search criterion to matches regex, and
place a single dot "." in the text field area. Make sure Search only active data is checked, then
click Find. The regular expression "." means to match anything.

Invoices

An invoice is the paperwork you send to a customer to request payment for products or services rendered.
GnuCash can generate and track invoices.

A credit note is the paperwork you send to a customer to correct products or services rendered that were
incorrectly invoiced. GnuCash can generate and track credit notes via the same menu entries as invoices.

Note

This section applies to both invoices and credit notes. In order to avoid repeating everything
twice and to keep the text easier to read it will refer only to invoices. You can apply it equally to
credit notes. Only where the behavior of credit notes differs from invoices this will be explicitly
mentioned.

New

To send an invoice to a customer you must first create the new document. To create an invoice use Business
→ Customer → New Invoice. The New Invoice window must be filled in appropriately.
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Figure 13.8. Creating a New Invoice

When you click the OK button, the Edit Invoice window opens.

Edit

From the Edit Invoice window you can enter an itemized list of goods and services you sold on this invoice
in a manner similar to how the account register works. For credit notes you enter an itemized list of goods
and services you refunded instead.

Figure 13.9. Edit Invoice Window
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When you have finished entering all the items, you can Post and print the invoice.

Post

When you finish editing an invoice and are ready to print, you must Post the invoice. The invoice does
not have to be posted immediately. In fact, you should only post an invoice when you are ready to print it.
Posting an invoice places the transactions in an accounts receivable account.

Figure 13.10. Post Invoice Window

Find

To find an existing invoice, use the Business → Customer → Find Invoice menu item. From the results of
the search, you can select an invoice to edit or view.

Note

Before you can edit a posted invoice, you will need to Unpost it.

One of the design goals in GnuCash’s Account Receivable system was to allow different processes to get
to the same state, so you can reach an invoice from different directions based on the way you think about
the problem:

• You can search for the customer first, then list their invoices.

• You can search for invoices by number or by company name.

• You can list invoices associated with a customer job.

Print

After you post an invoice, you should print it and send it to your customer. To print an invoice use File
→ Print Invoice menu item.
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Figure 13.11. Invoice Print Output

Note

You can modify the appearance of the invoice, IE: add a company logo, etc. To do so, see the the
section called “Changing the Invoice Appearance”.

Invoices can also be printed from the main window by selecting Reports → Business Reports → Printable
Invoice from the main menu. The resulting report window states that no valid invoice is selected. To select
the invoice to print:

1. Use the Options Toolbar button or select Edit → Report Options from the main menu.

2. Select the General tab of the report options dialog.

3. Click the Select button next to the Invoice Number field.

4. Search for the invoice as usual.

You can also print invoices from within the Process Payment dialog. See the the section called “Process
Payment” for instructions on how to do so.

Assign Starting Invoice Number

By default, GnuCash starts with invoice number 1 and increments from there. You can manually type an
invoice number into the text box each time you create an invoice, but this gets tiring and sooner or later
leads to duplicate numbers.

You can change the starting invoice number if it is important you. Use File → Properties, access the Coun-
ters tab, change the Invoice number value to be one less than your desired starting invoice number and
click the OK button or the Apply button.

Customer Jobs
Customer Jobs are used to group multiple invoices and credit notes to the same customer. Use of the
Customer Jobs feature is optional. The feature is useful when you have multiple jobs for the same customer,
and would like to view all the invoices and credit notes related to a single job.
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Figure 13.12. New Customer Job

To use customer jobs, you must create them using the Business → Customer → New Job menu item. You
will see the New Job window.

To edit an existing customer job, use the Business → Customer → Find Job menu item. Select the desired
job in the search results, and click the View/Edit Job button.

To select from the invoices and credit notes associated with a given job, use Business → Customer → Find
Job menu item. Select the desired job in the search results and click the View Invoices button. A window
listing invoices and credit notes associated with this job appears. Select an invoice or credit note and click
the View Invoice button to open an invoice editor in the main application window.

Process Payment

Eventually, you will receive payment from your customers for outstanding invoices. To register these
payments, use the Process Payment application found in Business → Customer → Process Payment.
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Figure 13.13. Process Customer Payment

Process Payment from Customer

Changing the Invoice Appearance

The default Invoice style, as shown in the section called “Print”, is fairly barren. The default invoice style
leaves the top part of the form blank, so you can print on company letterhead paper. There are some things
you can do to change invoice appearance.

Use File → Properties to enter your Company information in the Business tab of the Book Options window.
Some of the entered information is printed on the right side of invoices.

To add a customized background, heading banner or logo to invoices, modify the invoice style sheets. To
do this, go to Edit → Style Sheets and select the New button in the Select HTML Style Sheet window that
will appear. You will then see a window like this:

Figure 13.14. The New Style Sheet Window

Give a Name to the new style sheet (e.g. Custom Invoice) and select the Fancy Template. When you click
the OK button, the HTML Style Sheet Properties window is displayed. This window presents you five
sections listed in the left pane: Colors, Fonts, General, Images, and Tables. The Colors section allows
you to change the colors of various items of the invoice. The Fonts section lets you set fonts type and
dimensions. The General section allows you to set the Preparer and Prepared for information, and to Enable
Links. The Images section allows you to import graphics into the style sheet. The Tables section allows
you to adjust the spacing around the tables which make up the invoice.
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To include a company logo, banner heading and background image, use your favorite graphics application
such as The Gimp or OpenOffice Draw to save the images in either GIF or PNG format. Then import them
into the style sheet using the Images section described above.

Below is an example that imports all three types of images.

Figure 13.15. HTML Style Sheets Example Window

The HTML Style Sheets window with an example Background Tile, Heading Banner, and Logo.

Note

The images are placed in the invoice as follows. The Background Tile is tiled to become the
background image, the Heading Banner goes to above the invoice text, and the Logo is placed in
the upper left corner of the invoice to the left of the Heading Banner. You will probably have to
try a few different sized images until you get the invoices to print nicely. Some sizing suggestions
are that the Logo should be 1 square cm (~0.5 inch), and the Heading Banner should be 15 cm
(~6 inches) wide and 1 cm (~0.5 inch) tall.

With the style sheet configured, when you print the invoice, you select the style sheet to use from the
Options menu. Below is the resultant invoice after applying the style sheet demonstrated above.
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Figure 13.16. HTML Style Sheets Example Output

The hideous invoice which results from the graphics selected in the style sheet.

Accounts Payable
Accounts Payable (or A/P) refers to the accounting of products or services which a company has bought
and needs to pay for.

System Components

GnuCash has an integrated accounts payable system. The transactions generated by the A/P system are
placed within the Accounts Payable account, as a record of what occurs. Generally you do not directly work
with this account but use the four integrated GnuCash A/P application components. The A/P components
are available from the Business → Vendor sub-menu. These A/P components are:

• Vendors are people or companies from which you buy products or services on credit.

• Bills represent the physical bills vendors send to request payment from you. A bill contains an itemized
list of things you purchased.

In addition, GnuCash also has support for Credit Notes which represent the inverse of Bills. A credit
note is usually received from a vendor to correct items that were erroneously billed or returned.

Both document types will be set up using the same menu items.

• Jobs (optional) is where you register Vendor Jobs. Jobs are mechanism by which you can group multiple
bills from a particular vendor.

• Process Payments is where you register payments to a vendor to whom you owe money.

The following sections introduce the individual Accounts Payable application components.
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Vendors
A vendor is a company or person from whom you purchase goods or services. Vendors must be registered
within the A/P system.

New

To register a new vendor, select the Business → Vendor →  New Vendor menu item. Fill in general infor-
mation about the vendor, such as Company Name, Address, Phone, Fax, etc. Below is a list of the other
options:

This is what the New Vendor registration window looks like:

Figure 13.17. New Vendor Registration Window
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Find and Edit

To search for an existing vendor, use the Business → Vendor →  Find Vendor window. You select a vendor
to View/Edit from the results of the search. This window is also used to look up a vendor when entering
bills and processing payments.

Figure 13.18. Find Vendor Window

If many vendors match the search criteria you provide, the search can be refined by running an additional
search within the current results. The current result set is searched when the Refine Current Search radio
button is selected. In fact, GnuCash selects this option for you after you run the initial search.

If the vendor you are searching for does not match the supplied search criteria, change the search criteria,
click the New Search radio button and then the Find button. The relevant step is the New Search selection.
If the vendor is not in the result of the original search, and you only search within this set, the vendor
cannot be found, regardless of new search criteria.

Note

To return a list of all registered active vendors, set the search criterion to matches regex, and place
a single dot “.” in the text field area. Make sure Search only active data is checked, then click
Find. The regular expression “.” means to match anything.

Bills
A bill is a request for payment you receive from a vendor. GnuCash can track bills.

A credit note is the document you receive from a vendor to correct products or services rendered that you
were incorrectly charged for on a bill. GnuCash can generate and track credit notes via the same menu
entries as bills.

Note

This section applies to both bills and credit notes. In order to avoid repeating everything twice and
to keep the text easier to read it will refer only to bills. You can apply it equally to credit notes.
Only where the behaviour of credit notes differs from bills this will be explicitly mentioned.

New

When you receive a bill from a vendor and want to enter it into GnuCash, you must create a new bill.
To create a new bill use the Business → Vendor → New Bill menu item, and fill in the resulting window
appropriately.
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Figure 13.19. New Bill Registration Window

When you click the OK button the Edit Bill window opens.

Edit

From the Edit Bill window you can enter an itemized list of goods and services you purchased, in a manner
similar to how the account register works. For credit notes you enter an itemized list of goods and services
the vendor refunded instead.
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Figure 13.20. Edit Bill Window

When you have finished entering all the items, Post the bill.

Post

When you finish editing a bill, you should Post the bill. You do not have to post the bill, you can close
it and return to it later. You have to post the bill eventually. Posting a bill places its transactions into an
accounts payable account. The Post Bill window appears and asks you to enter information:

Figure 13.21. Post Bill Window

Find

To find an existing bill, use the Business → Vendor → Find Bill menu item. From the results of the search,
you can select a bill to edit, or view.
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Note

Before you can edit a posted bill, you will need to Unpost it.

Note

There are other ways to access an existing bill. These are similar to accessing invoices for your
customers. See the section called “Find” for more information.

Vendor Jobs
Vendor Jobs are used to group multiple bills and credit notes from a single vendor. Use of the vendor jobs
feature is optional. The feature is useful when you have multiple jobs for the same vendor, and would like
to view all the bills and credit notes for a single job.

To use vendor jobs, you must create them using the Business → Vendor → New Job menu item. You will
see the New Job window.

Figure 13.22. New Vendor Job

To edit an existing vendor job, use the Business → Vendor → Find Job menu item. Select the desired job
in the search results, and click the View/Edit Job button.

To select from the bills associated with a given job, use Business → Vendor → Find Job menu item. Select
the desired job in the search results and click the View Invoices button. A window listing bills and credit
notes associated with this job appears. Select a bill or credit note and click the View Invoice button to
open a bill editor in the main application window.

Process Payment
Eventually, you need to pay your bills. To do so, use the Process Payment application found in Business
→ Vendor → Process Payment.
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Below is the GnuCash Accounts Payable payment window.

Figure 13.23. Process Vendor Payment

Process Payment to Vendor

Payroll
Payroll is a financial record of wages, net pay, paid vacations, and deductions for an employee. This section
demonstrates how to track payroll using GnuCash.

Basic Concepts
Payroll is a financial record of wages, net pay, paid vacations, and deductions for an employee. Basically,
anything that relates to giving money or benefits to an employee. Payroll is one of the more complex tasks
in accounting, because there are many different accounts, people, and agencies involved in paying salaries.

Payroll is typically accounted for as an expense. Sometimes accountants “store” some payroll expenses
in a short term liability account. This is useful for things such as payroll taxes, which may be paid at a
different time than the employee. The employee might get paid biweekly, while taxes are paid quarterly.
This chapter presents a methodology which expenses payroll immediately for salaries, but stores taxes in
liability accounts.

Note

GnuCash does not have an integrated payroll system. While you can track payroll expenses in
GnuCash, the calculation of taxes and deductions has to be done outside of GnuCash.

Account Setup
Local tax law must be considered when setting up accounts. Because there are many different ways payroll
taxes are handled throughout the world, this section presents a very simple structure. From this, you should
be able to adapt your particular payroll deductions setup.

Assume that you must pay 2 taxes, Tax1 and Tax2, and that each has an employee contribution and an
employer contribution.

The employee’s salary and these two taxes are expense accounts. The tax components are liability accounts.
The tax liability accounts are where you accumulate the taxes withheld for all of your employees. The
taxes are later paid to the appropriate government agency.
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              Simple Payroll Account Layout:
              
              -Assets
              --Checking
              -Liabilities
              --Tax1  (short term “storage” account)
              --Tax2  (short term “storage” account)
              -Expenses
              --Salaries
              --Tax1
              --Tax2
           

Note

Resist the temptation to create per-employee sub-accounts to track individual salaries. Creating a
sub-account for each employee leads to unmanageably large lists of accounts. Imagine the account
structure after a few years of employees coming and going. It is much simpler to keep all of
your employees’ payroll records within a single account (Expenses:Salaries for example) and use
reports to view per-employee information.

The Transaction report can be used to sort and total by description or memo (but not by part of
them).

To report salary transactions for a specific employee where the employee name or code is entered
in the transaction description or memo, use the Find Transaction assistant (Edit → Find) to select
the transactions, and then report on them using Reports → Account Report . Further formatting or
analysis may be done by copying and pasting the report into a spreadsheet. See Find Transaction
[ghelp:gnucash-help?tool-find-txn] in the GnuCash Help Manual.

Payroll Protocol Sample
GnuCash does not have an integrated payroll system. GnuCash can track your payroll expenses, but you
need to develop a payroll protocol and perform the calculations outside of GnuCash, in a spreadsheet for
example. In this section, one such protocol is presented. You can use the sample protocol as a model.

Step 1: Deductions list

The first step to the payroll protocol is to create a list of all the possible taxes and deductions for each
employee. Each entry should include definitions and formulas for calculating each value. Once the protocol
is established it needs to be changed only when payroll laws or tax rates change.

In the proposed scenario, such a list would look like this:

• E_GROSS_SALARY - Employee gross salary
• E_TAX1 - Employee contribution to tax1 (X% of E_GROSS_SALARY)
• E_TAX2 - Employee contribution to tax2 (X% of E_GROSS_SALARY)
• C_TAX1 - Company contribution to tax1 (X% of E_GROSS_SALARY)
• C_TAX2 - Company contribution to tax2 (X% of E_GROSS_SALARY)

Note

The employee’s net salary (E_NET_SALARY) is defined as E_GROSS_SALARY - E_TAX1 -
E_TAX2 and need not be placed in this list since it is composed of items that already exist.
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Place the actual formulas for calculating each deduction in this list. Sometimes these formulas are quite
complex, and sometimes they simply say "look it up in table XYZ of the tax codes".

Notice that you can calculate some interesting values using the above definitions. One such value is the
total cost to the company: E_GROSS_SALARY + C_TAX1 + C_TAX2.

Step 2: Create the Transaction Map

When you record payroll in GnuCash, do so with a single split transaction. This split transaction populates
the appropriate expense and liability accounts. If you need to look the payroll details at a later time, open
the split transaction.

With the deductions list from above, an employee split transaction map can be generated. Each of the items
in the list is mapped to a GnuCash account.

Table 13.4. Payroll Transaction Map

Account Increase Decrease

Assets:Checking E_NET_SALARY

Expenses:Salaries E_GROSS_SALARY

Liabilities:Tax1 E_TAX1

Liabilities:Tax2 E_TAX2

Expenses:Tax1 C_TAX1

Liabilities:Tax1 C_TAX1

Expenses:Tax2 C_TAX2

Liabilities:Tax2 C_TAX2

Note that the C_TAX1 and C_TAX2 components have entries in the both the liability and expense ac-
counts. The company component of each tax is expensed at the time of payroll, but remains a liability
until taxes are due.

Step 3: Pay the Employee

Go to the account from which the employee will be paid, for example your Assets:Checking account. Open
a split transaction and enter the real values using the Transaction Map above as a guide. Repeat this for
all employees.

Tip

This manual process is tedious, especially if you have a large number of employees.

One GnuCash tool you certainly want use when entering employee payroll is duplicate transaction
(use the Duplicate Toolbar button). This saves you from having to enter all the transaction splits
for each employee. You still need to change the amounts of money to match each employee’s
real payroll values, but you will not have to build the split for each employee.

If payroll transactions do not change significantly every pay period, you can also use the duplicate
transaction feature to duplicate each employee’s most recent payroll transaction for the current
pay period. If you find you are doing so all the time, read about the Schedule Transactions feature
and save even more time!
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Step 4: Pay the Government

The final thing to do is to pay the taxes to the government. The liability accounts have been collecting the
taxes for various government agencies, and periodically you need to send a check to the government to
pay this charge. To do so, you simply enter a 2 account transaction in (for example) your checking account
to pay off the tax liability. The transaction is between the checking account and the liability account, no
expense account is involved. The expense accounts are charged at the time the tax liability is recorded.

Business Payroll Example
Using the account setup seen previously, let’s go through an example. Assume that there are 2 employees
(E1 and E2) who each earn $1000 per month gross salary. The employee contribution to Tax1 and Tax2
are 10% and 5% respectively. The company contribution to Tax1 and Tax2 are 15% and 10% each on top
of the employee’s gross salary.

Starting with $50k in the bank, and before doing any payroll, the account hierarchy looks like this:

Figure 13.24. Payroll Example: Initial Setup
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The deductions list for employee 1 are:

• E_GROSS_SALARY - Employee gross salary - $1000

• E_TAX1 - Employee contribution to tax1 - $100 (10% of E_GROSS_SALARY)

• E_TAX2 - Employee contribution to tax2 - $50 (5% of E_GROSS_SALARY)

• C_TAX1 - Company contribution to tax1 - $150 (15% of E_GROSS_SALARY)

• C_TAX2 - Company contribution to tax2 - $100 (10% of E_GROSS_SALARY)

Table 13.5. Payroll Transaction Map for Employee 1

Account Increase Decrease

Assets:Checking $850 (E_NET_SALARY)

Expenses:Salaries $1000 (E_GROSS_SALARY)

Liabilities:Tax1 $100 (E_TAX1)

Liabilities:Tax2 $50 (E_TAX2)

Expenses:Tax1 $150 (C_TAX1)

Liabilities:Tax1 $150 (C_TAX1)

Expenses:Tax2 $100 (C_TAX2)

Liabilities:Tax2 $100 (C_TAX2)

From the checking account, enter the split transaction for employee 1. It should look like this:

Figure 13.25. Payroll Example: Employee Split Transaction

The Split Transaction for Employee 1

Tip

When paying employees, enter only the employee name in the Description area. If you decide
to use GnuCash’s check printing capabilities, the check is automatically made out to the correct
employee. If you want to record other information in the transaction besides the employee name,
use the Notes area, available when viewing the Register in double-line mode.

Repeat this for the second employee, which leaves the account hierarchy looking like this:
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Figure 13.26. Payroll Example: Accounts After Salaries Paid

Now, you will enter the company contributions. The Liabilities:Tax1 and Liabilities:Tax2 accounts track
how much you must pay to the government for each tax type. When it is time to pay these agencies, you
will make a transaction from the checking account to these liability accounts. No expense accounts are
involved. The main account will then appear like this:
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Figure 13.27. Payroll Example: Accounts After Paying Government
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Chapter 14. Budgets
This chapter explains how to create and use budgets with GnuCash.

Basic Concepts
A budget is a tool for estimating expected income and expenses. You can use it to help you plan how
you intend for your finances to change over a period of time, and to examine how your actual financial
transactions for the period compare to your planned transactions.

The budgeting concept is quite general, so GnuCash offers a budgeting tool that is both simple and flexible.
You, the user, have to decide how complex or simple you want to make your budget. This guide will help
you make some of those decisions.

Terminology
There are a few helpful terms listed below that will be used to discuss budgeting.

• Budget - A financial plan describing the expected revenues and/or disbursements for a particular time
period

• Cash Budget - A budget planning for expected cash receipts and cash disbursements. This type of budget
tracks cash flow -- where your money comes from, where it goes, and, of course, how much.

• Expense Budget - A budget chiefly for planning what you spend your money on. This type of budget
tracks your expenses. It is typically not concerned with things like appreciation or repayment of liabil-
ities. However, it would account for interest charges. For example, if you buy $100 worth of groceries
with your credit card, you incur an $100 expense for groceries, and a $100 liability to your credit card
company. When you pay the credit card bill for $110, you are incurring an additional interest expense
of $10. An expense budget plans for the transaction of buying the groceries and paying the interest, but
not the transaction of repaying the credit card company.

• Capital Budget - A budget that describes a plan for paying for a large future expense, often through a
combination of saving and borrowing money. Note: Capital budgets can sometimes get quite complex
because they can try to answer the question "Can we afford to do such-and-such?" by exploring various
hypothetical scenarios that can involve hypothetical accounts.

• Budget Period - The period of time during which the plan is expected to take place. The most common
budget periods are annual and monthly. Sometimes, you may budget for several consecutive periods
at once, for convenience or for finer-grained planning. For example, an annual budget may include 12
monthly budget periods.

Creating a Budget
Even before you begin to make a budget, it’s important to have given some thought to your account
hierarchy. For example, if you want to budget a certain amount for your electric bill and a certain amount
for your water bill, you can’t have only an Expenses:Utilities account. Your accounts must be at least as
specific as your budget.

Choose Which Accounts To Budget For
The first step in creating a budget is to decide what it is you want to plan for. This decision will affect which
accounts you include in your budget. For example, if you are only interested in tracking your expenses,
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you may create an expense budget by only entering amounts for expense accounts. On the other hand, if
you want to track all of your cash flow, you may create a cash flow budget by entering amounts for asset,
liability, income and expense accounts.

Before you begin to create your budget, you need to make two decisions: What accounts do I want to
budget for? and When do I want my budget to be for? You can always change your mind later, after you’ve
created a budget, but you need to start with something.

Tip

As a rule of thumb, if you mostly care about what you spend your money on, you may want to
make an expense report. If you’re also concerned about having enough money in the right places
at the right times, you may want to use a cash-flow budget.

Choosing a Budget Period
Before creating a budget you must also decide what period of time you want to plan for. The most common
budget periods are monthly and annual. If you want your budget to plan for changes in financial patterns
over time, then you should include multiple budget periods in your budget. For example, if you want to
plan on having higher utility expenses in the winter than in the summer, then you might break your annual
budget into 4 quarters or even 12 months, and budget a higher value for the winter periods than for the
summer periods.

Getting Started

To create your first budget click on Actions → Budget → New Budget. You will immediately see a new
budget with the default settings and no entries. Then click on the Options button. The most important
options are the budget period and the number of periods. For the budget period, choose the beginning date
and the smallest period of time that you want to plan for. Then, for the number of periods, choose how
many periods you want to plan for.

The budget page now shows a list of accounts with a column for each budget period. The date shown in
the title of each column is the beginning of that budget period.

Entering Budget Values
Now, you must enter the budget values - the amounts that you expect the account balances to change
during the budget period. There are two ways to enter budget values. The first way is to simply click on
the cell and enter an amount.

If you have past transactions recorded in GnuCash, the second way is to let GnuCash estimate the budget
values by looking at those transactions. First, select the accounts you want GnuCash to estimate. Then click
on the Estimate Toolbar button. In the Estimate Budget Values dialog, select the date past which GnuCash
should look for past transactions. GnuCash will start at that date and look forward for the duration of your
budget. For example, if you are making an annual budget, and you select Jan. 1, 2005, GnuCash will look
at all the transactions in that account from Jan. 1, 2005 through Dec. 31, 2005.

Budget Reporting
You’ve already done the hardest part - creating your budget. But now you want to know how your actual
financial transactions compare to your plan. You need to run the Budget Report.
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Click on Reports → Budget → Budget Report. For each account, the Budget Report will show the budgeted
and the actual amounts in two adjacent columns for each period in the budget. If you have created multiple
budgets, you can use the Budget Report Options to select which budget to use in the report.

Two other types of budget reports are commonly used in the small business setting. They are the Budgeted
Income Statement and the Budgeted Balance Sheet.

Budgeted Income Statement
The budgeted income statement is similar to the income statement. Both show the revenues and expenses
for a given period as well as the profit, which is the difference revenue - expenses. The income statement is
based on historical data, but the budgeted income statement is based on the predictions made in the budget.

Budgeted Balance Sheet
The budgeted balance sheet is similar to the balance sheet. Both show the assets, liabilities, and equity.
The difference is that the balance sheet is based on historical data, and the budgeted balance sheet is based
on the predictions made in the budget.
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General Concepts
This chapter presents many additional accounting treatments for frequently encountered business and less-
frequently found personal activities that need recording in accounting books. The explanations below cover
both the description and purpose of the activity, and they include also the usual accounting treatments
(bookings or recordings) for these transactions.

These concepts have evolved over centuries of experience by those keeping accounting records and will
help you maximize your record keeping’s utility and meaningfulness.

This section introduces categorization of assets in the balance sheet based on time or the asset’s useful
life (current and long-term). Sometimes assets are also considered from the standpoint of their liquidity
, which is regarded as how close or distant the asset is from being turned into cash. Near-cash assets are
relatively quickly converted to cash (e.g., accounts receivable), while assets requiring rather a long time
to convert to cash are considered to be relatively fixed  in their non-cash state (e.g., heavy equipment,
buildings, land). (Fixed does not mean they were repaired!)

You should find that current assets parallel those with more liquidity, while long-term and fixed assets are
those with much less liquidity. Finally, below you will find a few assets that could be either current or
long-term based on the nature of the facts constituting them.

Other Assets Described

Current Assets

Current Assets are those activities whose normal expected life would be one year or less. Such activities
could be tracking reimbursable expenses, travel advances, short-term loans to a friend or family member,
prepaid expenses, annual insurance premium amortization, and so on. The individual entity could have
many other kinds of short term activities that reflect what it is doing. (These asset types are explained
individually below.)

Long-term (Fixed) Assets

Long-term (Fixed) Assets are those activities whose normal expected life exceeds one or more years. This
grouping covers both tangible and intangible assets. Examples of tangible assets are land, buildings, and
vehicles (cars, trucks, construction equipment, factory presses, etc.) Intangible assets include such things
as patents, copy rights, goodwill, etc. Because the lives of some of these assets show wear and tear and
deterioration in value over time, businesses and individuals can allow for that diminution in value by
calculating depreciation on such assets. For example, land normally does not depreciate, but buildings do,
as do equipment and vehicles. (These asset types are explained individually below.)

Current Assets
This section explains short-term receivables, reimbursable expenses, travel advances, prepaid premiums,
prepaid rent, suspense or wash accounts.
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Short-term Receivables
This kind of account is useful to reflect an agreement made with someone you trust. Suppose you lent
someone $500 and he agreed to repay you $50 a month. If he paid on time, the loan you made would be
paid off within a year, which is why it is classified as a short-term receivable. So you could record that
loan initially in this account tree: OtherAssets:Current Assets:LoanToJoe. At the time you give him the
money: your entry is debit (increase) LoanToJoe $500 and credit (decrease) Bank $500. Each time you
receive Joe’s payment you record $50 debit (increase) to Bank and credit (decrease) LoanToJoe.

Tip

Don’t become confused by the use of the word “Loan”. “Loan-To” is the tipoff that you really
have a receivable, that is, you will receive from Joe, the money you previously loaned. Until he
actually pays the money owed you, you reflect his debt in your books by an account describing
your expectation–you will receive the money owed you, hence the word “receivable”.

Reimbursable Expenses
This kind of activity is one in which you spend your own money on behalf of someone else (your employ-
er, perhaps) and later you receive repayment of what you spent. The case might be a business trip. The
employer has a policy of covering (paying for) all authorized expenses. After the trip is over, the employ-
ee submits a report listing dates and amounts spent with receipts for all the expenditures. The employer
reviews the report and pays for all items that it considers as having a valid business reason. (Normally,
employees know in advance what the employer will reimburse, so only those items are recorded as a re-
imbursable expense on the employee’s books.)

Because a business trip can involve different kinds of expenditures (air travel, lodging, transportation at
the destination, etc.), different kinds of expenditures would be recorded in the one account as long as the
expenditures all related to the same trip. In other words, if a second trip is made before the first is fully
settled, a second account for a different event could be set up. It would make sense to do this, if it would
help to keep separate all the details of one trip from those of another. It is up to the person making the trip
to decide how much trouble it would be to put separate trips in separate accounts or to put them all in the
same account. The trip taker should remember that the account must be reconciled in order to know with
certainty that all expenses have been reimbursed.

Recording the expenditures on the trip would be much the same. That is, if you paid trip expenses by
cash you would debit (increase) the reimburseable expense account for the money paid in cash, because
it is a receivable to you until it has been reimbursed to you. The credit offsetting your expenditure would
decrease the account that shows the cash in your pocket or the account from which you drew the cash for
the payment made. If you paid by credit card, the debit side would be the same as just described, but the
credit would be an increase to the credit card company account on your books.

When you received your reimbursement, then the journal entry (or transaction) to record receipt of the
funds from the employer would be: debit (increase) Bank for the check amount and credit (decrease) the
reimbursable expense account for the check amount.

If it turns out that the reimbursable expense account is not zero balance after processing the employer’s
payment, then it means that there is a difference between you and the employer in handling the expense,
which needs to be investigated. If the balance is a debit (a positive balance), your account has some money
that was not reimbursed. If the balance is a credit (a negative balance), you were paid for more than what
you recorded as due you. In both of those situations you should reconcile the difference between what you
recorded and what was paid. That effort should disclose exactly what is causing the discrepancy. You will
need to contact the employer’s bookkeeper to know what was paid, if the reimbursement check was not
accompanied by a detailed list of the items being paid you.
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In the event the employer refused to reimburse you for an expenditure, that effectively makes it your
expense. In that case, you would make this entry: debit (increase) your own Expense (appropriately named)
and credit (decrease) the Reimbursable Expense account. That entry should result in a zero balance in the
Reimbursable Expense account. If not, reconcile until you identify the difference.

Tip

Sometimes there are small differences that don’t match an individual entry. In those cases divide
the amount by 2 or by 9. If the unresolved amount is divisible by two, it suggests that both you
and the employer entered the item in the same manner: both as debits or both as credits. If it is
divisible by 9, then likely one of you transposed adjoining numbers; e.g., one entered 69 and the
other entered 96. If the difference is divisible neither by 2 or by 9, then it could be that more
than one error is present.

Travel Advances
These are very similar to Reimbursable Expenses. The difference is that someone gives you money first;
you spend it, and then you give a report accounting for what you spent it on. The report is supported by
invoices establishing who, what, where, when, and how much for each expenditure. In the Reimbursable
Expense case, you spent your money first and later recovered it.

In the Travel Advance case when you receive the advance, you record on your books this entry: debit
(increase) Bank for the travel advance amount received (say, $500); credit (increase) the short-term liability
Travel Advance ($500). This is a liability, because you are not gifted with the money, but only loaned it
for the purpose of having funds to spend when doing the employer’s business.

Frequently, the way these monetary arrangements work is that at the beginning of for example a salesper-
son’s employment, he or she receives the advance and monthly (or more frequently) turns in a report about
who, what, where, when, and how much he spent. The money in the report is reimbursed if approved.

During the period after receiving the advance and before filing a request for reimbursement report, the
salesperson can record his or her expenditures into the advance liability account. In that case, the balance
in the account will show how much of the advance has not yet been spent (assuming the Travel Advance
balance is a credit). If no mistakes have been made and all expenses are approved, then the sum of the
unspent account balance and the reimbursing check amount will equal the original travel advance amount.

It makes sense for the salesperson to record the travel expenses to this advance account (and not to his or
her own expense accounts), because the money is being spent on behalf of the employer, for the employer’s
authorized expenses. It is not the employee’s own money, and therefore not his or her own expense.

When the salesperson receives the report reimbursement (say, $350), he or she debits (increases) Bank,
and credits (increases) again the Travel Advance liability account, assuming that previously he or she had
been recording expenditures to the travel advance account. Tracking activity in this manner causes the
account to always show the amount that is owed the employer.

See the section called “Reimbursable Expenses” above for what to do if the employer does not accept
an item the employee put on the travel advance reimbursement request report. The difference resolution
effort is essentially the same for both types of accounts.

Prepaid Premiums or Prepaid Rent
Some types of expenses are usually billed as semi-annual or annual amounts. For example, the insurance
industry will bill home insurance annually, while car insurance premiums can be annual or semi-annual.
For those that pay an amount that covers several months or a full year, the proper accounting treatment is
to reflect in each accounting period the amount that expresses the benefit applying to that period.
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In the case of someone who pays a full-year’s insurance premium at the beginning of the insurance period,
the entry to record this is debit (increase) Prepaid Insurance Premium for say, $1,200, and credit (decrease)
Bank for $1,200.

Then a monthly recurring journal entry (scheduled transaction) is created that debits (increases) Insurance
Expense $100 and credits (decreases) Prepaid Insurance Premium $100. This technique spreads the cost
over the periods that receive the insurance coverage benefit. Businesses following generally accepted ac-
counting practices would normally use this technique, especially if they had to present financial statements
to banks or other lenders. Whether individuals do depends on the person and how concerned they are to
match cost with benefit across time periods. Another factor influencing use of this technique would be
the number of such situations the person encounters. It is relatively easy to remember one or two, but
more difficult if having to manage 10 to 20. You would set up as many or as few as proved useful and
important to you.

Suspense or Wash Accounts
The purpose of these accounts is to provide a device to track “change of mind” situations. The objective of
these accounts is to provide a temporary location to record charges and credits that are not to be included
permanently in your books of record. When the transactions reflected in these accounts have been fully
completed, Wash/Suspense accounts will normally carry a zero balance.

For example, say in the grocery store you see canned vegetables on sale, so you buy 6 cans at $1 per
can. Say that the total purchases were $50. When you come home and are putting things in the cupboard
you discover you already had 12 cans. You decide to return the 6 you just bought. Some persons in this
situation would charge (increase) the whole bill to Grocery Expense; and when they returned the cans,
they would credit (decrease) Grocery Expense. That is one way of handling that. The effect of this method
is to leave recorded on your books the cost of items that you really did not purchase from a permanent
standpoint. It is only when the items have actually been returned and the vendor’s return receipt has also
been recorded that the distortion this method generates will then be removed.

Actually, there are several treatments, depending on when and how the original transaction was booked/
recorded and when you decided to return the items purchased. Basically, did you change your mind before
you recorded the transaction or after doing so?

If you decided to return the items after recording the purchase transaction, you may originally have charged
Grocery Expense for the full amount ($50) of all items. In that scenario, what you kept and the amount of
the items to be returned were grouped into one account. You could edit the original transaction and restate
the amount charged to the Grocery Expense account to be the difference ($44) between the total paid ($50)
for groceries and the value of the items to be returned. That leaves the returned-item value as the amount
($6) you should record to the Suspense account.

Obviously, if you decided to return items before you recorded your purchase, then you would book the
original entry as a charge to Grocery Expense for the amount kept ($44) and as a charge to Suspense for the
amount returned ($6). The off-setting credit ($50) to cash or credit card is not affected by these treatments.

When there are several persons shopping and at different vendors, there can be a case where there are
several returns happening at once and in overlapping time frames. In that case the Wash Account is charged
(increased) at time of changing the mind, and either Bank or Credit Card is credited. When the return
occurs, the reverse happens: Bank or Credit Card is debited for the cash value of the returned items and
the Wash/Suspense Account is credited in the same amount.

If the wash account has a non-zero balance, scanning the debit and credit entries in the account will show
the non-matched items. That is, debits not matched by offsetting credits indicate items intended to be
returned but not actually returned yet. The reverse (credits not matched by offsetting debits) indicates that
returns were made but the original charge was not recorded in the Wash Account.
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These differences can be cleared up by returning unreturned items or recording charges (debits) for items
already returned. The mechanics of doing that likely will be finding the original expense account the item
was charged to and making an entry like: debit Wash Account, credit original expense. It also could be as
described above where the original recording is adjusted by adding a charge to Wash/Suspense account
and decreasing the amount charged to the original account.

Short or Long-term Assets
This section explains why some types of assets may be short or long-term and presents an example.

An example is deposits (e.g., utility, rental, security). If the deposit agreement contains a provision to
recover the deposit at the end of a year, the treatment could be that of a short-term asset. However, when
the agreement is that the deposit holder returns the funds only upon successful inspection at the end of the
relationship, then at the start of the relationship or agreement, the person paying the deposit has to decide
whether to write it off as a current expense or to track it for eventual recovery at the end of the agreement
(not infrequently, moving to a new location).

Whichever decision is made, the accounting treatment is to debit (increase) expense (assuming the write-
off decision) or debit (increase) Deposits Receivable (assuming the intent is to recover the deposit in the
future) and credit (decrease) Bank for the amount of the deposit (if paid by cash) or credit (increase) credit
card if paid using that payment method.

Long-term (Fixed) Assets
This section illustrates long-term assets (those whose useful lives exceed a year) and discusses these types:
land, buildings, leasehold improvements, intangibles, vehicles and other equipment.

Land
Land is not a wasting asset. That is, it does not get used up over time and rarely suffers damage such that it
loses value. For that reason, it usually is recorded at cost at the time of purchase. Appreciation in its value
over decades is not recorded and is not recognized in any way on the books of the owner. It is only after
land has been sold that sale price and purchase cost are compared to calculate gain or loss on sale.

Land is frequently sold/purchased in combination with structures upon it. That means that the cost has
to become separated from the cost of structures on it. Land valuation is usually part of the transfer of
ownership process and its value is shown on the purchase documents separately from that of any structures
it supports.

Land values shown on purchase documents frequently arise from the process of value determination man-
aged by assessors whose job it is to assign values to land for tax purposes. Local and regional areas of a
state or province use the values determined by assessors in their tax formulas, which provide revenues for
local and regional governing authorities to finance their required community services.

Should land be acquired in a situation not subject to a history of land valuation by a formal valuation
system, then the purchaser can appeal to real estate agents and an examination of recent sale transactions
for information that would allow calculating a reasonable amount to express the value of the land.

Buildings
Buildings are the man-made “caves” in which much of life’s human interaction occurs. These structures
are wasting assets, because in their use they or their components gradually wear. Over time they begin to
lose some of their function and they can suffer damage due to planetary elements or human action.

236



Other Assets

Accepted accounting practice is to record the cost of the building determined at time of ownership transfer
(purchase) or at conclusion of all costs of construction. Because buildings are frequently used for decades,
and due to the need to be able to calculate gain or loss on sale, accounting practice preserves the original
cost by not recording declines in value in the account containing the original purchase or construction cost.

Instead, the depreciation technique is used to show (in the balance sheet) the structure’s net book value
(original cost reduced by accumulated depreciation). Depreciation is a separate topic treated elsewhere
in this Guide.

Leasehold Improvements
When a business does not own the building where it operates, and instead has a long-term lease, it is not
uncommon for the business tenant to make improvements to the premises so that the structure obtains both
function and appearance that enhances conducting its business activities.

In these cases, the expenditures that the business incurs are recorded in a Leasehold Improvements account:
increase (debit) Leasehold Improvements, decrease (credit) Bank or increase (credit) a suitable liability
account (which could be a liability to a contractor or a bank or a credit card, etc.).

Vehicles or Equipment
Vehicles or Equipment of all kinds usually last for several years, but their useful lives are much shorter
than that of assets that have little movement in their functioning. Because they do wear out over time,
common accounting practice in business is to record depreciation using life spans and depreciation methods
appropriate to the nature and use of the asset. Frequently, the life and depreciation methods chosen are
influenced by what is permitted per national tax regulations for the kind of asset being depreciated.

Usually, businesses depreciate their assets. Individuals can do so as well to the degree that taxing authorities
permit. Very wealthy persons employ accountants and attorneys to track and manage their investments
and assets holdings to take advantage of all tax benefits permitted by law.

Intangibles
The mechanics of accounting (debiting and crediting appropriate accounts) for these assets are relatively
simple, much the same as for any of the above assets. Where the difficulty lies is in their valuation, which is
an advanced topic and not something that individual persons and small businesses would likely encounter.
For that reason further discussion of items such as patents, copyrights, goodwill, etc. are left out of this
Guide.
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Chapter 16. Depreciation
This chapter will introduce the concept of depreciation in accounting and give some real life examples
for using it.

Basic Concepts
Depreciation is the accounting method for expensing capital purchases over time. There are two reasons
that you may want to record depreciation; you are doing bookkeeping for your own personal finances and
would like to keep track of your net worth, or you are doing bookkeeping for a small busines and need to
produce a financial statement from which you will prepare your tax return.

The method of recording depreciation is the same in either case. but the end goal is different. This section
will discuss the differences between the two. But first, some terminology.

• Accumulated depreciation - the accumulated total of book depreciation taken over the life of the asset.
This is accumulated in the depreciation account in the asset section.

• Book depreciation - this is the amount of depreciation that you record in your financial statements per
accounting period.

• Fair market value - the amount for which an asset could be sold at a given time.

• Net book value - this is the difference between the original cost and the depreciation taken to date.

• Original cost - this is the amount that the asset cost you to purchase. It includes any cost to get the asset
into a condition in which you can use it. For example - shipping, installation costs, special training.

• Salvage value - this is the value that you estimate the asset can be sold for at the end of it’s useful life
(to you).

• Tax depreciation - this is the amount of depreciation that you take for income tax purposes.

Personal Finances
Depreciation is used in personal finances to periodically lower an asset’s value to give you an accurate
estimation of your current net worth. For example, if you owned a car you could keep track of its current
value by recording depreciation every year. To accomplish this, you record the original purchase as an
asset, and then record a depreciation expense each year (See the section called “Example” for an example).
This would result in the net book value being approximately equal to the fair market value of the asset
at the end of the year.

Depreciation for personal finance has no tax implications, it is simply used to help you estimate your net
worth. Because of this, there are no rules for how you estimate depreciation, use your best judgement.

For which assets should you estimate depreciation? Since the idea of depreciation for personal finances is
to give you an estimate of your personal net worth, you need only track depreciation on assets of notable
worth that you could potentially sell, such as a car or boat.

Business
As opposed to personal finance where the goal is tracking personal worth, business is concerned with
matching the expense of purchasing capital assets with the revenue generated by them. This is done through
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book depreciation. Businesses must also be concerned with local tax laws covering depreciation of assets.
This is known as tax depreciation. The business is free to choose whatever scheme it wants to record
book depreciation, but the scheme used for tax depreciation is fixed. More often than not this results in
differences between book and tax depreciation, but steps can be taken to reduce these differences.

Now, what purchases should be capitalized? If you expect something that you purchase to help you earn
income for more than just the current year, then it should be capitalized. This includes things like land,
buildings, equipment, automobiles, and computers - as long as they are used for business purposes. It does
not include items that would be considered inventory. So if you made a purchase with the intent to resell
the item, it should not be capitalized.

In addition to the purchase of the asset itself, any costs associated with getting the asset into a condition
so that you can use it should be capitalized. For example, if you buy a piece of equipment and it needs to
be shipped from out of town, and then some electrical work needs to be done so you can plug the machine
in, and some specialized training is needed so you know how to use the machine, all these costs would
be included in the cost of the equipment.

You also need to know the estimated salvage value of the asset. Generally, this is assumed to be zero. The
idea behind knowing the salvage value is that the asset will be depreciated until the net book value (cost
less depreciation) equals the salvage value. Then, when the asset is written off, you will not have a gain
or loss resulting from the disposal of the asset.

The last step is to determine the method of depreciation that you want to use. This will be discussed on
the next few pages.

Note

Warning: Be aware that different countries can have substantially different tax policies for de-
preciation; all that this document can really provide is some of the underlying ideas to help you
apply your “favorite” tax/depreciation policies.

Estimating Valuation
A central issue with depreciation is to determine how you will estimate the future value of the asset.
Compared to the often uncertain estimates one has to do where appreciation of assets is concerned, we
are on somewhat firmer ground here. Using sources listed below should make it fairly straight forward to
estimate the future value of your depreciating assets.

• Tax Codes: For businesses that want to use depreciation for tax purposes, governments tend to set up
precise rules as to how you are required to calculate depreciation. Consult your local tax codes, which
should explicitly state how to estimate depreciation.

• Car Blue Book: For automobiles, it is easy to look up in references such as “Blue Books” estimates of
what an automobile should be worth after some period of time in the future. From this you will be able
to develop a model of the depreciation.

Depreciation Schemes
A depreciation scheme is a mathematical model of how an asset will be expensed over time. For every
asset which undergoes depreciation, you will need to decide on a depreciation scheme. An important point
to keep in mind is that, for tax purposes, you will need to depreciate your assets at a certain rate. This is
called tax depreciation. For financial statement purposes you are free to choose whatever method you want.
This is book depreciation. Most small businesses use the same rate for tax and book depreciation. This way
there is less of a difference between your net income on the financial statements and your taxable income.
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This section will present 3 of the more popular depreciation schemes: linear, geometric, and sum of digits.
To simplify the examples, we will assume the salvage value of the asset being depreciated is zero. If you
choose to use a salvage value, you would stop depreciating the asset once the net book value equals the
salvage value.

1. Linear depreciation diminishes the value of an asset by a fixed amount each period until the net value
is zero. This is the simplest calculation, as you estimate a useful lifetime, and simply divide the cost
equally across that lifetime.

Example: You have bought a computer for $1500 and wish to depreciate it over a period of 5 years.
Each year the amount of depreciation is $300, leading to the following calculations:

Table 16.1. Linear Depreciation Scheme Example

Year Depreciation Remaining Value

0 - 1500

1 300 1200

2 300 900

3 300 600

4 300 300

5 300 0

2. Geometric depreciation is depreciated by a fixed percentage of the asset value in the previous period.
This is a front-weighted depreciation scheme, more depreciation being applied early in the period. In
this scheme the value of an asset decreases exponentially leaving a value at the end that is larger than
zero (i.e.: a resale value).

Example: We take the same example as above, with an annual depreciation of 30%.

Table 16.2. Geometric Depreciation Scheme Example

Year Depreciation Remaining Value

0 - 1500

1 450 1050

2 315 735

3 220.50 514.50

4 154.35 360.15

5 108.05 252.10

Note

Beware: Tax authorities may require (or allow) a larger percentage in the first period. On
the other hand, in Canada, this is reversed, as they permit only a half share of “Capital Cost
Allowance” in the first year. The result of this approach is that asset value decreases more
rapidly at the beginning than at the end which is probably more realistic for most assets than
a linear scheme. This is certainly true for automobiles.

3. Sum of digits is a front-weighted depreciation scheme similar to the geometric depreciation, except
that the value of the asset reaches zero at the end of the period. This is a front-weighted depreciation
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scheme, more depreciation being applied early in the period. This method is most often employed in
Anglo/Saxon countries. Here is an illustration:

Example: First you divide the asset value by the sum of the years of use, e.g. for our example from above
with an asset worth $1500 that is used over a period of five years you get 1500/(1+2+3+4+5)=100.
Depreciation and asset value are then calculated as follows:

Table 16.3. Sum of Digits Depreciation Scheme Example

Year Depreciation Remaining Value

0 - 1500

1 100*5=500 1000

2 100*4=400 600

3 100*3=300 300

4 100*2=200 100

5 100*1=100 0

Account Setup
As with most accounting practices, there are a number of different ways to setup depreciation accounts.
We will present here a general method which should be flexible enough to handle most situations. The
first account you will need is an Asset Cost account (GnuCash account type Asset), which is simply a place
where you record the original purchase of the asset. Usually this purchase is accomplished by a transaction
from your bank account.

In order to keep track of the depreciation of the asset, you will need two depreciation accounts. The first is
an Accumulated Depreciation account in which to collect the sum of all of the depreciation amounts, and
will contain negative values. In GnuCash, this is an account type asset. The Accumulated Depreciation
account is balanced by a Depreciation Expense account, in which all periodic depreciation expenses are
recorded. In GnuCash, this is an account type expense.

Below is a generic account hierarchy for tracking the depreciation of 2 assets, ITEM1 and ITEM2. The
Asset Cost accounts are balanced by the Bank account, the Accumulated Depreciation account is balanced
by the Expenses:Depreciation account.

-Assets
   -Fixed Assets
      -ITEM1
         -Cost                (Asset Cost account)
         -Depreciation     (Accumulated Depreciation account)
      -ITEM2
         -Cost                (Asset Cost account)
         -Depreciation     (Accumulated Depreciation account)
   -Current Assets
      -Bank
-Expense
   -Depreciation        (Depreciation Expense account)
  

One of the features of the account hierarchy shown above is that you can readily see some important
summary values about your depreciating asset. The Assets:Fixed Assets:ITEM1 account total shows you
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the current estimated value for item1, the Assets:Fixed Assets:ITEM1:Cost shows you what you originally
paid for item1, Assets:Fixed Assets:ITEM1:Depreciation shows you your accrued depreciation for item1,
and finally, Expenses:Depreciation demonstrates the total accrued depreciation of all your assets.

It is certainly possible to use a different account hierarchy. One popular account setup is to combine the
Asset Cost and Accrued Depreciation asset accounts. This has the advantage of having fewer accounts
cluttering your account hierarchy, but with the disadvantage that to determine some of the summary details
mentioned in the paragraph above you will have to open the account register windows. As with most
things, there are many ways to do it, find a way that works best for you.

The actual input of the depreciation amounts is done by hand every accounting period. There is no way in
GnuCash (as of yet) to perform the depreciation scheme calculations automatically, or to input the values
automatically into the appropriate accounts. However, since an accounting period is typically one year,
this really is not much work to do by hand.

Example
Let’s go ahead and step through an example. Imagine you are a photographer and you use a car and an
expensive camera for your personal business. You will want to track the depreciation on these items,
because you can probably deduct the depreciation from your business taxes.

The first step is to build the account hierarchy (as shown in the previous section, replace ITEM1 and ITEM2
with “car” and “camera”). Now, record the purchase of your assets by transferring the money from your
bank account to the appropriate Asset Cost accounts for each item (eg: the Assets:Fixed Assets:Car:Cost
account for the car). In this example, you start with $30k in the bank, the car cost $20k and the camera
cost $10k and were both purchased on January 1, 2000.
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The asset depreciation example main window, before depreciation

Looking at the tax codes, we realize that we must report depreciation on these items using the “sum of
digits” scheme, over a 5 year period. So, the yearly depreciation amounts for the car come to $6667, $5333,
$4000, $2667, $1333 for years 1 to 5 respectively, rounded to the nearest dollar. The yearly depreciation
amounts for the camera are $3333, $2667, $2000, $1333, $667. Consult the previous section on Depreci-
ation Schemes for the formula for calculating these values.

For each accounting period (IE: fiscal year) you record the depreciation as an expense in the appropriate
Accrued Depreciation account (eg: the Assets:Fixed Assets:Car:Depreciation account for the car). The
two windows below show your car’s accrued depreciation account and the main window after the third
year (IE: three periods) of depreciation using this sum of digits scheme.
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The asset depreciation register window

The asset depreciation main window

Note

A Word of Caution: Since depreciation and tax issues are closely related, you may not always be
free in choosing your preferred method. Fixing wrong calculations will cost a whole lot more time
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and trouble than getting the calculations right the first time, so if you plan to depreciate assets, it
is wise to make sure of the schemes you will be permitted or required to use.
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Chapter 17. Python Bindings
GnuCash historically has always been a traditional application in the sense that you open it, use it to
manipulate your financial data via the windows it presents, save your data and close the windows again.
This has the inherent limitation that you can only do whatever the windows, menus and toolbars allow
you to do.

Sometimes you might need a little more flexibility. For example, you need a report with just a little different
information than what the built-in reports provide, or you want to automate a frequently recurring action.
Such custom manipulations are ideal candidates to write in one or the other scripting language.

Starting with GnuCash version 2.4 you can write Python scripts to manipulate your financial data.

Note

The Python extensions are an optional feature in the source code. To be able to use Python scripts,
GnuCash must have been compiled with this option enabled, otherwise all what follows won’t
work. At present this option is not enabled by default, so if you need this, you may have to compile
GnuCash from source yourself.

The Python extensions come with a couple of ready to use scripts. This chapter will show you how to
use some of these.

Note

This chapter is not about how to write your own Python scripts. Refer to the developer documen-
tation for that instead.
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Chapter 18. Importing Business Data
Importing Bills and Invoices

General
This functionality creates invoices or bills from a csv import file containing rows of invoice entry data.
The import file may contain rows for new and/or existing invoices. If an invoice already exists, GnuCash
adds the imported entries to the invoice (unless the invoice is already posted). If the import file contains
posting data for an invoice, then GnuCash will also attempt to post the invoice. If any row of an invoice
contains an error, GnuCash will ignore all rows of the same invoice.

The field separator in the csv file must be either a comma or a semicolon; field values may be enclosed
in double quotes.

For the sake of readability, in this chapter the term “invoice” by itself is used to refer to both customer
invoices and vendor bills.

The format of the import file
The import file should contain rows of invoice entry data, each row marked by an invoice ID. The file
should be sorted on invoice ID. Each row contains header and entry fields, but GnuCash takes the invoice
header data from the first row of an invoice ID. For informational purposes, the header data may be repeated
for each subsequent row of the same invoice.

There is no information in the file to indicate whether it concerns customer invoice or vendor bill data.
Instead, a user option in the import dialog makes that distinction.

Each row should contain the fields listed below, in the same sequence, separated by a comma or a semi-
colon. The fields are listed here by their technical name, which GnuCash uses in the preview of the import
data.

• id - The invoice ID. Mandatory. Any row without an invoice ID will be ignored. If the invoice ID
already exists, GnuCash will add the entries to the existing invoice (unless it is already posted).

• date_opened - Use the same date format as defined in Preferences. Defaulted to today's date if left
blank, or if the date provided is not valid.

• owner_id - Customer or vendor number. Mandatory in the first data row of an invoice. If not provided,
all rows of the same invoice will be ignored.

• billingid - Billing ID. Optional

• notes - Invoice notes. Optional.

• date - The date of the entry. Defaulted to date opened if left blank, or if the date provided is not valid.

• desc - Description. Optional

• action - Action. Optional

• account - Account for the entry. Mandatory in each row. If not provided or invalid, all rows of the
same invoice will be ignored.
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• quantity - Quantity. Defaulted to 1 if left blank.

• price - Price. Mandatory for each row. If not provided, all rows of the same invoice will be ignored.

• disc_type - Type of discount. Optional. Only relevant for invoices, not for bills. Use “%” or blank
for percentage value, anything else for monetary value.

• disc_how - Discount how. Optional. Only relevant for invoices, not for bills. Use “>” for discount
applied after tax, “=” for discount and tax applied before tax, and “<”, blank or anything else for discount
applied before tax.

• discount - Amount or percentage of discount. Optional. Only relevant for invoices, not for bills

• taxable - Is this entry taxable? Optional. Use “Y” or “X” for yes, “N” or blank for no.

• taxincluded - Is tax included in the item price? Optional. Use “Y” or “X” for yes, “N” or blank
for no.

• tax_table - Tax table. Optional. If the tax table provided does not exist, it will be blank in the invoice.

• date_posted - Date posted. Optional. Use the same date format as defined in Preferences. If you
provide a date posted for the first row of an invoice, GnuCash will attempt to also post the invoice (as
opposed to only saving or updating it).

• due_date - Due date. Optional. Use the same date format as defined in Preferences. Defaulted to date
posted, if left blank. Only relevant in the first row of an invoice, if the invoice is posted.

• account_posted - Post to account, for vendor or customer posting. Only mandatory in the first row
of an invoice, if the invoice is posted.

• memo_posted  - Memo. Optional. Only relevant in the first row of an invoice, if the invoice is posted.

• accu_splits - Accumulate splits? Optional. Use “Y” or “X” for yes, “N” or blank for no. Only
relevant in the first row of an invoice, if the invoice is posted. If you use a spreadsheet program to create
the import file, it is advised not to use blank for no, because a final column with only blanks may not
be recognized as relevant data when the spreadsheet program creates the csv file.

Note on double quotes

If you use the field separator character within a field, the field value should be enclosed in double
quotes. Only for the fields description (desc) and notes, can you also include a double quote within
a quoted field value, by doubling the double quote. E.g. "This field value uses the
separator, and a ""quoted"" word", would be imported as This field value
uses the separator, and a "quoted" word.

Example content for two bills; one of 2 entries, and one of 3 entries. The first is saved and posted, the
second only saved. Using comma field separator, decimal point and dd/mm/yyyy date format.

1204;15/12/2018;2001;PO 210220;Special delivery;16/12/2018;Pride and Prejudice;pc;Expenses:Books;1;30.00;;;;X;;A1;17/12/2018;17/1/2019;Liabilities:Accounts Payable;;X
1204;15/12/2018;2001;PO 210220;Special delivery;16/12/2018;Electronic principles;pc;Expenses:Books;1;50.00;;;;X;;A1;17/12/2018;17/1/2019;Liabilities:Accounts Payable;;X
1205;15/12/2018;2044;PO 21099;;16/12/2018;Ultimate Guide;pc;Expenses:Books;1;10.01;;;;;;;;;;;
1205;15/12/2018;2044;PO 21099;;16/12/2018;Dinner & drinks;pc;Expenses:Dining;1;10.01;;;;;;;;;;;
1205;15/12/2018;2044;PO 21099;;16/12/2018;UG course;pc;Expenses:Education;1;10.01;;;;;;;;;;;
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Example content for one customer invoice, with one entry, including tax and discount. Using comma fields
separator, decimal point and dd/mm/yyyy date format. The the value of the description field contains the
separator character.

20221;16/12/2018;1001;Order 3378;Discount as agreed;4/12/2018;"Accounting part 1, 2";ea;Income:Other Income;1;769.95;%;=;10;X;N;A1;16/12/2018;16/01/2019;Assets:Accounts Receivable;Posted by import;X
    

Import your data

To import your invoice data, navigate to File → Import → Import Bills & Invoices… to open a new import
dialog, and provide the necessary information.

• 1. Choose the file to import - Select your import file, or manually type the path and file name.

• 2. Select import type - Select the import type, either Bill or Invoice.

• 3. Select import options - Select your csv format. Use the with quotes options if your file contains fields
enclosed in double quotes. These options also match fields not enclosed in quotes; except for the fields
for description and notes, fields should not contain the quote character itself. See Note on double quotes
above. Use one of the other options if your file does not have fields enclosed in quotes; any quote
characters in the file will be imported as is.

• 4. Preview - Once you have selected your import file and csv format, GnuCash shows you a preview
of the data. You can verify if your data is listed in the correct columns. If you do not see any rows in
the preview, then GnuCash was not able to match your import data rows to the selected csv format. See
the section called “What could go wrong?” below.

• 5. Afterwards - You can choose if GnuCash should open tabs for the invoices after the import. Either
for all invoices, or for the invoices that are saved but not posted, or for none of the invoices. Opening
tabs slows down the import process considerably.

• Start the import - If you are satisfied with your selections, hit the OK button to start the import.

If your data file contains invoice IDs that already exist, then GnuCash will ask you (once per import ses-
sion) to confirm that you want to update existing invoices. If not confirmed, all rows for existing invoices
will be ignored.

Note

Internally, GnuCash uses so called regular expressions to match the import rows to the data fields.
The import option Custom regular expression offers the option to use your own regular expression
for this matching process. Obviously, this option requires that you are well versed in regular
expressions. When you choose the option Custom regular expression, GnuCash opens a window
in which you can edit the GnuCash regular expression, or replace it with your own. Your regular
expression should contain a named subpattern for each of the fields of the csv file (using the
technical names). A custom regular expression could be useful if the rows of your source data
file contain all required fields, but in a different order or format. E.g. if the format of your source
data file starts with customer number, followed by invoice ID, followed by the due date, and uses
| as separator, your regular expression would start with something like this:

 ^(?<owner_id>[^|]*)\|(?<id>[^|]*)\|(?<due_date>[^|]*)
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With a custom regular expression, GnuCash could import your source data files, without the need
to convert them to the GnuCash import format.

Feedback and statistics
GnuCash executes the import process in three steps:

• Import - Imports the data file and attempts to match each row to the data fields.

• Validation and adjustment - Validates the data fields and replaces data with defaults if ap-
plicable.

• Processing - Handles the currency related validations, and creates, updates and posts the invoices.

After all steps have finished, GnuCash issues information about the result of the process. The initial dialog
shows the informational or error messages from the validation and processing steps. The second dialog
shows the statistics of the process:

• Import - rows ignored: the number of rows that could not be matched to the data fields.

• Import - rows imported: the number of rows that were successfully matched to the data fields.

• Processing and validation - rows fixed: the number of rows for which a default value was used for a field.

• Processing and validation - rows ignored: the number of rows for that were not processed because of
a validation error.

• Processing and validation - invoices created: the number of invoices created.

• Processing and validation - invoices updated: the number of invoices that were updated.

If there were unmatched rows in the import step, a final dialog shows the actual rows that could not be
matched.

What could go wrong?

Errors in the import step

If the statistics show unmatched rows under “Import - rows ignored”, then there is some issue with the
format of your import file. Verify that you use and select the correct separator. Verify that your data rows
have exactly 21 separator characters (1 for each field, except for the last). Verify whether you use the
separator character within a data field; if so, enclose the field in double quotes.

If you use one of the with quotes import options, verify if you use the double quote character in any of
the data field values; if within the description or notes fields, make sure that the field value is quoted, and
precede each double quote within the field with an extra double quote; if within any other field, remove
the double quote character.

Errors in the validation step

The following errors can occur in the validation step. Any error in a data row will cause all rows of the
same invoice to be ignored.

Note

In versions 3.4 and earlier, an error in a data row would cause just that row to be ignored, as
opposed all rows of the same invoice.

250



Importing Business Data

• The field ID is blank. Every row should have an invoice ID.

• The field owner_id is blank. Every first row of an invoice should have an owner_id.

• The customer or vendor number in field owner_id does not exist. The owner_id in the first row of an
invoice should be an existing customer (for invoices) or vendor (for bills).

• The date in field date_posted is not a valid date. If you provide a value for date_posted in the first
row of an invoice, it should be a valid date. Did you use the date format as set in Preferences?

• The account in the field account_posted does not exist. If you provide a value for the field
date_posted in the first row of an invoice, the field account_posted should be an existing ac-
count.

• The account in the field account_posted is not of type Accounts Receivable (for invoices) or Ac-
counts Payable (for bills). If you provide a value for the field date_posted in the first row of an
invoice, the field account_posted should be an account of the correct type.

• The field price is blank. Every row should have a value for the field price.

• The account in the field account does not exist. Every row should have an existing account in the
field account.

Any error in the validation step is listed after the overall import process completes. Correct your data file
accordingly.

Errors in the processing step

The following errors can occur in the processing step.

• The invoice cannot be updated because it is already posted. All rows of the same invoice will be ignored.
If you want to update the existing invoice, unpost it first in GnuCash.

• The currency of the invoice differs from the currency of the account posted (“Invoice x NOT posted
because currencies don't match”). GnuCash determines the currency of the invoice either from the cus-
tomer or vendor master data (for a new invoice) or from the invoice itself (for an existing invoice).
The currency of the invoice must agree with the currency of the post to account in the field accoun-
t_posted. GnuCash creates the invoice but cannot post it. Manually correct the invoice in GnuCash.

• The invoice requires currency conversion. (“Invoice x NOT posted because it requires currency con-
version”). The invoice contains entries on accounts with different currencies, or the currency of the
entries differs from the currency of the post to account. For such an invoice, GnuCash needs exchange
rates to translate the currency amounts. GnuCash creates the invoice but cannot post it. Post the invoice
manually in GnuCash, and provide the requested exchange rates.

Not supported invoice functionality
Currently the invoice import function does not support (at least) the following:

• Import of billing terms and job.

• Import of customer and job in default chargeback project for bills.

• Application of billing terms from customer or vendor master data.

• Automatic numbering of invoices.
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• Credit notes.

Importing Customers and Vendors

General
This functionality creates and updates customers and vendors from a csv import file containing rows of
vendor/customer master data. The import file may contain rows for new and/or existing customers/vendors.
If a customer/vendor already exists, GnuCash updates the existing customer/vendor.

The format of the import file
The import file should contain rows of customer/vendor data, one row for each customer/vendor. The
customer/vendor is identified by the customer/vendor number in the field id of the data rows. If the field
is blank, GnuCash will use the next number from the relevant counter (set in the Counters tab under File
→ Properties).

There is no data in the file to indicate whether it concerns customer or vendor master data. Instead, a user
option in the import dialog makes that distinction.

Each row should contain the fields listed below, in the same sequence, separated by a comma or a semi-
colon. The fields are listed here by their technical name, which GnuCash uses in the preview of the import
data.

• id - The customer/vendor number. If it is for an existing customer/vendor, GnuCash will update the
customer/vendor. Note that in GnuCash e.g. '000010' is a different customer number than '10'. If the id
field is empty, GnuCash will use the next number from the relevant counter.

• company - The company name. If it is left blank, it is defaulted to the value of field name. If that is
also blank, then the row is ignored.

• name - Billing address - Name. Optional.

• addr1 - Billing address - Address line 1. At least one of the four address lines of the billing address
must be filled. If not, then the row is ignored.

• addr2 - Billing address - Address line 2.

• addr3 - Billing address - Address line 3.

• addr4 - Billing address - Address line 4.

• phone - Billing address - Phone. Optional

• fax - Billing address - Fax. Optional

• email - Billing address - Email. Optional

• notes - Notes. Optional

• shipname - Shipping information - Name. Optional. Not relevant for vendors.

• shipaddr1 - Shipping information - Address line 1. Optional. Not relevant for vendors.

• shipaddr2 - Shipping information - Address line 2. Optional. Not relevant for vendors.
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• shipaddr3 - Shipping information - Address line 3. Optional. Not relevant for vendors.

• shipaddr4 - Shipping information - Address line 4. Optional. Not relevant for vendors.

• shipphone - Shipping information - Phone. Optional. Not relevant for vendors.

• shipfax - Shipping information - Fax. Optional. Not relevant for vendors.

• shipmail - Shipping information - Email. Optional. Not relevant for vendors.

Example content for a customer with a separate shipping address. Using a semicolon for separator.

2201;All Star Company;All Star Company;Union Avenue
776;San Juan;CA;;0482938838;;contact@allstar.com;Last contacted on
4/4/2018.;All Star Company; John Alderman, Office 456;Union Avenue
777;San Juan;CA;78998766;;alderman@allstar.com

Example content for a vendor; no ID given, so GnuCash will take the next number from the counter. Using
a comma for separator.

,Johnson Supplies,Johnson Supplies,Electric Park 56,Plain-
s,VA,,0482986538,,jack@johnson.com,Discount negotiated,,,,,,,,

All fields by technical name in the required sequence.

id, company, name, addr1, addr2, addr3, addr4, phone, fax, email, notes,
shipname, shipaddr1, shipaddr2, shipaddr3, shipaddr4, shiphone, shipfax,
shipmail

Import your data
To import your customer or vendor data, navigate to File → Import → Import Customes & Vendors… to
open a new import dialog, and provide the necessary information.

• 1. Choose the file to import - Select your import file, or manually type the path and file name.

• 2. Select import type - Select the import type, either Customer or Vendor.

• 3. Select import options - Select your csv format. Use the with quotes options if your file contains fields
enclosed in double quotes. These options also match fields not enclosed in double quotes, but fields
should not contain the double quote character itself. Use one of the other options if your file does not
have fields enclosed in quotes; any double quote characters in the file will then be imported as is.

• 4. Preview - Once you have selected your import file and csv format, GnuCash shows you a preview
of the data. You can verify if your data is listed in the correct columns. If you do not see any rows in
the preview, then GnuCash was not able to match your import data rows to the selected csv format. See
the section called “What could go wrong?” below.

• Start the import - If you are satisfied with your selections, hit the OK button to start the import.

Note

Internally, GnuCash uses so called regular expressions to match the import rows to the data fields.
The import option Custom regular expression offers the option to use your own regular expression
for this matching process. Obviously, this option requires that you are well versed in regular
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expressions. When you choose the option Custom regular expression, GnuCash opens a window
in which you can edit the GnuCash regular expression, or replace it with your own. Your regular
expression should contain a named subpattern for each of the fields of the csv file (using the
technical names). A custom regular expression could be useful if the rows of your source data file
contain all necessary fields, but in a different order or format. E.g. if the format of your source
data file starts with customer number, followed by company name, name, and one address field,
and that is all you want to import, then your custom regular expression would be something like
this (using comma as a separator):

^(?<company>[^,]*),(?<id>[^,]*),(?<name>[^,]*),(?<addr1>[^,]*),(?<addr2>[^,]*),(?<addr3>[^,]*)$
     

With a custom regular expression, GnuCash could import your source data files, without the need
to convert them to the GnuCash import format.

Feedback and statistics
GnuCash executes the import process in three steps:

• Import - Imports the data file and attempts to match each row to the data fields.

• Validation and adjustment - Validates the data fields and replaces data with defaults if ap-
plicable.

• Processing - Creates or updates the vendor or customer master data.

After all steps have finished, GnuCash issues information about the result of the process. The initial dialog
shows the statistics of the process:

• Import results - lines ignored: the number of rows that could not be matched to the data fields.

• Import results - lines imported: the number of rows that were successfully matched to the data fields.

• Import results - customers/vendors fixed: the number of rows for which a default value was used for
a field.

• Import results - customers/vendors ignored: the number of rows for that were not processed because
of a validation error.

• Import results - customers/vendors created: the number of customers/vendors created.

• Import results - customers/vendors updated: the number of customers/vendors that were updated.

If there were unmatched rows in the import step, a final dialog shows the actual rows that could not be
matched.

What could go wrong?

Errors in the import step

If the statistics show unmatched rows under “Import results - lines ignored”, then there is some issue with
the format of your import file. Verify that you use and select the correct separator. Verify that your data
rows have exactly 18 separator characters (1 for each field, except for the last). Verify whether you use
the separator character within a data field; if so, enclose the field in double quotes.
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If you use one of the with quotes import options, verify if you use the double quote character in any of
the data field values. If so, remove them; importing double quotes as is, is not supported when using the
with quotes import options.

Errors in the validation step

If the statistics show rows under “Import results - customers/vendors ignored”, then data rows were ignored
because of one of the errors below:

• The field company and the field name are both blank. The field company is mandatory; if it is blank,
then it is defaulted to the value of the field name, but if both are blank, then the data row cannot be
processed.

• The fields addr1, addr2, addr3 and addr4 are all blank. At least one of these fields must have a
value, otherwise the data row cannot be processed.

Not supported customer/vendor functionality
Currently the customer/vendor import function does not support (at least) the following:

• Import of any of the fields in the customer tab for billing information: currency, terms, discount, credit
limit, tax included and tax table.

• Import of any of the fields in the vendor tab for payment information: currency, terms, tax included
and tax table.
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GnuCash Glossary
This is a glossary of common terms used in GnuCash. Some entries here are taken from Wikipedia (http://en.wikipedi-
a.org).

Account An account keeps track of what you own, owe, spend or receive.

Accounting Period An accounting period is the period with reference to which accounting books of an
entity are prepared. Common accounting periods include month, quarter, and year.

AqBanking A library which implements the German Home Banking Computer Interface
(HBCI) and Electronic Banking Internet Communication Standard (EBICS), OFX
Direct Connect and Paypal. It is the successor of openHBCI.

Asset An asset is something you own. Anything tangible or intangible that can be owned
or controlled to produce value and that is held to have positive economic value
is considered an asset.

Balance Sheet A Balance Sheet is a summary of the financial balances of an individual or orga-
nization. It summarizes a company's assets, liabilities and ownership equity at a
specific point in time.

Book A book is a record of all transactions for an individual or organization. In GnuCash,
each file contains a book.

Capital Gain/Loss The difference between the purchase and selling prices of an investment at the time
the investment is sold. Also known as Realized Gain/Loss. Before an investment
is sold, the difference in value is referred to as Unrealized Gain/Loss.
See Also Realized Gain/Loss, Unrealized Gain/Loss.

Capital stock See Stock.

Chart of Accounts A listing of all the accounts available in the data file. The chart of accounts con-
sists of balance sheet accounts (assets, liabilities, stockholders' equity) and income
statement accounts (revenues, expenses, gains, losses).

Commission The fee paid to a broker to buy or sell securities.

Commodity A commodity is something of value that is easily tradeable or sellable; for exam-
ple, currencies, stocks, bonds, grain, copper, and oil are all commodities.

Common stock See Stock.

Compounding The concept that the reinvested interest can later earn interest of its own (interest
on interest). This is often referred to as compound interest.

Cost Basis Cost basis is the original cost of property, adjusted for various factors. Its prima-
ry use is for tax purposes. Factors that affect the cost basis include: stock splits,
dividends, depreciation and return of capital distributions. Cost basis is used to
determine the capital gain.

CSV Stands for Comma Separated Values. CSV files are used to store data in plain text.
Each line of the file is a record and each record can be comprised of multiple fields
separated by commas. CSV is one import format that GnuCash supports.
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Dividends Dividends are cash payments a company makes to shareholders. The amount of
this payment is usually determined as some amount of the profits of the company.
Not all common stocks give dividends.

Equities Equities are investments in which the investor becomes part (or whole) owner in
something.

Financial Transaction Services
(FinTS)

A banking protocol used by German banks. Developed by the German Central
Banking Committee ZKA (Zentraler Kredit-Ausschuss). The standard is used only
by German banks. Prior 2002, it was called Home Banking Computer Interface
(HBCI). FinTS is one import format that GnuCash supports.
See Also Home Computer Banking Interface (HBCI).

GSettings Since version 2.5 the tool that stores user configuration data. It uses the native data
store of the operating system:

Linux DConf since Gnome 3.0 dropped GConf

MacOS Defaults. Use the command-line defaults(1) to modify prefs
when GnuCash isn't running.

Windows Registry.

Home Computer Banking Inter-
face (HBCI)

A bank-independent online banking protocol used by German banks. Home Bank-
ing Computer Interface (HBCI) was developed by the German Central Banking
Committee ZKA (Zentraler Kredit-Ausschuss). Since 2002, it has been called Fi-
nancial Transaction Services (FinTS). HBCI is one import format that GnuCash
supports.
See Also Financial Transaction Services (FinTS).

Interest What a borrower pays a lender for the use of their money. Normally, this is ex-
pressed in terms of a percentage of the principal per year. For example, a savings
account with 1% interest will pay you $1 for every $100 you keep deposited per
year.

Liability A liability is a debt or obligation that an individual or organization owes.

LibOFX An open source library for OFX. It was created by one of the GnuCash developers,
originally to be the OFX interface for GnuCash.
See Also OFX.

Liquidity A measure of how easily convertible an investment is to cash. Money in a savings
account is very liquid, while money invested in a house has low liquidity because
it takes time to sell a house.

Lot A lot is a means of grouping a commodity so that you later identify that the item
bought in one transaction is the same as one sold in a different transaction. Lots
are often implemented with stocks, where capital gain can depend on which item
is being sold at a given time.

MT940 A financial information standard defined by SWIFT and used by several European
banks. It is also used internally in HBCI. Unfortunately, you can't download the
MT940 standard, but some banks publish it on their websites. MT940 is one import
format that GnuCash supports.

OFX The Open Financial eXchange format. This is a financial information exchange
standard used by many institutions. OFX is one import format that GnuCash sup-
ports.
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Price Database The price database contains a store of price quotes for stocks, mutual funds, and
currencies.

Principal The original amount of money invested or borrowed.

QFX The Quicken Financial eXchange format is a proprietary financial information
exchange standard promoted by Quicken and used by many institutions. QFX is
one import format that GnuCash supports.

QIF The Quicken Interchange Format (QIF) is an open specification for reading and
writing financial data to files. This is an older format that is still used by many
institutions. QIF is one import format that GnuCash supports.

Realized Gain/Loss The difference between the purchase and selling prices of an investment at the time
the investment is sold. Also known as Capital Gain/Loss. Before an investment is
sold, the difference in value is referred to as Unrealized Gain/Loss.
See Also Capital Gain/Loss, Unrealized Gain/Loss.

Reconciliation Reconciliation is a verification process in which the user compares their records
with those of the financial institution to ensure that the records in each system
agree at some particular point in time. During reconciliation, the user checks in-
dividual transactions in their file against the institution's statement; upon comple-
tion, the reported balances of the institution and the reconciled account will match
at that point in the register.

Return The total income plus capital gains or losses of an investment.
See Also Yield.

Reversing Transaction In formal accounting, a transaction is never deleted. Therefore, when a mistake
is made, the original transaction remains in the ledger, and a transaction is added
to the ledger that reverses the original. This reversing transaction duplicates the
original transaction, but with debit and credit amounts reversed. This removes the
effect of the erroneous transaction from the books. After entering the reversing
transaction, a corrected transaction can then be entered. Reversing transactions are
not commonly used in personal accounting.

Risk The probability that the return on investment is different from what was expected.
Investments are often grouped on a scale from low risk (e.g., savings accounts or
government bonds) to high risk (e.g., common stocks or junk bonds). As a general
rule of thumb, the higher the risk, the higher the possible return.

Scheduled Transaction Scheduled transactions provide a framework for remembering information about
transactions that are set to occur in the future, either once or periodically.
See Also Yield.

Scheme Scheme is a functional programming language based on a dialect of LISP. Reports
in GnuCash use the Scheme programming language; thus, users wishing to cus-
tomize reports must write Scheme.

Shareholder A shareholder is a person who holds common stock in a company.

Split A split, or Ledger Entry, is the fundamental accounting unit. Each split consists of
an amount, the value of that amount expressed in a (possibly) different currency,
a Memo, a pointer to the parent Transaction, a pointer to the debited Account, a
reconciled flag and timestamp, an action field, and a key-value frame which can
store arbitrary data.
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Stock A security that represents a certain fractional ownership of a company. This is
what you buy when you “buy stock” in a company on the open market. This is
also sometimes known as capital stock, or common stock.

Stock split Occurs when a company offers to issue some additional multiple of shares for
each existing stock. For example, a “2 for 1” stock split means that if you own
100 shares of a stock, you will receive an additional 100 shares at no cost to you.
The unit price of the shares will usually be adjusted so there is no net change in
the value, so in this example the price per share will be halved. Note that such
transactions affect the cost basis per share owned.

Transaction A transaction consists of a date, a description, an ID number, a list of two or more
splits, and a key-value frame. Transactions embody the notion of "double entry"
accounting.

Unrealized Gain/Loss Unrealized gain or loss is the difference in value between a purchase price and
the current value of a given asset. These gains remain unrealized until the asset is
sold, at which point they become Realized gains or losses.
See Also Capital Gain/Loss, Realized Gain/Loss.

Valuation The process of determining the market value or the price the investment would
sell at in a “reasonable time frame”.

XML The eXtensible Markup Language is an international markup standard. GnuCash
stores its data by default in an XML data structure.

Yield A measure of the amount of money you earn from an investment (i.e., how much
income you receive from the investment). Typically, this is reported as a percent-
age of the principal amount. Yield does not include capital gains or losses (see
Return). For example, a stock that sells for $100 and gives $2 in dividends per
year has a yield of 2%.
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Appendix A. Migration Guide
This appendix is to help current users of other financial software packages in their migration to GnuCash.
We address the conceptual differences between the layout of GnuCash accounts versus other software
packages.

Using Accounts vs. Categories
If you are familiar with other personal finance programs, you are already accustomed to tracking your
income and expenses as categories. Since GnuCash is a double-entry system (refer to section 2.1), income
and expenses are tracked in accounts. The basic concept is the same, but the account structure allows
more consistency with accepted business practices. So, if you are a business user as well as a home user,
GnuCash makes it easy to keep track of your business as well as your personal accounts.

Income and expense accounts give you the same information you would get with categories, but they
also give you more flexibility in entering your transactions. In GnuCash, you have the option to enter
transactions directly into income and expense accounts through their account registers. Other programs
that use categories do not offer this option, because there is no “account register” for a category.

You also have the option in GnuCash to treat income and expense accounts exactly as you would treat
categories, if you are more comfortable with that method. In Quicken® and similar programs, transactions
require an account and a category. Substitute an income or expense account name in GnuCash where you
would normally enter a category name in the other programs, and the result should be the same. We will
discuss transaction entry in Chapter 4 in greater detail.

Organization of QIF Files (Discussion)

Common Duplication Issues (Discussion)

Checking QIF Data (Discussion)

Converting XML GnuCash File
The GnuCash XML data file can be transformed to almost any other data format (e.g., QIF, CSV...) quite
easily if one is familiar with XSLT. The GnuCash data file is well-formed XML, and it can therefore be
run through an XSLT parser with an associated stylesheet. This allows one to transform the file to just
about any format that can be designed, given a properly written stylesheet.

A few steps need to be followed. The writing of a stylesheet is a task for a different time, but if you can
get one written, here’s what you need to do:

1. Copy the GnuCash XML data file to a working file.

Note

If the file was last modified by a version of GnuCash older than 2.0, then before to continue
to the next step you will need to modify the working file’s <gnc-v2> tag to read something
like this:
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<gnc-v2 xmlns:cd="http://www.gnucash.org/XML/cd"
        xmlns:book="http://www.gnucash.org/XML/book"
        xmlns:gnc="http://www.gnucash.org/XML/gnc"
        xmlns:cmdty="http://www.gnucash.org/XML/cmdty"
        xmlns:trn="http://www.gnucash.org/XML/trn"
        xmlns:split="http://www.gnucash.org/XML/split"
        xmlns:act="http://www.gnucash.org/XML/act"
        xmlns:price="http://www.gnucash.org/XML/price"
        xmlns:ts="http://www.gnucash.org/XML/ts"
        xmlns:slot="http://www.gnucash.org/XML/kvpslot"
        xmlns:cust="http://www.gnucash.org/XML/cust"
        xmlns:entry="http://www.gnucash.org/XML/entry"
        xmlns:lot="http://www.gnucash.org/XML/lot"
        xmlns:invoice="http://www.gnucash.org/XML/invoice"
        xmlns:owner="http://www.gnucash.org/XML/owner"
        xmlns:job="http://www.gnucash.org/XML/job"
        xmlns:billterm="http://www.gnucash.org/XML/billterm"
        xmlns:bt-days="http://www.gnucash.org/XML/bt-days"
        xmlns:sx="http://www.gnucash.org/XML/sx"
        xmlns:fs="http://www.gnucash.org/XML/fs"
        xmlns:addr="http://www.gnucash.org/XML/custaddr">
    

You can put pretty much anything you want behind the equal signs, but a URL is what is
typically used.

2. Create an XSLT stylesheet containing the transformation your desire, or obtain one that’s already writ-
ten (AFAIK, there aren’t any, but I’m working on a CSV one).

3. Install an XSLT processor such as Saxon (http://saxon.sourceforge.net/) or Xalan-J (http://xml.a-
pache.org/). Any conforming processor will do, really...

4. Run the work file and the stylesheet through the processor according to the processor’s instructions.

5. You will now have a file in the desired output format. An enterprising individual could go so far as to
write a stylesheet to transform the GnuCash data file to an OpenOffice spreadsheet (or vice-versa, for
that matter). Such things as QIF ought to be a little less work.

Benefits are that you don’t need to write a Scheme module or a new C routine to do this transformation.
Anyone who knows or can learn XML and XSLT can perform this task. Not much harder, really, than
writing a Web page....

Anyhow, I just wanted this tidbit to be captured somewhere permanently. The process works on 3.7
datafiles, and ought to work on earlier versions, too.
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Appendix B. Frequently Asked
Questions

This is a list of questions asked on the mailing lists for which there really is no section in the documentation
covering the subject.

Sources of Information

Q: Where’s the FAQ?
A: You’re looking at it. The most up-to-date copy can be found within the GnuCash Wiki [http://wiki.gnu-
cash.org/wiki/FAQ].

Q: Are there mailing lists for GnuCash?
A: Yes. Go to http://lists.gnucash.org/mailman/listinfo/gnucash-user and http://lists.gnucash.org/mail-
man/listinfo/gnucash-devel to subscibe.

Q: Is there a searchable archive for the mailing lists?
A: Yes, you can search the mail list archives at http://news.gmane.org/gmane.comp.gnome.app-
s.gnucash.devel and http://news.gmane.org/gmane.comp.gnome.apps.gnucash.user (and http://news.g-
mane.org/gmane.comp.gnome.apps.gnucash.german if you speak German).

Q: Are there other means of obtaining support for Gnu-
Cash?

A: Yes. Many of the developers hang out on icq in the #gnucash discussion on irc.gnome.org. Also, there
is a wiki online at http://wiki.gnucash.org/wiki/GnuCash.

General Information

Q: Can I run GnuCash on Windows?
A: Yes. Starting with release 2.2.0, GnuCash is also available on Windows.

Other related options would be colinux, VMWare and a windows-based X-server hosting a remote Gnu-
Cash session.

Q: I heard it is too hard to compile GnuCash!
A: This was probably true at the time when 1.6.0 was released. It is no longer true today, as almost every
distribution ships with all the necessary libraries (except g-wrap, which means there is in fact “one” extra
library to be installed before compiling GnuCash). However, by default, distributions won’t install the
development packages of the required libraries, so you might need to start your distribution’s installer
program and tell it to install not only the library packages but also the -devel packages. In general, it was
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noted that this problem concerns many applications in the gnome domain, and this also boils down to the
fact that there is no such thing as “one monolithic gnome package”.

Q: Is there a batch mode (non-interactive) available for
GnuCash, for building reports, etc?

A: No, for now GnuCash must be run interactively.

Q: Can multiple people access the same datafile in Gnu-
Cash?

A: You can have multiple people with access to the same datafile, but they cannot use the data file simul-
taneously.

To setup multi-person access, all the people must have read/write access to the directory containing the
file (to read the other’s created files, and to create new files). One way to do this is by creating a user group
and setting the data directory to be owned by the shared group and set to mode 2775. The “2” makes the
directory setgid which copies the permissions to all files.

Q: Why is GnuCash written in C?
A: The core functionality of GnuCash is written in C, but do not forget that much of this can be accessed
through Guile (scheme). There are a number of reasons for why GnuCash is written in C. The first is
historical, GnuCash was started in 1996 (or maybe even earlier!) and many of the OOP (C++, Java, Python)
compilers were not yet mature and standarized enough on the variety of platforms considered at that time,
so C was the only option at that time. A second reason is because the standard GUI GnuCash uses is GTK,
which is written in C.

Q: Why don’t you rewrite GnuCash in programming lan-
guage xyz so that I can contribute easily?

A: The quick answer is “We won’t”. The longer answer is complex but still amounts to “We won’t”.
GnuCash is a large body of code maintained by a small group of developers who are comfortable in C and
Scheme (Guile). Actually, 80% of it is in C and approx. 13% is in Scheme/Lisp. There is no valid reason
that would justify rewriting this amount of existing code in a newer language. Also, creating language
bindings to recent languages such as Python or Ruby or (insert your favourite language here) is labor
intensive, and we’re already stretched pretty thin maintaining and developing the existing code.

Having said that, this is an open source project and you’re free to do with it or contribute what you want.
Just don’t expect much support if the reason for your changes is that you’re not willing to learn C or
Scheme. Also, GnuCash used to have SWIG bindings (http://www.swig.org) which have been used for
some perl programming code. According to a list discussion, these SWIG bindings might still be a way to
include other languages into GnuCash, but currently they are unused and unmaintained.

Q: I really want feature XYZ but GnuCash doesn’t have it.
How do I get it added?

A: Ask nicely. :-) You can file an enhancement request at http://bugs.gnucash.org/enter_bug.cgi?produc-
t=GnuCash. Please bear in mind to describe your proposed enhancement as verbosely as possible. The
trick here is to learn how to give the best information to the programmers about what your proposed new
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feature should do. If you want to speed up development significantly, consider donating some money as
described on GnuCashDevelopment.

Q: Is there a web interface available for GnuCash?
A: No

Q: How can I provide security for GnuCash data using
CFS, etc.)

A: Unanswered

Q: How can I contribute to the GnuCash project?
A: We’re working on a more formal process, but for now you should subscribe to the mailing list at
http://lists.gnucash.org/mailman/listinfo/gnucash-user and http://lists.gnucash.org/mailman/listinfo/gnu-
cash-devel and discuss what you can contribute with the participants on the lists. Please be aware that
GnuCash is a large body of code written in C and Scheme (see the FAQ above, “Why is GnuCash written
in C?” if you want to know why). If these are languages that you are not willing to work with, consider
contributing in other ways.

Q: I think I found a bug. How do I report it?
A: First of all, try to verify that it is indeed a bug and that it has not been reported before. Search the mail
list archives (see FAQ above). Then search the GnuCash Bugzilla [http://bugs.gnucash.org] database.

If you feel you have indeed found a bug, you can then report it at http://bugs.gnucash.org/enter_bug.c-
gi?product=GnuCash. Please bear in mind to report your bug as verbosely as possible. The trick here is to
learn how to give the best information to the programmers about how to reproduce bugs. A Programmer
will usually only be able to fix a bug they can see, if you can’t make the programmer see your bug, it
won’t get fixed!

Using GnuCash
Q: How can I move the transactions from account “A” in-
to account “B”, thus combining them?

A: At present, GnuCash does not offer a way to move groups of splits from one account to another. You
will need to move them one at a time. Open the register for account “A” and select the pulldown menu
item View → Transaction Journal to expose all the splits. For every split where the “Account” field shows
account “A” reset it to account “B”. To do this quickly and safely, first use Ctrl+C to copy the destination
account name (“account B”) to the clipboard. Then highlight each reference to account “A” by double
clicking on it and use Ctrl+V to paste the destination account name. Pressing Enter after each paste,
silently moves the transaction out of the register.

Be careful! If you inadvertently set the “Account” field to an unintended location, you will need to search
through all your accounts to find the lost transaction to correct your mistake.

Q: Is it possible to merge two GnuCash files?
A: At present this is not possible.
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Q: How can I save a template of my account structure?
A: This is available from the menu: File → Export → Export Accounts

Q: When I search for customers (or anything else for
that matter), how can I return a list of everything?

A: Enter a search criteria of matches regex, and place a single dot “.” in the text field area. Then, click
Find. The regular expression “.” means to match anything.

Q: How can I record a transaction on different dates (ac-
tual date and bank date)?

A: You record the transaction on the date you write the check or initiate the transaction. When it “clears”
the bank, you can click in the “Reconciled” field to “clear” the transaction (change the “n”on-reconciled
to “c”leared).

Accounting

Q: How do I treat taxes? As an account payable or as an
expense?

A: This is a loaded question, and you should really talk to your accountant. How you treat taxes really
depends on what kind of taxes they are, and how you WANT to treat them.. In some cases they are expenses,
in some cases they are liabilities.
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Appendix C. Contributed Account
Trees

UK Vat
Account types (only shown if different to parent type)

• [E] Expense

• [I] Income

• [A] Asset

• [L] Liability

• [Q] Equity

• [B] Bank accounts

• [C] Credit Cards

• [R] Accounts Receivable

• [P] Accounts Payable

(Box n) refers to VAT form box number (I actually have these as descriptions to the account to remind me)

Add all the (Box n -part) together to get the whole (Box n) The VAT shows you liability - if its negative
they owe you.

Capital Equipment (Box 7 - part) and (Box 6 - part) is the value of all *additions* (purchases) made over
the VAT return period - not the absolute value, nor the difference in value unless that difference is wholly
due to new purchases. Depreciation, losses (e.g a write off of faulty item) and other reductions in capital
value are not included. If you sell a capital item then that sale and its VAT is recorded under Income.
The asset is “converted to cash”, so the “net of VAT” increase in your bank account, when the invoice is
payed, is matched by a decrease in capital.

Bank Accounts [B]
  |___ Main Account
  |___  Reserve Account

Cash [A]

Assets [A]
  |___ Capital Equipment    (Box 7 - Part) - additions only, not absolute value
  |           |___ Computers      Can be depreciated to zero this year
  |           |___ EEC reverse VAT purchase  (Box 6 - Part) create sub-accounts if needed
  |___  Other

Receivable [R] Customers to whom you give credit - (business section)
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Cards [C]
  |___  Card 1

Liabilities [L]
  |___  Owed Corp Tax
  |___  Owed Fees
  |___  Owed Tax / NI
  |___  Other

VAT [L]   Net (Box 5)
  |___ i/p [A]   purchases (Box4)
  |___  o/p [L]     (Box3)
             |___EEC   on reverse VAT purchases (Box 2)
             |___Sales   all including zero rate UK/ EEC  and World (Box1)

Payable [P]   Suppliers who give you credit (business section)

Equity [Q]
  |___  Corp Tax
  |___  Director’s Loan
  |___  Dividends
  |             |___  Director1
  |             |___  Director2
  |             |___  Shareholder 1
  |___ Grants (and stuff that does not count as income)
  |___Opening Balances

Income [I]   (Box 6 - part)
   |___ Interest
   |___ Misc
   | ___ Sales
                |___ EEC
                |     |____ goods  (Box 8) (sub accounts as needed)
                |     |____ services includes software (sub accounts as needed)
                | ___ UK
                |____ World

Expenses [E]
        |__Depreciation
        |__ Emoluments
        |            |___ Directors Fees
        |            |___ NI Employer
        |            |___ Employee 1
        |                     |___NI
        |                     |___Net Salary
        |                     |___Stakeholder
        |                     |___Tax
        |___ Other Non VAT Expenses
        |___ VAT Purchases    (Box 7 - part)
                    |___  Accountancy
                    |___  Bank Charges
                    |___  Consumables
                    |___  EEC  reverse VAT purchases  (Box 6 - Part)

270



Contributed Account Trees

                    |         |___ goods (Box 9) (sub accounts as needed)
                    |         |___ services   includes software (sub accounts as needed)
                    |___  Office
                    |___  Phone and Internet
                    |___  Software
                    |___  Subscriptions
                    |___  Sundry
                    |___  Travel / Accom
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Appendix D. Auxiliary File Formats
These are the formats of some auxiliary files used by GnuCash.

Check Format Files (*.chk)

Overview
The check format file is used to tell GnuCash how to print a check or checks onto a page of paper. This
file first describes the overall layout of a page (number of checks, orientation, etc) and then describes
the layout of the specific items on a single check. The file is organized as a typical Key/Value file used
by many Linux applications. Keys/values pairs are grouped into sections that begin with the group name
enclosed in square brackets.

GnuCash looks for check format files in two different locations when you bring up the check printing
dialog. The first location is typically /usr/share/gnucash/checks, where check files distributed
with the application can be found. The second location is the user private ~/.gnucash/checks direc-
tory. Users may add check formats at any time (even while GnuCash is running) simply by dropping a
new *.chk file in this directory. The next time the check printing dialog is opened the new check format
will appear in the list of available check formats.

Note

Printing functions differently depending on the version of GTK that is installed on your system.
When GnuCash is using a version of GTK prior to 2.10 all offsets are measured from the lower
left corner of the page or check. When using GTK 2.10 or later, all offsets are measured from
the upper left corner of the page or check.

Example file
A typical GnuCash check file is presented below. The contents of this file will be described in the next
sections.

[Top]
Guid = 67b144d1-96a5-48d5-9337-0e1083bbf229
Title = Quicken/QuickBooks (tm) US-Letter
Rotation = 0.0
Translation = 0.0;4.0
Show_Grid = false
Show_Boxes = false

[Check Positions]
Height = 252.0
Names = Top;Middle;Bottom

[Check Items]
Type_1 = PAYEE
Coords_1 = 90.0;102.0;400.0;20.0

Type_2 = AMOUNT_WORDS
Coords_2 = 90.0;132.0
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Type_3 = AMOUNT_NUMBER
Blocking_Chars_3 = true
Coords_3 = 500.0;102.0

Type_4 = DATE
Coords_4 = 500.0;67.0

Type_5 = NOTES
Coords_5 = 50.0;212.0
        

Field Descriptions

Top Group

This section of the check file describes the overall layout of a page of checks (or check) that goes into
the printer.

Table D.1. Overall Page Description Fields

Name Type Required Description

Guid string mandatory The guid is used to
uniquely identify a check
format to GnuCash. It
must be unique across the
entire set of application
supplied and user sup-
plied check formats. If
you copy an application
check file as the basis of
your own check format,
you must change this val-
ue. The uuidgen program
may be used to generate
these identifiers.

Title string mandatory The title is used to
uniquely identify a check
format to the user. This
value is presented verba-
tim in the check format
list of the check print-
ing dialog. If you copy
an application check file
as the basis of your own
check format, you should
change this value. The
title may be any utf-8
string.

Font string optional If supplied, this is the de-
fault font used to print all
text items on this check.
This field can contain
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Name Type Required Description

any string that is accept-
able by gtk as a font spec-
ifier. If this field is omit-
ted, the default font is the
font specified in the Gnu-
Cash preferences dialog.
A typical string would be
“sans 12”.

Blocking_Chars boolean optional If supplied, this is the
default used when print-
ing all TEXT items on
this check. When set to
true, will print *** before
and after each text field
on the check. Blocking
characters are printed to
protect check fields from
alteration. For example,
the amount field may be
printed as ***100.00***

DateFormat boolean optional If supplied, this is the de-
fault used when printing
all DATE items on this
check. When set to true,
will print the format of
the DATE in 8 point type,
centered and below the
actual DATE. For exam-
ple DDMMYYYY.

Rotation double optional This value specified the
rotation of the entire page
(in degrees) around the
origin point. For gtk ver-
sions prior to 2.10, the
origin point is in the
lower left corner of the
page and rotation values
increase in the counter-
clockwise direction. For
gtk version 2.10 and lat-
er, the origin point is in
the upper left corner of
the page and rotation val-
ues increase in the clock-
wise direction. Rotation
of the page is applied be-
fore translation.

Translation list of 2 doubles optional These values specify the
x and y translation of
the entire page (in points)
relative to the origin
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Name Type Required Description

point. For gtk versions
prior to 2.10, the ori-
gin point is in the low-
er left corner of the page
and translation values in-
crease moving up and to
the right. For gtk version
2.10 and later, the ori-
gin point is in the up-
per left corner of the page
and translation values in-
crease moving down and
to the right. Rotation of
the page is applied before
translation.

Show_Grid boolean optional If this value is set to
true then GnuCash will
draw a grid on the page,
starting at the origin with
the lines spaced every 50
points. This can be help-
ful when creating a check
format file.

Show_Boxes boolean optional If this value is set to true
then for each item where
the width and height have
been specified, GnuCash
will draw a box show-
ing location and maxi-
mum size of that item .
This can be helpful when
creating a check format
file.

Note

The Blocking_Chars and DateFormat options are defined for all check formats in Edit->Prefer-
ences->Printing. It is recommened that these global options be set to false (the default), and that
the options be set for individual Check Items as described below.

Check Positions Group

This group of items specifies how multiple checks are laid out on the same sheet of paper, and gives names
to each of these check locations so that a user can specify which check location that GnuCash should print.
This entire group of key/value pairs is optional, and should be omitted if the format file only specifies a
single check per page of paper.

Table D.2. Multiple Checks Per Page Fields

Name Type Required Description

Height double mandatory This field specifies the
height of a single check
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Name Type Required Description

on the page. If there are
multiple checks per page
then this item is manda-
tory. If there is only a sin-
gle check per page, this
entire section should be
omitted.

Names list of strings mandatory This field specifies the
names of the check
locations that can be
printed on each page.
These names represent
the check positions start-
ing from the top of the
page and moving down-
ward. The names are pre-
sented verbatim in the
check position list of the
check printing dialog. A
typical value for this field
is "Top;Middle;Bottom",
but it could also be
"First;Second;Third" or
any other set of strings
that clearly identify the
check locations. If there
are multiple checks per
page then this item is
mandatory. If there is on-
ly a single check per
page, this entire section
should be omitted.

Check Items Group

This section specifies the individual items that are printed on the check. There is no limit to the number
of items that may be present in this section, and any given type of item can be repeated multiple times.
This allows for the printing of checks that have a side stub, or for the one-per-page business checks that
have both the check and multiple check stubs on the same page. For example, to print the payee name on
a business check and on both stubs, simply specify three payee items with differing print coordinates.

Each key names in this section explicitly includes the item number to which it applies. E.G. The key named
Type_1 applies to the first item to be printed, and the key Coords_3 applies to the third item to be printed.
Item numbers start at one and increase sequentially. Any gap in the numbering sequence is interpreted by
GnuCash as the end of the item list. Items are printed in the order of their item numbers, not in the order
in which they appear in the file.

Each item specified must include a type declaration. The rest of the parameters for that item depend upon
the particular type of that item. See Table D.4, “Individual Check Item Types” for a list of valid item types
and their required parameters.
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Table D.3. Individual Check Item Fields

Name Type Required Description

Type_n string mandatory This field specifies the
type of a single item to
be printed on a check.
See Table D.4, “Individ-
ual Check Item Types”
for a list of valid item
types.

Coords_n list of 2 or 4 doubles mandatory This field specifies the
coordinates where the
item should be placed on
a check, and optionally
also specifies the width
and height of the item.
The numbers in order are
the X and Y offset of
the lower left corner of
the item, and optionally
the width and height of
the item. If the width is
supplied then the height
must also be supplied,
so this field will always
contain two or four num-
bers. For gtk versions
prior to 2.10, the ori-
gin point is in the low-
er left corner of the page
and translation values in-
crease moving up and to
the right. For gtk version
2.10 and later, the ori-
gin point is in the up-
per left corner of the page
and translation values in-
crease moving down and
to the right.

Note

Regardless of
whether the ori-
gin is at the
top or the bot-
tom of the page,
the coordinates
always specify
the lower left
point of the
item.
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Name Type Required Description

Font_n string optional If supplied, this is the
font used to print this
specific text item. This
field can contain any
string that is acceptable
by gtk as a font specifi-
er. If this field is omitted,
the default font is the font
specified in the Top sec-
tion of the check descrip-
tion file, or if that was
omitted the font specified
in the GnuCash prefer-
ences dialog. This field
is only recognized when
using gtk version 2.10 or
later.

Align_n string optional If supplied, this is the
alignment used to print
this specific text item.
This field must contain
one of the strings “left”,
“center” or “right”. If this
field is omitted, the text
will be left aligned. This
field is only recognized
when using gtk version
2.10 or later.

Text_n string optional This field is only used
when the item type is
TEXT. It specifies the
utf-8 text that should be
printed on the check.

Filename_n string optional This field is only used
when the item type is
PICTURE. It specifies
the filename of the image
that should be printed on
the check. The string may
specify either an absolute
path name or as a relative
path name. If a relative
path name is specified,
GnuCash first looks in
in the application check
format folder (typical-
ly /usr/share/gnu-
cash/checks) for the
image file, and if
it isn’t found there
then it looks in the
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Name Type Required Description

user private ~/.gnu-
cash/checks directo-
ry for the image. This
field is only recognized
when using gtk version
2.10 or later.

Blocking_Chars_n boolean optional If supplied, this will set
the print Blocking_Chars
option for this item.

DateFormat_n boolean optional If supplied, this will set
the print DateFormat op-
tion for this item.

These are the individual items that can be printed on a check. All items require the coordinates on the
page where the item should be printed. The majority of these items result in text being printed on the page,
and these items may have individual font and alignments specified. For example, the numerical amount
of a check could be printed right justified while everything else is printed left justified. Other types may
have unique parameters.

Table D.4. Individual Check Item Types

Name Required Fields Optional Fields Description

PAYEE Coords Font
Align
Blocking_Chars
                    

This type value tells
GnuCash to print the
check payee name at the
specified coordinates.

DATE Coords Font
Align
Blocking_Chars
DateFormat
                    

This type value tells
GnuCash to print the
check date at the speci-
fied coordinates.

NOTES Coords Font
Align
Blocking_Chars
                    

This type value tells
GnuCash to print the
transaction notes field at
the specified coordinates.

CHECK_NUMBER Coords Font
Align
Blocking_Chars
                    

This type value tells
GnuCash to print the
check number at the
specified coordinates.
The check number re-
flects the book op-
tion selection under
File → Properties for
number source (trans-
action number or an-
chor-split action - see
Use Split Action Field
for Number [ghelp:gnu-
cash-help?num-
action-book-option] in
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Name Required Fields Optional Fields Description

the Book Options sec-
tion of the GnuCash Help
Manual).

MEMO Coords Font
Align
Blocking_Chars
                    

This type value tells
GnuCash to print the split
memo field at the speci-
fied coordinates.

ACTION Coords Font
Align
Blocking_Chars
                    

This type value tells
GnuCash to print the
split action field at
the specified coordinates.
However, the printed
field reflects the book
option selection under
File →  Properties for
number source (trans-
action number or an-
chor-split action - see
Use Split Action Field
for Number [ghelp:gnu-
cash-help?num-
action-book-option] in
the Book Options sec-
tion of the GnuCash
Help Manual). If num-
ber source for the book is
specified as anchor-split
action, this field will in-
stead print the transac-
tion number field.

AMOUNT_WORDS Coords Font
Align
Blocking_Chars
                    

This type value tells
GnuCash to print the
check amount in words at
the specified coordinates.
The amount will appear
similar to the string "One
thousand, two hundred
thirty four and 56/100".

AMOUNT_NUMBER Coords Font
Align
Blocking_Chars
                    

This type value tells
GnuCash to print the
check amount in num-
bers at the specified co-
ordinates. The amount
will appear similar to the
number "$1,234.56".

ADDRESS Coords Font
Align
Blocking_Chars
                    

This type value tells
GnuCash to print the ad-
dress at the specified co-
ordinates.
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Name Required Fields Optional Fields Description

SPLITS_ACCOUNT Coords Font
Align
Blocking_Chars
                    

This type value tells
GnuCash to print the ac-
count names for each
split entry stating at
the specified coordinates.
See the note on splits
printing.

SPLITS_AMOUNT Coords Font
Align
Blocking_Chars
                    

This type value tells
GnuCash to print the
amount for each split en-
try stating at the specified
coordinates. Amounts
are printed with currency
symbols. See the note on
splits printing.

SPLITS_MEMO Coords Font
Align
Blocking_Chars
                    

This type value tells
GnuCash to print the
memo text for each split
entry stating at the speci-
fied coordinates. See the
note on splits printing.

TEXT Coords, Text Font
Align
Blocking_Chars
                    

This type value tells
GnuCash to print an ar-
bitrary string at the spec-
ified coordinates. The
string to be printed is
specified with the Text_n
key.

PICTURE Coords, Filename (none) This type value tells
GnuCash to print an im-
age at the specified coor-
dinates. The image to be
printed is specified with
the Filename_n key. This
type is only recognized
when using gtk version
2.10 or later.

Note

SPLIT items include all split entries for the transaction except for the split that applies to the
current account register (referred to as the anchor-split). This is usually the last split listed when
splits are displayed in the register. The coordinate location defines the lower left location for the
split information.

Creating Check Format Files
Creating your own check format file is a fairly simple task. The easiest way to start is to copy an exist-
ing check format file from the application directory (typically /usr/share/gnucash/checks) to
the directory ~/.gnucash/checks. Make sure to change the guid so the new file will be accepted
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by gnucash, and change the title to something descriptive. Then change or add individual item fields as
necessary. You can also create a new check file by clicking the Save Format button on the Custom format
page of the check printing dialog.

Note

Key names are case sensitive. If you’re having problems with a check format file, ensure that all
key names have capital letters as documented above.
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Appendix E. GNU Free Documentation
License

Version 1.1, March 2000
Copyright © 2000 Free Software Foundation, Inc.

Free Software Foundation, Inc. 59 Temple Place,
        Suite 330, Boston, MA
        02111-1307  USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it
is not allowed.

0. PREAMBLE
The purpose of this License is to make a manual, textbook, or other written document “free” in the sense of
freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying it,
either commercially or noncommercially. Secondarily, this License preserves for the author and publisher
a way to get credit for their work, while not being considered responsible for modifications made by others.

This License is a kind of “copyleft”, which means that derivative works of the document must themselves
be free in the same sense. It complements the GNU General Public License, which is a copyleft license
designed for free software.

We have designed this License in order to use it for manuals for free software, because free software
needs free documentation: a free program should come with manuals providing the same freedoms that
the software does. But this License is not limited to software manuals; it can be used for any textual work,
regardless of subject matter or whether it is published as a printed book. We recommend this License
principally for works whose purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS
This License applies to any manual or other work that contains a notice placed by the copyright holder
saying it can be distributed under the terms of this License. The “Document”, below, refers to any such
manual or work. Any member of the public is a licensee, and is addressed as “you”.

A “Modified Version” of the Document means any work containing the Document or a portion of it, either
copied verbatim, or with modifications and/or translated into another language.

A “Secondary Section” is a named appendix or a front-matter section of the Document that deals exclu-
sively with the relationship of the publishers or authors of the Document to the Document’s overall sub-
ject (or to related matters) and contains nothing that could fall directly within that overall subject. (For
example, if the Document is in part a textbook of mathematics, a Secondary Section may not explain any
mathematics.) The relationship could be a matter of historical connection with the subject or with related
matters, or of legal, commercial, philosophical, ethical or political position regarding them.

The “Invariant Sections” are certain  Secondary Sections whose titles are designated, as being those of
Invariant Sections, in the notice that says that the Document is released under this License.

The “Cover Texts” are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover
Texts, in the notice that says that the Document is released under this License.
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A “Transparent” copy of the  Document means a machine-readable copy, represented in a format whose
specification is available to the general public, whose contents can be viewed and edited directly and
straightforwardly with generic text editors or (for images composed of pixels) generic paint programs or
(for drawings) some widely available drawing editor, and that is suitable for input to text formatters or
for automatic translation to a variety of formats suitable for input to text formatters. A copy made in an
otherwise Transparent file format whose markup has been designed to thwart or discourage subsequent
modification by readers is not Transparent. A copy that is not “Transparent” is called “Opaque”.

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input
format, LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming
simple HTML designed for human modification. Opaque formats include PostScript, PDF, proprietary
formats that can be read and edited only by proprietary word processors, SGML or XML for which the
DTD and/or processing tools are not generally available, and the machine-generated HTML produced by
some word processors for output purposes only.

The “Title Page” means, for a printed book, the title page itself, plus such following pages as are needed
to hold, legibly, the material this License requires to appear in the title page. For works in formats which
do not have any title page as such, “Title Page” means the text near the most prominent appearance of the
work’s title, preceding the beginning of the body of the text.

2. VERBATIM COPYING
You may copy and distribute the Document in any medium, either commercially or noncommercially,
provided that this License, the copyright notices, and the license notice saying this License applies to the
Document are reproduced in all copies, and that you add no other conditions whatsoever to those of this
License. You may not use technical measures to obstruct or control the reading or further copying of the
copies you make or distribute. However, you may accept compensation in exchange for copies. If you
distribute a large enough number of copies you must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.

3. COPYING IN QUANTITY
If you publish printed copies of the Document numbering more than 100, and the Document’s license
notice requires Cover Texts, you must enclose the copies in covers that carry, clearly and legibly, all these
Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts on the back cover. Both covers
must also clearly and legibly identify you as the publisher of these copies. The front cover must present
the full title with all words of the title equally prominent and visible. You may add other material on the
covers in addition. Copying with changes limited to the covers, as long as they preserve the title of the
Document and satisfy these conditions, can be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed
(as many as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either in-
clude a machine-readable Transparent copy along with each Opaque copy, or state in or with each Opaque
copy a publicly-accessible computer-network location containing a complete Transparent copy of the Doc-
ument, free of added material, which the general network-using public has access to download anony-
mously at no charge using public-standard network protocols. If you use the latter option, you must take
reasonably prudent steps, when you begin distribution of Opaque copies in quantity, to ensure that this
Transparent copy will remain thus accessible at the stated location until at least one year after the last time
you distribute an Opaque copy (directly or through your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing
any large number of copies, to give them a chance to provide you with an updated version of the Document.
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4. MODIFICATIONS
You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and
3 above, provided that you release the Modified Version under precisely this License, with the Modified
Version filling the role of the Document, thus licensing distribution and modification of the Modified
Version to whoever possesses a copy of it. In addition, you must do these things in the Modified Version:

• A.  Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and
from those of previous versions (which should, if there were any, be listed in the History section of the
Document). You may use the same title as a previous version if the original publisher of that version
gives permission.

• B.  List on the Title Page, as authors, one or more persons or entities responsible for authorship of
the modifications in the Modified Version, together with at least five of the principal authors of the
Document (all of its principal authors, if it has less than five).

• C.  State on the Title Page the name of the publisher of the Modified Version, as the publisher.

• D.  Preserve all the copyright notices of the Document.

• E.  Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

• F.  Include, immediately after the copyright notices, a license notice giving the public permission to
use the Modified Version under the terms of this License, in the form shown in the Addendum below.

• G.  Preserve in that license notice the full lists of  Invariant Sections and required Cover Texts given
in the Document’s license notice.

• H.  Include an unaltered copy of this License.

• I.  Preserve the section entitled “History”, and its title, and add to it an item stating at least the title,
year, new authors, and publisher of the Modified Version as given on the Title Page. If there is no
section entitled “History” in the Document, create one stating the title, year, authors, and publisher of
the Document as given on its Title Page, then add an item describing the Modified Version as stated
in the previous sentence.

• J.  Preserve the network location, if any, given in the Document for public access to a Transparent
copy of the Document, and likewise the network locations given in the Document for previous versions
it was based on. These may be placed in the “History” section. You may omit a network location for
a work that was published at least four years before the Document itself, or if the original publisher of
the version it refers to gives permission.

• K.  In any section entitled “Acknowledgements” or “Dedications”, preserve the section’s title, and
preserve in the section all the substance and tone of each of the contributor acknowledgements and/or
dedications given therein.

• L.  Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles.
Section numbers or the equivalent are not considered part of the section titles.

• M.  Delete any section entitled “Endorsements”. Such a section may not be included in the Modified
Version.

• N.  Do not retitle any existing section as “Endorsements” or to conflict in title with any Invariant
Section.
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If the Modified Version includes new front-matter sections or appendices that qualify as Secondary Sec-
tions and contain no material copied from the Document, you may at your option designate some or all
of these sections as invariant. To do this, add their titles to the list of Invariant Sections in the Modified
Version’s license notice. These titles must be distinct from any other section titles.

You may add a section entitled “Endorsements”, provided it contains nothing but endorsements of your
Modified Version by various parties--for example, statements of peer review or that the text has been
approved by an organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as
a Back-Cover Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of
Front-Cover Text and one of Back-Cover Text may be added by (or through arrangements made by) any
one entity. If the Document already includes a cover text for the same cover, previously added by you or
by arrangement made by the same entity you are acting on behalf of, you may not add another; but you
may replace the old one, on explicit permission from the previous publisher that added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their names
for publicity for or to assert or imply endorsement of any Modified Version .

5. COMBINING DOCUMENTS
You may combine the Document with other documents released under this License, under the terms de-
fined in section 4 above for modified versions, provided that you include in the combination all of the
Invariant Sections of all of the original documents, unmodified, and list them all as Invariant Sections of
your combined work in its license notice.

The combined work need only contain one copy of this License, and multiple identical Invariant Sections
may be replaced with a single copy. If there are multiple Invariant Sections with the same name but dif-
ferent contents, make the title of each such section unique by adding at the end of it, in parentheses, the
name of the original author or publisher of that section if known, or else a unique number. Make the same
adjustment to the section titles in the list of Invariant Sections in the license notice of the combined work.

In the combination, you must combine any sections entitled “History” in the various original documents,
forming one section entitled “History”; likewise combine any sections entitled “Acknowledgements”, and
any sections entitled “Dedications”. You must delete all sections entitled “Endorsements.”

6. COLLECTIONS OF DOCUMENTS
You may make a collection consisting of the Document and other documents released under this License,
and replace the individual copies of this License in the various documents with a single copy that is included
in the collection, provided that you follow the rules of this License for verbatim copying of each of the
documents in all other respects.

You may extract a single document from such a collection, and dispbibute it individually under this Li-
cense, provided you insert a copy of this License into the extracted document, and follow this License in
all other respects regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT
WORKS

A compilation of the Document or its derivatives with other separate and independent documents or works,
in or on a volume of a storage or distribution medium, does not as a whole count as a Modified Version
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of the Document, provided no compilation copyright is claimed for the compilation. Such a compilation
is called an “aggregate”, and this License does not apply to the other self-contained works thus compiled
with the Document , on account of their being thus compiled, if they are not themselves derivative works
of the Document. If the Cover Text requirement of section 3 is applicable to these copies of the Document,
then if the Document is less than one quarter of the entire aggregate, the Document’s Cover Texts may
be placed on covers that surround only the Document within the aggregate. Otherwise they must appear
on covers around the whole aggregate.

8. TRANSLATION
Translation is considered a kind of modification, so you may distribute translations of the Document under
the terms of section 4. Replacing  Invariant Sections with translations requires special permission from
their copyright holders, but you may include translations of some or all Invariant Sections in addition to
the original versions of these Invariant Sections. You may include a translation of this License provided
that you also include the original English version of this License. In case of a disagreement between the
translation and the original English version of this License, the original English version will prevail.

9. TERMINATION
You may not copy, modify, sublicense, or distribute the Document except as expressly provided for under
this License. Any other attempt to copy, modify, sublicense or distribute the Document is void, and will
automatically terminate your rights under this License. However, parties who have received copies, or
rights, from you under this License will not have their licenses terminated so long as such parties remain
in full compliance.

10. FUTURE REVISIONS OF THIS LICENSE
The Free Software Foundation [http://www.gnu.org/fsf/fsf.html] may publish new, revised versions of the
GNU Free Documentation License from time to time. Such new versions will be similar in spirit to the
present version, but may differ in detail to address new problems or concerns. See http://www.gnu.org/
copyleft/ [http://www.gnu.org/copyleft].

Each version of the License is given a distinguishing version number. If the Document specifies that a
particular numbered version of this License “or any later version” applies to it, you have the option of
following the terms and conditions either of that specified version or of any later version that has been
published (not as a draft) by the Free Software Foundation. If the Document does not specify a version
number of this License, you may choose any version ever published (not as a draft) by the Free Software
Foundation.

Addendum
To use this License in a document you have written, include a copy of the License in the document and
put the following copyright and license notices just after the title page:

Copyright YEAR YOUR NAME.

Permission is granted to copy, distribute and/or modify this document under the terms of
the GNU Free Documentation License, Version 1.1 or any later version published by the
Free Software Foundation; with the Invariant Sections being LIST THEIR TITLES, with
the Front-Cover Texts being LIST, and with the Back-Cover Texts being LIST. A copy
of the license is included in the section entitled “GNU Free Documentation License”.
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If you have no Invariant Sections, write “with no Invariant Sections” instead of saying which ones are
invariant. If you have no Front-Cover Texts, write “no Front-Cover Texts” instead of “Front-Cover Texts
being LIST”; likewise for Back-Cover Texts.

If your document contains nontrivial examples of program code, we recommend releasing these examples
in parallel under your choice of free software license, such as the  GNU General Public License [http://
www.gnu.org/copyleft/gpl.html], to permit their use in free software.
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GnuCash Help Manual
by The GnuCash Documentation Team

This manual describes how to use the GnuCash Financial software.
Copyright © 2002-2019 GnuCash Documentation Team

Permission is granted to copy, distribute and/or modify this document under the terms of the GNU Free Documentation
License (GFDL), Version 1.1 or any later version published by the Free Software Foundation with no Invariant
Sections, no Front-Cover Texts, and no Back-Cover Texts. You can find a copy of the GFDL at this link [ghelp:fdl]
or in the file COPYING-DOCS distributed with this manual.

This manual is part of a collection of GNOME manuals distributed under the GFDL. If you want to distribute this
manual separately from the collection, you can do so by adding a copy of the license to the manual, as described in
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Chapter 1. Introduction to GnuCash
What is GnuCash?

GnuCash is a personal and small business finance application. It’s designed to be easy to use, yet powerful
and flexible. GnuCash allows you to track your income and expenses, reconcile bank accounts, monitor
stock portfolios and manage your small business finances. It is based on professional accounting principles
to ensure balanced books and accurate reports.
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Chapter 2. Using This Document &
Getting Help

This document is organized in two dimensions:

• From the GUI (Graphical User Interface) explaining the available options and their functions, with links
to deeper descriptions and usage. Chapter 4, GnuCash Windows & Menus Options Overview

• By classifying Operations, Tasks, or Functions based on whether it is an Account, Transaction,
Reporting or other oriented operation. Examples are:

• Account Actions - Chapter 5, Setting Up, Editing & Working with Accounts

• Transaction/Register Actions - Chapter 6, Common Transaction Operations

• Tools and Assistants - Chapter 8, Tools & Assistants

• Reporting & Charting - Chapter 9, Reports And Charts

• Customization - Chapter 10, Customizing GnuCash

Accessing Help
When GnuCash is running and this documentation is installed, this window is accessed by

• pressing the F1 key or

• selecting from the menu Help → Contents.

• Help → Tutorial and Concepts Guide (Ctrl+H) will open the other part of this documentation.

• In most dialogs the Help button will lead you directly to the page which decribes that dialog.

The complete help menu is explained in the section called “Account Tree - Help Menu”.

Operating System and Help Viewer

Depending on your operating system we use different programs to display this help document:

Linux Gnome Yelp
MacOS default web browser
Windows Windows help viewer

See their respective manuals to get help about help.

GnuCash Tutorial and Concepts Guide
The guide is the counterpart to this help. It explains the concepts used in GnuCash and has a tutorial that
takes you through using GnuCash to manage your accounts. It will appear if you choose Open the new
user tutorial in the Welcome to GnuCash! menu.

To open this Guide manually go to Help → Tutorial and Concepts Guide or press Ctrl+H.
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Using This Document & Getting Help

Important

It is strongly recommended to read this guide if you are new to GnuCash or unfamiliar with
accounting concepts.

GnuCash Wiki
An immense amount of less-formal, but often more recent documentation, both of GnuCash itself and its
maintenance and development may be found in the GnuCash Wiki [https://wiki.gnucash.org/wiki/] ; the
Frequently Asked Questions [https://wiki.gnucash.org/wiki/FAQ] page should be a first stop whenever
you encounter difficulty using GnuCash.

Tip

You should also try its search page [https://wiki.gnucash.org/wiki/Special:Search].

GnuCash On-line Assistance

Mailing Lists

The primary source of user support is the user mailing list [mailto:gnucash-user@gnucash.org].
If English is not your primary language, see wiki:user mailing lists [https://wiki.gnucash.org/wiki/
Mailing_Lists#User_Lists] for local lists. If you prefer a web forum-like presentation, you can use it
via Nabble [http://gnucash.1415818.n4.nabble.com/GnuCash-User-f1415819.html]. One must subscribe
[https://lists.gnucash.org/mailman/listinfo/gnucash-user] before posting, even if using Nabble.

IRC

Several of the developers and experienced users monitor the #gnucash channel at irc.gnome.org [irc://
irc.gnome.org/gnucash]. They're usually doing something else, too, and of course aren't always at their
computers. Log in, ask your question, and stay logged in; it may be several hours before your question is
noticed and responded to. To see if you missed anything check the IRC logs [https://lists.gnucash.org/logs/
]. Requirements, netiquette and other details are explained in the IRC wiki page [https://wiki.gnucash.org/
wiki/IRC].

GnuCash Website
The GnuCash website [https://www.gnucash.org/] has more details on these channels. You will also find
pointers there to additional useful resources such as the bug tracking system.
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Chapter 3. Getting Started
Welcome to GnuCash! Screen

This screen is intended for you to use to get up and running quickly. The Cancel button is used to exit
the screen. It will then prompt you with Display Welcome Dialog Again?. If you do not want to see the
Welcome to GnuCash! menu again click the No button. Click the Yes button or press the keyboard Enter
key for the default which is to have the Welcome to GnuCash! screen run again.

Note

Selecting either of these options will leave you with a minimum GnuCash main window.
Operations in this window are described in Chapter 4, GnuCash Windows & Menus Options
Overview.

New Account Hierarchy Setup
This assistant helps you to create a set of GnuCash accounts. It will appear if you choose Create a new set
of accounts in the Welcome to GnuCash! menu, or if you select File → New .

Import QIF Files
This Assistant helps you import Quicken QIF files. It will appear if you choose Import my QIF files in
the Welcome to GnuCash! menu.

To start this assistant manually go to File → Import ... → Import QIF....

In the following all the screens that you can see in this assistant are described in order of appearance.

1. The Import QIF files assistant opens with a screen that briefly describes what this assistant does and
requests the file(s) to import. The three buttons at the very bottom of the screen will not change while
using the assistant.

• Cancel: exit the process and cancel importing QIF files.

Warning

If you click this button, any selections you have made up to this point will be lost.

• Back: brings up the previous screen so that you can change a previous selection until the first screen.

• Forward: brings up the next screen so you can continue through the assistant.

2. The next screen allows you to Select a QIF file to load. The Select... button on this screen is used to
access the list of files. The Select... button brings up the Select QIF File dialog.

Navigate to where you have stored your QIF files and select the first one then click Import. The next
screen will display it in the Select a QIF File to Load field.

Note

If the file you are loading does not have an QIF date listed in it you will see the Set a date
format for this QIF file screen. Select the proper format from the pull down list and continue.
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Getting Started

Note

If the file you are loading does not have an account name listed in it you will see the Set the
default QIF account name screen. Otherwise you will skip this screen and go on to the screen
in the next section that shows loaded QIF files.

• The Account name: field is used to set an account name for this QIF file.

3. The next screen shows you the QIF files you have loaded. You can use this screen to return to the
previous screen and load more QIF files. It will also let you unload any files you have loaded by mistake.

• The top panel shows the list of QIF Files you have loaded.

• The Load another file button takes you back to the previous screen to load another QIF file.

• The Unload selected file button allows you to select a file from the top panel and remove it from
the list.

When you have selected all the QIF files to be imported, click the Forward button.

4. Depending on the type of data contained in the QIF files to be imported, you may see only one or all
of the following screens:

Accounts and
stock holdings

This screen gives a description of the Accounts and stock holdings matching
process on the following Match QIF accounts with GnuCash accounts screen.

Tip

This and other informational screens in the Import QIF files assistant can
be turned off in the Online Banking tab (see the section called “Online
Banking”) under GnuCash Preferences.

The next screen lets you Match QIF accounts with GnuCash accounts. You will see
a list of QIF account names on the left and suggested GnuCash account names on
the right. The New? column indicates if the GnuCash account name will be created
by the QIF Import.

To change the GnuCash account to a different one select the QIF account. A screen
will pop up to select another account or create a new one.

• Select an account from the list to choose a already existing account.

• The New Account button allows you to add a new account name as a sub-account
(child of selected) of the selected account.

• The OK button is used to confirm your selection.

• The Cancel button is used to exit the dialog without using any changes you have
made.

Income and
Expense
categories

This screen gives a description of the Income and Expense categories matching
process on the following Match QIF categories with GnuCash accounts screen.
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Tip

This and other informational screens in the Import QIF files assistant can
be turned off in the Online Banking tab (see the section called “Online
Banking”) under GnuCash Preferences.

The next screen lets you Match QIF categories with GnuCash accounts. You will
see a list of QIF category names on the left and suggested GnuCash account names
on the right. The New? column indicates if the GnuCash account name will be
created by the QIF Import.

To change the GnuCash account to a different one select the QIF category. A dialog
will pop up to select another account or create a new one.

• Select an account from the list to choose a already existing account.

• The New Account button allows you to add a new account name as a sub-account
(child of selected) of the selected account.

• The OK button is used to confirm your selection.

• The Cancel button is used to exit the dialog without using any changes you have
made.

Payees and
memos

This screen gives a description of the Payees and memos matching process on the
following Match payees/memos to GnuCash accounts screen.

Tip

This and other informational screens in the Import QIF files assistant can
be turned off in the Online Banking tab (see the section called “Online
Banking”) under GnuCash Preferences.

The next screen lets you Match payees/memos to GnuCash accounts. You will see
a list of QIF payee/memo names on the left and suggested GnuCash account names
on the right. The default GnuCash account used is called Unspecified. The New?
column indicates if the GnuCash account name will be created by the QIF Import.

To change the GnuCash account to a different one select the QIF payee/memo. A
dialog will pop up to select another account or create a new one.

• Select an account from the list to choose a already existing account.

• The New Account button allows you to add a new account name as a sub-account
of the selected account.

• The OK button is used to confirm your selection.

• The Cancel button is used to exit the dialog without using any changes you have
made.

5. The next screen allows you to Enter the QIF file currency. The drop down list defaults to the currency
configured in the Accounts tab (see the section called “Accounts”) under GnuCash Preferences. If you
wish the new accounts to use a different currency, select one from the list.

6



Getting Started

When you have selected the currency, click the Forward button.

6. Depending on the type of data contained in the QIF files to be imported, you may or may not see one
or more of the following screens:

Tradable
Commodities

This screen gives a description of the Tradable Commodities process on the screen.

Tip

This and other informational screens in the Import QIF files assistant can
be turned off in the Online Banking tab (see the section called “Online
Banking”) under GnuCash Preferences.

A series of screens, one for each of the stock, mutual fund, or commodity, displays
the exchange, full name, and symbol for each of the commodities listed in the QIF
file you are importing so that you can check them before proceeding.

Match duplicate
transactions

This screen gives a description of the Match duplicate transactions process on the
following Select possible duplicates screen.

Tip

This and other informational screens in the Import QIF files assistant can
be turned off in the Online Banking tab (see the section called “Online
Banking”) under GnuCash Preferences.

The next screen lets you Select possible duplicate transactions. Imported
transactions are shown on the left panel and possible matches to each selected
transaction are shown on the right.

• The left panel shows the list of Imported transactions to select from for matching
duplicates

• The right panel shows the list of possible duplicates for the selected imported
transaction. Select the one that most closely matches

7. The last screen, Update your GnuCash accounts, gives you a list of three choices to finish the assistant.

• Cancel: exit the process and cancel importing QIF files.

Warning

If you click this button, any selections you have made up to this point will be lost.

• Back: brings up the previous screen so that you can change a previous selection until the first screen.

• Forward: imports the data and creates the accounts you have specified.

You should now have successfully imported your accounts.

Tip

Imported transactions might need to be reconciled. This process is described in the GnuCash
Tutorial and Concepts guide.
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Tip of The Day
The Tip of the Day screen starts whenever you start GnuCash unless it has been disabled in the GnuCash
Preferences. It gives tips on features and using GnuCash. You can use the three buttons at the bottom of
the screen to look through the tips.

Close Dismiss the Tip of the Day screen

Prev Shows the previous tip

Forward Shows the next tip

The Show tips at startup check-box is used to enable or disable the Tip of the Day from running at GnuCash
start-up.

It is also possible to configure the Tip of the Day to run at start-up under the General tab in GnuCash
Preferences. The Tip of the Day can also be manually run by going to Help → Tip of the Day.
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Chapter 4. GnuCash Windows & Menus
Options Overview

The main GnuCash window displays the accounts, reports, menu selections and tools you may use to
process your financial data. This section gives you an overview of the different windows and sections of
windows that you will see in GnuCash.

Links in the various tables will lead to additional details on the topic.

GnuCash Windows and Menus

Main GnuCash Window
You can access commonly used sub-windows and tools through this window.

Figure 4.1. The Main GnuCash Window

The parts in which the main GnuCash window is divided.

When you start GnuCash, after a couple of windows (Splash screen, Tip of the Day) the main window
will be displayed. This window is divided into the following sections (see Figure 4.1, “The Main GnuCash
Window” for reference):

Titlebar Displays the name of the currently opened file and the active tab’s name
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Menubar Displays the available menu entries

Toolbar Displays the available Toolbar buttons

Tab bar Lists the open reports, registers and tree of accounts

Main pane The major display space showing the content of the currently selected tab

Summarybar Displays a financial summary

Statusbar Gives a description of the active menu item and shows a progress bar

Note

The contents and options within the various sub-menus of the different sections of the main
GnuCash window will vary upon the active display window.

The tree of accounts is labeled Accounts in the Tab bar, and displays all your accounts and their balances,
grouped according to standard accounting practice.

Tip

To open an additional view of the tree of accounts go to View → New Accounts Page. This will
open the account tree in the existing window.

Tip

To open a new window with a tree of accounts view, go to Windows → New Window with Page.

Account Tree Display
Figure 4.2. The Account Tree Display.

This is an image of the Accounts tab.
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Account Tree - Menus
The Menubar for the Accounts Tree window contains the following options.

Account Tree - File Menu

The following table describes the options in the File Menu.

Clicking on the File option of the Menubar will “pull down” a menu of options described in Table 4.1,
“Account Tree - File Menu - Access to file, account operations and printing.”.

Table 4.1. Account Tree - File Menu - Access to file, account operations and
printing.

Menu Item Description

New File (Ctrl+N) Creates a new data file (starts with new accounts and data.)

Open... (Ctrl+O) Opens an already existing GnuCash data file.

Import → Opens the Import sub-menu to import
files from other financial programs.

Import QIF... Starts the QIF file Import
process.

Import OFX/QFX... Starts the OFX/QFX file Import
process.

Import Accounts from CSV... Starts the CSV Account file
import process. The file to import
must be in the same format as the
one exported by GnuCash.

Import Transactions from CSV... Starts the CSV Transactions file
import process. The file to import
must be a delimited file.

Replay GnuCash .log file... Starts the replaying of a GnuCash
log file. Used for data recovery
from "crashes".

Import MT940 Import an end-of-day account
statement in SWIFT MT940
format into GnuCash.

Import MT942 Import an interim account
statement in SWIFT MT942
format into GnuCash.

Import DTAUS Import a traditional german
DTAUS file into GnuCash.

Import DTAUS and send Import a DTAUS file into
GnuCash and transmit its orders
by Online Banking.

Import Bills & Invoices... Open the Import Transactions
from text file window.

Import Customers and
Vendors ...

Open the Import Customers and
Vendors from text file window.
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Menu Item Description

Save (Ctrl+S) Saves the currently open file.

Save As... (Shift+Ctrl+S) Saves the currently opened file with a different name.

Warning

Do NOT store your data file in ~/.gnucash/books.

Revert Reload the last saved version of the currently opened file. Useful if
you need to discard changes made to the data and not yet saved.

Print This entry is only activated if a printable item like a report or an
invoice is selected..

Page Setup... (Shift+Ctrl+P) Lets you choose the paper size, layout and margins for printing.

Export → Opens the Export sub-menu.

Export Account Tree to CSV Exports your account hierarchy
to a delimited CSV file. Does not
export data.

Export Transactions to CSV Exports transactions to a
delimited CSV file.

Export Active Register to CSV... Export the active Register to a
CSV file.

Export Accounts Exports your account hierarchy
to a new GnuCashfile. Does not
export data.

Properties (Alt+Enter) Sets options for this GnuCash data file.

Recently opened files Numbered list of most recently opened GnuCash data files.

Close (Ctrl+W) Close the current tab.

Note

In the initial Account tree this item is not available - it will
be grayed out.

Quit (Ctrl+Q) Exits GnuCash.

Account Tree - Edit Menu

Table 4.2. Account Tree - Edit Menu - Access to file and account editing operations
and preferences.

Menu Item Description

Cut (Ctrl+X) Performs a standard Cut operation.

Copy (Ctrl+C) Performs a standard Copy operation.

Paste (Ctrl+V) Performs a standard Paste operation.

Edit Account (Ctrl+E) Modify name or characteristic of selected account.
the section called “Editing an Account”

Delete Account... (Delete) Remove an account. See the section called
“Deleting an Account”
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Menu Item Description

Renumber Subaccounts... Starts the Renumber Account assistant. See the
section called “Renumbering Subaccounts”.

Note

This item is selectable only if you have
highlighted an account with at least one
subaccount in the accounts tree.

Open Account Opens the register window for the currently
selected account.

Open Subaccount Opens a register window that displays all the
transactions for the selected account and for all its
subaccounts.

Find... (Ctrl+F) Set criteria for a search for a specific transaction.
See the section called “Find” for specifics on
searches.

Preferences (GnuCash → Preferences on MacOS). Customize GnuCash for location, style, and
numerous other preferences. See the section called
“Setting Preferences”.

Style Sheets Modify/customize Style Sheets. See the section
called “Changing Style Sheets”.

Tax Report Options Set tax characteristics on account(s) (US). Assign
tax form and line to account. See the section called
“Setting Tax Report Options”

Account Tree - View Menu

Table 4.3. Account Tree - View Menu - Changes display window view.

Menu Item Description

Toolbar Check-box to enable/disable display of Toolbar.

Summarybar Check-box to enable/disable display of
Summarybar .

Statusbar Check-box to enable/disable display of Statusbar.

Filter by ... Set filter for accounts displayed in the Account
Tree display.

Refresh (Ctrl+R) Repaint the display screen.

New Accounts Page Open a new tab that displays the account tree.

Account Tree - Actions Menu

Table 4.4. Account Tree - Actions Menu - Setup scheduled transactions, repair
accounts, perform stock splits, transfer and reconcile transactions.

Menu Item Description

Online Actions → Online Banking Submenu
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Menu Item Description

Note

This is shown only if WITH_AQBANKING
was set while building GnuCash.

Important

The menu entries will be enabled by the successful
completion of Tools → Online Banking Setup....

Note

Not all options are for all institutions available.

Get Balance Get the balance for the selected
account.

Get Transactions... Get the transactions online
through Online Banking.

Issue SEPA Transaction... Issue a new international
European (SEPA) transaction
online through Online Banking.

Internal Transaction... Issue a new bank-internal
transaction online through Online
Banking.

Issue SEPA Direct Debit... Issue a new international
European (SEPA) direct debit
note online through Online
Banking.

Show log window... Open the Online Banking
Connection Window

Scheduled Transactions → Scheduled Transactions sub-menus

Scheduled Transaction Editor Invoke tool to edit scheduled
transactions. See the section
called “Edit Scheduled
Transaction Window”

Since Last Run... Display Scheduled transactions
since last running of GnuCash.
the section called “Since Last
Run Assistant”

Mortgage & Loan Repayment... Starts the Mortgage & Loan
Repayment assistant for setting
up repayments. the section called
“Mortgage & Loan Repayment
Assistant”

Budget → Budget sub-menus

New Budget Opens the window to create a
new budget.
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Menu Item Description

Open Budget Opens an existing budget.

Copy Budget Copy a budget.

New Account... Creates a new account and opens the account properties window.

New Account Hierarchy... Starts the New Account Hierarchy Setup assistant.

Transfer... (Ctrl+T) Starts the Transfer assistant for transfer between accounts.

Reconcile... Open the Reconcile window. the section called “Reconciling an
Account to a Statement”

Auto clear... Opens the auto-clear screen where you can fill up the automatic
clear information.

Stock Split... Starts the Stock Split assistant. Additional details the section called
“Recording a Stock Split”

View Lots... Opens the Lots in Account form.

Check & Repair → Check & Repair Submenus

Check & Repair Account Check for and repair unbalanced
transactions and orphan splits in
this account.

Check & Repair Subaccounts Check for and repair unbalanced
transactions and orphan splits in
this account and its subaccounts.

Check & Repair All Check for and repair unbalanced
transactions and orphan splits in
all accounts.

Reset Warnings... GnuCash gives warnings when certain operations are attempted,
such as removing a transaction or removing the splits of a
transaction. The warning message gives you the option to not give
you these warnings when attempting the operation. Check-boxes
labeled Remember and don’t ask me again and Remember and don’t
ask me again this session allow disabling the warnings. This option
resets the warnings to the default, i.e. display all warnings.

Tip

Warnings may be selectively enabled.

Rename Page Open the form to rename the current page/tab.

Account Tree - Business Menu

Table 4.5. Account Tree - Business Menu - Access small business features of
GnuCash.

Menu Item Description

Customer → Select customer related activities.

Customers Overview Open a customers overview page.

New Customer... Start the form to create a new
customer.
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Menu Item Description

Find Customer... Start the assistant to search for a
customer.

New Invoice... Start the form to create a new
invoice.

Find Invoice... Start the assistant to search for an
invoice.

New Job... Start the form to create a new
job.

Find Job... Start the assistant to search for a
job.

Process Payment... Starts the Process Payment
assistant. Requires an account of
type "A/Payable" before running
assistant.

Vendor → Select vendor related activities.

Vendors Overview Open a vendors overview page.

New Vendor... Start the form to create a new
vendor.

Find Vendor... Start the assistant to search for a
vendor.

New Bill... Start the form to create a new
bill.

Find Bill... Start the assistant to search for a
bill.

New Job... Start the form to create a new
job.

Find Job... Start the assistant to search for a
job.

Process Payment... Starts the Process Payment
assistant. Requires an account of
type "A/Payable" before running
assistant.

Employee → Select employee related activities.

Employees Overview Open an employees overview
page.

New Employee... Start the form to create a new
employee.

Find Employee... Start the assistant to search for an
employee.

New Expense Voucher... Start the form to create a new
expense voucher.

Find Expense Voucher... Start the assistant to search for an
expense voucher.
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Menu Item Description

Process Payment... Starts the Process Payment
assistant. Requires an account of
type "A/Payable" before running
assistant.

Sales Tax Table View and edit the list of tax tables.

Billing Terms Editor View and edit the list of Billing Terms.

Bills Due Reminder View and edit the list of Bills Due Reminder.

Account Tree - Reports Menu

This is a brief listing of each of the available reports and graphs. See the section called “Reports Listed
By Class” for specific report details. Each report or graph may be customized by selecting a different
Stylesheet or by pressing the Options button in the Toolbar.

Table 4.6. Account Tree - Reports Menu - Access GnuCash Reports and Charts.

Menu Item Description

Assets & Liabilities →

Advanced Portfolio

Asset Barchart

Asset Piechart

Average Balance

Balance Sheet

Balance Sheet using eguile-gnc

General Journal

General Ledger

Investment Portfolio

Liability Barchart

Liability Piechart

Net Worth Barchart

Net Worth Linechart

Price Scatterplot

Business Reports →

Customer Report

Customer Summary

Easy Invoice

Employee Report

Fancy Invoice

Job Report

Payable Aging

Printable Invoice

Receivable Aging
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Menu Item Description

Tax Invoice

Vendor Report

Income & Expense →

Cash Flow

Equity Statement

Expense Barchart

Expense Piechart

Expenses vs. Day of Week

Income & Expense Chart

Income Barchart

Income Piechart

Income Statement

Income vs. Day of Week

Profit & loss

Trial Balance

Sample & Custom →

Welcome Sample Report

Custom Multicolumn Report

Sample Report With Examples

Budget →

Budget Balance Sheet

Budget Barchart

Budget Flow

Budget Income Statement

Budget Profit & Loss

Budget Report

Account Summary Report showing the balance of selected accounts.

Future Scheduled Transactions
Summary

Report showing a summary of future transactions.

Tax Schedule Report & TXF
Export

Create a Tax report (US) and/or export data for tax preparation
software. (TXF)

Transaction Report

Saved Report Configurations Open the screen to manage saved user configured reports.
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Account Tree - Tools Menu

Table 4.7. Account Tree - Tools Menu - Access to miscellaneous tools and editors

Menu Item Description

Online Banking Setup... Performs the initial setup of an account for Online
Banking access (FinTs, OFX DirectConnect, ...)
by AqBanking, if GnuCash was built with the
option WITH_AQBANKING. the section called
“The Online Banking Setup Assistant”

Price Editor Tool to enter or modify Stock/Fund prices. Details
at the section called “Price Editor”

Security Editor Tool to enter or modify Stock or commodities.
Details at the section called “Security Editor”

Loan Repayment Calculator Details at the section called “Loan Repayment
Calculator”

Close Book Open a screen where you can enter the required
information to close the current accounting period.
See the section called “Close Book”.

General Journal See the section called “General Journal”

Account Tree - Windows Menu

Table 4.8. Account Tree - Windows Menu

Menu Item Description

New Window Opens a new GnuCash empty window.

New Window with Page Moves the current tab into a new window.

Opened windows A numbered list of open windows.

Account Tree - Help Menu

Table 4.9. Account Tree - Help Menu - Access to this help and the Tutorial and
Concepts Guide.

Menu Item Description

Tutorial & Concepts Guide Explanation of accounting principles and how to
apply them in GnuCash

Tips Of The Day Shows short notes about features you might
otherwise miss.

Contents Open this document.

About Show the information screen with GnuCash version,
license and credits

Account Tree - Toolbar Icons/Buttons
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The GnuCash main Window has a number of buttons in the Toolbar to quickly access some common
functions used with the specific active tab. The Toolbar can be hidden or shown by selecting View →
Toolbar. The specific options displayed in the Toolbar vary with the functions available to the "active tab".

A brief description of the function of a Toolbar button is displayed when the mouse pointer is placed over
the icon for a couple of seconds.

Table 4.10. Account Tree - Window Toolbar

Toolbar Buttons Description

Save (Ctrl+S) Perform a save on the data file, commit all
transactions to the data file.

Close (Ctrl+W) Close the currently active account page

Note

This icon is not available for the first
accounts tab. It is available for additional
account tree displays.

Open Open a transaction register of the selected account.

Edit Edit the characteristics for the selected account. the
section called “Editing an Account”

New Start the assistant for creating a new account. the
section called “Creating a New Account”

Delete Remove the selected account. the section called
“Deleting an Account”

Tab bar
The Tab bar displays “file/notebook folder” style tabs for open transaction registers, reports and the
account tree.

Main pane - Account tree
The account tree displays the list of your accounts in hierarchical format. This enables you to organize
your accounts by type.

Tip

The triangle shape (or plus sign) beside the account name is used to open and close the account
tree. When you click on the triangle (plus sign), it changes from a rightward-pointing into a
downward-pointing sign (minus sign) to indicate that the tree is opened. You will then see offset
below the account name either a list of the sub account(s) or another triangle (plus sign) to the
left of an account. This indicates another lower level of the account tree.

In the main pane are also shown, by default, four columns: Account Name, Type, Description and Total.
For each account, this informations, if available, is displayed in the same row of the account.

Tip

The columns shown for each account in the Account Tree can be customized to suit your needs.
Click on the arrow icon on the far right of the Account Tree window to display a drop down list
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of column options. Click on a column description to add it to the Account Tree window. Click
again on the column description to hide it.

The default display for the account tree window is in Notebook mode. This is indicated by the tab in the tab
row of the main window. Other tabs will appear beside this one when you open reports, account registers
or additional account trees.

Summarybar
The Summarybar displays balances appropriate for the opened account type at a glance. Usually accounts
display today’s account balance, any balance for future dates, a balance for cleared items and a reconciled
balance. Stock accounts, however, display shares totals and their value. The Summarybar can be hidden
or shown by selecting View → Summarybar.

Statusbar
The Statusbar displays informations about the currently highlighted menu item. It also shows a progress
bar when opening or saving a GnuCash data file or generating reports. The Statusbar can be hidden or
shown by selecting the Statusbar item on the View menu.

Account Register/General Journal

Account Register & General Journal Window
This window is used to enter and edit your account data. It also provides tools for scheduling future
transactions, finding and reporting on transactions and printing checks.

To open the Account Register Window for an account, select the account in the Account Tree then go to
File → Open Account or press Ctrl+O. This will open a new window with the Account Register. Pressing
the Open button on the Toolbar in the Account Tree Window or the Jump button in the Account Register
Window are alternate methods.

Figure 4.3. The Account Register Display.

This is an image of the Account Register tab.
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Tip

Appearance of the Account Register Display is highly customizable (see  Tutorial and
Concepts Guide, Choosing a Register Style [https://www.gnucash.org/docs/v3/C/gnucash-guide/
txns-register-oview.html#txns-regstyle1]).

Note

The methods to enter transactions are described in detail in Chapter 6, Common Transaction
Operations.

Account Register Menus
The Menubar for the Transaction Register window contains the following options.

Account Register - File Menu

The following table describes the options in the File.

Clicking on File in the Menubar will “pull down” a menu of choices described in Table 4.11, “Account
Register - File Menu - Access to file and account operations and printing.”.

Table 4.11. Account Register - File Menu - Access to file and account operations
and printing.

Menu Item Description

New File (Ctrl+N) Creates a new data file (starts with new accounts and data.)

Open... (Ctrl+O) Opens an already existing GnuCash data file.

Import → Opens the Import sub-menu to import
files from other financial programs.

Import QIF ... Starts the QIF file Import
process.

Import OFX/QFX ... Starts the OFX/QFX file Import
process.

Import Accounts from CSV... Starts the CSV Account file
import process. The file to import
must be in the same format as the
one exported by GnuCash.

Import Transactions from CSV... Starts the CSV Transactions file
import process. The file to import
must be a delimited file.

Replay GnuCash .log file... Starts the replaying of a GnuCash
log file. Used for data recovery
from "crashes".

Import MT940 Import an end-of-day account
statement in SWIFT MT940
format into GnuCash.

Import MT942 Import an interim account
statement in SWIFT MT942
format into GnuCash.
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Menu Item Description

Import DTAUS Import a traditional german
DTAUS file into GnuCash.

Import DTAUS and send Import a DTAUS file into
GnuCash and transmit its orders
by Online Banking.

Import Bills & Invoices... Open the Import Transactions
from text file window.

Import Customers and
Vendors ...

Open the Import Customers and
Vendors from text file window.

Save (Ctrl+S) Saves the currently open file.

Save As... (Shift+Ctrl+S) Saves the currently opened file with a different name.

Warning

Do NOT store your data file in ~/.gnucash/books.

Print Checks... (Ctrl+P) Starts the Print Checks assistant. See the section called “Printing
Checks”.

Page Setup... (Shift+Ctrl+P) Let you choose the paper size, layout and margins for printing.

Export → Exports ...

Export Accounts Tree to CSV Exports your account hierarchy
to a delimited CSV file. Does not
export data.

Export Transactions to CSV Exports transactions to a
delimited CSV file.

Export Accounts Exports your account hierarchy
to a new GnuCashfile. Does not
export data.

Properties (Alt+Enter) Sets options for this GnuCash data file.

Recently opened files Numbered list of most recently opened GnuCash data files.

Close (Ctrl+W) Closes the currently opened transaction register.

Quit (Ctrl+Q) Exits GnuCash.

Account Register - Edit Menu

Table 4.12. Account Register - Edit Menu - Access to file and account editing
operations and preferences.

Menu Item Description

Cut (Ctrl+X) Performs a standard Cut operation.

Copy (Ctrl+C) Performs a standard Copy operation.

Paste (Ctrl+V) Performs a standard Paste operation.

Assign as payment... Assign as payment the selected transaction.

Edit Account Open form to edit/modify account characteristics
and parameters.

23



GnuCash Windows &
Menus Options Overview

Menu Item Description

Find... (Ctrl+F) Set criteria for a search for a specific transaction.
See the section called “Find” for specifics on
searches.

Preferences (GnuCash → Preferences on MacOS). Customize GnuCash for location, style, and
numerous other preferences. See the section called
“Setting Preferences”.

Style Sheets Modify/customize Style Sheets.

Tax Report Options Set tax characteristics on account(s) (US). Assign
tax form and line to account. See the section called
“Setting Tax Report Options”.

Account Register - View Menu

Table 4.13. Account Register - View Menu - Changes GnuCash display window
characteristics.

Menu Item Description

Toolbar Check-box to enable/disable display of Toolbar.

Summarybar Check-box to enable/disable display of Summary Bar.

Statusbar Check-box to enable/disable display of Status Bar.

Basic Ledger Radio button to select register display mode. See  Tutorial
and Concepts Guide, Choosing a Register Style [https://
www.gnucash.org/docs/v3/C/gnucash-guide/txns-register-
oview.html#txns-regstyle1].

Auto-Split Ledger Radio button to select register display mode.

Transaction Journal Radio button to select register display mode.

Double Line Check-box to enable/disable display of Double Line display.

Sort by... Set the sort order of the transactions display. Requires a click to start
options form. Option form requires Cancel/OK to close.

Standard Order Keep normal account order

Date Sort by date

Date of Entry Sort by date of entry.

Statement Date Sort by the statement date
(unreconciled items last).

Number Sort by number.

Amount Sort by amount.

Memo Sort by memo.

Description Sort by Description.

Action Sort by action field.

Notes Sort by notes field.

Reverse Order Reverse the sort order.

Save Sort Order Save the sort order between
sessions.
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Menu Item Description

Filter by ... Set filtering for accounts displayed in the Account Tree or
transactions in Register display.

Refresh (Ctrl+R) Repaint the display screen.

New Accounts Page Open a new tab that displays the
account tree.

Account Register - Transaction Menu

Table 4.14. Account Register - Transaction Menu - access to transaction tools.

Menu Item Description

Cut Transaction Cut the selected transaction into the clipboard.

Copy Transaction Copy the selected transaction into the clipboard.

Paste Transaction Paste the selected transaction from the clipboard.

Duplicate Transaction Insert in the register a copy of the selected
transaction.

Delete Transaction Delete the selected transaction.

Remove Other Splits Remove all splits from the selected transaction.

Enter Transaction Enter in the register the transaction you are
currently working on.

Cancel Transaction Blanks all fields in the selected transaction if it has
not yet been recorded.

Void Transaction Void the selected transaction.

Unvoid Transaction Unvoid the selected transaction.

Add Reversing Transaction Add a copy of the selected transaction with an
inverted amount.

Associate File with Transaction Associate a file with the selected transaction.

Associate Location with Transaction Associate a URL with the selected transaction.

Open Associated File/Location Open the file or location associated with the
transaction. Available if a file or location was
associated with the currently selected transaction.

Account Register - Actions Menu

Table 4.15. Account Register - Actions Menu - Setup scheduled transactions, repair
accounts, perform stock splits, transfer and reconcile transactions.

Menu Item Description

Online Actions → This menu item (and sub-menu) is shown only
if Online Banking was enabled for GnuCash

Get Balance

Get Transactions Download transactions from
online accounts
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Menu Item Description

Issue Transaction... Upload transaction(s) to online
account ??

Issue SEPA Transaction...

Internal Transaction...

Direct Debit...

Show log window... Open the Online Banking
Connection Window

Scheduled Transactions → Scheduled Transactions sub-menus

Scheduled Transaction Editor Invoke tool to edit scheduled
transactions. See the section
called “Edit Scheduled
Transaction Window”

Since Last Run... Display Scheduled transactions
since last running of GnuCash.
the section called “Since Last
Run Assistant”

Mortgage & Loan Repayment... Starts the Mortgage & Loan
Repayment assistant for setting
up repayments. the section called
“Mortgage & Loan Repayment
Assistant”

Budget → Budget sub-menus

New Budget Opens the window to create a
new budget.

Open Budget Opens an existing budget.

Copy Budget Copy a budget.

Transfer... (Ctrl+T) Starts the Transfer assistant for transfer between accounts.

Reconcile... Start the Reconcile process for the selected account. the section
called “Reconciling an Account to a Statement”

Stock Split... Starts the Stock Split assistant. Additional details the section called
“Recording a Stock Split”

View Lots... Opens the Lots in Account form.

Blank Transaction Move to the blank transaction at the bottom of the register

Split Transaction Expand the currently selected transaction to show splits.

Edit Exchange Rate Edit the exchange rate for the current transaction.

Schedule... Create a Scheduled Transaction with the current transaction as a
template.

Jump Jump to the corresponding transaction in the other account.

Check & Repair → Check & Repair Submenus

All Transactions Check for and repair unbalanced
transactions and orphan splits in
this account.
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Menu Item Description

This Transaction Check for and repair splits in this
transaction.

Reset Warnings... GnuCash gives warnings when certain operations are attempted,
such as removing a transaction or removing the splits of a
transaction. The warning message gives you the option to not give
you these warnings when attempting the operation. Check-boxes
labeled Remember and don’t ask me again and Remember and don’t
ask me again this session allow disabling the warnings. This option
resets the warnings to the default, i.e. display all warnings.

Tip

Warnings may be selectively enabled.

Rename Page Open the form to rename the current page/tab.

Account Register - Business Menu

The items shown in the Business menu are the same as listed in Table 4.5, “Account Tree - Business Menu
- Access small business features of GnuCash.”.

Account Register - Reports Menu

The items shown in the Reports menu are the same as listed in Table 4.6, “Account Tree - Reports Menu
- Access GnuCash Reports and Charts.” plus the two types of report listed in the following.

• Account report

• Account Transaction Report

Account Register - Tools Menu

The items shown in the Tools menu are the same as listed in Table 4.7, “Account Tree - Tools Menu -
Access to miscellaneous tools and editors”.

Account Register - Windows Menu

The items shown in the Windows menu are the same as listed in Table 4.8, “Account Tree - Windows
Menu”.

Account Register - Help Menu

The items shown in the Help menu are the same as listed in Table 4.9, “Account Tree - Help Menu - Access
to this help and the Tutorial and Concepts Guide.”.

Account Register - Toolbar Icons/Buttons
The GnuCash main Window has a number of icons/buttons in the Toolbar to quickly access some common
functions used with the specific active tab. The Toolbar can be hidden or shown by selecting the Toolbar
item on the View menu.

Note

The specific options displayed in the Toolbar varies by the functions available to the active tab.
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A brief description of the function of a button is displayed when the mouse pointer is placed over the
button for a couple of seconds.

Table 4.16. Account Register (Transaction Register) Window Toolbar

Toolbar Buttons Description

Save (Ctrl+S) Perform a save on the data file, commit all
transactions to the data file.

Close Close this register.

Duplicate Make a copy of the current transaction.

Delete Delete the current transaction in this register.

Enter Record the current transaction.

Cancel Cancel the current transaction.

Blank Move to a blank transaction at bottom of register.

Split Show all splits in the current transaction. Not
highlighted if View → Auto-Split Ledger is enabled.

Jump Jump to the corresponding transaction in the other
account

Schedule Create a Scheduled Transaction with the current
transaction as a template.

Transfer Start the transfer assistant to transfer funds from one
account to another.

Reconcile Start the Reconcile process for the selected account.
the section called “Reconciling an Account to a
Statement”

Tab Bar

The Tab bar displays “notebook/file folder” style tabs for open transaction registers, account trees and
reports.

List of Transactions

The List of Transactions displays transactions you have entered and a running balance. It also provides a
blank transaction to enter new transactions. The column headings vary according to what type of account
you have opened. Common headings are Date, Description, Transfer and Balance.

The View menu can be used to alter the appearance of the List of Transactions. Possible changes are
limiting the number of transactions shown, using a different sort order and changing the style to more
easily see transactions. The Split button also provides quick access to view all the parts of a transaction.

Summarybar

The Summarybar displays balances appropriate for the opened account type at a glance. Usually accounts
display Present (today’s) account balance, any balance for Future dates, a balance for Cleared items, a
Reconciled balance and a Projected Minimum balance. Stock accounts, however, display shares totals and
their value. The Summarybar can be hidden or shown by selecting the View → Summarybar item.
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Statusbar
The Statusbar works the same as described in the section called “Statusbar”.

Report Window
Report Display Window

This window is shown whenever a report or chart is selected from the Reports menu.

To open the report window, select a report from the Reports item in the Menubar. This will open a new
window with the report displayed. It provides a web browser type display with active links to account data.

Note

Depending on the report there may be a delay while the report is generated. An approximation of
the progress to completion is displayed in the Statusbar, if has not been opted out of displaying.

Figure 4.4. The Report Window

This is an image of the Income/Expense Chart.

Report Menus
The Menubar for the report window contains the following options.

Reports - File Menu
The following table describes the options in the File Menu.
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Clicking on the File option of the Menubar will “pull down” a menu of options described in Table 4.17,
“Report - File Menu - Access to file and account operations and printing.”.

Table 4.17. Report - File Menu - Access to file and account operations and printing.

Menu Item Description

New File (Ctrl+N) Creates a new data file (starts with new accounts and data.)

Open... (Ctrl+O) Opens an already existing GnuCash data file.

Import → Opens the Import sub-menu to import
files from other financial programs.

Import QIF ... Starts the QIF file Import
process.

Import OFX/QFX ... Starts the OFX/QFX file Import
process.

Import Accounts from CSV... Starts the CSV Account file
import process. The file to import
must be in the same format as the
one exported by GnuCash.

Import Transactions from CSV... Starts the CSV Transactions file
import process. The file to import
must be a delimited file.

Replay GnuCash .log file... Starts the replaying of a GnuCash
log file. Used for data recovery
from "crashes".

Import MT940 Import an end-of-day account
statement in SWIFT MT940
format into GnuCash.

Import MT942 Import an interim account
statement in SWIFT MT942
format into GnuCash.

Import DTAUS Import a traditional german
DTAUS file into GnuCash.

Import DTAUS and send Import a DTAUS file into
GnuCash and transmit its orders
by Online Banking.

Import Bills & Invoices... Open the Import Transactions
from text file window.

Import Customers and
Vendors ...

Open the Import Customers and
Vendors from text file window.

Save (Ctrl+S) Saves the currently open file.

Save As... (Shift+Ctrl+S) Saves the currently opened file with a different name.

Warning

Do NOT store your data file in ~/.gnucash/books.

Revert Reload the last saved version of the currently opened file. Useful if
you need to discard changes made to the data and not yet saved.
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Menu Item Description

Print Report... (Ctrl+P) Print the selected report.

Page Setup... (Shift+Ctrl+P) Let you choose the paper size, layout and margins for printing.

Export as PDF → Exports the displayed report as a PDF file.

Export → Opens the Export sub-menu.

Export Accounts Tree to CSV Exports your account hierarchy
to a delimited CSV file. Does not
export data.

Export Transactions to CSV Exports transactions to a
delimited CSV file.

Export Report Export the current report in an
HTML formatted file.

Export Accounts Exports your account hierarchy
to a new GnuCashfile. Does not
export data.

Properties (Alt+Enter) Sets options for this GnuCash data file.

Recently opened files Numbered list of most recently opened GnuCash data files.

Close (Ctrl+W) Closes the current report.

Quit (Ctrl+Q) Exits GnuCash.

Report - Edit Menu

Table 4.18. Reports - Edit Menu - Access to file and account editing operations and
preferences.

Menu Item Description

Cut (Ctrl+X) Performs a standard Cut operation.

Copy (Ctrl+C) Performs a standard Copy operation.

Paste (Ctrl+V) Performs a standard Paste operation.

Find... (Ctrl+F) Set criteria for a search for a specific transaction.
See the section called “Find” for specifics on
searches.

Preferences (GnuCash → Preferences on MacOS). Customize GnuCash for location, style, and
numerous other preferences. See the section called
“Setting Preferences”.

Style Sheets Modify/customize Style Sheets.

Report Options Open form to edit/modify report selection
criteria, stylesheets, date ranges, and many other
parameters.

Tax Report Options Set tax characteristics on account(s) (US). Assign
tax form and line to account. See the section called
“Setting Tax Report Options”.
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Report - View Menu

Except Filter By..., the items shown in the View menu are the same as listed in Table 4.3, “Account Tree
- View Menu - Changes display window view.”

Report - Actions Menu

Table 4.19. Reports - Actions Menu - Setup scheduled transactions.

Menu Item Description

Online Actions → This menu item (and sub-menu) is shown only
if Online Banking was enabled for GnuCash

Show log window... Open the Online Banking
Connection Window

Scheduled Transactions → Scheduled Transactions sub-menus

Scheduled Transaction Editor Invoke tool to edit scheduled
transactions. See the section
called “Edit Scheduled
Transaction Window”

Since Last Run... Display Scheduled transactions
since last running of GnuCash.
the section called “Since Last
Run Assistant”

Mortgage & Loan Repayment... Starts the Mortgage & Loan
Repayment assistant for setting
up repayments. the section called
“Mortgage & Loan Repayment
Assistant”

Budget → Budget sub-menus

New Budget Opens the window to create a
new budget.

Open Budget Opens an existing budget.

Copy Budget Copy a budget.

Reset Warnings... GnuCash gives warnings when certain operations are attempted,
such as removing a transaction or removing the splits of a
transaction. The warning message gives you the option to not give
you these warnings when attempting the operation. Check-boxes
labeled Remember and don’t ask me again and Remember and don’t
ask me again this session allow disabling the warnings. This option
resets the warnings to the default, This option resets the warnings to
the default, i.e. display all warnings.

Tip

Warnings may be selectively enabled.

Rename Page Lets you type a new name for the current page or tab.
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Report - Business Menu

The items shown in the Business menu are the same as listed in Table 4.5, “Account Tree - Business Menu
- Access small business features of GnuCash.”.

Report - Reports Menu

The items shown in the Reports menu are the same as listed in Table 4.6, “Account Tree - Reports Menu
- Access GnuCash Reports and Charts.” with the addition of:

Table 4.20. Report - Reports Menu.

Menu Item Description

Save Report Configuration Save the current report configuration. If you are not working with a
saved report configuration, you will be asked to give it a name. You
will be able to run the exact same report again by using the Reports 
→ Saved Report Configurations menu item.

Save Report Configuration As... Save the current report configuration with a new name.

Report - Tools Menu

The items shown in the Tools menu are the same as listed in Table 4.7, “Account Tree - Tools Menu -
Access to miscellaneous tools and editors”.

Report - Windows Menu

The items shown in the Windows menu are the same as listed in Table 4.8, “Account Tree - Windows
Menu”.

Report - Help Menu

The items shown in the Help menu are the same as listed in Table 4.9, “Account Tree - Help Menu - Access
to this help and the Tutorial and Concepts Guide.”.

Reports - Toolbar Icons/Buttons
The Report Window has a Toolbar to quickly access the functions used with reports. The Toolbar can be
hidden or shown by selecting View → Toolbar.

Table 4.21. Reports - Toolbar Buttons

Toolbar Button Description

Save (Ctrl+S)

Close (Ctrl+W) Closes the displayed report.

Back Move back one step in the history.

Forward Move forward one step in the history.

Reload Reload (rerun) current report.

Stop Stops the HTML requests.

Save Report Configuration Saves the displayed report. You will be able to run
the exact same report again by using the Reports →
Saved Report Configurations menu item.
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Toolbar Button Description

Save Report Configuration As... Saves the displayed report in a configuration file
with a given name. You will then be able to run
the exact same report again by using the Reports →
Saved Report Configurations menu item.

Export Exports HTML formatted report to a file.

Options Edit options specific to selected report.

Print (Ctrl+P) Queues the current report for printing.

Export as PDF Exports the selected report as a PDF file.

Tab Bar
The Tab bar displays “notebook/file folder”-style tabs for open transaction registers, account trees and
reports.

Report Main Display
This is where the report or chart you have selected is shown. The properties of this window are editable in
two ways. Selecting the Options button on the Toolbar lets you edit what the report is showing and which
accounts the information is drawn from. Selecting Edit → Style Sheets... lets you select the properties of
the page that displays your report.

The report is able to act like a web browser if your report contains links to external web pages. The Toolbar
buttons allow you to move Back and Forward through web pages. It will also open account registers when
you click on links to accounts contained in the report.

You can also Export your report to a file and Print the report through the Toolbar buttons.

Summarybar
The Summarybar is not displayed when viewing a report window.

Statusbar
The Statusbar works the same as described in the section called “Statusbar”.

Reconcile Window
To simplify navigation the following are the topics covered in this section; the section called “Reconcile
Display Window”, the section called “Menus”, the section called “Toolbar Buttons”.

The detailed explanation of reconciling an account is described in the section called “Reconciling an
Account to a Statement”.

Reconcile Display Window
To open the Reconcile window, click Actions → Reconcile... from the Menubar or the Reconcile button
from the Toolbar in a register window. This will open a Reconcile screen in which you need to enter the
Statement Date and the Ending Balance. If you select the Include subaccounts option, all transactions in
the subaccounts of the selected account will also be counted for the reconcile operation. Pressing the OK
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button will open a Reconcile window allowing you to compare deposit and withdrawal transactions to
your statement.

Table 4.22. Components of the Reconcile Window.

Component Description

Menubar Contains the Menus used in the Reconcile Window.

Toolbar (Icons and/or Text) Contains buttons used to access common Reconcile
Account Window tasks.

Funds In This pane in the left contains a list of funds deposited
in the account.

Funds Out This pane in the right contains a list of funds
withdrawn from the account.

Balance Pane This pane in the lower right contains a list of
balances useful for reconciling.

Menus

The following tables describe menus in the Reconcile Window.

Table 4.23. Reconcile Menu - Access to Reconcile Information and finishing or
postponing.

Menu Item Description

Reconcile Information... Opens the Reconciling Information Window.

Finish (Ctrl+F) Complete the reconciliation of this account.

Postpone (Ctrl+P) Postpone the reconciliation of this account.

Cancel Cancel the reconciliation of this account.

Table 4.24. Account Menu - Access to account operations.

Menu Item Description

Open Account Opens a transaction register for the accounts

Edit Account Modify name or characteristic of selected account.
the section called “Editing an Account”

Transfer... (Ctrl+T) Opens a Transfer assistant for entering a transfer
transaction between any two accounts.

Check & Repair Verify and repair this account if necessary.

Table 4.25. Transaction Menu - Access to transaction editing operations.

Menu Item Description

New Add a new transaction to the account.

Balance Opens the account‘s register window with a pre-
compiled balancing transaction.

Edit Edit the currently selected transaction.

Delete Remove the currently selected transaction.
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Table 4.26. Help Menu - Access to help.

Menu Item Description

Help Open this Help text file.

Toolbar Buttons

The Reconcile window has a Toolbar to quickly access some common functions used with reconciliation.

Table 4.27. Reconcile Window Toolbar

Toolbar Button Description

New Add a new transaction to the account.

Balance Opens the account‘s register window with a pre-
compiled balancing transaction.

Edit Edit the currently selected transaction.

Delete Remove the currently selected transaction.

Open Open an Account transaction window.

Finish Complete the reconciliation of this account.

Note

This button is not active (grayed out) until
the Difference value in the balance pane
(lower right) is 0.

Postpone Postpone the reconciliation of this account.

Cancel Cancel the reconciliation of this account.

Schedule Transaction Window
To simplify navigation the following are the topics covered in this section; the section called “Scheduled
Menu”, the section called “Scheduled Transactions Toolbar Buttons”, the section called “Scheduled
Transactions Window”. the section called “Edit Scheduled Transaction Window”,

The detailed explanation of scheduling transactions is described in the section called “Scheduling
Transactions”.

Scheduled Transactions Main Display Window
This window is shown when Actions → Scheduled Transactions → Scheduled Transactions Editor is
selected from the Menubar. This will open a new tab window with the Scheduled Transactions displayed.

Scheduled Transaction Main Window Components

Table 4.28. Components of the Schedule Transactions Window.

Component Description

Menubar Contains the Menus used in the Schedule
Transactions Window. It provides the standard
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Component Description

list of Menubar options and an additional option,
Scheduled, which presents options; New, Edit or
Delete. If no transaction is highlighted Edit and
Delete will be "grayed out".

Toolbar (Icons and/or Text) Contains buttons used to access Schedule
Transitions tasks.

Tabs Tabs to switch between open displays.

Transactions The Transactions pane contains a list of transactions
scheduled and related characteristics.

Upcoming The Upcoming pane contains a calendar of the next
months In this calendar the days in which one or
more transactions are scheduled, are highlighted
with a circle.

You can change the time interval displayed in the
calendar by selecting a different period from the
View: drop down list on the right.

Tip

Click on a date in the pane and the details
about the scheduled transactions on that
date will be displayed.

Scheduled Menu

The following table describe the Scheduled menu options available in the Menubar when you are in the
Scheduled Transaction window.

Table 4.29. Scheduled Menu - Access to scheduled transaction editing operations.

Menu Item Description

New Add a new scheduled transaction.

Edit Edit the currently selected transaction.

Delete Remove the currently selected transaction.

Scheduled Transactions Toolbar Buttons

The Scheduled Transactions window has a Toolbar to quickly access some common functions used with
scheduling.

Table 4.30. Scheduled Transactions Window Toolbar

Toolbar Button Description

Save (Ctrl+S) Save the current schedule of transactions.

Close (Ctrl+W) Close the Scheduled Transactions window.

New Add a new scheduled transaction.

Edit Edit the currently selected transaction.
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Toolbar Button Description

Delete Remove the currently selected transaction.

Budget Window
Actions → Budget → Open Budget will open the default budget or offer you a choice if there is more than
one budget. A new tab will open with the budget displayed.

Budget Window Menus
Here are some menu items that are particularly useful to working with budgets.

Budget Window - Edit menu

Table 4.31. Edit Menu - Special items for the budget window.

Menu Item Description

Estimate Budget Estimate a budget value for the selected accounts
from past transactions.

Delete Budget Delete this budget.

Budget Options Edit this budget’s options.

Budget Window - Actions menu

Table 4.32. Actions Menu - Items in the standard menu that relate to budgets.

Menu Item Description

Budget → Opens the Budget sub-menu to select budget actions.

New Budget Create a new budget and open it
in a new tab.

Open Budget If no budget exists, create a new
budget and open it. If only one
budget exists, open it; otherwise
user selects one to open.

Copy Budget If no budgets exist yet, just
open a new budget. If only one
budget exists, create a copy of
it; otherwise user selects one to
copy. If a copy is made, then the
copy is opened in a new tab.

Budget Window - Reports menu

Using more than one budget

When there is more than one budget, the reports will use the budget selected in book options by
default. See the section called “Book Options” and the section called “Budgeting Book Options
Tab” for more details. After the report is displayed, the budget it uses can be changed in the report
options General tab.
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Table 4.33. Reports Menu - Items in the standard menu that relate to budgets.

Menu Item Description

Budget → Opens the Budget sub-menu to select a budget report.

Budget Balance Sheet

Budget Barchart

Budget Flow This report includes information
from one budget period at a time.
The left column of numbers
shows the budgeted amounts,
and the right column of numbers
shows the actual amounts. It only
shows certain accounts, those
that have no sub-accounts.

Budget Income Statement

Budget Profit & Loss This report is identical to the
Budget Income Statement report.

Budget Report The budget report shows all
accounts and all periods. For
each period it gives the budgeted
amount and the actual amount.
There is an option to add another
column showing the difference
(budgeted - actual).

Budget Window Toolbar Buttons
The Budget window has a Toolbar to quickly access common functions used with budgeting.

Table 4.34. Budget Window Toolbar

Toolbar Button Description

Save (Ctrl+S) Save the current budget.

Close (Ctrl+W) Close the Budget window.

Options Edit this budget’s options.

Estimate Estimate a budget value for the selected accounts
from past transactions.

Delete Delete this budget.

Budget Window Main Display
The budget window contains a list of accounts down the left hand side, and a set of columns down the
right hand side that represent budget values. Each column corresponds to a budget period. The number of
periods for a budget can be changed using the Budget Options dialog.

Procedure 4.1. Entering a budget value

1. Click the row corresponding to the account you wish to budget
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2. Choose the period this value is for, and click in the cell corresponding to that period

3. Type the value in the cell

4. Press Enter to finish editing the value.

Budget Options

Table 4.35. Budget options

Option Description

Budget Name The budget name is used in the tab’s name and also
in any reports you create with the budget.

Notes A description of the budget.

Budget Period The budget period includes when the budget starts
(start date) and how long each budget period lasts.

Number of Periods The number of periods in the budget.

Business Windows

Customers Overview
To open the Customers Overview window, click Business → Customer  → Customers Overview.

Table 4.36. Customers Overview - Toolbar Buttons

Toolbar Buttons Description

New Create a new customer

Edit Edit the selected customer

New Invoice Create a new invoice (by default it is for the selected
customer)

Customer Listing Show customer aging overview for all customers

Table 4.37. Customer context menu

Context menu item Description

Rename Page

Edit Customer Edit the selected customer

New Invoice Create a new invoice

Customer Report Show customer report

Note

The customer context menu appears if you right click on a customer in the list.

Vendors Overview
To open the Vendors Overview window, click Business → Vendor  → Vendors Overview.
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Table 4.38. Vendors Overview - Toolbar Buttons

Toolbar Buttons Description

New Create a new vendor

Edit Edit the selected vendor

New Bill Create a new bill (by default it is for the selected
vendor)

Vendor Listing Show vendor aging overview for all vendors

Table 4.39. Vendor context menu

Context menu item Description

Rename Page

Edit Vendor Edit the selected vendor

New Bill Create a new bill

Vendor Report Show vendor report

Note

The vendor context menu appears if you right click on a vendor in the list.

Employees Overview
To open the Employees Overview window, click Business → Employee  → Employees Overview.

Table 4.40. Employees Overview - Toolbar Buttons

Toolbar Buttons Description

New Create a new employee

Edit Edit the selected employee

New Voucher Create a new voucher (by default it is for the selected
employee)

Table 4.41. Employee context menu

Context menu item Description

Rename Page

Edit Employee Edit the selected employee

New Voucher Create a new voucher

Employee Report Show employee report

Note

The employee context menu appears if you right click on an employee in the list.
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Chapter 5. Setting Up, Editing &
Working with Accounts

This section describes the process of setting up, editing and working with GnuCash Accounts. In GnuCash
an Account is used as the basic tool to organize the recording of where money comes from and goes
to. GnuCash also extends the concept of real world accounts such as a bank account or loan account to
grouping income and expense accounts. This allows you to quickly see where you spent your money and
what your major income and expenses are. GnuCash sets Account Types (as described in the next section)
to help in organizing and grouping accounts. Account Types can be used to create a Chart of Accounts.

Types of GnuCash Accounts
GnuCash supports a number of different account types. It is recommended to choose an appropriate account
type based on the list of account types described below.

Warning

The Accounts Payable and Accounts Receivable types are used internally by GnuCash’s business
features. Transactions involving these accounts should not be added, changed or deleted in any
way other than by using

• post/unpost bill/invoice/voucher or

• process payment

Table 5.1. Types of GnuCash Accounts.

Account Type Description

Accounts Payable Accounts Payable are used by businesses to record
amounts that must be paid. Example: The business
has bought something, but the business has not paid
the bill until later.

Note

Previous versions of this help defined A/P
and A/R the other way round.

Accounts Receivable Accounts Receivable records amounts for which
money has not yet been received. Example: A
business has sold something and issued a bill, but
the client has not payed until later.

Note

Previous versions of this help defined A/P
and A/R the other way round.

Asset Asset accounts are used for tracking things that
are of value and can be used or sold to pay debts.
(Normally a placeholder account)
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Account Type Description

Bank The Bank account type denotes savings or checking
accounts held at a bank or other financial institution.
Some of these accounts may bear interest. This is
also the appropriate account type for check (debit)
cards, which directly withdraw payments from a
checking account.

Cash The Cash account type is used to denote the cash
that you store in your wallet, shoe box, piggyback,
or mattress.

Credit Card The Credit Card account type is used to denote
credit card accounts, both for cards that allow
floating lines of credit (e.g. VISA, MasterCard,
or Discover) and with cards that do not permit
continuing balances (e.g. American Express)

Currency Currency Accounts were used for trading
currencies, but have been replaced by the Currency
Transfer pane on the Transfer Funds Window (the
section called “Transfer Funds Dialog Box”).

Equity Equity accounts are used to store the opening
balances when you first start using GnuCash or start
a new accounting period.

Expense Any expense such as food, clothing, taxes, etc. This
type is called a category in Quicken.

Income Any income received from sources such as salary,
interest, dividends, etc. This type is called a category
in Quicken.

Liability Liability accounts are used for tracking debts
or financial obligations. (Normally a placeholder
account)

Mutual Fund A professionally managed portfolio of stocks and
bonds or other investments divided up into shares.

Stock A share of ownership in a corporation, which
entitles its owner to all the risks and rewards that go
with it.

The New Account Hierarchy Setup assistant described in the first section of this help is a convenient
way of setting up a set of accounts to use as a framework of account types.

When new accounts are created the available choices of account types are grayed out according to what
type the parent account is. The following list contains the possible choices.

• Accounts Payable: All accounts except Equity, Expense and Income can be child accounts.

• Accounts Receivable: All accounts except Equity, Expense and Income can be child accounts.

• Asset: All accounts except Equity, Expense and Income can be child accounts.

• Bank: All accounts except Equity, Expense and Income can be child accounts.

• Cash: All accounts except Equity, Expense and Income can be child accounts.
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• Credit Card: All accounts except Equity, Expense and Income can be child accounts.

• Currency: All accounts except Equity, Expense and Income can be child accounts.

• Equity: Only Equity accounts can be child accounts.

• Expense: Only Expense or Income accounts can be child accounts.

• Income: Only Expense or Income accounts can be child accounts.

• Liability: All accounts except Equity, Expense and Income can be child accounts.

• Mutual Fund: All accounts except Equity, Expense and Income can be child accounts.

• Stock: All accounts except Equity, Expense and Income can be child accounts.

Creating a Chart of Accounts
The Chart of Accounts is like a table of contents for your finances. The best way to conceptualize a chart
of accounts is as a tree. The main branches represent entire categories or groups, while the leaves of the
tree denote individual bank accounts or expense categories. When a summary report is requested, typically
only the main branches are shown in the report, rather than the individual accounts. For example, a chart
of accounts might look like the following:

        300             Expenses
         |
         +--310         Living Expenses
         |   |
         |   +--311     Beer
         |   |
         |   +--312     Cable
         |
         +--320         Business Expenses
         |   |
         |   +--321     8-inch Floppies
         |   |
         |   +--322     Blue Ray RW DVDs
         |   |
         :   :

Accounts codes

Note that accounts not only have names; they may have codes, to order the accounts. When a
report is generated, the sort order is determined by the numbering. It’s customary to have the leaf
accounts end in non-zero digits, while parent nodes have increasing numbers of zeros.

Warning

GnuCash does not prevent duplicate numbering, although we would encourage you to avoid this.
Account codes are treated as numbers in base-36, thus, if you run out of numbers, you can use
the letters, a through z.
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Editing a Chart of Accounts
Editing the Chart of Accounts is done within the Parent Account pane of the Edit Account dialog. It is
possible to move an account to any part of the Chart of Accounts. It is recommended to keep accounts
generally under the related types of accounts as described in the section called “Types of GnuCash
Accounts”. This helps to preserve the Chart of Accounts structure.

To move the selected account to a different parent account just select the account in the Parent Account
pane. If New top level account is selected then the account will be moved to the top level.

Creating a New Account
To create a new account go to Actions → New Account... or click the New Toolbar icon in the Account
Tree Window. The New Account dialog will be opened.

The New Account properties dialog consists of two tabs, the General tab and the Opening Balance tab.

Creating a New Account involves planning in advance several details that are used in the New Account
dialog.

• What type of account is needed.

• Where it fits in the structure of the Chart of Accounts.

• If there is an Opening Balance.

• If there is a Commodity (security/currency) needed for the account.

• If online updating of the commodity price is needed.

These details are described below.

General Information Tab
The General tab is used to access the basic information about the account. It provides a way of connecting
the account to stock information if it is one of the currency, mutual fund or stock account types. It can
also be flagged as a Placeholder account. It displays if it is flagged as a Tax Related account (which is set
through the Edit → Tax Report Options dialog).

There are seven fields in the Identification section of this tab.

1. Account Name: The name for the account such as First Bank Checking.

2. Account Code: The optional number code as described in Accounts codes.

3. Description: Optional description for the account.

4. Security/Currency:

Note

The Type field in the Select Security is determined by the selection of Account Type panel
in the New Account screen.

• For accounts other than Stock or Mutual Fund this should be the default currency, USD (US Dollar)
or your local currency symbol. If this account is for a foreign currency then use the Select... button
to choose a different currency from the currencies pull-down list.
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• For Accounts containing a Stock and Mutual Fund; first select stock or mutual fund in the Account
Type panel, then the Parent Account, then use the Select... button, to choose the Type (usually the
exchange the security is traded on) and security from the Select Security window.

If the required security/fund is not on the list, and you have the correct Type you will need to create
the security/fund. To create a commodity for mutual fund and stock accounts select the New... button
in the Select Security screen, to bring up the New Security: screen. The options are described in detail
in the Security Editor the section called “Security Editor” section. Fill in a name, symbol and type
and Close to create the security. After the security is created select the Type: (usually the exchange
the security is traded on) and the name in the Currency/security: drop down list and Close the screen.

5. Smallest Fraction: The smallest fraction that will be tracked.

6. Account Color: The color to assign to the account’s register tab. Click on the color button to open the
Pick a Color screen. To reset the account color click the Default button.

7. Notes: This is a free form text box that can be used for any additional notes about the account.

Below the panes are 3 check-boxes: one to show if the account is Tax Related, one to mark the account
as a Placeholder, and one to mark an account Hidden.

The Tax Related check-box means that an account has been flagged to be included in the Tax Schedule
Report. This flag is only displayed on the Edit Account dialog and is set in the Income Tax Information
dialog (Edit → Tax Report Options). See the Tax Schedule Report and TXF Export section in Reports
Chapter (the section called “General Reports”).

The Placeholder check-box sets an account to read-only status and prevents the addition of transaction
data to the account.

Note

Setting an account to Placeholder will also hide that account in the pop-up account list in a register.
Sub-accounts to the placeholder account will still display in the pop-up, however.

The Hidden check box hides an account (and any sub-accounts) in the account tree. To reset this option,
you will first need to open the View → Filter By... dialog for the account tree and check the Show hidden
accounts option. Doing so will allow you to select the account and reopen this dialog.

Note

Hidden accounts still appear in the pop-up account list in a register. To remove an account from
this pop-up account list as well, check the Placeholder check box.

Below these checkboxes is a pane that contains a list of Account Types. Select a type from the descriptions
in the section called “Types of GnuCash Accounts”.

The next pane contains an account tree to choose a Parent Account. To create a new account tree select
New top level account.

Note

The available choices in the Account Type pane depends on the selected account in the Parent
Account pane. For example if the Parent Account is Assets you will see only Equity in the Account
Type pane. This is to help maintain a proper account structure for the Chart of Accounts.
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Steps to enable Online price updating

1. GnuCash relies on an external tool to retrieve online quotes. This tool is a Perl module named
“Finance::Quote” and has to be installed on your computer independently from GnuCash. The first step
in enabling online price updating should thus be to ensure Finance::Quote is properly installed.

To determine if the Perl module Finance::Quote is already installed on your system, type “perldoc
Finance::Quote” in a terminal window and check to see if there is any documentation available. If you
see the documentation, then the module is installed, if you do not see the documentation, then it has
not been installed.

Installing Finance::Quote differs from one operating system to another. For the various supported
systems, you can follow these guidelines:

• Linux: Most linux distributions (like Fedora, openSuse, Mandriva, Ubuntu, and so on) have a
package in their software repositories for the Finance::Quote perl module. So in most cases, you can
simply use your preferred package manager (yum, apt, rpm, synaptics, yast,...) to install the module.
The name of the package may vary from one distribution to another. It’s often called something like
“perl-Finance-Quote”.

• Windows: Finance::Quote on Windows requires perl to be installed already. If you haven’t done so,
you should first install ActivePerl, or more recently, Strawberry Perl.

The Windows installer from the GnuCash home page comes with a small helper program to install
Finance::Quote for you. You can find it in the Start Menu under the GnuCash group and is called
“Install Online Price Retrieval”.

• MacOS: If you have installed GnuCash from the installer found on the GnuCash home page,
Finance::Quote is already installed for you.

• If none of the above applies to your setup, you can try these alternative, more generic instructions:

a. Close any GnuCash applications you have running.

b. Locate the folder where GnuCash is installed by searching for “gnc-fq-update” (without the
quotes).

c. Change to that directory, open a root shell and run the command gnc-fq-update. This will launch a
Perl CPAN update session that will go out onto the Internet and install the Finance::Quote module
and its dependencies on your system. The gnc-fq-update program is interactive, however, with
most systems you should be able to answer “no” to the first question: “Are you ready for manual
configuration? [yes]” and the update will continue automatically from that point.

After installation is complete, you should run the “gnc-fq-check” test program, in the same directory,
distributed with GnuCash to test if Finance::Quote is installed and working properly.

Note

If you feel uncomfortable about performing any of these steps, please either
email the GnuCash-user mailing list (<gnucash-user@gnucash.org>) for help
or come to the GnuCash IRC channel on irc.gnome.org. More information is
available on the GnuCash Wiki FAQ for example http://wiki.gnucash.org/wiki/
FAQ#Q:_How_do_I_fix_a_.22system_error.22_or_.22unknown_error.22_when_getting_stock_quotes.3F
You can also leave out this step and manually update your stock prices.
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2. Create the Account for the mutual fund or stock with it listed in the Security/Currency field, as described
above.

Tip

When creating these accounts it is a good time to create income accounts to track dividends,
capital gains (long and short) and expense account(s) for tracking commissions and losses (if
you track losses as expenses).

3. Create the mutual fund or stock with either the Security Editor for existing stock/funds or the New
Security/Currency dialog for a new stock/fund.

Select Get Online Quotes, Type of Quote Source and Timezone.

Online currency quotes require that the check-box for Online quotes and the timezone be selected in the
Security screen and the Security Editor check-box for "get quote" box is checked for those currencies
that are to be downloaded.

• Get Online Quotes This check-box is to enable this security/fund to have quotes downloaded from
an online source.

• Type of Quote Source use the radio buttons to select the type of source for the Online quotes.
Multiple: quote sources like “Europe” should be used if fail-over to multiple sites are desirable.
Single: selections will only return information from the specified source.

After selecting the type of source for price quotes, select a quote source from the pull-down menu.
For details on currently supported sources see the section called “Finance::Quote Sources”.

Note

Note that Yahoo will provide price quotes for many mutual funds including Fidelity,
T.Rowe Price and Vanguard, and that the quoted prices at Yahoo should be identical to
those that may be found at the source sites.

If you are outside the US and use one of the different Yahoo sources or multiple sources containing
Yahoo, you should append the market code for the security such as PA for Paris, BE for Berlin,
etc. Example: 12150.PA (a Peugeot security in the Paris market). Table A.4, “Yahoo Codes for
Exchanges and Markets” below lists suffixes for various markets around the world.

Pseudo-symbols for TIAA-CREF funds are listed in table Table A.5, “Pseudo-symbols that can be
used for TIAA-CREF quotes”.

• Timezone for these quotes: Select the timezone for the source of the online quotes you are receiving.
For example, Yahoo normally quotes Eastern timezone, so choose America/New York if you use
that quote source.

4. Select a commodity to the Price Editor.

5. Select Get Quotes in the Price Editor.

6. Check the latest price for the selected security.

If you wish to update price quotes from the command line, you can do so by the following command:

gnucash --add-price-quotes <gnucash-file-name>
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The command gnucash --add-price-quotes <gnucash-file-name> can be used to fetch
the current prices of your stocks. The file specified “<gnucash-file-name>” will depend on the name and
location of your data file. This can be determined by the name displayed in the top frame of the GnuCash
window, before the “-”. The file name can also be found under File in the list of recently opened file; the
first item, numbered 1, is the name of the currently open file.

This can be automated in Mac OSX by creating a crontab entry. For example, to update your file every
Friday evening (18:00) after markets close (modify the time accordingly for your time zone), you could
add the following to your personal crontab:

0 18 * * 5 /path/to/gnucash --add-price-quotes /path/to/gnucash-filename
> /dev/null 2>&1'

For Linux, which needs dbus, usually started by the desktop manager, to communicate with dconf or gconf:

0 18 * * 5 env `dbus-launch` sh -c 'trap "kill $DBUS_SESSION_BUS_PID"
EXIT; /path/to/gnucash --add-price-quotes /path/to/gnucash-filename > /
dev/null 2>&1'

Remember that Mutual Fund “prices” are really “Net Asset Value” and require several hours after the
exchange closes before being available. If NAVs are downloaded before the current days NAVs are
determined, yesterday’s NAVs are retrieved.

Opening Balance tab
The Opening Balance tab is visible only when creating a new account, and is disabled for Stock and Mutual
Fund accounts. In the latter case, opening balances must be created by hand. Please see Section 8.5.1 in
the Tutorial and Concepts Guide for instructions if you need to create an opening balance in a Stock or
Mutual Fund account. It is used to record the beginning balance for an account. This allows it to be used
for two different scenarios. If using GnuCash for the first time to record transactions, it can be used as a
beginning balance. If the accounts in use are closed at the end of a period and new accounts are created,
it is used to close and carry balances forward.

There are three panes in this tab. The top pane contains the Balance Information.

• Balance: The balance to start the account with.

• Date: The date the opening balance should be recorded.

The next pane is the Transfer Type pane.

• Use Opening Balances Equity account: This transfers the opening balance for the account from a
standard Equity account called Opening Balances.

• Select Transfer Account: This enables the pane below so a different account can be used to transfer
the opening balance.

The last pane is the Transfer Account pane. Select the account to use for opening balances from the list
of accounts in this pane.

Editing an Account
The Edit Account dialog consists of just the General tab. This tab has the same information that was
described in the section called “Creating a New Account”. To access the Edit Account dialog go to Edit
→ Edit Account (menu shortcut Ctrl+E) or click the Edit Toolbar icon in the Account Tree Window.

49



Setting Up, Editing &
Working with Accounts

Renumbering Subaccounts
Use Renumber Subaccounts to rewrite the account codes for all children of the current account. For
example, you have the following account structure:

Table 5.2. Starting account numbers.

Code Name

10 Colors

10-1 Red

10-2 Orange

10-3 Yellow.

10-4 Blue

10-5 Violet

You now need to add the “Green” account, but you want it to sort between the Yellow and Blue accounts.
Instead of having to manually renumber all the accounts starting with Blue, you can use the Renumber
subaccount command on the Colors account. In the pop-up dialog the prefix value should default to “10”,
the account code for the colors account. If you set an interval value of “5” and click Renumber you will
end up with the following account structure:

Table 5.3. Renumbered account numbers

Code Name

10 Colors

10-05 Red

10-10 Orange

10-15 Yellow.

10-20 Blue

10-25 Violet

Now you have room in the account code numbering space to add the Green account with an account code
to force the proper ordering.

Table 5.4. Final account numbers.

Code Name

10 Colors

10-05 Red

10-10 Orange

10-15 Yellow.

10-18 Green

10-20 Blue

10-25 Violet

Deleting an Account
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Deleting an Account means removing all transaction information and information about this account from
the file. This cannot be undone. You will be prompted to verify that you wish to remove the account. If the
account still contains transaction information you will be warned that this account contains transactions.

A side effect of removing an account that contains transactions is that you will end up with unbalanced
accounts. This will be indicated in the account by a gray check-box next to the debit and credit amounts.
You can automatically repair these unbalanced accounts by using the Actions → Check & Repair menu.
This will automatically assign the unbalanced amounts to a new account named Imbalance.

Reconciling an Account to a Statement
Reconciliation of Accounts in GnuCash with statements from a bank or other institution is a way of double
checking the accuracy of your (and your banks) transactions and the balance of your accounts. It also is
useful to track uncleared checks and other outstanding transactions.

The reconciling process in GnuCash involves two dialogs: the the section called “Reconciling Information”
dialog followed by the the section called “Reconcile” window. They provide access to various GnuCash
functions to make it easy to enter and update account information during the reconciliation.

Tip

The Reconcile window is accessed from the account tree window or the account register window
by going to Actions → Reconcile... or using the menu shortcut Alt+A, R.

The Summary Bar at the bottom of the Account Register Window indicates the amounts of Present
(Balance), Future (Balance), Cleared (Transactions), Reconciled (Transactions) and Projected Minimum.
Online account information can be used to mark which transactions the bank has processed by changing
the R (reconciliation status) column in the register from n (new) to c (cleared). The bank statement is then
used with the Reconcile window to reconcile the account which changes the R field to y (reconciled).

Reconciling Information
The Reconcile Information dialog is used to indicate the closing Statement Date and the Starting Balance
(fixed from last reconciliation) and Ending Balance from the statement. The Include Sub-accounts check-
box is used if one or more subaccounts are used to track the account you are reconciling. The Enter Interest
Payment button is used to add a transfer to the accounts for an interest payment. If selected a dialog will
be displayed to add the the section called “Interest Payment” to the account.

Note

The Enter Interest Payment button is shown only if you are reconciling an account of Bank type.

When you have entered all relevant data, press Ok to proceed to the the section called “Reconcile” dialog
or Cancel to discard the reconciliation process.

Interest Payment

There are three panes in the Interest Payment dialog. At the bottom is a button called No Auto Interest
Payments for this Account which will cancel the dialog. The top pane contains the Payment Information.

• Amount: Enter the amount of the interest payment.

• Date: Select the date for the interest payment.
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• Num: Enter a number for the transaction (optional).

• Description: Enter an informational description for the transaction.

• Memo: Enter a note about the transaction (optional).

The Reconcile Account pane highlights in the tree the account that the interest payment will be transferred
to or from.

The Payment From pane contains a list of accounts where you can select the source account.

Note

If the payment is for a credit or loan account then usually the payment would be from an Expense
account. If the payment is for a checking or savings account then usually this would be from an
Income account.

Tip

The Show Income/Expense check-box shows or hides the Income and Expense accounts.

Select OK to enter the interest transaction (or Cancel the payment) and return to the initial reconciliation
screen.

Reconcile

Note

For a detailed description of menu items and buttons on the reconcile window, see the section
called “Reconcile Window”.

The Reconcile dialog is where the actual process of matching your statement to GnuCash data takes place
on a per transaction basis.

The Reconcile dialog is composed of a toolbar and three panes; Funds In on the left, Funds out on the
right and a balance pane.

Note

If you enabled the option Use formal accounting labels in the Accounts section of the GnuCash
preferences, you will see Debits and Credits panes instead of Funds In and Funds Out panes.

The Funds In and Funds Out pane shows all unreconciled deposits to the account. Both panes are composed
of five columns.

Tip

To order the listed transactions with a preferred criteria, click on the relevant column header. To
reverse the selected order click a second time on the column header.

Date The date of the unreconciled transaction.

Num The number of the unreconciled transaction.

Description The Description of the unreconciled transaction.
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Amount The Amount of the unreconciled transaction.

R Shows a check if the transaction will be reconciled when done.

To mark a transaction as reconciled just click on it and a checkmark will appear on the relevant R column.

Tip

You can check or uncheck the reconcile status of all transactions in either pane by clicking on
a transaction in the required pane then clicking Ctrl-A followed by space. This will toggle the
reconcile status of all transactions in the pane to either checked or unchecked state. This procedure
can be repeated to achieve the desired status for the transactions in the pane.

Note

Under each pane a Total for reconciled transactions is shown.

The balance pane shows a summary of the balances used in reconciliation.

Statement Date The date on the statement set on the the section called
“Reconciling Information”.

Starting Balance The balance at the end of the last reconciliation.

Ending Balance The balance entered from the statement.

Reconciled Balance The balance of selected transactions.

Difference The difference between the Reconciled and Ending balances.

The set of unreconciled transactions in the Funds In and Funds Out panes can be changed by using the
menus and Toolbar to access the account and transaction information. You can create a New transaction,
Edit a selected transaction, add a Balance transaction (of the same amount as listed under Difference in
the balance pane), and delete the selected transaction.

Tip

To modify a listed transaction, double click on it.

By pressing the Open icon the register of the account to reconcile will be opened.

If you wish to postpone the reconciliation until later use the Reconcile → Postpone menu item (menu
shortcut Ctrl+P) or pressing the Postpone icon. If you wish to cancel the reconciliation use the Reconcile
→ Cancel menu item or press the Cancel icon.

All previous commands are also available in the Reconcile dialog menu.

Select each unreconciled transaction matching a transaction on the statement so a green tick appears in the
R column. The Balance pane changes to reflect each selected transaction until the Ending Balance equals
the Reconciled Balance and the Difference is zero. Once this is done select the Finish button or Reconcile
→ Finish (menu shortcut Ctrl+F) to finish the reconcile process.
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A transaction represents the movement of money from one account to another account. Whenever you
spend or receive money, or transfer money between accounts, that is a transaction. In GnuCash transactions
always involve at least two accounts.

GnuCash uses accounts as a way of grouping or organizing the recording of transactions. This section
describes the methods GnuCash has to help enter transactions quickly into the register.

GnuCash has several methods available for entering transactions.

• Entering directly into the register window is the most common way of entering transactions.

• Using the Transfer Funds window .

• Importing transactions either from a file or via on-line banking.

Transfer Funds Dialog Box
The Transfer Funds Dialog Box, accessed via Actions → Transfer... or its shortcut or by pressing the
Transfer icon from the account register tab, serves two purposes in GnuCash:

• A way to create a simple (i.e. two-split) transaction between arbitrary accounts.

• Collect exchange rate or amount information in a multi-currency transaction (see the section called
“Multiple Currency/Commodity Transactions”).

Note

The Basic Information and Transfer Accounts panes will be disabled in the Transfer Funds dialog
when it is being used only to collect exchange rate or amount information.

Basic Information

The Basic Information section collects the entries for constructing a transaction: Date, description, amount,
etc.

• Amount: The amount of the transaction in the Transfer Fromaccount's commodity.

• Date: The posting date for the transaction, i.e. the date that you want to record it in your book.

• Num: A reference number for the transaction, often a check number.

• Description: The description of the transaction, often the payer or payee.

• Memo: Additional information you might want to note about the transaction. Anything entered here
will be added to the Memo fields of both splits.
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Transfer Accounts
The Transfer From and Transfer To tree views are used to select the accounts which will participate in
the transaction. They normally show only Asset and Liability accounts. If you need to use an Income or
Expense account in one of them, check the Show Income/Expense checkbox below the appropriate view.

• Choose the Transfer From account.

• Choose the Transfer To account.

Currency Transfer
The Currency Transfer pane is used to collect the needed information to enter the amount of the Transfer
To split. You may enter either a price or an amount and GnuCash will compute the other. If you have
Online Price Retrieval installed (see the section called “Steps to enable Online price updating”) you can
use the Fetch Rate button to retrieve a current quote.

The Currency Transfer pane is enabled only if the selected accounts use different commodities or the
Transfer Funds dialog was launched to collect price or amount information from editing a transaction in
the register.

The Currency Transfer pane is organized as a radio group with two selections, Exchange Rate and To
Amount. Each consists of a radio button and a numeric entry.

If a relevant price is available in the price database (see the section called “Adding a stock price manually”)
the Exchange Rate will have that as a default entry.

• Select the Exchange Rate radio button if you want to enter a price or use the Fetch Rate button.

• Select the To Amount radio button if you want to enter the amount of the To Account split.

• Enter the price/exchange rate or the amount in the numeric entry corresponding to radio button you
selected. GnuCash will calculate the other amount for you when you exit the field. If it's enabled you
can use the Fetch Rate button to retrieve a current quote.

Note

If you have created a price in the Price Editor (see the section called “Adding a stock price
manually”) for the current date quote retrieval will not update that price. You must first delete
the manually-created price in the Price Editor before you Button1on the Fetch Rate button.

Note

The Fetch Rate button will immediately create or replace a price in the Price Editor unless there
is an existing manually-created price for today.

Finishing Up
Select OK to commit the transaction (or confirm the price/amount) or Cancel to dismiss the dialog without
entering the transaction.

Note

When committing a transaction or confirming an exchange rate the price on the transaction date
in the Price Editor may be updated. See the section called “Price Editor” for details.

55



Common Transaction Operations

Enter Transaction via register
When the Account Register Window for an account is opened the list of transactions for that account is
shown. This window has the name of the account on its tab. The menus contain several functions that alter
the display of transactions. The Toolbar also contains several functions that are often used when entering
or manipulating transactions. These are described in the the section called “Account Register & General
Journal Window” section of this document.

Entering Directly in the Register Window

The register window will look slightly different depending on the style options you have chosen. The
following describes entering simple transactions in the basic ledger style. The cursor is placed in the date
field by default when the register window is opened.

Note

When working on transactions in GnuCash, be aware that the Enter key and the Tab key behave
differently, and perform different actions.

The Enter key moves to the first field of the next split, regardless of which field you are in. If there
is no next split, proceeds to the next transaction. In any case, Enter finishes the transaction edit,
and any imbalance is posted to Imbalance-CUR, where CUR is the currency of the transaction.

The Tab key moves to the next field in the current split. If it's the last field, moves to the next
split, creating a new one if there isn't one. If the split is blank, the Tab key finishes the transaction
and posts any imbalance to Imbalance-CUR, as above.

1. Selecting the small icon on the right of the date field drops down a date selection calendar. Use the
arrows to select the correct month and year for the transaction then select the date. Selecting the icon
once more will close the date selection calendar. It is also possible to type in the date or part of the
date and let GnuCash fill the rest.

2. Press Tab to move to or select the Num field. Here you can enter a check or transaction number. Pressing
+ (plus) will automatically advance the number by one from the last transaction to have a number.

3. Press Tab to move or select the Description field. This field is used to enter either a payee or other
description for the transaction. It will automatically attempt to fill the payee name as you type.

4. At this stage one of two things will happen if tab is pressed. If GnuCash matches an existing transaction
the cursor will jump to one of the amount fields, automatically filling in the transfer account. Selecting
any field with the mouse instead of tabbing will not automatically fill the transferring account field.
If there is no matching (existing) transaction, GnuCash will move the cursor to the Transfer field with
only one line of the transaction supplied.

5. Accounts may be selected either by typing them in or by pressing the small button on the right of the
Transfer field, which will display a pick list of all non-placeholder accounts. Note that this pick list will
still display hidden accounts. If you have hidden an account in your chart of accounts, you may want
to set the account also to be a placeholder account so that it doesn't display here.

When typing, GnuCash will fill in available accounts as you type. For example, if you have Equity
and Expenses top-level accounts, typing E will fill in Equity because it sorts before Expenses.
Continuing to type x will present Expenses the account separator (: by default, see the section called
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“Accounts”Account Preferences about changing it) will accept the currently offered account so that
you can start typing the name of a child account.

6. The next field R is used for reconciliation. This is described in the Reconcile an Account to a Statement
section. the section called “Reconciling an Account to a Statement”

7. Press the Tab key to move to the first of the amount fields. The names of the next two columns are
different according to what type of account is opened. For example, Bank accounts show Deposit and
Withdrawal here, Credit Card accounts show Payment and Charge, and Stock accounts show Shares,
Price, Buy and Sell.

8. Enter an amount for the transaction in the correct fields. When the transaction is "balanced" pressing
the Enter key, selecting the Enter icon or going to Transaction → Enter Transaction will finish the
transaction. Selecting the Cancel icon or going to Transaction → Cancel Transaction will erase the
transaction.

9. Transactions with just one transfer account will show the name of that account in the Transfer field in
completed transactions. (The Transfer field is the fourth (4) from the left in the register display.)

10.To move to the blank transaction at the bottom of the register, press the Blank Toolbar icon or go to
Actions → Blank Transaction.

Multiple Split Transactions
The register window will look slightly different depending on the style options you have chosen. The
following describes entering transactions with multiple splits in the basic ledger style. GnuCash describes
as a “Split” when money is transferred to or from more than two accounts in a transaction. The cursor is
placed in the date field by default when the register window is opened.

The multiple account lines will not be displayed in the Basic Ledger unless the Split icon or the Action
→ Split Transaction option have been selected.

1. Selecting the triangle icon on the right of the date field drops down a date selection dialog. Use the
arrows to select the correct month and year for the transaction then select the date. Selecting the icon
once more will close the date selection calendar. It is also possible to type in the date or part of the
date and let GnuCash fill the rest.

2. Press Tab to move to or select the Num field. Here you can enter a check or transaction number. Pressing
+ (plus) will automatically advance the number by one from the last transaction to have a number.

3. Press Tab to move to or select the Description field. This field is used to enter either a payee or other
description for the transaction. It will automatically attempt to fill the payee name as you type.

4. At this stage one of two things will happen if tab is pressed. If GnuCash matches an existing transaction
the cursor will jump to one of the amount fields, automatically filling in the transfer account. Selecting
any field with the mouse instead of tabbing will not automatically fill the transferring account field.
If there is no matching (existing) transaction, GnuCash will move the cursor to the Transfer field with
only one line of the transaction supplied.

5. When typing in the Transfer field GnuCash will also attempt to automatically match the account. It
does this alphabetically, so typing Ex will match the Expenses section of the account list. When the
section is matched, it is possible to move to a child account by pressing : (colon). If after typing Ex you
press : then the cursor will move to the first child account in the list. Typing combinations of letters and
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: will allow movement down the tree of accounts quickly. The small icon on the right of the Transfer
field can be used as an alternate way of selecting accounts.

6. The next field is used for reconciliation. This is described in the section called “Reconciling an Account
to a Statement”

7. Press Tab to move to the first of the amount fields. The names of the next two columns are different
according to what type of account is opened. For example, Bank accounts show Deposit and Withdrawal
here, Credit Card accounts show Payment and Charge, and Stock accounts show Shares, Price, Buy
and Sell.

8. Enter the total amount for the transaction in the correct field. Before pressing Tab or Enter read next
step.

9. To enter the additional splits, press the Split button on the Toolbar or select Actions → Split Transaction.
Transactions with more than one split show the text --Split Transaction-- and the Split button will need
to be used to show the details.

10.The display will expand, the titles of the amount columns will be renamed and the Transfer column
name will be blank. The first line contains the description and the amount of the transaction. The second
line contains the currently opened account name in the Account field and the amount of the transaction.
The third line contains the transfer account name in the Account field. If the amount is not balanced,
GnuCash will indicate this by placing gray check-boxes in the amount columns with the unbalanced
amount in a blank last row.

11.When one of the short lines is selected, the column titles will change. The very first and last (Date
and Balance) columns will have blank titles. Num will change to Action, Description to Memo, the
now blank Transfer column will change to Account. The last two amount columns will show the name
described in step seven.

12.The Action and Memo columns are optional to fill out at this stage. Action is used to describe what
kind of account transfer is involved. Memo is an additional description of the transfer.

13.Move to the missing amount field on the third line and fill in the amount. Pressing the Enter key,
selecting the Enter icon or going to Actions → Enter will now move the cursor to the next line.

14.The Account column contains the list of transfer accounts. This column is the one that is used to add
splits. The method described in step five can be used to select another account on a blank line. Add
as many additional splits as needed.

15.When the transaction is balanced the gray check-boxes will disappear and the last blank line will not
have an amount.

16.Pressing Enter as described above will jump to the next transaction. Selecting the next transaction
will close the split or it can be manually closed by pressing the Split icon or selecting Actions → Split
Transaction.

Multiple Currency/Commodity Transactions
Any transaction that has splits whose accounts are denominated in different commodities (currencies are a
subset of commodities) requires an exchange rate to convert between the two. For more information please
see Chapter 10 of the Tutorial and Concepts Guide.

Registers for accounts of type STOCK or FUND display four columns, Shares, Price, Buy, and Sell (the last
two will be Credit and Debit respectively if you've enabled Use formal accounting labels in the Accounts
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tab of Preferences). Enter any two and GnuCash will calculate the other for you; if you enter 3 and the
result doesn't balance GnuCash will ask which one to change to make the split balance.

Registers of other types have only Credit and Debit (the names will be different depending on the account
type if you haven't enabled Use formal accounting labels) and so use the Transfer Dialog with most of
the fields disabled to collect either an Exchange Rate or a To Amount (the amount in the other currency/
comodity). Please see (the section called “Currency Transfer”) for details of using this dialog.

Note

When committing a transaction or confirming an exchange rate the price on the transaction date
in the Price Editor may be updated. See the section called “Price Editor” for details.

Editing a Transaction
Editing a transaction involves just selecting the part of the transaction that needs to be changed. Once the
changes are complete pressing the Enter key, selecting the Enter icon or going to Transaction → Enter
Transaction will now move the cursor to the next line or transaction.

To see a more detailed view of a transaction for editing in Basic Ledger, press the Split button on the
Toolbar or select Actions → Split Transaction.

Deleting a Transaction
If a transaction needs to be removed from the register, select the transaction and press either the Delete
icon on the Toolbar or go to Transaction → Delete Transaction. A window will appear to confirm the
delete, unless the preference has been changed. The window presents two options; "Remember and don’t
ask again", and "Remember and don’t ask again this session". The response will be set according to the
selected checkbox. The preference can also be reset via Actions → Reset Warnings. the section called
“Reset Warnings...”.

Parts of a transaction can also be removed by pressing the Split button on the Toolbar or selecting Actions
→ Split Transaction. The part of the transaction that needs to be deleted can be then selected for deletion.

Add Reversing Transaction
In formal accounting, transactions should never be deleted or altered. Instead, when a mistake is made, the
original transaction remains in the ledger, and a reversing transaction is added to the ledger. This reversing
transaction restores the ledger to its state before the error, allowing the user to enter the transaction again
correctly.

While a user can certainly enter reversing transactions manually, GnuCash includes a menu option
(Transaction → Add Reversing Transaction) that can quickly create the reversing transaction for you. This
option only appears when you are in an account register. When you are in the transaction that needs to be
reversed, all you need to do is select this menu item, and a duplicate transaction that reverses the active
transaction is immediately created.

Note

Once you choose the menu item, a reversing transaction is immediately created in the account
using the current date. You may wish to locate the new transaction at the end of the register, and
add explanatory notes to it.
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Removing Transaction Splits
Removing Transaction Splits involves erasing all splits except the one for the account that is opened. This
is a useful way of reusing a previous transaction that has multiple splits that need to be changed. (Note
this can be done without opening the split, but doing so makes the effect more visible)

1. If in Basic Ledger, press the Split button on the Toolbar or select Actions → Split Transaction to open
the transaction. If in other modes select transaction.

2. Select Transaction → Remove Transaction Splits.

A window will appear to confirm the delete, unless the preference has been changed. The window
presents two options; "Remember and don’t ask again", and "Remember and don’t ask again this
session". The response will be set according to the selected checkbox. The preference can also be reset
via Actions → Reset Warnings. the section called “Reset Warnings...”.

3. All Accounts and their related details will be removed except for the currently opened account.

4. The amount is not balanced and GnuCash will indicate this by placing gray check-boxes in the amount
columns with the unbalanced amount in the blank last row.

5. Edit the transaction to fill in the new details.

Copying a Transaction
Copying Transactions is available from the Transaction menu. The Transaction menu has Cut Transaction,
Copy Transaction and Paste Transaction which allows a whole transaction to be cut or copied and pasted to
a new transaction line. This way of copying a transaction will use the date showing in the new transaction
blank line.

The Transaction → Duplicate Transaction... or the Toolbar Duplicate which, unlike the Copy method,
allows for choosing a different date.

• Select the transaction to duplicate.

• Go to Transaction → Duplicate Transaction...

• A dialog called Duplicate Transaction will prompt for a new Date and Num for the transaction.

• Press OK to add the transaction to the register.

Setting the reconcile status (R field) of a
transaction

In the GnuCash register there is a column labeled R. This field indicates the status of a transaction. Possible
values are:

n No. This is the default status when a transaction is created.

c Cleared. Status may be assigned either manually or by an import process.
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y Yes, reconciled. This status is solely assigned by the reconciliation process (see the section called
“Reconciling an Account to a Statement”). Places limits optionally requiring confirmation on editing
fields in that line of a transaction.

f Frozen. Not implemented at this time

v Voided. Status is assigned or released manually through the transaction menu (the section called
“Account Register - Transaction Menu”) to a transaction and applies to every line in the transaction. It
hides most of the transaction details but does not delete them. When a transaction is voided a reason
entry is required that appears to the right of the transaction notes. The notes and void reason will only
be visible when you have enabled View → Double Line.

Jump to another Account Register
When using the Account Register Window it is frequently useful to be able to view another account and
also the transfer account at the same time. GnuCash allows you to do this quickly by using the Jump button
available in the Toolbar or the Actions → Jump menu item in the Account Register Window.

Select the transaction in the Account Register Window and either click the Jump icon or select Actions
→ Jump to open the Account Register Window target. If the transaction is split between more than one
transfer account then you will need to show all the split transfer accounts first and select the transfer
account to jump to.

Scheduling Transactions
Scheduled Transactions provide the ability to have reminders scheduled or transactions scheduled to be
entered at a specified date. This is combined with the Since Last Run assistant (the section called “Since
Last Run Assistant”) to review and enter the transactions. The Mortgage & Loan Repayment assistant
(the section called “Mortgage & Loan Repayment Assistant”) is used to setup a scheduled transaction to
repay a compounding interest loan. The Scheduled Transaction Editor (the section called “Edit Scheduled
Transaction Window”) is used to create and edit transactions that are to be added to the register in an
automated way.

The easiest way to setup a scheduled transaction is to use an existing transaction in an account register as
a template. Select the transaction you wish to use as a template and then either select the Schedule icon on
the Toolbar or go to Actions → Schedule.... This will bring up the Make Scheduled Transaction dialog.

• Name: Enter a name to use for the scheduled transaction. This will be used in the Description field of
the transaction.

• Frequency: Choose the time period you want between scheduled entries. The dates that the transactions
will be entered will show in the mini calendar pane to the right.

• Start Date: Choose a date for the scheduled transaction to start.

• Never End: This scheduled transaction has no finish date.

• End Date: Choose a date for the scheduled transaction to end.

• Number of Occurrences: Enter the number of times you wish the scheduled transaction to be added to
the register.

The Advanced... button brings up the Scheduled Transaction Editor’s dialog to Edit the Scheduled
Transaction. This is described in the section Scheduled Transaction Editor. the section called “Edit
Scheduled Transaction Window”
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Scheduled Transactions Window
The Scheduled Transactions Window is used to access the list of scheduled transactions and create, edit or
remove them. It also provides a calendar which displays upcoming scheduled transactions. Clicking on the
calendar view and hovering over any date will pop up a small dialog that shows the transactions scheduled
for that day. The yellow highlight in the calendar indicates which days have scheduled transactions. To
dismiss the hover dialog click once more.

The top pane of the Scheduled Transaction Window contains the list of scheduled transactions that are
currently setup. This window lists the Name of the transaction, if the transaction is enabled for scheduling,
the Frequency (month and day) that the transaction is to be entered, the last time the transaction was entered
and the next time the transaction will be entered.

The right side of this pane contains a down arrow button that when clicked will pull-down a window to
allow selection of the characteristics displayed in the list. Unchecking the appropriate box will remove
the characteristic from the display.

The Toolbar of this window contains three buttons to create, delete and edit scheduled transactions. New
and Edit buttons opens the Edit Scheduled Transaction dialog. Delete removes the selected scheduled
transaction. The same options are available thru Schedule → New/Edit/Delete, from the Scheduled
Transaction Tab.

Below the list of scheduled transactions is the Upcoming calendar. This calendar displays up to the next
year and highlights the dates that the scheduled transactions are scheduled to occur so it is easy to see when
the transactions are scheduled. Clicking on a date in the calendar brings up a list of scheduled transactions
for that date. Moving the mouse over other dates changes to the list of transactions on those dates. Clicking
once more on the calendar removes the transaction list.

The Scheduled Transaction Window is activated from the Account tab or the Transaction Register via
Actions → Scheduled Transaction → Scheduled Transaction Editor....

Edit Scheduled Transaction Window
The Edit Scheduled Transaction Window is divided into a Name area, Options area, Occurrences area,
Recurrence Frequency area, mini calendar and Template Transaction pane.

The Name field is used to enter the name for the scheduled transaction. This will be used in the Description
of the transaction.

The Options area contains check-boxes to set if the transaction is automatically created and how many
days in advance the transaction is created and/or a reminder posted.

The Occurrences area contains selections to set for dates limits on transactions to be entered or the number
of transactions to be entered.

The Recurrence Frequency area contains selections to set how often the transaction is scheduled to be
added and on what dates this occurs.

The mini calendar provides a visual indication of what transactions are already scheduled.

The Template Transaction pane allows you to setup the transaction as you would like it to be entered into
the register.

These options are described in more detail in the section called “Scheduling Transactions”
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• From the Scheduled Transaction tab selecting a transaction from the list and pressing the Edit or New
buttons will bring up the Edit Scheduled Transaction Editor.

Printing Checks
Checks are printed in GnuCash from the account register. GnuCash provides the ability to print to several
standard Quicken Checks (including US Letter) or to make a custom check format. Check position and
Date formats are also customizable.

To print a single check in GnuCash, select the transaction to print a check for and go to File → Print Checks.
This will open the Print Checks properties dialog to print the selected transaction.

To print multiple checks in GnuCash execute a search to find the transactions you wish to print. With the
search results window as the front window go to File → Print Checks. This will open the Print Checks
properties dialog to print all the transactions in the search results window.

The Print Checks dialog has two tabs. The first tab, Options, is used to setup the most common options to
print a check. The second tab, Custom format, is used to setup the position of various fields on the check.
It is useful to print a test check to a plain piece of paper first and use that to make any adjustments needed.

The default selection in Options is for Quicken/Quickbooks (tm) US-Letter checks.

• Check format: Test with Quicken first then use custom if the position is incorrect.

• Check position: This sets if the Top, Middle or Bottom check is printed. Custom is used if the position
of the checks on the page is incorrect.

• Date format: The default here is set in the Preferences International section. Choose a date format. This
can also be adjusted by the Use of the Months: and Years: lines. Custom allows the date format to be
set in the Format: box (%m means month, %d means day, %Y means year) A Sample of the format
chosen is displayed below.

• Address: This sets the address of the Payee, if the check format includes a space for it and you are
printing a single check.

The Custom format tab has two sections. The top half of the window (above the dividing line) allows you
to position the fields in each check. It contains two columns to enter in the X and Y co-ordinates of the
field position on the check. Positions in the Custom Check Format entry area are specified with x = 0 at
the left edge of the check with x increasing to the right, and y = 0 at the top edge of the check with y
increasing as you travel down. (If you are using a version of GTK prior to 2.10, then y = 0 is at the bottom
of the page and y increases as you travel up.)

• Payee:

• Date:

• Amount (words):

• Amount (numbers):

• Address:

• Notes:

• Memo:
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• Splits Amount:

• Splits Memo:

• Splits Account:

The part of the custom format tab below the dividing line contains fields to position the entire check
correctly on the page. The Translation field is the distance from the top left corner and the Rotation field
rotates the check clockwise by the indicated amount.

The Units field in the bottom half of the window specifies the units used in all the fields in both halves
of the window.

Once OK is pressed on the Print Check dialog the Print GnuCash Document dialog is presented. Press
OK to print the check.

Importing Transactions from Files
Imported transactions will generally be to a specific account in your account tree. In the following this will
be referred to as the import or base account. It may or may not be specified in the data being imported
depending on the import format. It is usually the first split of a transaction being imported.

All transactions will also need to have a destination account for any other splits associated with the
tansaction. These may or may not be supplied in the imported data, depending upon the data source and the
format of the data. If it is not, GnuCash may be able to assign an account on the basis of the previous import
history by matching infomation in the imported data to data associated with previous account assignments
in the importer. The user may always over-ride this automatic assignment or where no assignment can be
made automatically assign an account manually.

Multi-split data exported from GnuCash in CSV format will normally have both the import and destination
accountsfor transaction splits specified in the data file.

Import Formats
GnuCash allows transactions to be imported in a number of structured formats for the exchange of financial
data as well as in the unstructured CSV format, a plain text tabular format commonly used for the import
and export of data to and from spreadsheets:

• QIF (.qif) Quicken Interchange format - import data from Quicken financial software;

• OFX/QFX (.ofx,.qfx) Open Financial eXchange format (QXF is an Intuit/Quicken proprietary version
of OFX);

• CSV (.csv) Comma Separated Values;

• MT940 SWIFT MT940 Customer End of Day Statement Message;

• MT942 SWIFT MT942 Customer Intra-day Transaction Report;

• DTAUS (.DTAUS) Banking data Exchange File;

These import methods can be accessed from the Import submenu of the main menu File entry, along with
methods for importing other types of data. Select the appropriate entry in the Import sub menu to initiate
importing transactions.
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Import QIF
To import data from Quicken®, MS Money®, or other programs that use QIF(Quicken® Interchange
Format), you must first export your data to a QIF file. One way to do this is to export each account as a
separate QIF file. An easier way, available in Quicken® 98 and beyond, is to export all accounts at once
into a single QIF file. Check your program's manual to determine if this option is available.

To import QIF files:

Select File → Import → Import QIF... from the menu to open the QIF Import dialog box illustrated below.

Figure 6.1. The Import QIF Files Assistent

Dialog Navigation. The right hand pane will display some or all of the following navigation buttons:

• Cancel: Exit the dialog;

• Back: Go back to the previous step;

• Next: Proceed to the next step.

The buttons displayed are determined by whether navigation to the destination step is valid from the current
step.

Import Dialog Steps. The left hand pane lists the steps in the import dialog process. The right hand pane
contains instructions and/or controls for performing the operations in the step selected and highlighted in
the left hand pane. The import process steps are:

• Import of QIF files: Initial informational panel. Click Next to proceed;

• Select a QIF file to load: Open a file selection dialog. Navigate to and select the file you wish to import
and click Import. Then click Next;
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• Load QIF files: Click the Start button to load the file. The file will be parsed and loaded. If errors or
warnings occur you may have to remove the file, edit it and reimport it. If there are no errors click Next;

• Set a date format for the file: Select a date format (m-d-y or d-m-y) appropriate to the locale of the
source of your QIF file. In the US this is generally m-d-y and in Europe d-m-y;

• Set the default QIF account name: If the QIF file does not specify an account name, enter an account
name. If importing data from another accounting program you should use the name used in that program;

• QIF files you have loaded: This step allows you to edit the list of files to be imported and to load
additional files. To remove a file, click on the row and then click on Unload selected file. To load another
file click the Load another file. When you have all the files you wish to import loaded, click Next;

• Accounts and stock holdings: Information panel. Click Next to proceed;

• Match QIF accounts with GnuCash accounts: QIF account names are matched to GnuCash accounts
if possible. New GnuCash accounts are created if no matching accounts are found. For stock, the required
account structures are also created. Created accounts are indicated by checking the checkbox in the
New column. Assigned accounts may be edited by selecting the appropriate the row and clicking on the
Change GnuCash Account button to to run the account selection dialog;

• Income and Expense categories: Information panel. Click Next to proceed;

• Match QIF categories to GnuCash accounts: QIF categories are matched to GnuCash accounts where
possible. New GnuCash accounts are created where no matching GnuCash account is found. Created
accounts are indicated by the checkbox in the New column being checked. If you are not sure what
changes are needed, it is safe to accept the GnuCash account names. These may be changed later in
GnuCash. Assigned accounts may be edited by selecting the appropriate row and clicking on the Change
GnuCash Account button to run the account selection dialog;

• Payees and Memos: Information page. Click Next to proceed;

• Match payees/memos to GnuCash accounts: QIF payees and memos are matched to GnuCash
accounts where possible and new accounts are created where this is not possible again indicated by the
checkbox in the New column. The assigned account may be changed by selecting a row and clicking
on the Change GnuCash Account button to to run the account selection dialog;

• Choose the QIF file currency: Select the required currency from the dropdown list and click on Next
to continue;

• Tradable commodities: Not yet implemented;

• QIF Import: Click on Start to begin the import. GnuCash currently proceeds to the Update your
GnuCash accounts tab if the import is successful;

• Match existing transactions: Not yet implemented;

• Select possible duplicates: Not yet implemented;

• Update your GnuCash accounts: Click Apply to complete the import. Depending upon the size of
your file, the import might take a few minutes to complete, so a progress bar displays the percentage
finished. When the import process is complete, GnuCash will return you to the main window, which
should now display the names of the accounts you imported.

Other features are not currently implemented;

• QIF Import Summary: Click on Close to exit the wizard.

66



Common Transaction Operations

Import OFX/QFX
File->Import->Import OFX/QFX transactions opens a file selection dialog. Navigate to the file you wish
to import, select a file with the appropriate extension (.ofx or .qfx), then press the Import button.

GnuCash then opens an Account Selection dialog to select an account in your CoA to match to an account
name in the import file. Select the appropriate account from the account tree and press the OK button. On
subsequent import of files from the same source account, the mapped GnuCash account is remembered
and the account selection dialog is not displayed.

The generic import transaction matcher dialog is opened next. See the  Import Matcher section (common
to both OFX/QFX and CSV import formats) following the Import CSV section to continue the import
process.

Import CSV
Clicking on File->Import->Import Transactions from CSV will bring up the CSV Transaction Import
Assistant dialog illustrated below.

Figure 6.2. The CSV Transaction Import Assistant - Introduction

The CSV Transaction import Assistant is largely self explanatory with information panes which describe
the functionality.

Dialog Navigation. Each pane displays a selction of the following navigation buttons at the bottom
right:

• Cancel Exit the CSV Transaction Import Assistant;
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• Back Return to the previous step in the assistant;

• Next Proceed to the next step in the assistant.

The buttons displayed are determined by the validity of the traget step from the current step.

CSV Import Process Steps.  The steps in the CSV import process are listed in the left hand pane with
the current step highlighted. Explanatory text and the widgets to setup and carry out the step are displayed
in the right hand pane. The function of the controls in each step is explained below, in the explanatory
information in the panes or in tooltips on some controls. The steps in the CSV import process are:

• Transaction Import Assistant: Introductory information panel. Click Next to continue;

• Select File for Import: Display the File selection dialog. Navigate to the file you wish to import then
click the Next button;

• Import Preview: The Import Preview pane controls set options for the import of CSV data and provides
a preview of the data to be imported.

Figure 6.3. The CSV Import Preview Pane

The CSV Import Preview Pane with settings to import the shown data.

Import preview Controls

• Load and Save Settings: Once you have set all the import parameters, you can save these settings
by typing in a setting a unique name in the Load and Save Settings Entry combo box and clicking
the Save icon just to the right of the box. A previously defined settings group can be retrieved by
selecting the appropriate setting group name from the dropdown list activated by the down arrow at
the right end of the text box. This will set all other settings to the stored values.

The delete/trashcan icon to the right of the Save icon can be used to remove the saved settings group
selected from the drop down list for the box.

The settings group GnuCash Export Settings defines a setting group for used for the export and
reimport of GnuCash transaction data - use this if importing data previously exported from GnuCash;
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• Account: If the data you are importing does not specify the source account for the transaction an
account can be selected from the drop down list will import all transactions to the selected account.
Leave blank if your imported data specifies a source account;

• File Format:

• Separators: Selecting this radio button will allow you to define characters which will be used
to distinguish columns in the input file. The default is comma separated. In countries using the
comma as decimal separator the semicolon is common as column separator. However spaces, tabs,
colons or semicolons or any combination of them may be used to separate columns in the input
file by selecting the appropriate check boxes. You may also define custom separators by typing
the required characters into the text box and selecting the Custom checkbox. This may be used in
combination with any of the predefined separators;

• Fixed-Width: Selecting this radio button will allow you to define column boundaries by double
clicking at the appropriate positions in the sample records displayed in the panel below. Single
clicking in a column will narrow, widen or merge the column.

• Multi-split: Selecting this check box allows the splits for a single transaction to be defined on
consecutive lines within the file with each line defining a single split. If not selected each line is
assumed to contain the information for a single transaction including one or two splits;

• Miscellaneous: The miscellaneous settings allow you to set:

• Encoding: This is usually UTF-8, but may differ for files from other sources;

• Date Format: This does not default to the Locale setting so check it matches the data you are
importing;

• Currency Format: Select the format of the decimal separator (full stop or comma or other) for
the currency if the correct value is not supplied by Locale;

• Leading Lines to Skip: Select the number of header lines to skip in the imported file;

• Trailing Lines to Skip: Select the number of trailing lines to skip in the import file;

• Skip alternate lines: Use to skip every second line in the import file.
to match the settings for the file you are importing. Tooltips may also contain information on the
setting and options.

The import panel shows the data being imported as it is interpreted using the settings chosen to define
columns and formats. The dropdown lists in the headers for each column of the import allow you to
associate a specific column in the imported data with a specific field in the display of a transaction in an
account register. At a minimum to import data, columns in the imported data containing the following
information must be specified:

• Date: of transaction;

• Account: into which transaction is to be imported (or alternatively set the base account as above);

• Description: of the transaction;

• Deposit or Withdrawal: column.

The dropdown list of GnuCash transaction data fields which may be associated with a column of the
imported data contains the following:
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• None: The column is not assigned to a transaction data field and is not imported;

• Date: Ensure the date format in the column matches the Miscellaneous date Format Setting;

• Num: Transaction Num field - Use for check numbers etc.;

• Description;

• Notes;

• Transaction Commodity;

• Void Reason;

• Action;

• Account: This header should be matched to a column specifying the source account for a transaction
if it is present. Otherwise, set the source account in the Account combo box;

• Deposit: Apply this header to a column containing the amount of the transaction. Positive amounts in
the column generally represent an increase in the account balance and negative amounts a decrease
in the balance (asset accounts: Checking, Savings). In external statements supplied by a bank for a
check or savings account, a credit (Cr) is normally an increase in the account balance and a debit (Dr)
a decrease in the account balance. In the banks eyes, your savings or checking account is a Liability
to them;

If the amount data is in separate columns for debits and credits you will have to apply both this
heading and the Withdrawal heading.

• Withdrawal: Apply this header to a column with the amount of the transaction where positive
amounts in the column represent a decrease in the account balance and negative amounts an increase
in the balance (e.g. Liability account: credit card).

Where separate columns are used for debits and credit to the account apply it to the opposite to the
column to which Deposits is applied;

Note

Some experimentation may be necessary to determine the correct allocation of the Deposit
and Withdrawal headings.

• Price: The price for commodity transactions and/or transactions involving currency exchange;

• Memo: Additional column containing descriptive information relevant to one split of a transaction.
If in the first line of a multi-split import it will apply to the source account. In subsequent lines/splits
it is applied to the transfer account defined in that line or allocated to it in the matcher;

• Reconciled: Apply to a column indicating the reconciliation status of the transaction. This generally
only applies to data exported from GnuCash;

• Reconcile Date: Apply to a column which specifies the date of reconciliation, generally only for
GnuCash exported data;

• Transfer Action;
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• Transfer Account: This header should be applied to a column which specifies the transfer account for
the second split of a single line import and/or for subsequent splits in multiline exported transactions;

• Transfer Memo: Apply to a column with descriptive information relevant to a split to a transfer
account specified by Transfer Account;

• Transfer Reconciled: Apply to a column with reconciliation status information relevant to a split to
a transfer account specified by  Transfer Account;

• Transfer Reconcile Date: Apply to a column containing a reconciliation date relevant to a split to a
transfer account previously specified in Transfer Account.

The Skip Errors check box will skip trying to import any rows with errors in matching the columns.

When you are happy with all the import settings, save them if you will use the same settings again, then
press the Next button.

• Match Import and GnuCash accounts: This window allows you to map the accounts identified in the
account columns (Account and Transfer Account) with accounts in the GnuCash account tree (Account
name). Double click on a row to bring up a dialog to select the matching GnuCash account. If you have
previously imported transactions to this account and account mappings can be matched automatically,
this window will not be displayed. When you have selected a match for all accounts, click on the Next
button;

• Transaction Information: The Transaction Information panel allows review of data entry settings so
far. Clicking Next will perform checks on the data. If there are errors you will be returned to the Import
Preview pane to edit the settings. For no errors you proceed to the next step;

• Match Transactions: Clicking on Match Transactions will then bring up the main Import Matcher
window. The Import Matcher is described in a separate section;

• Import Summary: GnuCash displays a summary of the imported data. Click on the Close to exit the
wizard.

Caution

Multi-split imports of multicurrency transactions and commodity transactions are experimental
and may currently experience some errors. Please experiment and report any bugs encountered.

Import MT940 and MT942 SWIFT and DTAUS format files
The SWIFT MT940 format is used for an end of day statement by banks using the SWIFT network for
data exchange. MT942 is used for an intra-day statement in the same system. DTAUS is a format used
with 9 track magnetic tapes since 1976 and later with other removable media (floppy disks). DTAUS has
not been supported by banks since 1 February 2016.

When you select File->Import->

• Import MT940 or;

• Import MT942 or;

• Import DTAUS.

from the menu, GnuCash opens a file selection dialog. Navigate to the MT940, MT942 or DTAUS format
file you wish to import and then click on the Import button. On the first import of data to a given account
specification in the import file, GnuCash will bring up an account selection dialog to select an appropriate
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account into which to import the transactions in the file. GnuCash will map the account description in the
import file onto the selected account and use it for future imports from the same account. The imported
transactions will then be displayed in the Generic Import Transaction Matcher for review.

Generic Transaction Import Matcher

Figure 6.4. The Generic Transaction Import Matcher Window

This is an image of the import transaction matcher window after opening a file to import.

The Import Matcher checks whether an imported transaction matches an existing transaction already
recorded in GnuCash within a predefined time window (~+_42 days) for the account into which the
transactions are being imported. A match probablity is calculated based on the Date, Amount, Transaction
ID's(if present), Check numbers (if present) and the Description and split Memo fields. Exact matches will
generate a high match probability and flag a transaction as matching an existing transaction and therefore
not to be imported. If there is a lower quality match to an existing transaction, the imported transaction may
be flagged for updating of non-matching information in the GnuCash record of the matching transaction.
These decisions can be overridden by the user.

If no matching transaction can be identified the transaction will be flagged for import. The matcher will
attempt to assign a transfer account based on matches between tokenized information for previously
imported transactions stored in lists associated with the transfer accounts which were assigned to them
on import.

• If a good match is obtained, the transfer account is assigned and the transaction is flagged as ready to
import.

• If a transfer account cannot be assigned, the transaction will be flagged for import and manual
assignment of the transfer account by the user. By default, if no transfer account is assigned, transactions
will be assigned to an Imbalance account on import. This is to indicate that they need an appropriate
account assigned to them.

The generic import transaction matcher is invoked when transaction data is imported using any of the
following import formats:

• QIF;
• OFX/QXF;
• CSV;
• MT940;
• MT942;
• DTAUS.

This window has the following
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Controls:

• List of downloaded transactions: Table containing information from the imported transactions.

• Show the Source Account column: Checkbox to displays the account into which the transactions are
being imported. This is the second column labelled Account in the screenshot;

• Help: Display a popup help window;

• Cancel: Close this window without importing transaction data;

• OK: Close this window importing transaction data;

The List of downloaded transactions has the following columns which display the following information
for each of the downloaded transactions:

Columns in “List of Downloaded Transactions”

• Date - The date supplied with the downloaded transaction;

• Account - The import or base account to which the transactions will be imported (optional see above);

• Amount - The amount of the transaction (split to the import or base account);

• Description - The description of the transaction;

• Memo - The memo for the split to the import or base account of the transaction;

• A - Checkbox which indicates that the transaction is to be imported as a new transaction;

• U+C - Checkbox which indicates that the transaction matches an existing transaction but has some
differences and the existing transaction will be updated with the different information

• C - Checkbox which indicates that the transaction matches an existing transaction and will not be
imported;

• Info - For transactions which have been matched to an existing transaction displays a bar indicating the
quality of the match and text indicating whether the transaction is to be imported.

In addition to the checkboxes, the import status of each transaction is indicated by the background color of
the transaction row. The checkbox state, background colors and their meaning are described in Table 6.1,
“Import Status of Transactions”.

Table 6.1. Import Status of Transactions

Checked
Box

Background Meaning

Gold No matches, flagged for input and no transfer account
matched – Import as a new transaction. Intervention
required to select a transfer account.

A DarkSeaGreen1 No matches detected, flagged for input and a transfer
account is matched – Import as a new transaction.
Reconciliation status will be set as cleared (c) on import.
Intervention is not required.

U+C

DarkSeaGreen1 Matches an existing transaction but not exactly on date
and/or amount – Intervention not required, import and
update. Reconciliation status will be set as cleared (n) on
import.
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Checked
Box

Background Meaning

C
DarkSeaGreen1 Matches an existing transaction: – Not to be imported. The

existing transaction reconciliation status will be as cleared
(c) on import. Intervention is not required

 Brown1 Transaction has poor matches and no action was set: – Not
to be imported. Intervention required.

 Cornflower Blue Row is selected

Note

The colors illustrated here are the defaults for GnuCash specified in gnucash-fallback-310.css
[https://github.com/Gnucash/gnucash/blob/maint/gnucash/gnucash-fallback-310.css]. You may
experience different colors if the gtk-3.0 CSS files have been modified

You may always intervene manually to

• change the import action by selecting another checkbox (or none) and/or

• manually assign a different transfer account

after reviewing the matched transactions and accounts and the automatically selected actions.

Multi row selection is enabled for the list of downloaded transactions. The following operations can be
performed on the list of downloaded transactions:

• Click Button1 on a row: Select this row (row is displayed with a blue background);

• Double-click Button1 on a row: If the transactions is flagged for import (see below) this will open
an account selection dialog to select a destination/transfer account to be used in the second split of the
imported transaction. You may create a new account if necessary in this dialog using the New Account
buttonIf the transaction is flagged as matching an existing transaction either for import or updating, the
match picker dialog is opened to allow the matched transactions to be examined and a correct match
selected;

• Ctrl+Button1 on a row: Add the row to a selection of rows (displayed with a blue background) to
which a single destination/transfer account may be applied;

• Shift+Button1 on a row: Select all rows between the last selected row and this row and add them to
the current selection of rows;

• Click Button2 in the window: Display a popup menu which when clicked in turn opens a dialog to
select a single destination/transfer account which will be applied to all rows currently selected.

Important

It is important to assign a transfer account to each transaction prior to import of the transactions.
Otherwise the tokenized information from the imported transaction will not be appended to the list
of tokens for an assigned account for use in future matching of transactions to transfer accounts.

Note

Note that "reconciled" in this context does not mean the same as "reconciled" in the process
of reconciling an account to an external statement. The reconciliation status of an imported
transaction is set to cleared (c) on import of a new transaction
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Where a row has been matched to an existing transaction or is to update an existing transaction it will
have a DarkSeaGreen background. Double-clicking Button1 on the row will bring up the Match Picker
dialog which displays detail of the imported. If you, feel the wrong transfer account has been assigned or
the matcher has not produced a valid result, you may change the checkbox selection if you disagree with
the matcher decisions and you may reassign an assigned transfer account (see below).

Double-clicking Button1 on a row marked as New with a DarkSeaGreen1 background and a transfer
account assigned to it will bring up the account selection dialog to allow you to choose a different transfer
account for the second split.

Double-clicking Button1 on a row marked New with no transfer account matched with a Gold background
will also bring up the account selection dialog to allow you to assign a suitable transfer account to the
transaction.

Assign a Destination Account to a Single Transaction

The currently selected row is selected by left clicking it. It is displayed with a Cornflower Blue background
color.

Double left clicking on a row will select it and open an Account Selection dialog to allow you to assign
a transfer account. Select the desired transfer account in the dialog and click OK. The dialog has a New
Account button which will allow you to create a suitable account if there is no existing account which can
be applied as the transfer account.The row background will change to a DarkSeaGreen1 and the assigned
destination account will be displayed in the Info column.

or alternatively, left click on a row to select it followed by a right click to bring up a popup menu then
select Assign a transfer account to display the Account Selection dialog, select the destination account
and click the OK button.

Assign a Destination Account to Multiple Transactions

Sometimes you will have several transactions which can have the same destination account. GnuCash
allows you to select multiple transactions and apply the same destination account to all transactions in
the selection.

Rows in a selection are displayed with a Cornflower Blue background.

Only rows which have the A checkbox checked and either a DarkSeaGreen1 or Gold background colour
can be selected for inclusion in a multiple selection. Rows with a Brown1 background or with the U+C or
C checkboxes checked cannot be selected in a multiple selection.

To select rows and add rows to a selection either:

• Click Button1 on first row and then Ctrl+Button1  on other rows to add to the selection; or

• Click Button1 on first row and then  Shift+Button1  on another row to select all rows between them.

• Rubber banding is also enabled so you may also  hold Button1 and drag over rows to create a selection.
To add more rows, Ctrl-Button1 and drag over more rows.

then Button2 to display a popup menu and then select Assign a transfer account to open the Account
Selection dialog. Select the desired destination account (create a new account if necessary) and click the
OK button in the Account Selection dialog.

Completing the Import

Once you have assigned destination accounts for all the imported transactions using the above methods (all
row backgrounds will be a light green colour), check that the assigned destination acounts are correct and
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then press the OK button at the bottom of Figure 6.4, “The Generic Transaction Import Matcher Window”.
The transactions selected for import will have their splits added to the selected source and destination
accounts.

The tokenized data from the transactions assigned to a given transfer account is stored on exiting from the
matcher and is used to match transactions to the appropriate transfer account in future imports.

Match Picker
The Match Picker allows you to review and edit existing GnuCash transactions which have been matched
to a transaction being imported. Button1 on a row with the C checkbox checked to bring this dialog up.

Figure 6.5. The Match Picker Dialog

The Match Picker dialog window showing existing GnuCash transactions matching an imported transaction.

The top pane of the Match Picker displays details of the first split of the transaction to be imported. The
column labels:

• Account

• Date

• Amount

• Description

• Memo

• Balanced

are the same and have the same meaning as in Columns in “List of Downloaded Transactions” with the
exception of the Balanced column which gives the amount of the balancing split for the transaction.

The lower pane displays the details of existing GnuCash transactions which match this transaction. If no
transactions are displayed check the Show Reconciled checkbox at the bottom of the panel. The first row
in this pane will normally be the auto-matched transaction with the best match score. Other rows will
display other existing transactions which might also be matches for the transaction being imported. The
columns in this pane are:
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• Confidence: This column indicateds the confidence of the individual match as both a bar chart and a
numerical value. Where the bar extends into the green, the match is good. If the bar only extend to the
red or yellow setions the quality of match is more doubtful.

• Date

• Amount: If this does not match exactly the amount of the transaction being imported but otherwise
the match is good, the amount of the imported transactions is used to update the existing transaction
matching it.

• Description

• Memo

• Reconciled: Indicates the reconciliation status of a matching existing transaction.

• Pending Action

If you are not happy with the existing transaction that was auto-matched, Button1 on your preferred match
to select it and then Button1 the OK. The transaction will then be marked as a (manual) match in the Info
column of the Import Matcher. To exit the dialog without changing the auto-match Button1 on the Cancel.

Import Match Editor
The Import Match Editor allows you to edit the data used by GnuCash to automatically assign a transfer
account in the Import Matcher. It can be used to edit the data used by the Bayesian matcher, the Non-
Bayesian matcher and online ID's. To open it select  Tools->Import Map Editor from the menu.

Figure 6.6. The Import Map Editor

The Import Map Editor illustrating typical entries for the Bayesian matcher.
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The three radio buttons at the top of the dialog select the type of data being displayed and edited:

• Bayesian: The Bayesian matcher matches a transfer or destination account using the frequency of
association of a token string with an assigned transfer/destination account in the Import matcher for a
specific source account (the account that the first split of the imported transactionis directed to);

• Non-Bayesian: The Non Bayesian matcher matches the transfer account on the basis of the occurrence
of a token string in transactions assigned to a transfer/destination account and does not record
the frequency of association. This was the original GnuCash matching process and has now been
superceeded by the Bayesian matcher in more recent versions;

• OnlineiD: Online ids are specific strings which identify specific accounts in information downloaded
from online sources. they may include account numbers and specific instiution identifiers.

The Bayesian matcher data columns are:

• Source Account: This is the account into which a transaction has been imported and is normally the
first split in an imported record. It may either be specified in the record itself or during the import setup
for all transactions to be imported. The arrow control at the left of each entry in this column may be
used to display all the data used in matching a transfer or destination account for transactions which
have this account as their source split;

• Match String: This column displays a specific token string that has been associated with the allocation
of the account in the Mapped to Account Name column as a transfer/destination account for transfers
to the Source Account;

• Mapped to Account Name: The account name in this column is a GnuCash account name which has
been allocated as a transfer/destination account in association with the token string in the Match String
column;

• Count of Match String Usage: This is the number of times the token string in the Match String column
has occurred in association with the transfer/destination account specified in the Mapped to Account
Name column for transactions imported to GnuCash.

The Non-Bayesian matcher displays the same first three columns as the Bayesian matcher having the
same usage. It does not store data on the frequency with which a particular token is associated with the
assignement of a given transfer/destination account. It has an additional column which specifies the type
of the imported data process in which the assignment occurred.It has the following columns:

• Source Account;

• Based on: This identifies the import process in which the Match String was associated with the transfer
destination account in the Mapped to Account Name column;

• Match String;

• Mapped to Account Name.

Online ID displays the same columns with the same data as the Non-Bayesian matcher.

The Filter textbox at the bottom of the dialog allows filtering of the displayed data matching the entered
string in either the Match String column or the Mapped to Account Name column.

The Expand All and Collapse All buttons expand or collapse the data in the other columns for the accounts
in the Source Account column.
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The Delete button will delete any selected rows in the displayed matcher data.

The Close button closes the Import Match Editor dialog.

Exporting Transactions
GnuCash allows transaction data to be exported in CSV format with the optional use of alternative column
separators. Transactions can be exported in either a single line format (simple layout) which can only be
used for transactions with two splits and may not allow all the data associated with a transaction to be
exported or in a multiline format where two or more lines are used for transactions with two or more splits
with each splits information on separate lines. Transaction data can be exported either from the currently
selected active register or from selected accounts. The menu commands to export transactions are:

• File->Export->Export Transactions to CSV;

• File->Export->Export Active Register to CSV.

These commands start the wizard illustrated in to setup the export. They differ only in that in the latter
case the Account Selection step is not available in the left hand pane.

Figure 6.7. The Export Transactions Wizard.

The Export transaction wizard opens at the first step and performs the steps listed in the left hand pane:

• Choose Export Settings;

• Account Selection;

• Choose File Name for export;

• Export Now...;

• Export Summary.

Navigation between the steps uses the buttons displayed in the right hand lower corner of the wizard.
Which of the following buttons are displayed will depend on what is permissible from the step:

• Cancel: Exit the wizard without exporting any transactions;
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• Back: Return to the previous step in the wizard;

• Next: Proceed to the next step.

Choose Export Settings
This step allows you to choose various options in the formattig of the transactions being exported.

The Options checkboxes may be selected singly or both may be selected together:

• Quotes: Surround each data field in quotes;

• Simple layout: If checked, the ouput transaction data will be as displayed in the single row register
view option and some of the transfer detail may be lost.

The column headers for data exported in Simple layout format are:

1. Date

2. Account Name: name of the source account;

3. Number

4. Description

5. Full Category Path: full account name for transfer/destination account;

6. Reconcile

7. Amount with Sym

8. Amount NUm

9. Rate/Price

If Simple layout is not checked the transaction data will be exported in a multi-line format.

The column headers for a multiline output for a transaction are:

1. Date: first line only;

2. Transaction ID: first line only;

3. Number: first line only;

4. Description: first line only

5. Notes: first line only;

6. Commodity/Currency: first line only;

7. Void Reason: first line only;

8. Action: first line and subsequent lines;

9. Memo: first line and subsequent lines;

10.Full Account Name: first line and subsequent lines;
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11.Account Name: first line and subsequent lines;

12.Amount with SYm: first line and subsequent lines;

13.Amount Num: first line and subsequent lines;

14.Reconcile: first line and subsequent lines;

15.Reconcile Date: first line and subsequent lines;

16.Rate/Price: first line and subsequent lines;

Each line contains the data relevant to a single split with the first line also having transaction data
relevant to all splits in the first 7 columns.

The Separators radio buttons allow the choice of an alternative column separator:

• Comma(,): This is the default separator;

• Colon(:): Use a colon to separate the columns;

• Semicolon(;): Use a semicolon to separate the columns;

• Custom: Define a custom character to separate the columns by entering it in the textbox.

Button1 on Next to go to the next step.

Account Selection
This step allows selection of one or more accounts and the specification of the date range containing the
transactions to be exported.

The Accounts panel displays an account tree which allows one or more accounts to be selected for export.
(Ctrl-Button1> and Shift-Button1 may be used to select accounts). The Select Subaccounts button will
select all subaccounts of a selected account. The Select All button will select all accounts in the account
tree for export. The number of accounts which have been selected is indicated.

The Dates panel allows selection of either all transactions or only those within a selected date range in
the selected accounts to be exported.

Choose File Name for export
A file selection dialog is presented allowing specification of a file name and a path to the directory/folder
in which it is to be stored.

Export Now...
The filename and path of the file to be exported and the number of accounts to be exported is displayed.
To continue with the export Button1 the Apply button.

Export Summary
Displays a message if the file is successfully exported or an error message and debugging suggections
if not.
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Online Actions ...
Note

This section is "under construction - any input will be welcome !!".

Get Balance

Get Transactions ...

Issue Transaction

Direct Debit

General Journal
The General Journal is an advanced register used to enter transactions without needing to open individual
accounts. The General Journal shows the transaction entries for all accounts on one register.

Entering transactions in the General Journal is more complicated than entering them in the individual
account registers. The advantage is the General Journal provides a more comprehensive view of the
transactions you have entered in all your accounts.

The General Journal defaults to showing only the previous month of transactions. This is changeable by
using the "Filter By..." on the View menu.
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Chapter 7. Business Features
The accounting needs of a business are quite different from that of a person. Businesses have customers
that owe money, vendors which are owed money, employee payroll, more complex tax laws, etc. GnuCash
offers business oriented features to facilitate these needs.

Accounts Receivable (A/R) are used by businesses to record sales for which they are not immediately paid.
Accounts Payable (A/P) record bills that they have received, but might not pay until later. These types of
accounts are used primarily when you have a lot of bills and receipts flowing in and out, and do not want
to lose track of them just because you do not pay or get paid right away. For most home users, A/R and
A/P are too complicated to be worth the effort.

Accounts Receivable (or A/R) refers to products or services provided by your company for which payment
has not yet been received. This is represented on the balance sheet as an asset, because the expectation is
that you will receive payment soon.

Accounts Payable (or A/P) refers to products or services bought by your company for which payment has
not yet been sent. This is represented on the balance sheet as a liability because you will have to pay for
them.

Initial Setup
To set up GnuCash to handle accounts receivable and accounts payable for a company the following
preliminary steps must be done.

Account Setup
There are many different ways to set up a business account hierarchy. You can start with the Business
Accounts setup which is available from the New Account Hierarchy assistant, or you could build one
manually. To access the prebuilt Business Accounts, start GnuCash and click on File → New File and
proceed until you see the list of available accounts, select Business Accounts.

Note

The prebuilt Business Account hierarchy will not meet your needs exactly. You will need to make
adjustments for the hierarchy to function well with your particular situation. It should be close
enough that it is recommended you begin with it.

Tax Tables
Tax Tables can used to determine the tax for customer invoices (or vendor bills).

A tax table can be assigned to an invoice line or bill line.

The default invoice line tax table can be assigned to each customer and the default bill line tax table can
be assigned to each vendor.

The default tax table for new customers or new vendors can be specified in the Book Options  window
which can be accessed by File → Properties → Business tab.

Tax Tables are maintained using the Sales Tax Table editor which is accessed via menu Business → Sales
Tax Table. The following fields should be entered:
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• Name This is the tax table name.

• Type Either Percent % or Value $ .

• Value This is the percentage or value depending on Type.

• Account This is the account to which tax will be posted. For tax collected from customers, this should
probably be a Liability account as it must be payed to the government. For tax paid to vendors, if tax
laws allow tax paid to vendors to offset tax collected from customers, this should probably also be
a Liability account (even though it will usually have a debit balance) so that the net tax owed to the
government can be easily observed.

If you set up Tax on Purchases and Tax on Sales as subaccounts of Liabilities:Tax then the net tax will
be rolled up and can be seen in the GnuCash Accounts tab.

If unsure about tax law requirements, get professional advice.

Company Registration
After you have built the account structure and defined your tax tables, register the GnuCash file as
belonging to your company by filling in the data requested in the the section called “Business Book Options
Tab” accessible from the File → Properties menu item.

Counters
Define the format and last used numbers of codes such as customer, invoice, vendor, bill, employee,
expense voucher, job number and order. See the section called “Counters Book Options Tab”.

Business Preferences
Set options on the Business tab of the GnuCash preferences, which is accessed via Edit → Preferences
(GnuCash → Preferences on MacOS). See the section called “Business”.

Billing Terms
Billing Terms can be used to determine the payment due date and be a guide for determining discount for
early payment of invoices (or vendor bills).

Note

As of GnuCash 2.6.7, Billing terms are only partially supported. Date due is calculated but
discount amount is not.

Discount for early invoice payment is not implemented. There are 2 ways this may be done,
although neither is recommended, and professional advice should be used to confirm that
regulations are being complied with:

• After creating and posting a payment which pays the invoice in full, manually edit the payment
transaction (usually strongly discouraged) and split the payment to reduce it by the amount of
the discount and a create a compensating split in an income (discount) account.

• Alternatively, after creating and posting a payment for the discounted amount, create a credit
note for the discount using a specific negative sales income (discount) account for the transfer
account.
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You can specify the billing terms on each invoice/bill. Invoice billing terms will default from the customer
billing terms. Bill billing terms will default from the vendor billing terms.

Billing Terms are maintained using the Billing Terms Editor which is accessed via menu Business →
Billing Terms Editor. The following fields should be entered:

• Name The internal name of the billing term. For some examples of billing term names and descriptions
see https://wiki.gnucash.org/wiki/Payment_Terms

• Description The description of the billing term, printed on invoices

• There are 2 types of billing terms, with different information to be entered

• Type Days

• Due Days The invoice or bill is due to be paid within this number of days after the post date

• Discount Days The number of days after the post date during which a discount will be applied for
early payment

• Discount % The percentage discount applied for early payment

• Type Proximo

• Due Day The day of the month bills are due

• Discount Day The last day of the month for the early payment discount

• Discount % The discount percentage applied if paid early

• Cutoff Day The cutoff day for applying bills to the next month. After the cutoff, bills are applied
to the following month. Negative values count backwards from the end of the month.

Accounts Receivable
GnuCash has an integrated accounts receivable system.

To use GnuCash’s integrated accounts receivable system, you must first set up Accounts Receivable
accounts of type A/Receivable under Assets to accrue income you're owed. It is within this account that
the integrated A/R system will place transactions, debiting it when you post bills and crediting it when
you receive payments.

        Basic A/R Account Hierarchy:

        -Assets
          -Accounts Receivable
          -Checking
        -Income
          -Sales
        -Liabilities
          -Tax
            -Tax on Purchases
            -Tax on Sales
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Note

You need to add additional asset, expense, and income accounts to this hierarchy for it to be
useful. The important aspects of this hierarchy are the use of an income account and the Accounts
Receivable asset account, with account type set to A/Receivable.

If you deal with customers in more than one currency you will need a separate Accounts
Receivable account for each currency.

The transactions generated by the A/R system are recorded within the Accounts Receivable account. You
generally do not work directly with this account. You generally work with the four integrated GnuCash A/
R application components available through the Business → Customer sub-menu. These four components
are:

the section called “Customers” People or companies to whom you sell
products or services on credit.

the section called “Invoices” The physical invoice you send to a customer
to request payment. This invoice contains an
itemized list of things you sold.

the section called “Customer Jobs” Is where you register Customer Jobs. Jobs
are a mechanism by which you can group
multiple invoices to a particular customer.

the section called “Process Payment” Used to register payments you received from
a customer.

The following sections introduce the individual components in more detail.

Customers
Customers are people or companies to whom you sell goods or services. They must be registered within
the A/R system.

New

To register a new customer, enter the menu Business → Customer → New Customer. Fill in customer
information, such as Company Name, Address, Phone, Fax, etc. Below is a list of the other options:

• Identification - Customer Number - can be any number by which you would like to refer to this customer.
You may leave it blank and a number will be chosen automatically. See the section called “Counters
Book Options Tab” for more info.

• Identification - Active - differentiates active customers from inactive ones. This is useful when you have
many past customers, and you want to see only those marked active.

• Billing Address - Name - is the contact name of the person to receive the invoices.

• Notes - records any additional comments about the customer.

86



Business Features

• Billing Information - Currency - specifies the billing currency for this customer. It will default to the
default currency set in Preferences

Note

All invoices will be denominated in this currency and GnuCash will require an Accounts
Receivable account in this currency.

• Billing Information - Terms - specifies the default billing terms for this customer. Billing terms must
be preregistered using Business → Billing Terms Editor.

• Billing Information - Discount - gives the customer a default percentage based discount at the time of
invoice creation. Enter a value from 0 to 100. You can override the default discount when you create
an invoice.

• Billing Information - Credit Limit - stores the maximum credit you are willing to extend to the customer.
This field is for your reference purposes only. GnuCash does not use the value.

• Billing Information - Tax Included - this specifies whether nor not tax is included in invoice amounts
by default. You can choose Yes, No, or Use Global.

• Yes means that the tax is already included in amounts on invoices.

• No means tax is not included.

• Use Global means to use the setting made in the global preferences accessible through Edit →

Preferences (Gnucash → Preferences on MacOS).

• Billing Information - Tax Table - specifies a default tax table to apply to invoice line items. Tax tables
must be registered from the Business → Tax Table Editor menu item.

• Shipping Address - records the customer’s shipping address if it is different from the billing address.
The shipping address is for your reference. GnuCash does not use the value.

Find and Edit

To search for an existing customer, use the Business → Customer → Find Customer window. You select a
customer to View/Edit from the results of the search. This window is also used to look up customers when
creating invoices and processing payments.

If many customers match the search criteria you provide, the search can be refined by running an additional
search within the current results. The current result set is searched when the Refine Current Search radio
button is selected. In fact, GnuCash selects this option for you after you run the initial search.

If the customer you are searching for does not match the supplied search criteria, change the search criteria,
click the New Search radio button and then the Find button. The relevant step is the New Search selection.
If the customer is not in the result of the original search, and you only search within this set, the customer
cannot be found, regardless of new search criteria.

Note

To return a list of all registered active customers, set the search criterion to matches regex, and
place a single dot "." in the text field area. Make sure Search only active data is checked, then
click Find. The regular expression "." means to match anything.
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Invoices
An invoice is the paperwork you send to a customer to request payment for products or services rendered.
GnuCash can generate and track invoices.

A credit note is the paperwork you send to a customer to correct products or services rendered that were
incorrectly invoiced. GnuCash can generate and track credit notes via the same menu entries as invoices.

Note

This section applies to both invoices and credit notes. In order to avoid repeating everything
twice and to keep the text easier to read it will refer only to invoices. You can apply it equally to
credit notes. Only where the behaviour of credit notes differs from invoices this will be explicitly
mentioned. Credit notes were introduced starting with GnuCash stable release 2.6.0.

New
To send an invoice to a customer you must first create a new invoice. To create an invoice use Business
→ Customer → New Invoice. The New Invoice window must be filled in appropriately:

• Invoice Information - Type - the type of customer document to create - either an invoice or a credit note.

• Invoice Information - Invoice ID - the identification number of this invoice. This is your internal number
for this invoice. If you leave it blank, an invoice number will be generated automatically. See the section
called “Counters Book Options Tab” for more info

• Invoice Information - Date Opened - the date this invoice was created.

• Billing Information - Customer - the customer who is to receive this invoice. If you remember the
company name you entered in the New Customer window for this customer, start to type it in this field
and GnuCash will try auto complete it for you. Else, press the Select... button to access the Find Customer
window described in the section called “Find and Edit”. Highlight the customer you are looking for with
a click in the search results, then press the Select button.

• Billing Information - Job (optional) - associates the new invoice with a customer job (see the section
called “Customer Jobs”). If you remember the job name you entered in the New Job window for this
job, start to type it in this field and GnuCash will try auto complete it for you. Else, press the Select...
button to access the Find Job window. This window is the same to the one described in the section
called “Find and Edit”. Highlight the job you are looking for with a click in the search results, then
press the Select button.

• Billing Information - Billing ID - this is the customer’s PO Number or other “customer reference
number”. You should use it to identify your invoices to this customer (and job, if you have one).

• Billing Information - Terms - the payback terms agreement for this invoice. A list of registered terms is
available within the pop up menu. If you specified a default value for the selected customer, this field
is initialized with the default.

When you click the OK button, the Edit Invoice window opens.

Edit
From the Edit Invoice window you can enter an itemized list of goods and services you sold on this invoice
in a manner similar to how the account register works. For credit notes you enter an itemized list of goods
and services you refunded instead.
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There are 15 columns in the Invoice Entries area:

• Date - The date this item was sold.

• Invoiced? - X means the item is attached to this invoice, an empty box means the item is not attached
to this invoice. The item is attached for you when you proceed to the next line item.

• Description (optional) - is what the item or service is called.

• Action (optional) - is a user defined field. You can place Cost Center information here, or use one of
the 3 predefined actions, Hours, Material, or Project.

• Income Account - selects which income account is credited with this income.

• Quantity - tracks how many of the items you sold.

• Unit Price - is the unit price of the item.

• Discount Type - is the type of discount:

• $ means Discount is a monetary value

• % means Discount is a percentage.

You can click the field to toggle between the discount types.

• Discount How - the discount can be computed as follows:

• > means the discount applies after tax.

• < means the discount applies before tax.

• = means both discount and tax are applied to the pretax value.

You can click the field to change the setting.

• Discount (optional) - is the total discount, in monetary units or percentage, depending on Discount Type.
You can leave it blank for no discount. Any default discount you specified for the customer will be
automatically entered for each new item.

• Taxable? - is this item taxable? X means yes, a blank field means no. You can click the field to toggle
the setting.

• Tax Included? - has the tax already been included in the unit price? X means yes, a blank field means
no. For example, if there is 1 item of $100 with a tax of 5% then:

• If Tax Included is empty, then subtotal = $100 and tax = $5.

• If Tax included is set (X), then subtotal = $95.23 and tax = $4.77. The computation is: Subtotal =
Total / (1+taxrate) and Tax = Total - Subtotal = Total - (Total / (1+taxrate)).

• Tax Table (optional) - this is a pop up menu of all the available tax tables. If you make the item taxable,
then this table is used to compute the amount of tax. The tax table determines tax percentages and the
accounts to which tax is charged.

• Subtotal (uneditable) - is the computed subtotal for this item (less tax).

• Tax (uneditable) - is the computed tax for this item.
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When you have finished entering all the items, you can Post and print the invoice.

Post
When you finish editing an invoice and are ready to print, you must Post the invoice. The invoice does
not have to be posted immediately. In fact, you should only post an invoice when you are ready to print it.
Posting an invoice places the transactions in an accounts receivable account.

The Post Invoice window appears and asks you to enter the following information:

• Post Date - specifies the date for the transactions entered into the accounts receivable account. By default
this is the invoice’s Date Opened (see the section called “New” for information about that date).

• Due Date - is the date on which payment for the invoice is expected.

• If you specified payment terms when you created the invoice, the date is calculated according to
selected terms, and the entry field is insensitive.

• If you did not specify payment terms, enter the expected payment due date here.

• Description - is an arbitrary description. When invoice transactions are placed in the accounts receivable
account, this description is entered in the memo field of those transactions.

• Post To Account - selects the accounts receivable account in which invoice transactions are posted. You
can select the account from a list of existing A/Receivable accounts.

• Accumulate Splits - determines if invoice items which transfer to the same account are combined into
a single split for that account or entered individually. For the sample invoice which sold Nails and a
Hammer, the setting affects post results as follows:

• Checked (splits are accumulated) - a single transfer of $575.00 from the Income:Sales account is
recorded.

• Not checked - the transaction created in the A/Receivable account, shows two transfers from
Income:Sales account $100.00 and $475.00. The memo fields in the splits indicate the sale of Nails
and the Hammer (the item descriptions entered on the invoice) respectively.

Find
To find an existing invoice, use the Business → Customer → Find Invoice menu item. From the results of
the search, you can select an invoice to edit or view.

Note

Before you can edit a posted invoice, you will need to Unpost it.

One of the design goals in GnuCash’s Account Receivable system was to allow different processes to get
to the same state, so you can reach an invoice from different directions based on the way you think about
the problem:

• You can search for the customer first, then list their invoices.

• You can search for invoices by number or by company name.

• You can list invoices associated with a customer job.
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Print
After you post an invoice, you should print it and send it to your customer. To print an invoice use File
→ Print Invoice menu item.

Tip

You can modify the appearance of the invoice, IE: add a company logo, etc. To do so, see the the
section called “Changing the Invoice Appearance”.

Invoices can also be printed from the main window by selecting Reports → Business Reports → Printable
Invoice from the main menu. The resulting report window states that no valid invoice is selected. To select
the invoice to print:

1. Use the Options Toolbar button or select Edit → Report Options from the main menu.

2. Select the General tab of the report options dialog.

3. Click the Select button next to the Invoice Number field.

4. Search for the invoice as usual.

You can also print invoices from within the Process Payment dialog. See the the section called “Process
Payment” for instructions on how to do so.

Assign Starting Invoice Number
By default, GnuCash starts with invoice number 1 and increments from there. You can manually type an
invoice number into the text box each time you create an invoice, but this gets tiring and sooner or later
leads to duplicate numbers.

You can change the starting invoice number if it is important you. Use File → Properties, access the
Counters tab, change the Invoice number value to be one less than your desired starting invoice number
and click the OK button or the Apply button.

Customer Jobs
Customer Jobs are used to group multiple invoices and credit notes to the same customer. Use of the
Customer Jobs feature is optional. The feature is useful when you have multiple jobs for the same customer,
and would like to view all the invoices and credit notes related to a single job.

To use customer jobs, you must create them using the Business → Customer → New Job menu item. You
will see the New Job window. The editable fields are:

• Job Info - Job Number (optional) - enter the number for this job. If left blank, a number will be chosen
for you. See the section called “Counters Book Options Tab” for more info.

• Job Info - Job Name - the name you want to assign to the new job.

• Owner Info - Customer - the customer for whom the job is created. If you remember the company name
you entered in the New Customer window for this customer, start to type it in this field and GnuCash
will try auto complete it for you. Else, press the Select... button to access the Find Customer window
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described in the section called “Find and Edit”. Highlight the customer you are looking for with a click
in the search results, then press the Select button.

• Owner Info - Billing ID - the customer’s reference to this job (e.g. their PO Number). This is the "Billing
Identification" that they require to correlated your invoices with their order. The Billing ID you enter is
used to set the billing id for new invoices associated with this job.

• Job Active - toggles this job being active or not. This is useful when you have many inactive jobs, since
it is easier to search only among jobs that are marked active.

To edit an existing customer job, use the Business → Customer → Find Job menu item. Select the desired
job in the search results, and click the View/Edit Job button.

To select from the invoices and credit notes associated with a given job, use Business → Customer → Find
Job menu item. Select the desired job in the search results and click the View Invoices button. A window
listing invoices and credit notes associated with this job appears. Select an invoice or credit note and click
the View Invoice button to open an invoice editor in the main application window.

Process Payment
Eventually, you will receive payment from your customers for outstanding invoices. To register these
payments, use the Process Payment application found in Business → Customer → Process Payment.

Tip

There is an alternative way of assigning a payment to (one or more) invoices where the payment
transaction already exists, say in the case where transactions have been imported from a bank.
There is no way to assign a payment to an invoice during the import process, so this must be done
after transactions have been imported.

This can best be done starting from the asset account register holding the imported payment
transaction (like your bank account). In that account, select the payment, right-click (control-
click for Mac OS X) and choose Assign as payment.... The payment window will pop-up, partly
filled in with the information from the transaction. Fill in the missing information like the proper
customer and invoice to complete the payment.

One caveat: the logic behind Assign as payment... won't properly detect credit note
reimbursements and will wrongfully interpret such a transaction as a vendor bill.

The Process Payment application consists of:

• Payment Information - Customer - the customer who paid you. If you remember the company name
you entered in the New Customer window for this customer, start to type it in this field and GnuCash
will try auto complete it for you. Else, press the Select... button to access the Find Customer window
described in the section called “Find and Edit”. Highlight the customer you are looking for with a click
in the search results, then press the Select button.

• Payment Information - Invoice - the invoice for which payment was received. If you remember the
invoice ID, start to type it in this field and GnuCash will try auto complete it for you. Else, press the
Select... button to access the Find Invoice window described in the section called “Find”. Highlight the
invoice you are looking for with a click in the search results, then press the Select button.

• Payment Information - Date - the date you you received payment.

• Payment Information - Amount - the amount of money received.
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• Payment Information - Num - the check number.

• Payment Information - Memo - any comments about this payment.

• Post To - the A/Receivable account to which to post this transaction.

• Transfer Account - the account where the money will be deposited (a checking account for example).

Over Payments or Pre-Payments
If a customer overpays an invoice or pays for goods or services before they have been invoiced, Process
Payment for the total amount received. GnuCash will then keep track of the over-payment (or pre-payment)
in the A/R account and you can use the residual when paying the next invoice.

Partial Payments
Partial payments are possible too. Select the invoice to pay. GnuCash will automatically suggest that
invoice's remaining balance as payment amount. Simply adjust that amount to what you want to pay.

Writing Off a Bad Debt

Note

Please check with your accountant to ensure the following is acceptable in your region.

The usual way to do this is to process a payment for the invoice to a BadDebt account. Such an account
would be an expense account. However, in GnuCash, you can't process a payment for an invoice directly
to an expense account, so it takes two steps:

• Pay the invoice to an asset or liability account, such as your checking account.

• Change the asset or liability account, in the  non Accounts Receivable split of the payment transaction,
to the BadDebt expense account.

Specifically

• Remove all transactions from the A/R account related to the invoice, except for the invoice's transaction
itself. This includes any payment transactions, and transactions between your BadDebt and A/R account.

In case the payment has associated lot link transactions (1), remove those as well.

If all is well, your Process Payment window for this customer should list the invoice the customer won't
pay, and no prepayments.

• Pay your invoice to an arbitrary asset or liability account. It can be your checking account. We will fix
that in the next step.

• Open the account register for your A/R account. For this invoice there should now be one payment
transaction. If you are using GnuCash 2.6.0 - 2.6.4 there will also be one lot link transaction (1).

• Select the payment transaction and change the transfer account to your BadDebt account. Make sure to
leave the transaction (eg by clicking on another transaction) to save the changes.

If all is well, your Process Payment window should still be clean: no pre-payments, and the bad debt
invoice gone.
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Note

(1): GnuCash versions 2.6.0 to 2.6.4 created lot link transactions which show in the A/R account
register. This came with its own set of subtle issues. It is recommended to upgrade to the latest
(or at least 2.6.6) version, which fixes a lot of small problems. Version 2.6.5 had a flaw in the
logic cleaning up the lot links. Once upgraded, please run Actions → Check & Repair on your
A/R and A/P accounts to clean up most of the lot link legacy. Don't forget to make a backup
first just in case.

Lots are used internally for relating payments to invoices. Lots themselves are invisible in the
account registers. To see them you need to open the lot viewer, which can be found in Actions →
View lots while in any A/R or A/P account register. Select a lot to see the Splits in lot.

Lot links are transactions which you can see in your A/R and A/P accounts. They are unusual in
the sense that all their splits are in one account (A/R or A/P). Each split in a lot link transaction
is linked (hence the name) to an invoice or payment transaction by means of a lot.

See https://wiki.gnucash.org/wiki/Business_Features_Issues for more information.

Changing the Invoice Appearance
The default Invoice style, as shown in the section called “Print”, is fairly barren. The default invoice style
leaves the top part of the form blank, so you can print on company letterhead paper. There are some things
you can do to change invoice appearance.

Use File → Properties to enter your Company information in the Business tab of the Book Options window.
Some of the entered information is printed on the right side of invoices.

To add a customized background, heading banner or logo to invoices, modify the invoice style sheets.
To do this, go to Edit → Style Sheets and select the New button in the Select HTML Style Sheet window
that will appear.

Give a Name to the new style sheet (e.g. Custom Invoice) and select the Fancy Template. When you click
the OK button, the HTML Style Sheet Properties window is displayed. This window presents you five
sections listed in the left pane: Colors, Fonts, General, Images, and Tables. The Colors section allows you
to change the colors of various items of the invoice. The Fonts section lets you set font type and dimensions.
The General section allows you to set the Preparer and Prepared for information, and to Enable Links. The
Images section allows you to import graphics into the style sheet. The Tables section allows you to adjust
the spacing around the tables which make up the invoice.

To include a company logo, banner heading and background image, use your favorite graphics application
such as The Gimp or OpenOffice Draw to save the images in either GIF or PNG format. Then import them
into the style sheet using the Images section described above.

Note

The images are placed in the invoice as follows. The Background Tile is tiled to become the
background image, the Heading Banner goes above the invoice text, and the Logo is placed in the
upper left corner of the invoice to the left of the Heading Banner. You will probably have to try
a few different sized images until you get the invoices to print nicely. Some sizing suggestions
are that the Logo should be 1 square cm (~0.5 inch), and the Heading Banner should be 15 cm
(~6 inches) wide and 1 cm (~0.5 inch) tall.

With the style sheet configured, when you print the invoice, you select the style sheet to use from the
Options menu.

94

https://wiki.gnucash.org/wiki/Business_Features_Issues


Business Features

Accounts Payable
GnuCash has an integrated accounts payable system. As with Accounts Receivable you must have an
Accounts Payable account set up under Liabilities for each currency in which you will issue invoices.
The Accounts Payable accounts accrue the amounts you owe to others, so bills credit these accounts and
payments and credit memos debit these accounts. Generally you do not directly work with this account
but use the four integrated GnuCash A/P application components. The A/P components are available from
the Business → Vendor sub-menu.

These A/P components are:

• Vendors are people or companies from which you buy products or services on credit.

• Bills represent the physical bills vendors send to request payment from you. A bill contains an itemized
list of things you purchased.

• Jobs (optional) is where you register Vendor Jobs. Jobs are a mechanism by which you can group
multiple bills from a particular vendor.

• Process Payments is where you register payments to a vendor to whom you owe money.

The following sections introduce the individual Accounts Payable application components.

Vendors
A vendor is a company or person from whom you purchase goods or services. Vendors must be registered
within the A/P system.

New
To register a new vendor, select the Business → Vendor → New Vendor menu item. Fill in general
information about the vendor, such as Company Name, Address, Phone, Fax, etc. Below is a list of the
other options:

• Identification - Vendor Number - can be any number by which you would like to refer to this vendor.
You may leave it blank and a number will be chosen automatically. See the section called “Counters
Book Options Tab” for more info

• Identification - Active - differentiates active vendors from inactive ones. This is useful when you have
many past vendors, and you want to see only those marked active.

• Payment Address - Name - is the contact name of the person to receive payments you make.

• Notes - records any additional comments about the vendor. Use it to track names of contact people
within the vendor’s company, for example.

• Payment Information - Currency - specifies the payment currency for this vendor. It will default to the
default currency set in Preferences

Note

All Bills and Credit Notes will be denominated in this currency and GnuCash will require an
Accounts Payable account in this currency.

• Payment Information - Terms - specifies the default payment terms for this vendor. Payment terms must
be preregistered using Business → Billing Terms.
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• Payment Information - Tax Included - specifies if tax is included in bills from this vendor. You can
choose Yes, No, or Use Global.

• Yes means that tax is already included in amounts on bills.

• No means tax is not included.

• Use Global means to use the setting made in the global preferences accessible through Edit →

Preferences (Gnucash → Preferences on MacOS).

• Payment Information - Tax Table - specifies a default tax table to apply to bills from this vendor. Tax
tables must be registered using the Business → Tax Table menu item.

Find and Edit
To search for an existing vendor, use the Business → Vendor → Find Vendor window. You select a vendor
to View/Edit from the results of the search. This window is also used to look up a vendor when entering
bills and processing payments.

If many vendors match the search criteria you provide, the search can be refined by running an additional
search within the current results. The current result set is searched when the Refine Current Search radio
button is selected. In fact, GnuCash selects this option for you after you run the initial search.

If the vendor you are searching for does not match the supplied search criteria, change the search criteria,
click the New Search radio button and then the Find button. The relevant step is the New Search selection.
If the vendor is not in the result of the original search, and you only search within this set, the vendor
cannot be found, regardless of new search criteria.

Tip

To return a list of all registered active vendors, set the search criterion to matches regex, and place
a single dot “.” in the text field area. Make sure Search only active data is checked, then click
Find. The regular expression “.” means to match anything.

Bills
A bill is a request for payment you receive from a vendor. GnuCash can track bills.

A credit note is the document you receive from a vendor to correct products or services rendered that you
were incorrectly charged for on a bill. GnuCash can generate and track credit notes via the same menu
entries as bills.

Note

This section applies to both bills and credit notes. In order to avoid repeating everything twice and
to keep the text easier to read it will refer only to bills. You can apply it equally to credit notes.
Only where the behaviour of credit notes differs from bills this will be explicitly mentioned.

New
When you receive a bill from a vendor and want to enter it into GnuCash, you must create a new bill.
To create a new bill use the Business → Vendor → New Bill menu item, and fill in the resulting window
appropriately.

96



Business Features

• Invoice Information - Type - the type of vendor document to create - either a bill or a credit note.

• Invoice Info - Invoice ID (optional) - the identification number of the invoice as emitted by the vendor
(IE: the vendor’s internal number for this invoice).

• Invoice Info - Date Opened - the date the Invoice was emitted by the vendor.

• Billing Info - Vendor - the issuing vendor. If you remember the company name you entered in the New
Vendor window for this vendor, start to type it in this field and GnuCash will try auto complete it for
you. Else, press the Select... button to access the Find Vendor window described in the section called
“Find and Edit”. Highlight the vendor you are looking for with a click in the search results, then press
the Select button.

• Billing Info - Job (optional) - associates a vendor job (see the section called “Vendor Jobs”) with this
bill. If you remember the job name you entered in the New Job window for this job, start to type it in this
field and GnuCash will try auto complete it for you. Else, press the Select... button to access the Find
Job window. This window is very similar to the one described in the section called “Find and Edit”.
Highlight the job you are looking for with a click in the search results, then press the Select button.

• Billing Info - Billing ID (optional) - the vendor’s ID for the bill (e.g.: their invoice #).

• Billing Info - Terms - the pay back terms agreement for this bill. A list of registered terms is available
within the pop up menu. If you specified a default value for the selected vendor, this field is initialized
with the default.

• Chargeback Project - Customer (optional) - the customer to associate with this bill. This is used to charge
your customer later.

• Chargeback Project - Job (optional) - the customer job to associate with this bill.

When you click the OK the Edit Bill window opens.

Edit
From the Edit Bill window you can enter an itemized list of goods and services you purchased, in a manner
similar to how the account register works. For credit notes you enter an itemized list of goods and services
the vendor refunded instead.

There are 12 columns in the Invoice Entries area:

• Date - The date this item was sold.

• Invoiced? - X means the item is attached to this invoice, an empty box means the item is not attached
to this invoice. If the box is empty you can attach the item to the invoice by first selecting the item row
and then clicking in this box.

• Description (optional) - is what the item or service is called.

• Action (optional) - is a user defined field. You can place Cost Center information here, or use one of
the 3 predefined actions, Hours, Material, or Project.

• Expense Account - selects the expense account to charge for this item.

• Quantity - tracks how many of the items you bought.

• Unit Price - is the unit price of the item.
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• Taxable? - is this item taxable? X means yes, a blank field means no. You can click the field to toggle
the setting.

• Tax Included? - has the tax already been included in the unit price? X means yes, a blank field means no.

• Tax Table (optional) - this is a pop up menu of all the available tax tables. If the item is taxable and tax
has not been included in the unit price, then this tax table is used to compute the amount of tax.

• Subtotal (uneditable) - computed subtotal for this item (less tax)

• Billable - is this item billable to the chargeback customer/job?

When you have finished entering all the items, Post the bill.

Post
When you finish editing a bill, you should Post the bill. You do not have to post the bill, you can close
it and return to it later. You have to post the bill eventually. Posting a bill places its transactions into an
accounts payable account. The Post Bill window appears and asks you to enter information:

• Post Date - specifies the date for the transactions entered into the accounts payable account.

• Due Date - is the date on which payment for the bill is expected.

• If you specified payment terms when you created the bill, the date is calculated according to selected
terms, and the entry field is insensitive.

• If you did not specify payment terms, enter the expected payment due date here.

• Description - is an arbitrary description. When bill transactions are placed in the accounts payable
account, this description is entered in the memo field of those transactions.

• Post To Account - selects the accounts payable account in which bill transactions are posted. You can
select the account from a list of existing A/Payable accounts.

• Accumulate Splits - determines if bill items which transfer to the same account are combined into a
single split for that account or entered individually. For the sample bill for Letterhead and Envelopes,
the setting affects post results as follows:

• Checked (splits are accumulated) - a single transfer of $100.00 to the Expenses:Office Supplies
account is recorded.

• Not checked - the transaction created in the A/Payable account, shows two transfers to
Expenses:Office Supplies account $75.00 and $25.00. The memo fields in the splits indicate the
purchase of Letterhead and Envelopes (the item descriptions entered on the bill) respectively.

Find

To find an existing bill, use the Business → Vendor → Find Bill menu item. From the results of the search,
you can select a bill to edit, or view.

Note

Before you can edit a posted bill, you will need to Unpost it.
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Note

There are other ways to access an existing bill. These are similar to accessing invoices for your
customers. See the section called “Find” for more information.

Vendor Jobs
Vendor Jobs are used to group multiple bills and credit notes from a single vendor. Use of the vendor jobs
feature is optional. The feature is useful when you have multiple jobs for the same vendor, and would like
to view all the bills and credit notes for a single job.

To use vendor jobs, you must create them using the Business → Vendor → New Job menu item. You will
see the New Job window. The editable fields are:

• Job Info - Job Number (optional) - enter the number for this job. If left blank, a number will be chosen
for you.

• Job Info - Job Name - the name you want to assign to the new job.

• Owner Info - Vendor - the vendor for whom the job is created.

• Owner Info - Billing ID - the vendor’s reference to this job (e.g. their PO Number).

• Job Active - toggles this job being active or not. This is useful when you have many inactive jobs, since
it is easier to search only among jobs that are marked active.

To edit an existing vendor job, use the Business → Vendor → Find Job menu item. Select the desired job
in the search results, and click the View/Edit Job button.

To select from the bills and credit notes associated with a given job, use the Business → Vendor → Find
Job menu item. Select the desired job in the search results and click the View Invoices button. A window
listing bills and credit notes associated with this job appears. Select a bill or credit note and click the View
Invoice button to open a bill editor in the main application window.

Process Payment
Eventually, you need to pay your bills. To do so, use the Process Payment application found in Business
→ Vendor → Process Payment.

Tip

There is an alternative way of assigning a payment to (one or more) bills where the payment
transaction already exists, say in the case where transactions are imported from a bank.

This can best be done starting from the asset account register holding the imported payment
transaction (like your bank account). In that account, select the payment, right-click (control-
click for Mac OS X) and choose Assign as payment.... The payment window will pop-up, partly
filled in with the information from the transaction. Fill in the missing information like the proper
vendor and bill to complete the payment.

One caveat: the logic behind Assign as payment... won't properly detect credit note
reimbursements and will wrongfully interpret such a transaction as a customer invoice.

The Process Payment application consists of:
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• Payment Information - Vendor - the vendor you wish to pay. If you remember the company name you
entered in the New Vendor window for this vendor, start to type it in this field and GnuCash will try
auto complete it for you. Else, press the Select... button to access the Find Vendor window described in
the section called “Find and Edit”. Highlight the vendor you are looking for with a click in the search
results, then press the Select button.

• Payment Information - Bill - the bill you wish to pay. If you remember the bill ID, start to type it in this
field and GnuCash will try auto complete it for you. Else, press the Select... button to access the Find
Bill window described in the section called “Find”. Highlight the bill you are looking for with a click
in the search results, then press the Select button in the search window.

• Payment Information - Date - the date you wish to make the payment, normally the current date.

• Payment Information - Amount - the amount of money to transfer in this payment.

• Payment Information - Num - the check number.

• Payment Information - Memo - any comments about this payment.

• Post To - the A/Payable account to post this transaction.

• Transfer Account - the account from which money for the payments comes from, such as a checking
account.

Over Payments or Pre-Payments
If you wish to overpay an invoice or pay for goods or services before they have been invoiced, Process
Payment for the total amount payed. GnuCash will then keep track of the over-payment (or pre-payment)
in the A/P account and you can use the residual in the future.

Partial Payments
You may wish to partially pay a bill. Select the bill to pay. GnuCash will automatically suggest that bill's
remaining balance as payment amount. Simply adjust that amount to what you want to pay.

Employees
GnuCash can help your company by tracking employees. You can register a the section called “New
Employee”, the section called “Find and Edit” existing employees, create the section called “New Expense
Voucher/Credit Note” and the section called “Find and Edit Expense Voucher/Credit Note”.

Expense vouchers are used to reimburse employees for authorized expenses (f.e. travel, parking, food
etc...). Employee credit notes are the opposite of expense vouchers.

New Employee

To register a new employee, select the Business → Employee → New Employee menu item. The New
Employee window will open with two tabs:

• Employee tab

• Access Control tab
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Employee tab

• Identification - Employee Number - can be any number by which you would like to refer to this
employee. You may leave it blank and a number will be chosen automatically. See the section called
“Counters Book Options Tab” for more info.

• Identification - Username (Mandatory) - a unique username to identify the employee.

• Identification - Active (Optional) - differentiates active employees from inactive ones. This is useful
when you have many past employees, and you want to see only those marked Active.

• Payment Address - Name (Mandatory) - the full name of the employee.

• Payment Address - Address (Mandatory) - the address of the employee.

• Payment Address - Phone, Fax, Email (Optional)- other optional contact information for the employee.

• Interface - Language (Optional) -

• Payment Information - Terms (Optional) - specifies the default payment terms for this employee.
Payment terms must be preregistered using Business → Billing Terms.

• Billing - Default Hours per Day (Optional) -

• Billing - Default Rate (Optional) -

• Billing - Currency - specifies the billing currency for this employee. It will default to the default currency
set in Preferences

Note

All expense vouchers and credit notes for this employee will be denominated in this currency
and GnuCash will require an Accounts Payable account in this currency.

• Billing - Credit Account (Optional) -

Access Control tab

• Access Control List

Find and Edit
To search for an existing employee, use the Business → Employee → Find Employee... menu. You select
an employee to View/Edit from the results of the search. This window is also used to look up an employee
when entering voucher and processing payments.

If many employees match the search criteria you provide, the search can be refined by running an additional
search within the current results. The current result set is searched when the Refine Current Search radio
button is selected. In fact, GnuCash selects this option for you after you run the initial search.

Note

If the employee you are searching for does not match the supplied search criteria, change the
search criteria, click the New Search radio button and then the Find button. The relevant step is
the New Search selection. If the employee is not in the result of the original search, and you only
search within this set, the employee cannot be found, regardless of new search criteria.
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Tip

To return a list of all registered active employees, set the search criterion to matches regex, and
place a single dot “.” in the text field area. Make sure Search only active data is checked, then
click Find. The regular expression “.” means to match anything.

New Expense Voucher/Credit Note
To register a new expense voucher/ Credit Note, select the Business → Employee → New Expense
Voucher... menu item. The New Expense Voucher window will open. You can enter the following data:

• Voucher information - Type (Optional) - select if you are entering a Voucher or a credit note.

• Voucher information - Voucher ID (Optional) - can be any number by which you would like to refer to
this voucher. You may leave it blank and a number will be chosen automatically. See the section called
“Counters Book Options Tab” for more info.

• Voucher information - Date opened - the date of the voucher. Click on the button on the right of the
date to open a calendar.

• Billing information - Employee (Mandatory) - the employee to which the voucher refers.

Tip

The field supports auto-completion so if you start typing GnuCash will try to complete the text
automatically using existing employees name. You can also press the button Select... to open
the Find Employee window.

• Billing information - Billing ID (Optional) - the identification number of the document (f.e. the bill
number for a dinner).

• Billing information - Terms (Optional) - the pay back terms agreement for this bill. A list of registered
terms is available within the pop up menu.

• Default chargeback project - Customer (Optional) - the Customer to which the voucher refers.

Tip

The field supports auto-completion so if you start typing GnuCash will try to complete the text
automatically using an existing Customer name. You can also press the button Select... to open
the Find Customer window.

• Default chargeback project - Job (Optional) - the Customer Job to which the voucher refers.

Note

you can type in this field only if there are one or more jobs registered in GnuCash belonging
to the selected Customer.

Tip

The field supports auto-completion so if you start typing GnuCash will try to complete the text
automatically using an existing Customer name. You can also press the button Select... to open
the Find Customer window.
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• Notes - records any additional comments about the voucher/credit note.

Find and Edit Expense Voucher/Credit Note
To search for an existing Expense Voucher, use the Business → Employee → Find Expense Voucher...
menu item. You select an Expense Voucher to View/Edit from the results of the search. This window is
also used to look up an expense voucher when entering vouchers and processing payments.

If many expense vouchers match the search criteria you provide, the search can be refined by running an
additional search within the current results. The current result set is searched when the Refine Current
Search radio button is selected. In fact, GnuCash selects this option for you after you run the initial search.

Note

If the expense voucher you are searching for does not match the supplied search criteria, change
the search criteria, click the New Search radio button and then the Find button. The relevant step
is the New Search selection. If the expense voucher is not in the result of the original search, and
you only search within this set, the voucher cannot be found, regardless of new search criteria.

Tip

To return a list of all expense vouchers, set the search criterion to matches regex, and place a
single dot “.” in the text field area. Make sure Search only active data is checked, then click Find.
The regular expression “.” means to match anything.
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Chapter 8. Tools & Assistants
There are many specialized Tools used in GnuCash. These tools enable access to the enhanced functionality
in GnuCash. These tools are accessed via the Tools option from any window that displays a Tools menu.
Several of these tools may not be displayed depending on if your software was not configured to support
Online banking, or the tools appropriate for the current window.

Find
The GnuCash Find assistant can be used to find transactions or to perform business related research on
your data file.

Find Transaction
Find Transaction is used to search for transactions in GnuCash and display the results in a register window.
To open the Find Transaction dialog in Split Search mode, you can type the keyboard shortcut Ctrl+f.

Exactly which transactions are searched depends on where you invoke the tool from. If you start from the
main accounts hierarchy page, all transactions will be searched. If you start from an individual account
register, only transactions in that account will be searched. And if you filter the transactions in a register
using View  →  Filter By... , then only transactions in that account and shown by the filter will be searched.

Note

The first row of the Find Transaction dialog indicates that you are performing a Split Search.

There are two panes in the Find Transaction dialog. The top pane contains the Search Criteria buttons and
the bottom pane contains the Type of Search selection.

There are two buttons in the top of the Search Criteria pane. The left button allows you to Add another
criteria row to search for multiple criteria. The existing criteria row needs to be completed before adding a
new row. The right button is used to Search for items where all criteria are met or Search for items where
any criteria are met. The all criteria are met search requires all of the criteria rows to have at least one
match. The any criteria are met search requires only one of the criteria rows to be matched.

The criteria row in the Search Criteria pane is used to combine different criteria buttons (see table Table 8.1,
“Search criteria buttons - Split Search” for a comprehensive list of combinations)

In the Type of Search pane there are five selections. The first option is always enabled, the following
three are available when you invoke the Find... option from a register window or after performing the first
Find if the Find... command was invoked from any other window. The last option is available only for
Business search.

New Search Perform a new transaction search

Refine current search Search within the results of the previous
search

Add results to current search Search based on the first set of criteria or the
new criteria

Delete results from current search Discard any results that match the previous
search results
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Search only active data Search only if data are marked as active. This
selector is greyed out for the Split Search as it
is meaningful only for business related search

Note

When selecting search criteria keep in mind that criteria are applied to individual splits or fields in
transactions, and that the entire transaction is included in the results. There is no visual indication
in the results to indicate which split or field met the search criteria.

When search criteria are selected, you can press the Find button. You will be presented with the search
results in a new register tab. A report of the search results may created and printed using Reports → Account
Report. The Account Report has limited formatting options but, like all GnuCash reports, being in html
format, can be copied and pasted into a spreadsheet for further formatting. Alternatively, the Account
Report can be exported to an html file, and the html file may be opened in a spreadsheet.

Note

Press the Close button to close the Find Transaction dialog.

Table 8.1. Search criteria buttons - Split Search

Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

contains

matches
regexb

Descriptiona

does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexb

Memoa

does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexb

Numbera

does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexb

Action
does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

Notes
contains

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row
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Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

matches
regexb

does not
match
regexb

is before

is before or
on

is on

is not on

is after

Date Posted

is on or
after

Date
selection
field

Remove
row

less than

less than or
equal to

equal to

not equal to

greater than

has credits
or debits

greater than
or equal to

less than

less than or
equal to

equal to

not equal to

greater than

has credits

greater than
or equal to

less than

less than or
equal to

equal to

not equal to

greater than

Value

has debits

greater than
or equal to

Amount
entry field

Remove
row

is less than

is less than
or equal toShares

equals

Amount
entry field

Remove
row
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Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

does not
equal to

is greater
than

is greater
than or
equal to

is less than

is less than
or equal to

equals

is not equal
to

is greater
than

Share Price

is greater
than or
equal to

Amount
entry field

Remove
row

is
Reconcilec

is not
Not Cleared Cleared Reconciled Frozen Voided

Remove
row

is
Balanced

is not
set true

Remove
row

matches
any account

Accountd
matches no
accounts

Choose
Accounts

Remove
row

All
Accountse

matches all
accounts

Choose
Accounts

Remove
row

aThe Description, Memo, Number are common to all lines in a transaction.
bregex means regular expression text search as used in various computer programs such as Perl
cThe Reconcile option applies the selected criteria to each line of a transaction individually. Each transaction line may have only
one of the indicated values, but there is often a mix of values within a complete transaction, so companion lines may not meet the
selected criteria. See separate note defining status values. For a detailed description of transaction statuses see the section called
“Setting the reconcile status (R field) of a transaction”
dThe Account option performs a search where the accounts selected in the Choose Accounts dialog will both be searched individually
for results. This means that a match in any of the selected accounts will either be displayed (matches any account) or discarded
(matches no account).
eThe All Accounts option performs a search where accounts selected in the Choose Accounts dialog will only return results that
match in both accounts.

Explanations of the Criteria

The Reconcile criterion deserves some more explanation. Think of the selected reconciliation status
buttons (Not Cleared, Cleared, and so on) as a single group, joined with a logical “or”. In other words,
the selection “is ” or “is not” applies to the “or” of the selected status buttons. The buttons which are left
unselected are simply ignored. (It’s not the same as saying the reconciliation status must not be one of
these.)
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For example: if you select Reconcile is Cleared Reconciled, that means you’re saying “I want all
transactions which contain cleared splits OR reconciled splits” (imagine an invisible “OR” between all
the selected status buttons). It’s the same as selecting Reconcile is Cleared, then adding another search
criterion with the Add button, then on the new line selecting Reconcile is Reconciled, and finally selecting
Search for items where any criteria are met. In either case, GnuCash will show you exactly the same set
of transactions.

Find Customer, Invoice, Job, Vendor, Bill, Employee,
Expense Voucher

The business find assistant is used to search for business related items (Customer, Invoice, Job, Vendor,
Bill, Employee, Expense Voucher). To open the business search dialog select the desired item to Find
from the Business → Customer/Vendor/Employee submenus.

Tip

The titlebar and the first row of the assistant dialog reports the item type you are searching for:
Customer, Invoice, Job, Vendor, Bill, Employee, Expense Voucher.

There are two panes in the Find dialog. The top pane contains the Search Criteria buttons and the bottom
pane contains the Type of Search selection.

Search Criteria section

There are two buttons in the top of the Search Criteria pane. The left button allows you to Add another
criteria row to search for multiple criteria.

Note

The existing criteria row needs to be completed before adding a new row.

The right button is used to Search for items where all criteria are met or Search for items where any criteria
are met. The all criteria are met search requires all of the criteria rows to have at least one match. The any
criteria are met search requires only one of the criteria rows to be matched.

The criteria row in the Search Criteria pane is used to combine different criteria buttons (see tables
Table 8.2, “Search criteria buttons - Customer Search”, Table 8.3, “Search criteria buttons - Invoice
Search”, Table 8.4, “Search criteria buttons - Job Search”, Table 8.5, “Search criteria buttons - Vendor
Search”, Table 8.6, “Search criteria buttons - Bill Search”, Table 8.7, “Search criteria buttons - Employee
Search” Table 8.8, “Search criteria buttons - Expense Voucher Search” for a comprehensive list of
combinations)

Type of Search section

In the Type of Search pane there are five selections. The first and alst options are always selectable while
the following three are available only when you perform the first search by setting some search criteria
and pressing the Find button.

New Search Perform a new search

Refine current search Search within the results of the previous
search
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Add results to current search Search based on the first set of criteria or the
new criteria

Delete results from current search Discard any results that match the previous
search results

Search only active data Search only if data are marked as active.

The rest of the search dialog

When search criteria are selected, you can press the Find button. You will be presented with the list of
search results in the same Find dialog.

Tip

Aside from the results, GnuCash gives you some buttons to manage the highlighted result.

Tip

In the bottom right of the Find dialog there is a button that allows you to create a New business
item.

Note

Press the Close button to close the Find assistant dialog.

List of search criteria buttons

Table 8.2. Search criteria buttons - Customer Search

Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

contains

matches
regexbCompany

Name does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexbCustomer

ID does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexbBilling

Contact does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

Shipping
Contact

contains Criteria
entry field

Remove
row
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Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

matches
regexb

does not
match
regexb

Is entry
Case
Insensitive?

Table 8.3. Search criteria buttons - Invoice Search

Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

contains

matches
regexb

Invoice ID
does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexbCompany

Name does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

is before

is before or
on

is on

is not on

is after

Date
Opened

is on or
after

Date
selection
field

Remove
row

is
Is Posted?

is not
set true

Remove
row

is before

is before or
on

is on

is not on

is after

Date Posted

is on or
after

Date
selection
field

Remove
row

is
Is Paid?

is not
set true

Remove
row

Billing ID
contains Criteria

entry field
Remove
row
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Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

matches
regexb

does not
match
regexb

Is entry
Case
Insensitive?

contains

matches
regexbInvoice

Notes does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

Customer

Vendor

Employee
is

Job

Customer

Vendor

Employee

Invoice
Owner

is not

Job

Criteria
entry field

Select...
Remove
row

Table 8.4. Search criteria buttons - Job Search

Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

contains

matches
regexb

Job Name
does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexbJob

Number does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexb

Billing ID
does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

isOnly
Active? is not

set true
Remove
row
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Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

contains

matches
regexbOwner's

Name does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

Table 8.5. Search criteria buttons - Vendor Search

Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

contains

matches
regexbCompany

Name does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexb

Vendor ID
does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexbBilling

Contact does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

Table 8.6. Search criteria buttons - Bill Search

Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

contains

matches
regexb

Bill ID
does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexbCompany

Name does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

Due Date
is before Remove

row
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Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

is before or
on

is on

is not on

is after

is on or
after

Date
selection
field

is before

is before or
on

is on

is not on

is after

Date
Opened

is on or
after

Date
selection
field

Remove
row

is
Is Posted?

is not
set true

Remove
row

is before

is before or
on

is on

is not on

is after

Date Posted

is on or
after

Date
selection
field

Remove
row

is
Is Paid?

is not
set true

Remove
row

contains

matches
regexb

Billing ID
does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexb

Bill Notes
does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

Customer
Bill Owner is

Vendor
Criteria
entry field

Select...
Remove
row
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Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

Employee

Job

Customer

Vendor

Employee
is not

Job

Table 8.7. Search criteria buttons - Employee Search

Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

contains

matches
regexbEmployee

Name does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexbEmployee

Username does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexbEmployee

ID does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

Table 8.8. Search criteria buttons - Expense Voucher Search

Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

contains

matches
regexb

Voucher ID
does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexbEmployee

Name does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row
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Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

is before

is before or
on

is on

is not on

is after

Due Date

is on or
after

Date
selection
field

Remove
row

is before

is before or
on

is on

is not on

is after

Date
Opened

is on or
after

Date
selection
field

Remove
row

is
Is Posted?

is not
set true

Remove
row

is before

is before or
on

is on

is not on

is after

Date Posted

is on or
after

Date
selection
field

Remove
row

is
Is Paid?

is not
set true

Remove
row

contains

matches
regexb

Billing ID
does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

contains

matches
regexbVoucher

Notes does not
match
regexb

Criteria
entry field

Is entry
Case
Insensitive?

Remove
row

115



Tools & Assistants

Button 1 Button 2 Button 3 Button 4 Button 5 Button 6 Button 7 Button 8

Customer

Vendor

Employee
is

Job

Customer

Vendor

Employee

Voucher
Owner

is not

Job

Criteria
entry field

Select...
Remove
row

Since Last Run Assistant
The Since Last Run assistant is run automatically when GnuCash is started. It is used to enter into the
register any transactions that are due to be automatically entered (see the section called “Scheduling
Transactions”). The run on GnuCash start can be altered in the Scheduled Transactions tab of the GnuCash
Preferences. To run the Since Last Run assistant manually, go to Actions → Scheduled Transactions →
Since Last Run...

In the Since Last Run assistant window you can see three columns:

Transaction The name assigned in the Scheduled Transaction Editor that identifies the scheduled
transaction.

State The state column of the scheduled transaction can be one of the following:

Tip

Click on the state field in the row of a transaction to change its state (this
option is available only if the state field is not empty)

Ignored If a scheduled transaction is being displayed, either to be created
or as a reminder, the user can set the status to Ignored to skip this
event. The scheduled transaction will not be entered in the register
and the next reminder for this scheduled transaction will be the
next occurrence. For instance, if you have a scheduled transaction
set up with a reminder to transfer $500 at the end of the month
to your savings account but you bought yourself a computer this
month and don’t have the money for this month’s transfer then
you would set the status to Ignored.

Postponed If a scheduled transaction has been listed with a status To-create
but you want to hold it and not have it entered to your register
yet, then you can set it to Postponed. When at some later time
you change it back to To-create it will be created with the
original posted-date. If you want to change that you must edit the
transaction after it's created.

Reminder You are n days from the scheduled transaction due date. The
number of days n to remind in advance, is set either in the
GnuCash Preferences Scheduled Transactions tab or in the
Overview tab of the Scheduled Transaction Editor.
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To-create This scheduled transaction will be automatically created when you
press OK.

Empty An empty field means that no operations are pending for the
scheduled transaction.

At the bottom of the window there are two buttons:

• The Cancel button is used to exit the Since Last Run window without creating the transactions scheduled
to be entered.

• The Ok button closes the Since Last Run window and applies the pending operations.

At the bottom right of the Since Last Run window there is also an option that allows to Review created
transactions. If this option is enabled when there are one or more transactions To-create, pressing OK
will open a register window in which are shown the details of the scheduled transactions splits entered
automatically by GnuCash.

Mortgage & Loan Repayment Assistant
This assistant creates a loan repayment scheduled transaction. When used to setup a scheduled transaction,
the assistant creates a variable formula so that the compounding interest is correctly calculated. To start
this assistant manually go to Actions → Scheduled Transactions → Mortgage and Loan Repayment....

It does not support zero-interest loans, but one doesn't really need an assistant for that: Just create a
scheduled transaction for the principal divided by the number of payments that lasts for the number of
payments. For example, if one has borrowed $1200 for a year at no interest and promised to pay it back
in monthly installments, the repayment schedule is $100 monthly for twelve months.

The Mortgage and Loan Repayment assistant opens with a screen that briefly describes what this assistant
does. The three buttons at the very bottom of the screen will not change while using the assistant.

• The Cancel button is used to exit the assistant and cancel creating the scheduled transaction. Any
selections you have made in this assistant up to this point will be lost.

• The Back button will bring up the previous screen so you can change a selection made on that screen.

• The Forward button will bring up the next screen so you can continue though the assistant.

The next screen allows you to enter the basic loan information. This is usually the information provided
by the bank when loan and disclosure documents are given to the borrower. Here you can also setup an
account that the scheduled transaction will use to enter the payment transaction.

• Loan Account: Choose an account for the loan payment transactions or use New... to setup a new account
for the transactions.

• Loan Amount: Enter the amount of the loan.

• Interest Rate: Enter the loan interest rate in percent per compounding period. The Assistant supports
rates between .001% and 100%.

• Type: Choose the type of loan. If an adjustable rate is used the frequency screen is enabled.

• Interest Rate Change Frequency: Choose the frequency for the rate change and the start date of the rate
change.
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• Start Date: Choose the date the loan is starting on.

• Length: Enter the length of the loan with the number and period, e.g. 60 months or 5 years.

• Months Remaining: This tells the Assistant how many months remain on the loan. The default value
assumes that the loan is paid up through today. For example, if a 5-year loan started on 1 January 2012
and today is 12 July 2015, the default months remaining is 18. If you want to create past payment
transactions you'll set the months remaining accordingly: In our example, if you wanted to create all of
the payments you'd set "months remaining" to 60; if you wanted to start tracking the payments at the
beginning of 2015 you'd enter 24.

The next screen is used to set escrow, insurance and tax options for the loan. It is mainly used for mortgage
payments. When each of the options here is set, this enables additional pages in the assistant to setup those
portions of the payments. All of the pages will be described here, even though some may not show if that
option is not chosen.

• ... utilize an escrow account for payments?: This selection enables the use of an account setup for
tracking escrow payments. If the mortgage or loan uses an escrow account to pay taxes, insurance, etc
then setup an account here.

• ... pay "Taxes"?: adds an additional page to setup a scheduled transaction to pay taxes.

• ... pay "Insurance"?: adds an additional page to setup a scheduled transaction to pay insurance payments.

• ... pay "PMI"?: adds an additional page to setup a scheduled transaction to pay PMI payments.

• ... pay "Other Expense"?: adds an additional page to setup a scheduled transaction to pay other expenses.

The next screen is used to setup the details of the scheduled transaction for the Loan Repayment.

• Transaction Memo: The name entered here will be used as the name for the scheduled transaction, the
description of the scheduled transaction and the memo.

• Payment Amount: Shows the variable used to calculate the payment amount.

• Payment From: Choose an account to pay the loan amount from.

• Principal To: Choose an account to transfer the principal part of the loan to.

• Interest To: Choose an account to transfer the interest part of the loan to.

• Repayment Frequency: Select the Frequency and start date for loan repayments. Note that the start date
will be the posted date of the first scheduled transaction. This is not taken into account for calculating
the remaining duration of the loan, see Months Remaining:. Make sure that you set both to reflect your
intentions or you may get surprising results.

The next screen is used to setup the details of the scheduled transaction for the Tax payment.

• Transaction Memo: The name entered here will be used as the name for the scheduled transaction, the
description of the scheduled transaction and the memo.

• Amount: Enter the payment amount.

• Payment From: Choose an account to pay the tax amount from.

• Payment To: Choose an account to transfer the tax payment to.
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• Repayment Frequency: Select the Frequency and start date for tax payments.

The next screen is used to setup the details of the scheduled transaction for the Insurance payment.

• Transaction Memo: The name entered here will be used as the name for the scheduled transaction, the
description of the scheduled transaction and the memo.

• Amount: Enter the payment amount.

• Payment From: Choose an account to pay the insurance amount from.

• Payment To: Choose an account to transfer the insurance payment to.

• Repayment Frequency: Select the Frequency and start date for insurance payments.

The next screen is used to setup the details of the scheduled transaction for the PMI payment.

• Transaction Memo: The name entered here will be used as the name for the scheduled transaction, the
description of the scheduled transaction and the memo.

• Amount: Enter the payment amount.

• Payment From: Choose an account to pay the PMI amount from.

• Payment To: Choose an account to transfer the PMI payment to.

• Repayment Frequency: Select the Frequency and start date for PMI payments.

The next screen is used to setup the details of the scheduled transaction for the Other Expense payment.

• Transaction Memo: The name entered here will be used as the name for the scheduled transaction, the
description of the scheduled transaction and the memo.

• Amount: Enter the payment amount.

• Payment From: Choose an account to pay the other expense amount from.

• Payment To: Choose an account to transfer the other expense payment to.

• Repayment Frequency: Select the Frequency and start date for other expense payments.

The last screen gives you a list of three choices to finish the assistant.

• The Cancel button is used to exit the assistant and cancel creating a new loan scheduled transaction.
Any selections you have made in this assistant up to this point will be lost.

• The Back button will bring up the previous screen so you can change a selection made on that screen.

• The Finish button creates the scheduled transaction.

You should now have the Mortgage or Loan Repayment scheduled transaction setup.

Recording a Stock Split
Stock splits commonly occur when a company decides its stock price is too expensive for individual
investors to buy the stock. Splits have the effect of lowering the price of a single share while keeping the
value of shares owned by investors who have already purchased shares.
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Stock Split Assistant
GnuCash uses the Stock Split assistant to record stock splits. This provides a way of entering the details
of the stock split and also any change in stock price or cash disbursement as a result of the stock split.

The Stock Split assistant is accessed by going to Actions → Stock Split....

The Stock Split assistant opens with a screen that briefly describes what this assistant does. The three
buttons at the very bottom of the screen will not change while using the assistant.

• The Cancel button is used to exit the assistant and cancel entering the stock split information. Any
selections you have made in this assistant up to this point will be lost.

• The Back button will bring up the previous screen so you can change a selection made on that screen.

• The Forward button will bring up the next screen so you can continue though the assistant.

The next screen allows you to select a Stock Account. Select an account from the list to record a stock
split or merger.

• Account: Lists the GnuCash account name for the stock.

• Symbol: The stock symbol for the stock associated with this account.

• Shares: The amount of shares that have been purchased in the account.

The next screen lets you set the Stock Split Details. The top part of the screen contains details used in
creating the stock split transaction.

• Date: Choose the date of the stock split.

• Share Distribution: Enter the amount of shares gained from the stock split. For a stock merger enter a
negative number.

• Description: Enter a description or leave as the default.

The bottom part of the screen contains details used to record a price for the split (optional).

• New Price: Enter the price of the shares on the day of the stock split.

• Currency: Choose the currency of the shares.

The next screen lets you enter a transaction for a cash disbursement (Cash In Lieu) as a result of the stock
split (optional).

• Cash Amount: Enter the amount of the Cash disbursement.

• Memo: Enter a memo or leave as the default.

• Income Account: Choose an Income Account for the disbursement.

• Asset Account: Choose an Asset Account for the disbursement.

The last screen gives you a list of three choices to finish the assistant.

• The Cancel button is used to exit the assistant and cancel creating the Stock Split transactions. Any
selections you have made in this assistant up to this point will be lost.

• The Back button will bring up the previous screen so you can change a selection made on that screen.
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• The Finish button creates the transactions for the Stock Split.

You should now have successfully entered the Stock Split or Merger.

The Online Banking Setup Assistant
Note

This section is "under construction - any input will be welcome !!".

The Online Banking Setup Assistant is used to create and edit data to enable access to Online
banking transactions. Currently the best instruction for this process are in the GnuCash wiki at https://
wiki.gnucash.org/wiki/Setting_up_OFXDirectConnect. If Online Banking Setup does not appear in your
Tools menu, verify that you are in an Account Tree or Register tab.

Price Editor
Note

GnuCash uses the term commodity to mean anything that it counts: Currencies, securities (i.e
intangible assets like stock or mutual fund shares and bonds), or tangible assets like trucks
and computers. When valuing one commodity in terms of another it uses the term Exchange
Rate between two currencies and Price between a non-currency commodity and a currency
commodity. For the rest of this section we'll use "price" to mean both price and exchange rate
and "commodity" to mean any sort of commodity except where currency behavior is different.

The Price Editor is used to list and edit the price of one commodity in another commodity. New prices
can be added, existing prices can be edited, and prices can be retrieved from a variety of sources on the
World-Wide Web when the commodity is properly configured.

Each commodity pair can have one price per day. An existing price will be overwritten by a newer one if the
newer one has the same or a more preferred source. The order of source preference (1 is most preferred) is:

1. user:price-editor: Prices created manually in the Price Editor

2. Finance::Quote: Online quotes

3. user:price: Prices entered explicitly in the Exchange Rateentry of the Transfer Funds dialog box or in
the Price column of a register for an account of types STOCK or MUTUAL

4. user:xfer-dialog: Prices calculated from an entry in the To Amount entry of the Transfer Funds dialog
box.

5. user:split-register: Prices calculated from the Shares and Debit or Credit columns of a register for an
account of types STOCK or MUTUAL

6. user:stock-split: Prices entered in the Stock Split Assistant

Note

Prices created manually in the Price Editor are preferred over prices retrieved via Finance::Quote
so Finance::Quote will fail to update such manually-created prices.

The Price Editor displays existing prices as follows:
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• Security: The Security/commodity being priced. The display is sorted by the Namespace that the
individual securities are listed on. The list is expanded by clicking on the caret on the left of the name.

• Currency: The currency the price is recorded in.

• Date: The date the price was recorded.

• Source: The source of the commodities price quote, listed above.

• Type: There are several different types of stock price quotes.

• Bid: Indicates what a specialist dealer is prepared to pay for a stock.

• Ask: Indicates at what price the dealers are prepared to sell a stock.

• Last: Indicate the price at which the last trade in that stock/security occurred at. This is the price
most commonly quoted in the media.

• Net Asset Value: Are typically used for mutual funds. They are calculated on the net value of the
fund’s assets each day around the time of the market close and are in effect until the next recalculation.

• Unknown: Use this if the type of price quoted is not known.

• Price: The actual price of the commodity.

Adding a stock price manually
To add a new price, click on Add, and enter the details of the security and price into the dialog box. To
edit an existing price, select the price in the price list, click the Edit button, and edit the figures.

To remove just one price, select the price and click the Remove button. If you want to remove all prices
older than a certain date, click on the Remove Old button and enter the details in the dialog box.

A pop-up will display with the message "Delete all stock prices based upon the criteria below:". Enter
the date of the last price you wish to delete.

Two check-boxes are below the date field;

• Delete manually entered prices - If checked, delete manually entered stock prices dated earlier than the
specified date. Otherwise only stock prices added by Finance::Quote will be deleted.

• Delete last price for a stock - If checked, delete all prices before the specified date. Otherwise the last
stock price dated before the date will be kept and all earlier quotes deleted.

Configuring for use of the Get Quotes button
To support on-line quotations for a particular stock or mutual fund account, you must first enable on-line
price quoting and select a price source in the Security. This is described in detail in the section called
“Configuring Securities/Currencies for On-Line Retrieval of Prices”. Once on-line quotes are enabled, and
Finance::Quote is installed, you can update prices for your stocks and mutual funds manually by clicking
the Get Quotes button.

Security Editor
The Security Editor is used to create and edit commodities that are used by mutual fund and stock type
accounts. It also shows the details of National Currencies that are used by GnuCash.
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To show the details for National Currencies click the Show National Currencies check-box at the bottom
of the screen.

Each entry in the editor shows the details used by the security/currency:

• Type: Categories for organizing securities. GnuCash has the following built in:

• CURRENCY or ISO4317: These are used for national currencies and are not editable with the
Security Editor.

• FUND: Ordinarily used for open-ended mutual funds, i.e., those that one purchases from and sells to
only the issuing company and that are priced daily at their net asset value.

• AMEX, ASX, EUREX, NASDAQ, and NYSE: These represent a few of the exchanges on which
stocks, closed-end mutual funds, and exchange-traded funds are traded.

• Template: This is a reserved word. It will not normally appear in the Security Editor unless you type
it in, and if you do it will cause problems. Don't use it.

If your investment doesn't fit into one of these categories, for example if you trade stocks on the DAX
or LSE, you can easily create your own type simply by typing it into the field. The type of security has
no meaning to Gnucash (except Template, don't use that!), it's there only to make it easier for you to
find the security from the selection lists.

• Symbol: Indicates the symbol or abbreviation for the commodity. This is usually the ticker symbol
(for stocks) or other unique abbreviation for the commodity. If the commodity is traded on any public
exchange, it is important to use the same identifier used on that exchange. For national currencies the
symbol is the ISO-4217 currency code.

• Name: The full name of the commodity is a recognizable name such as US Dollars or IBM Common
Stock.

• Code: This is any numeric or alphanumeric code that is used to identify the commodity. The CUSIP
code is a unique identifying numeric string that is associated with every stock, bond or mutual fund, and
most kinds of traded options, futures and commodities. This code is not required.

• Fraction: This is the smallest traded unit of the commodity, expressed as a fraction of a single nominal
unit. This unit is used by GnuCash accounts as the default fraction for trades in the commodity.

Adding or Editing a Commodity
To add a new commodity (stock, or mutual fund), click on Add, and enter the details of the commodity into
the New Security dialog box. To edit an existing commodity, select the commodity from the Commodities
list, click the Edit button, and edit the Edit Security dialog box. To remove a commodity, select the
commodity and click the Remove button.

The fields in the New/Edit Security screens are the same as defined for the Security Editor the section
called “Security Editor”. Below these fields are the options for Online Quotes.

Configuring Securities/Currencies for On-Line Retrieval
of Prices

To support on-line quotations for a particular stock or mutual fund account, you must first enable on-line
price quoting and select a price source in the Security Editor. Online currency quotes require only that
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the check-box for Online quotes and the timezone be selected, and that the “Get Quotes” box be checked
in the Security Editor.

Detailed instructions are in the section on Creating New Accounts. the section called “Steps to enable
Online price updating”

Loan Repayment Calculator
The Loan Repayment Calculator is used to calculate compound interest. It provides a way of entering four
of the five parameters of a compound interest calculation and then calculating the remaining figure.

The calculator is split into two panes. The left pane has five fields with a Calculate button and a Clear
button. The Calculate button is used to select the figure to calculate. The Clear button is used to clear any
amount in the field.

• Payment Periods: This field is used to select the number of payments you wish to use in the calculation.

• Interest Rate: This field is used for the interest rate percentage.

• Present Value: This field usually contains the amount you have borrowed. It is the base amount you
wish to compound.

• Periodic Payment: This field contains the amount that is the payment for the period selected (IE
monthly, weekly, etc). If it is for repaying a loan it should be a negative number.

• Future Value: This field contains the final value at the end of the periods above. If we are repaying
a loan in full it would be 0.

The right pane contains buttons to select what sort of payments and compounding is used for the left pane
calculations.

• Compounding: This button allows you to select the interval used if the Discrete Compounding button
is selected.

• Payments: This button allows you to select the interval used for the Payment Periods field.

• End of Period Payments: Use this button if the payment is at the end of the period.

• Beginning of Period Payments: Use this button if the payment is at the beginning of the period.

• Discrete Compounding: This button is used where interest is charged at a discrete interval defined by
the Compounding button above.

• Continuous Compounding: This button is used when the interest is charged continuously.

• Payment Total: This field shows the total amount paid.

Examples of using the Loan Repayment Calculator are given in the Tutorial and Concepts Guide.
GnuCash Tutorial and Concepts Guide’s Chapter on Loans [https://code.gnucash.org/docs/C/gnucash-
guide/loans_calcs1.html]

Close Book
The Close Book dialog box is used for “closing the books,”--an accounting process that resets the balances
of the income and expense accounts. In this process, income account balances are transferred into an
income equity account, while expense account balances are transferred into an expense equity account.
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You must specify both these accounts, which may be the same. You must also specify the date for the
closing transfer.

Dialog Box Details
The dialog box has the following parts:

• Closing Date: Specify the date for the closing transfer. You can type in a date or choose one from the
drop-down.

• Income Total: Specify the account into which the total balance of all income accounts will be transferred.
Optionally you can create a new account to receive the transfer using the New button.

• Expense Total: Specify the account into which the total balance of all expense accounts will be
transferred. Again, you can optionally create a new account to receive the transfer using the New button.

• Description: Specify the description that will be entered in the closing entry.

How It Works
GnuCash closes books by creating one transaction per currency for income accounts, and one transaction
per currency for expense accounts. The transactions all use the date selected by the user, and each
transaction may contain any number of splits. Each split moves the balance out of one income or expense
account. The last split in each closing transaction moves the total offsetting debit/credit balance into the
specified equity account.

Each transaction will use the description provided by the user in the Description: entry.

The fact that GnuCash just uses transactions to close the books makes it very simple to undo a book closing:
just delete the closing transactions.

What It Doesn’t Do
The book closing tool does not delete any accounts or transactions; create any new files; or hide any
accounts.

Necessity
Note that closing the books in GnuCash is unnecessary. You do not need to zero out your income and
expense accounts at the end of each financial period. GnuCash’s built-in reports automatically handle
concepts like retained earnings between two different financial periods.

In fact, closing the books reduces the usefulness of the standard reports because the reports don’t currently
understand closing transactions. So from their point of view it simply looks like the net income or expense
in each account for a given period was simply zero.

Conclusion
If you close your books, be prepared to see inaccuracies in the standard reports. On the other hand, you
will see current-period income and expense figures in the chart of accounts.

Lots in Account
GnuCash uses lots in 2 ways:
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• To link security buy transactions to sell transactions so the real cost of the sold securities can be used
to calculate capital gain or loss. See the section called “Lots for Security Capital Gains”.

• To link payments or credit notes to the invoices to which they apply in the Business Features. See the
section called “Lots for Business Features”.

Lots for Security Capital Gains
The Lots in Account SSSS window, where SSSS is the security account, is used to manually or
automatically link security transaction splits to lots and create capital gain/loss transactions to account for
the difference between the costs of buying a security and the value received by selling it.

To open the Lots in Account window, open the security account register, then select Actions → View Lots.

Figure 8.1. Lots in Account window for Security Capital Gains

An image of the Lots in Account  window for a security account.

Screen Elements

Adjusting the Size of Screen Elements

As well as adjusting the size of the whole window, it is possible to adjust the proportions of the window
elements both horizontally and vertically.

There are 2 bars for adjusting the window horizontally. One between the Title and the Lots in This Account
panel, and the other between the Splits free panel and the >> and << buttons.

The window proportions may be adjusted vertically by dragging the vertical bar located to the right of
Show only open lots.

These resizing bars can be hard to see, so move the mouse pointer until it changes to the resize pointer then
click and drag the bar. The resize pointers are different depending on your operating system and theme.
Here are some examples of resize pointers:
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It is not possible to individually adjust the size of panel columns.

Fields

• Title: Shows the title for the highlighted (selected) lot in the Lots in This Account panel. When a new
lot is created by clicking the New Lot button, it has a default title of Lot n  where n is a number starting
at 0 (for each security account) and incrementing by 1. Deleting a lot does not reset the next number to
be used, but the title can be changed as required.

• Notes: Notes for the highlighted lot. Users are free to enter anything they wish and the notes can be
changed as required.

Panels

The order of the items in all the panels in this window can be adjusted by clicking on the column headings.

• Lots in This Account panel

This panel shows lots for this security account.

If Show only open lots is checked, only lots that have not been completely sold are shown.

Columns

• Type: Always blank for security lots. This window is also used for business lots (which link payments
to invoices) when coming from an Accounts Payable or Receivable account and in that case, Type
will be I for invoice. Credit Notes are also Type I.

• Opened: Open  if there are no splits in the lot, otherwise the date of the earliest split in this lot.

• Closed:  Open if the lot is not fully sold, otherwise the date of the last sell split.

• Title: Lot Title.

• Balance: Number of unsold securities in this lot.

• Gains: Calculated gains or losses for this lot.

• Splits free panel

This panel shows buy and sell splits for this security account which are not linked to a lot. Capital Gains
splits (Shares and Price are 0) are not shown.

Columns

• Date: Transaction Date Posted.

• Num: Transaction Num.

• Description: Transaction Description.

• Amount: Number of shares bought or sold from the transaction split. Positive for buys, negative for
sells. If the security transaction split has been split into multiple subsplits (because a split may only be
linked to 1 lot), this amount will not be the full transaction amount, but only the amount for this split.

• Value: Amount x split price.

• Gain/Loss: For sell splits, shows calculated gain or loss. This will be recalculated during scrubbing.
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• Balance: Cumulative number of unsold shares for free splits.

• Splits in Lot panel

This panel shows splits linked to the highlighted lot in the Lots in This Account panel. This panel will
be empty until a lot is highlighted in the Lots in This Account panel. Capital Gains splits (Shares and
Price are 0) are not shown.

Columns

• Date: Transaction Date Posted.

• Num: Transaction Num.

• Description: Transaction Description.

• Amount: Split number of shares bought or sold. Positive for buys, negative for sells. If the security
transaction split has been split into multiple subsplits (say by scrubbing because a split may only be
linked to 1 lot), this amount will not be the full transaction amount, but only the amount for this split.

• Value: Amount (No of Shares) x split price.

• Gain/Loss: For sell splits, shows calculated gain or loss. This will be recalculated during scrubbing.

• Balance: The number of unsold shares in this lot after this transaction.

Buttons

• >>: Links a free split (buy or sell) to a lot. This button is not enabled until both a lot and a free split are
highlighted. The split moves from the Splits free panel to the Splits in lot panel.

Multiple buy splits and multiple sell splits may be linked to the same lot. Refer to following section
about the Scrub Account button for details of the capital gains transactions created in these situations.

• <<: Unlinks a split from a lot. The split moves from the Splits in lot panel to the Splits free panel. This
button is not enabled until a split in the Splits in lot panel is highlighted. When the last split is unlinked
from a lot, the lot is automatically deleted if there is no capital gain/loss transaction.

• New Lot: Creates a new lot which shows in the Lots in This Account panel. The new lot is not linked
to any split.

• Scrub Account:

• Creates a lot for each buy transaction split that is not already linked to a lot.

A new lot is created for each unlinked buy transaction split because gains on investments, in some
jurisdictions, may be taxed at different rates depending on how long they were held before being sold.
As a separate capital gains transaction is created for each lot, this makes it easier to determine tax on
the capital gains based on the lot opened and closed dates.

If you know that the capital gains from a sale are all to be taxed at the same rate, you can manually
link multiple buys to a lot so scrubbing will only create 1 capital gains transaction.

It is also possible to manually link multiple sell transaction splits to a lot. In this case scrubbing
creates a capital gains transaction per sell transaction split based on the average cost of securities
held at the time of each sale, assuming acquisitions are allocated to sales using the security account
costing method (currently only FIFO). As this makes it complicated to manually verify the costs are
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correct, it may be wise to limit this to specific situations, say for example if there are multiple sales
on the same day.

• Links buy and sell transaction splits to lots using FIFO method.

• Calculates gain/loss and creates a separate capital gain/loss transaction for each lot that does not
already have one.

Note

If gain/loss splits have been manually entered as part of a sell transaction, scrubbing does not
recognize them, so if manually adding gain/loss, always separate the gain/loss splits from
the transaction that reduces the No of Shares, by putting them in a separate transaction.

• Scrub: Scrub only the highlighted lot. This button is only enabled if a lot is highlighted. If no buy splits
are linked to the highlighted lot, nothing is done. The Scrub button will link any free sell splits to the lot
as required until the sum of the sell split amounts equals the sum of the buy split amounts. If the sum
of the sell split amounts is greater than the sum of the buy split amounts, a sell split will itself be split
into 2 splits, with the remaining amount in an unlinked split.

Note

For both the Scrub Account and the Scrub buttons:

The Gain/Loss for each lot is recalculated and a capital gain transaction is created if needed.
The transaction has 1 split for the security account and the other with account Orphaned Gains-
CCC where CCC is the security currency. The Orphaned Gains-CCC  account is used because
GnuCash doesn't know which capital gain or loss account should be used, so the user must
change it to the required income (or expense) gain or loss account.

• Delete: Delete the highlighted lot. Any linked splits are automatically freed (unlinked). This button is
only enabled if a lot is highlighted.

• Close: Close the Lots in Account SSSS window.

See Tutorial and Concepts Guide,  Automatic Calculation of Capital Gain or Loss Using Lots [https://
code.gnucash.org/docs/C/gnucash-guide/invest-sell1.html#invest-sellLots] for more details.

Lots for Business Features

Introduction

For business features, lots are used to link payments or credit notes to the invoices to which they apply.
This is for both customer invoices and vendor bills.

There are 2 main uses for the Lots in Account window in relation to the business features:

1. To enquire about which payments or credit notes offset particular invoices. For each invoice and credit
note, GnuCash automatically creates 1 (and only 1) lot. By selecting the lot for the invoice or credit note
in the Lots in This Account panel, all the transaction splits for that lot show in the Splits in Lot panel.

Tip

Alternatively, print the invoice and check the Payments option on the Display tab in the report
options. The Tax Invoice always shows payments so does not have the Payments option.

129

https://code.gnucash.org/docs/C/gnucash-guide/invest-sell1.html#invest-sellLots
https://code.gnucash.org/docs/C/gnucash-guide/invest-sell1.html#invest-sellLots
https://code.gnucash.org/docs/C/gnucash-guide/invest-sell1.html#invest-sellLots


Tools & Assistants

2. To correct mistakes that are hard to correct otherwise (either due to bugs in past versions of gnucash
or due to unintended use of said features). Some of these use cases are found on this wiki page [https://
wiki.gnucash.org/wiki/Business_Features_Issues]. In the context of the normal operation of business
features , the Lots in Account window is not used to create, delete, link or unlink lots. Lots are usually
generated and manipulated internally only by the business features programs.

To open the Lots in Account AAAA window, where AAAA is the Accounts Receivable (AR) or Accounts
Payable (AP) account, open the AR or AP account register, then select Actions → View Lots.

Figure 8.2. Lots in Account window for business features

An image of the Lots in Account window for an Accounts Receivable account.

Screen Elements

The screen elements of the Lots in Account window for an AR or AP account are the same as for a security
account, although the actions and data are different. As this window is only used for creating, deleting,
linking or unlinking lots in  exceptional circumstances, the differences are not described. See the section
called “Screen Elements” for a description of the screen elements and what the buttons do when used with
the lots of a security account.
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Chapter 9. Reports And Charts
Note

This section is a “work in process”. Some of the material has not been reviewed for V2.0. While
it may not be strictly accurate, it is at least a "guide".

Introduction
Reports and Charts give GnuCash the ability to present an overview of financial data in various ways.
This can range from a simple summary of account totals to an advanced portfolio view. This section will
present an explanation of the main GnuCash reports and how to adjust them.

To run a report or chart, click on the Reports menu, then either select a report (it will open with standard
options), or click on Saved Report Configuration to select a report you have previously configured and
saved.

Once the report has opened, click on the Options toolbar button to configure the report as needed, for
example to set the report date or select accounts.

Tip

If you intend to save a report configuration, you should choose a named report date option such
as Today rather than enter a specific date so it is not necessary to enter a specific date again in
future reports.

Tip

If you often run a report with a date as at the start or end of an accounting period, set the accounting
period start and end dates in Edit → Preferences → Accounting Period then select appropriate
report date options. See the section called “Accounting Period”.

Tip

If you cannot find a specific report to suit your requirements, you may be able to use the Find
Transaction assistant (Edit → Find) to select a set of transactions, and then report them using
Reports → Account Report . Further formatting or analysis may be done by copying and pasting
the report into a spreadsheet.

After you have configured a report, you can save the configuration for future use by clicking either the
Save Report Configuration or Save Report Configuration As... button.

Saving a Report Configuration
To save a report configuration for future use, while the required report tab is selected, go to the report
options, select the General tab and change the Report Name  to a meaningful unique name. Do not confuse
this with the Report Title which prints at the top of a report.

Click the Save Report Configuration or Save Report Configuration As... button. This will store your
customized report options in a file in your home directory. E.g. Linux: ~/.gnucash/saved-reports-
[versioninfo]
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The first time you save a report with a name that has not already been saved, you can use either the Save
Report Configuration or the Save Report Configuration As... button. You can modify the report name
before saving it.

After a report configuration for a specific name has been saved, the Save Report Configuration button will
immediately update the saved report configuration without giving the opportunity to save the configuration
with a new name. Use the Save Report Configuration As... button to save the current report configuration
with a new name.

After your customized report has been saved, it is available for use by the Reports → Saved Report
Configurations menu and it will also be listed when starting Reports → Sample & Custom → Custom
Multicolumn Report .

Working with Saved Report Configurations

Selecting Reports → Saved Report Configurations will open a dialog window with a list of the Saved Report
Configurations  you have previously created. In this context Saved Report Configurations means the set
of customized settings for standard reports.

The Saved Report Configurations window lists each of your previously saved report configurations, and
3 small buttons at the end of each. These buttons perform the following actions

• Load (and run) report configuration. Double clicking a report configuration also performs this action.

• Edit report configuration name. This enables a report configuration to be renamed.

• Delete report configuration.

Configuring Reports and Charts
GnuCash reports have many configuration options. First, run the original report itself. Then, access the
report options with the Options button on the toolbar.

Note

Check changed Graphic Engine Options

Report Options Buttons

After modifying report options, either

• Click the OK button to apply the changes, regenerate the report and close the options window.

or

• Click the Apply button to apply the changes, regenerate the report and leave the options window open
for possible further changes. In this case, both the Apply and OK buttons will be disabled, indicating
changes have been applied, until further changes are made.

or

• Click the Cancel button to close the options window without applying any unapplied changes.
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Common Report Options
Many reports share similar options. Some common ones include:

• Report Name: Set the title of the report. This is also used to print the report for later viewing.

• Date Options: Reports typically specify either a single date, or a date range, for the report. Dates can be
specified in two ways, either directly (using the date selector), or by selecting a relative date from the
menu. Relative dates allow you to specify dates like Beginning of this year or Today.

Tip

If you often run a report with a date as at the start or end of an accounting period, set the
accounting period start and end dates in Edit →  Preferences → Accounting Period then select
appropriate report date options. See the section called “Accounting Period”.

• Step Size: This option is used on bar charts to determine the interval which each bar represents. Typical
values are daily, weekly, monthly, and yearly.

• Accounts: Select the appropriate accounts for the report. Note that in some reports only certain types of
accounts can be selected. For example, an expense piechart only allows expense accounts to be selected.

• Show Long Account Names: This option allows displaying either short account names (for example,
Power) or long account names (for example, Utilities:Power).

• Include Subaccounts?: Summary reports typically have an include all subaccounts option, which if
selected ensures that all subaccounts are included if the parent account is.

• Depth: This option allows the selection of how many levels the report displays subaccounts. If the
subaccounts go deeper than selected, an overall value for all the subaccounts is calculated and included
in a total. To make sure every account selected is individually displayed, select All.

• Style Sheet: Select a Style Sheet. Style sheets control how reports are displayed. At the moment, there
are four style sheets: Default, Easy, Footer and Technicolor. You can customize each of these from the
Edit → Style Sheets... menu item. This is described in the the section called “Changing Style Sheets”
section.

• Plot Dimensions: There are width and height options for most charts, which specify the displayed
dimensions (in pixels).

• Report Currency: Select the report currency. Generally, values will be converted to this currency for
display.

The default Report Currency is defined in Edit → Preferences Reports tab. See the section called
“Reports”.

• Price Source: Select how stock and currency prices are calculated in this report. Choose between:

• Nearest in time (default for most reports): A price retrieved from the prices database on the date
nearest to the date of the report or of the datum for time-series reports.

• Most recent: The latest price in the price database.

• Average Cost: The amount-weighted net average of all splits exchanging the commodity for another
regardless of account. Gain/loss splits are included in the calculation.
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• Weighted Average: The gross amount-weighted average price of all splits exchanging the commodity
for another regardless of account. Gain/Loss splits are not in the calculation.

More information on Average Cost and Weighted Average may be found in the Investments chapter of
The Tutorial and Concepts Guide.

• Totals: Charts display totals in the chart legend if this option is selected.

• Maximum Slices: Controls the maximum number of slices displayed in a piechart - other accounts will
be placed in a slice marked Other.

• Maximum Bars: Controls the maximum number of bars displayed in a barchart.

• Display Columns: Choose columns to show from the register.

Reports Listed By Class
GnuCash has classified the main types of reports into major classes. These are all available under the
Reports menu.

General Reports
The General Reports include the Account Summary Report, the Future Scheduled Transactions Summary,
the Tax Schedule Report and TXF Export, and the Transaction Report and also the reports in the Sample
& Custom menu.

Account Summary

Future Scheduled Transactions Summary

Tax Schedule Report and TXF Export

The tax schedule report lists all taxable income and deductible expense amounts used in the preparation of
US Income Tax returns. The purpose of the report is to provide a complete audit trail for these amounts. The
report is intended to be used by a tax payer to manually prepare his or her own tax return, or alternatively,
to be provided to a tax preparer for that purpose. The report can also be used to generate an export of all tax
related income and expenses to a TXF (Tax eXchange Format) file (this is in addition to exporting to the
HTML format that all reports allow). The TXF file can be imported into tax filing programs such as TaxCut
or TurboTax. The report should be run, inspected carefully for errors or omissions, and then corrections
made to transactions, report settings, currency conversion rates or the account structure as needed. This
process should be repeated as often as needed until all the amounts on the report are correct before a final
version is used and saved along with the tax returns.

For accounts specified in the report options (none = all) that are also flagged as Tax-related, all transactions
for the time period selected (also in the report options) are included. The report sorts transactions by date
within account providing subtotals by account within tax code within Form or Schedule line number.
Support is also provided for multiple copies of and for sub-line items for selected Forms/Schedules.
Optionally uses special date processing to include federal estimated tax payments after year end.

All totals are in USD since this is the currency required for filing US Income Tax returns. Non-USD
transaction amounts are converted to USD using the transaction conversion rate to USD, if available. If
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not, a conversion rate from the price database is used (either the date nearest the transaction date or nearest
the report date as specified in the report options; if none is available, transaction amounts are converted to
zero and the report provides a comment accordingly). A complete audit trail of conversions is provided.

Note

For this to work, the user has to segregate taxable and non taxable income to different accounts,
as well as deductible and non deductible expenses. The Income Tax Information dialog is used
for this. To access the Income Tax Information dialog go to Edit → Tax Report Options. The user
also must set the TXF category of each tax related account. The Income Tax Information dialog
is described in the the section called “Setting Tax Report Options” section.

Transaction Report

This report lists transactions in selected accounts during a specified financial period. Two fields may be
optionally used for sorting and totalling.

Report Options

Figure 9.1. Transaction Report, Report Options

This is an image of the Transaction Report, Report Options, Display tab.

• Accounts tab
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• Accounts: Select one or more accounts to be reported.

There are 4 buttons to aid account selection

Select All Select all accounts

Clear All Clear the selection and unselect all accounts

Select Children Select all descendants of selected account

Select Default Select the default account selection

• Show Hidden Accounts: Show accounts that have been marked hidden.

• Filter By: Optionally select accounts to be either included or excluded depending on Filter type

• Show Hidden Accounts: Show accounts that have been marked hidden in the Filter By list of accounts

• Filter Type: One of

None Do not do any filtering

Include Transactions to/from Filter Accounts Include Transactions to/from Filter Accounts
only

Exclude Transactions to/from Filter Accounts Exclude Transactions to/from all Filter Accounts

• Reset defaults button: Reset all values to their defaults

• Display tab

• Date refers to the 'posted date' i.e. effective date of a transaction.

• Reconciled Date refers to the 'date of reconciliation' of a transaction.

• Num is commonly used for check numbers.

• Description is a description of the transaction

• Memo is the memo field of a transaction. This can be used as a secondary description of a transaction.

• Notes: Display the notes if the memo is unavailable

• Account Name will print the account name containing the transaction.

• Use Full Account Name if the account name is enabled, this option will display the full account name
hierarchy.

• Account Code this refers to the 'account code' related to the account.

• Detail Level— One of

Single Display 1 line

Multi-Line Display N lines

Note

Before stable version 3.0 Detail Level was called Style on the General tab.
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If Detail Level is Multi-Line, check boxes Other Account Name and Use Full Other Account Name
are automatically deselected and disabled, and the Transfer column is not reported.

• Other Account Name: For multi-split transactions, this parameter should be unticked. See below for
more details.

• Use Full Other Account Name will enable display of full corresponding account name.

• Other Account Code will enable display of corresponding account code.

• Shares: Display number of shares

• Price: Display share prices

• Amount: One of

None Do not display Amount

Single Single column display

Double Two column display

• Subtotal Table will add a summary table for the various subtotals generated in the report. It lists the
same subtotals generated in tabular form.

• Running Balance refers to the running balance of the account holding the transaction.

• Totals will add a 'Grand Total' line adding all transactions in the report.

• Sign Reverses: One of

Global Preference Use reversing option specified in global
preference.

None Do not display signs reversed

Credit Accounts Reverse amount display for Liability, Payable,
Equity, Credit Card and Income accounts

Income and Expense Reverse amount display for Income and Expense
accounts

• Reset defaults button Reset all values to their defaults

• Filter tab

• Account Name Filter will include only selected accounts containing the substring. Alternatively, if
the next option is checked, the account name filter will be matched according to full POSIX regular
expressions.

• Use regular expressions for account name filter toggles regular expressions for account name filter.

• Transaction Filter will include only transactions which contain this substring in the description, notes,
or memo. Alternatively if the next option is checked, the filter will be matched using full POSIX
regular expressions.

• Use regular expressions for transaction filter toggles regular expressions for the transaction filter.
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• Reconcile Status

All Show all transactions

Unreconciled Unreconciled only

Cleared Cleared only

Reconciled Reconciled only

• Void Transactions: One of

Non-void only Show only non-voided transactions

Void only Show only voided transactions

Both Show both and include voided transactions in
totals

• Closing transactions: One of

Excluding closing transactions Show only regular transactions

Show both closing and regular transactions Show both regular and closing transactions

Show closing transactions only Show closing transactions only

• Reset defaults button: Reset all values to their defaults

• General tab

• Report name: Enter a descriptive name for this report

• Stylesheet: Select Default, Easy, Footer or Technicolor

• Start Date: Enter or select a specific Start Date

or select one of the following named start date options which will be used to determine the start date
each time the report is run

Today The current date

Start of this month First day of the current month

Start of previous month First day of the previous month

Start of current quarter First day of the current quarterly accounting
period

Start of previous quarter First day of the previous quarterly accounting
period

Start of this year First day of the current calendar year

Start of previous year First day of the previous calendar year

Start of accounting period First day of the accounting period as defined in
the global preferences

• End Date: Enter or select a specific End Date,
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or select one of the following named end date options which will be used to determine the end date
each time the report is run

Today The current date

End of this month Last day of the current month

End of previous month Last day of the previous month

End of current quarter Last day of the current quarterly accounting
period

End of previous quarter Last day of the previous quarterly accounting
period

End of this year Last day of the current calendar year

End of previous year Last day of the previous calendar year

End of accounting period Last day of the accounting period as defined in
the global preferences

• Style: One of

Single Display 1 line

Multi-Line Display N lines

Note

In stable version 3.0, the Style option will be renamed to Detail Level and moved to the
Display tab.

• Common Currency: Convert all transactions into a common currency

• Report's currency: Select the currency to display values

• Show original currency amount Also show original currency amounts

• Table for Exporting: Formats the table for cut & paste exporting with extra cells

• Add options summary: Adds an informative text describing options that were changed by user. This
is mainly useful for troubleshooting reports.

• Reset defaults button: Reset all values to their defaults

• Sorting tab

• Primary Key: Primary Sort Key. One of

None Do not sort

Account Name Sort and subtotal by account name

Account Code Sort and subtotal by account code

Date Sort by date

Reconciled Date Sort by the reconciled date

Reconciled Status Sort by the reconciled status
139



Reports And Charts

Register Order Sort as within the register

Other Account Name Sort by account transferred from/to's name

Other Account Code Sort by account transferred from/to's code

Amount Sort by amount

Description Sort by description

Number Sort by check/transaction number

Memo Sort by memo

• Primary Subtotal: Subtotal according to the primary key

• Primary Subtotal for Date Key: Do a date subtotal. Only configurable if primary key is date or
reconciled date. One of None, weekly, monthly, quarterly or yearly

• Primary Sort Order: One of

Ascending Smallest to largest, earliest to latest

Descending Largest to smallest, latest to earliest

• Secondary Key: Secondary Sort Key. Same options as Primary Key

• Secondary Subtotal: Subtotal according to the secondary key

• Secondary Subtotal for Date Key: Do a date subtotal. Only configurable if primary key is date or
reconciled date. One of None, weekly, monthly, quarterly or yearly

• Secondary Sort Order: One of

Ascending Smallest to largest, earliest to latest

Descending Largest to smallest, latest to earliest

• Show Full Account Name: Show the full account name for subtotals and subtitles

• Show Account Code: Show the account code for subtotals and subtitles

• Show Account Description: Show the account description for subtitles

• Show Informal Debit/Credit Headers: Show informal names for debit/credit in the subtitles. This
requires that subtotal is enabled, and the primary or sortkey is account or account code.

• Add indenting columns: Add columns to align transactions within the same grouping together, and
can be useful to highlight groups.

• Show subtotals only (hide transactional data): Will hide transactions. This may be useful for reports
whereby only subtotals are required.

• Reset defaults button: Reset all values to their defaults

Displaying Split Account Details

This is controled by the Detail Level option on the Display tab.
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Note

In stable versions before 3.0 this option was called Style on the General tab.

In Single line mode, there's only one line per transaction. So you can have the account name on one side
of the equation and

a. the other account name if there's only one other split in the transaction

or

b. "Split" if there are multiple other splits in the transaction. You can't display multiple "other" account
names in one line. There's just no room for it.

In the case of Multi-Line mode, this report uses a completely different concept. For each transaction, every
split (both the split in this account and the split(s) in the other account(s) !) is printed on a separate line.
And every split really means every split: both the split which belongs in the account being reported and
the split(s) in the other account(s) that balance the transaction. So even the most basic transaction, with
only two splits (this account and other account) will print two lines in multiline mode.

For a simple transaction like this

Description Account Debit Credit

Cheques Received

"multiple payers" IncomeAccount £30.00

BankAccount £30.00

then on a Transaction Report for the bank account the details appear pretty much as above.

For clarity of the accounts, you might enter transactions with multiple splits referring to the same account.
For example, the above transaction might well be entered like this

Description Account Debit Credit

Cheques Received

"FirstPayer" IncomeAccount £10.00

"SecondPayer" IncomeAccount £20.00

BankAccount £30.00

When this transaction is printed on the bank account's Transaction Report in Single line mode, then under
other account it simply prints the word split instead of the account name.

To display the additional split detail, you need to set Single/Multi-Line to Multi-Line and then tick Display
-> Account Name. Do NOT tick Display -> Other Account Name.

You can choose whether or not to turn off the full account name using Display -> Use Full Account Name.

Use Full Other Account Name has no effect in Multi-Line mode.

Assets & Liabilities
The Assets & Liabilities reports includes the Balance Sheet report, Investment reports and the Net Worth
report.

• Advanced Portfolio:

Columns
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• Account: Stock Account

• Symbol: Ticker Symbol/Abbreviation as defined in the Security Editor. A report option can suppress
this column.

• Listing: Type as defined in the Security Editor. A report option can suppress this column.

• Shares: Number of shares (quantity). A report option sets how many decimal places to show. A report
option can suppress this column.

• Price: Unit market price as at report date. A report option can suppress this column.

• Basis: Cost of all shares acquired by any means, including brokerage fees if the option to include
them is checked. Report option Basis calculation method can be set to Average, LIFO or FIFO.

• Value: Number of shares * Unit market price as at report date

• Money In: Sum of the cost of stock purchased, excluding stock acquired as part of a Dividend
Reinvestment Plan. I.e. External money used to purchase shares.

• Money Out: Money from selling shares or a spin off transaction.

• Realized Gain: Money received for selling shares minus basis for shares sold, minus brokerage fees
for the sale if the option to include them in basis is checked.

• Unrealized Gain: Value less Basis for unsold shares

• Total Gain: Realized Gain + Unrealized Gain

• Rate of Gain: Total Gain / Money In * 100 (from GnuCash 2.6.1 onwards)

• Income: Total of all income transactions associated with a stock account.

Note

To include income from dividends which are not reinvested (if there is no split to the stock
account in the income transaction, the report has no way of associating the income with a
particular stock) :

Ensure there is a dummy transaction split to the stock account with quantity 0, price 1
and value 0 in the dividend transaction. Enter the dummy stock split with no values in the
dividend account and it will create the transaction with price 1 even though you cannot see
the Price column in that register.

In GnuCash 2.6.6, this report was modified to simplify the recording of dividend and interest
payments. With this change it may not be necessary to include the dummy stock split in
the transaction. The report will find income (and expense) transactions that are in the parent
account of the stock account being reported on. This is done by looking in the parent account
for transactions that have exactly two splits (not counting trading account splits) where the
other split is to an income or expense account with the same name as the stock's account.

For example given an account structure like

                Assets (type ASSET)
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                  Broker (type ASSET)
                    Widget Stock (type STOCK)
                Income (type INCOME)
                  Dividends (type INCOME)
                    Widget Stock (type INCOME)
                

A transaction that debits the "Assets:Broker" account and credits the
"Income:Dividends:Widget Stock" account will count as income even though it doesn't have
a split with account "Assets:Broker:Widget Stock".

This only works if the parent account ("Assets:Broker" in this case) is a Bank or Asset
account and the Income/Expense account has the same name as the stock account. It won't
double count transactions that have a dummy split since they won't have exactly two split
transactions.

It will not work if the income or expense account split is to a subaccount of the account with
the same name as the stock account i.e. "Income:Dividends:Widget Stock:Franked"

• Brokerage Fees: Brokerage Fees

• Total Return: Total Gain + Income

• Rate of Return: Total Return / Money In * 100

Common report options are described in the section called “Configuring Reports and Charts”

Report Specific Options

• Accounts Tab

• Include accounts with no shares: Unchecked (default) or checked.

• Display Tab

• Show ticker symbols: Checked (default) or unchecked. If unchecked, Symbol column will be
omitted.

• Show listings: Checked (default) or unchecked. If unchecked, Listing column (source of shares
price quotes) will be omitted.

• Show number of shares: Checked (default) or unchecked. If unchecked, Shares column will be
omitted.

• Share decimal places: The number of decimal places to show in the number of shares. Default is 2.

• Show prices: Checked (default) or unchecked. If unchecked, Price column will be omitted.

• General Tab

• Price Source: Nearest in time (default) or Most Recent.

• Basis calculation method: Average (default), FIFO or LIFO.

• Set preference for price list data: Checked (default): Use price list data. If there is no relevant price
list data, transaction prices will be used and there will be a warning. Unchecked: Get prices from
stock transactions. 143
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• How to report brokerage fees: Include in basis (default), Include in gain or Ignore.

• Asset Barchart:

The Asset Barchart report displays bars that present the value of all assets in a GnuCash file over time. By
default, the report shows all accounts in Accounts Receivable, Current Assets, Fixed Assets, Investments
and Special Accounts (if they exist) and it displays monthly bars for the current financial period. This
report provides a graphic view of the assets in the file over time.

Tip

Like all the generic reports, the user can assign a title and save the report with it's selected
options for re-use later.

The display is in the form of either a stacked barchart or simple barchart with an option to display a
table of the values.

This report calculates and displays a default of 8 bars or up to 24 separate asset accounts value at the end
of the day on several dates through a specified time period. The report automatically selects the most
significant accounts to display with all other selected accounts summed as Other.

The report exploits the outline structure of the chart of accounts to allow the user to select top level
accounts and sub-accounts down to a user-selectable depth. Selected sub-accounts below the selected
depth are automatically summed up into the next level when it is also selected. The default number of
sub-account levels is 2, giving a summary view. Increasing the number of sub-levels increases the detail
available to display. It is possible to un-select a higher level account and leave sub-accounts selected
to force greater detail to appear in the report.

By default the report includes all asset accounts and sub-accounts, as well as Imbalance and Orphan
Special accounts in whatever currencies or commodities may be present. The report's base currency is
the default currency of the GnuCash file but if the file has data for multiple currencies, then it can be
changed to another currency.

Since each account may be individually selected, the report can be designed to focus on a small subset
of data such as current assets or investments.

The overall interval of the report defaults to start at the start of the current accounting period and to
end at the end of the current accounting period. Numerous other starting choices and ending choices
are available.

The first bar shows the selected values at the end of the day on the first date chosen. There are a number
of choices for step size from day to year with the default being month. Note that if any step date would
fall on the 29th, 30th or 31st in a month that does not have such a date the next interval will be 31 days
later. For that step only the date will slip up to 3 days into the following month. This is true for releases
at least through 2.4.13. Bug 639049 is open in Bugzilla to modify this behavior.

Currently, there is no option to start the report on the last day of any period. There is also no option to
show beginning balances or end of previous step balances. This makes it difficult to correlate this report
to business quarterly reports, for example.

The Net Worth linechart report, Liability barchart report and Net Worth barchart report are similar
except for the graphic type and default account groups selected.

Other features are customizable in a manner similar to other standard reports.
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• Asset Piechart:

• Average Balance:

• Balance Sheet: This report summarizes assets, liabilities, and equity. When properly maintained, assets
should equal the sum of liabilities and equity. If that is not the case, there is some kind of internal
imbalance in the accounts.

• Balance Sheet using eguile-gnc:

• General Journal:

• General Ledger:

• Investment Portfolio: This report summarizes the value of the stocks in the current portfolio.

• Liability Barchart:

• Liability Piechart:

• Net Worth Barchart: Net worth is the difference between the value of assets or liabilities.

• Net Worth Linechart: Net worth plotted over time. Net worth is the difference between the value of
assets or liabilities.

• Price Scatterplot:

Business Reports
The Business Reports includes Customer and Vendor Reports and Printable Invoices as well as Aging
reports.

Customer Report

Customer Summary

Easy Invoice

Employee Report

Fancy Invoice

Job Report

Payable Aging

This report provides a listing of vendors and their aged outstanding balances. Vendors may be included if
they have posted business transactions (e.g. invoices) for the selected accounts payable account. It shows
their current balance, and how much they have due from invoices over time periods 0-30 days, 31-60 days,
61-90 days, and over 90 days. The report also contains links to each vendor and to their current vendor
report.

Optionally, vendor address details may be also shown.
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Tip

To export vendor address details, say in order to do a mail merge, select the optional vendor
address details in the report options display tab, apply the options to regenerate the report, then
copy and paste the report into a spreadsheet. Alternatively, the report can be exported to a .html
file, then read into a spreadsheet.

Report Options

Note

See Common Report Options in the Configuring Reports and Charts section of this help manual
for more details of the common options.

• General tab

• Report name: Enter a descriptive name for this report - see Common Report Options.

• Stylesheet: Select a style sheet for this report - see Common Report Options.

• To: Select a date to report on or a named date. Transactions up to and including the selected date will
be used to calculate the outstanding aged balances. See Common Report Options.

• Report's currency: Select the currency to display the values in - see Common Report Options

• Price Source: Select the source of price information used for currency conversion if needed. One of

Average Cost The volume-weighted net average price of all
exchanges.

Weighted Average (default) The volume-weighted gross average price of all
exchanges up to the date of the report

Most recent The most recent recorded price

Nearest in time The price recorded nearest in time to the report
date

• Show Multi-currency Totals: If not selected, all totals are shown in the report currency.

• Sort By: Sort companies by one of

Name (default) Company name

Total Owed Total amount owed to company

Bracket Total Owed Amount owed in oldest bracket. If same, use next
oldest

• Sort Order: One of

Increasing (default)

Decreasing

• Show zero balance items: Show companies even if they have a zero outstanding balance.

• Due or Post Date: Leading date. Which date to use to determine aging. One of146



Reports And Charts

Due Date (default)

Post Date

• Payable Account: The accounts payable account used to select vendors to be reported. Vendors are
included if they have a posted business transaction (usually an invoice) on or before the report date
and also meet the Show zero balance items criteria.

• Display tab

• Address Name: Display vendor address name. This, and other fields, may be useful if copying this
report to a spreadsheet for use in a mail merge.

• Address 1: Display address line 1.

• Address 2: Display address line 2.

• Address 3: Display address line 3.

• Address 4: Display address line 4.

• Phone: Display address phone number.

• Fax: Display address fax number.

• Email: Display email address.

• Active: Display vendor active status.

Printable Invoice

Receivable Aging

This report provides a listing of customers and their aged outstanding balances. Customers may be included
if they have posted business transactions (e.g. invoices) for the selected accounts receivable account. It
shows their current balance, and how much they have outstanding from invoices over time periods 0-30
days, 31-60 days, 61-90 days, and over 90 days. The report also contains links to each customer and to
their current customer report.

Optionally, customer address details may be also shown.

Tip

To export customer address details, say in order to do a mail merge, select the optional customer
address details in the report options display tab, apply the options to regenerate the report, then
copy and paste the report into a spreadsheet. Alternatively, the report can be exported to a .html
file, then read into a spreadsheet.

Report Options

Note

See Common Report Options in the Configuring Reports and Charts section of this help manual
for more details of the common options.
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• General tab

• Report name: Enter a descriptive name for this report - see Common Report Options.

• Stylesheet: Select a style sheet for this report - see Common Report Options.

• To: Select a date to report on or a named date. Transactions up to and including the selected date will
be used to calculate the outstanding aged balances. See Common Report Options.

• Report's currency: Select the currency to display the values in - see Common Report Options.

• Price Source: Select the source of price information used for commodity conversion if needed. One of

Average Cost The volume-weighted net average price of all
exchanges

Weighted Average (default) The volume-weighted gross average price of all
exchanges

Most recent The most recent recorded price

Nearest in time The price recorded nearest in time to the report
date

• Show Multi-currency Totals: If not selected, all totals are shown in the report currency.

• Sort By: Sort companies by one of

Name (default) Company name

Total Owed Total amount owed by company

Bracket Total Owed Amount owed in oldest bracket. If same, use next
oldest

• Sort Order: One of

Increasing (default)

Decreasing

• Show zero balance items: Show companies even if they have a zero outstanding balance.

• Due or Post Date: Leading date. Which date to use to determine aging. One of

Due Date (default)

Post Date

• Receivables Account: The accounts receivable account used to select customers to be reported.
Customers are included if they have a posted business transaction (usually an invoice) on or before
the report date and also meet the Show zero balance items criteria.

• Display tab

• Address Source: Which customer address fields to display. One of

Billing (default) Address fields from billing address.

Shipping Address fields from shipping address.
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• Address Name: Display customer address name. This, and other fields, may be useful if copying this
report to a spreadsheet for use in a mail merge.

• Address 1: Display address line 1.

• Address 2: Display address line 2.

• Address 3: Display address line 3.

• Address 4: Display address line 4.

• Phone: Display address phone number.

• Fax: Display address fax number.

• Email: Display email address.

• Active: Display vendor active status.

Tax Invoice

Vendor Report

Income & Expense
The Income & Expense reports includes the Cash Flow and Income Statement reports.

• Cash Flow:

• Equity Statement:

• Expense Barchart:

• Expense Piechart:

• Expense vs Day of Week:

• Income & Expense Chart:

• Income Barchart:

• Income Piechart:

• Income Statement: This report summarizes sources of income and expenditure. (This report was called
Profit & Loss in gnucash-1.8.)

• Income vs Day of Week:

• Profit & Loss: This is the same report as the Income Statement but with a different title.

• Trial Balance: This report summarizes sources of income and expenditure.

Sample & Custom

Welcome Sample Report
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Custom Multicolumn Report

This report is used to place multiple reports into a single report window to examine a set of financial
information at a glance.

Sample Report with Examples

Budget

Budget Balance Sheet

Budget Barchart

Budget Flow

Budget Income Statement

Budget Profit & Loss

Budget Report

This report is used to compare budgeted and real amounts for selected accounts. It allows you to review
how well you follow the budget.

The report is generated as a table in which each row represents an account and each set of columns shows
the budgeted amount, the real amount, and the difference between them for each report period.

Each entry in the real amount column is the sum of all the splits in the row's account over the column's
period. For example, if the report is set up for monthly periods, the column is for May, and the row is for
Expenses:Groceries, then the value will be the sum of all Expenses:Groceries splits for that May.

The report supports selecting a range of periods instead all of them. Periods that are out of range can be
included in the report as the consolidated columns around the selected range. This allows you to focus on
particular periods, for example the current one, and is especially useful for budgets with many periods.
For example, if you have a 12 period budget you can make a 3 column report with the format "(all periods
before columns set) (current period columns set) (all periods after columns set)" that is easily fits on the
screen and allows you to match values with account names.

Budget report options

Note

Here we describe only options that are specific for the Budget Report. You can find information
about standard parameters in the section called “Configuring Reports and Charts”.

• Show budget - include the budgeted values for the period

• Show actual - include the real values for the period
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• Show difference - include the difference between budgeted and real values for the period. Enabling this
option does not force including budgeted and actual values in the report

• Show Column with totals - Adds a final column set containing budgeted, real value, and difference
columns summing those values across all periods of the report.

• Rollup budget amounts to parent - not used in the report, can be deleted or should be fixed

• Include accounts with zero total balances and budget values - enables display of accounts with no
budget or splits in any period.

• Budget - Select the budget to use for report generation

• Report for range of budget periods - Enables reporting on a subset of the budget by selecting a beginning
and an ending period.

• Range start - a combobox with a list of options to select the start period:

1. First - select first budget period

2. Previous - select previous period.

3. Current - select current period.

4. Next - select next period.

5. Last - select last budget period

6. Manual - enables spinbox where you can select exact period

Note

The current, previous, and next options select the period based on the date on which the report
is run, with current being the period in which the date falls, previous being the one before that,
and next the period after. If the current date falls outside the date range covered by the budget,
the first or last period will be used as appropriate.

• Exact start period - options for select exact start period, enabled only if the range start option is set
to Manual

• Range end - a combobox with a list of options to select the end period. Values are the same as in Range
start options

• Exact end period - the same as Exact start period but for the end of range

• Include collapsed periods before selected - if on, then includes in the report all budget periods, that are
before selected period range, as a single consolidated column set

• Include collapsed periods after selected - if on, then includes in the report all budget periods, that are
after selected period range, as a single consolidated column set.

Printing or Exporting Reports and Charts
Note

Verify !!! How customize printing with Gnome?
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GnuCash is able to print reports and to export the reports to HTML (web) pages. The Print GnuCash
Document dialog is accessed from the Print button on the Toolbar or go to File → Print in the menu. To
Export a report to a web page (HTML) select the Export button on the Toolbar and type in a file name.

Most reports, being presented in HTML, can also be copied and pasted into a spreadsheet.

The Print GnuCash Document dialog is used to select which Printer to send the print job to or to print to
a File. It also contains a Preview button to view the document before printing. Press Print to send the job
to the selected printer or Cancel to dismiss the Print dialog.

Printing from an open register prints the Account Report, which is also called the Register Report. This
lists transactions in the account with a total. Other reports print as viewed in the Report screen.

Creating Reports and Charts
Note

This section may need updating !!!

It is possible to write reports if the current ones are not suitable. To do this you will need to know Scheme
(a LISP-like programming language), and it is an excellent idea to have a copy of the GnuCash source
code available.

The reporting interface is documented in the source code file src/report/report-system/
doc/report-html.txt. The file src/report/utility-reports/hello-world.scm in
the GnuCash source distribution provides a good example of how reports are developed.

Accessing the GnuCash API
It is also necessary to access data from the engine to get information for your report. This is since version
2.1.x performed by a set of Scheme wrapper functions that are documented in the file src/engine/
swig-engine.c. Up to version 2.0.5 it was src/g-wrap/gnc.html. Examine some of the other
reports in src/scm/report for an indication of how they are used.

Some users started a table in https://wiki.gnucash.org/wiki/Custom_Reports#The_GnuCash_API.

Because the above file only contains the syntax of the function you can use the Doxygen source
documentation either local after running

./configure --enable-doxygen --enable-html-docs
make doc

on your sources or online https://code.gnucash.org/docs/MAINT/ or https://code.gnucash.org/docs/
MASTER/ to get more information about the functions.

Report Rendering
At present, reports are produced by calling a HTML-generation API, which outputs a dialect of HTML
and rendering this with a HTML widget. This has limitations, particularly when trying to align objects
precisely, as might be necessary for printing onto pre-printed invoices for example.
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Chapter 10. Customizing GnuCash

Account Display Options
The View → Filter By ... is used to set or modify the view of the account tree window. The Accounts tab
of this form allows the selection of the types of accounts to display. These selections effect the view on
each specific open window of the account tree.

The Other tab allows enabling/disabling of the options; Show Hidden accounts, Show zero total accounts.

The account tree window, by default, only shows the quantity of each commodity that you own, under the
column heading Total. Often, however, you may want to display other values. This is easily accomplished
by clicking on the Options button (the small down pointing arrow on the right side of the main account
window Titlebar), and selecting the option(s) to display. These selections set the view on all open windows
of the account tree.

Setting Preferences
The GnuCash Preferences window allows you to customize your GnuCash session by setting several
options. From the GnuCash menu select Edit → Preferences (GnuCash → Preferences on MacOS). The
GnuCash Preferences window will open. Using the tabs on the left make your desired changes. The settings
in this dialog are set per user and not stored with the file. This is in contrast to the settings described in
the section called “Book Options”, which are kept with, and are part of, the file (or Book), and as such are
common to all users. So GnuCash Preferences settings are individual to each user who uses a given file
and any changes made by one user will not affect other users of that file. Also, a given user's preferences
will be common to all files that that user opens with GnuCash.

Tip

Pausing the cursor for a couple of seconds over options in these windows will display a tooltip
with in-depth information on the choice.

Note

The changes you make will be applied at once.

To close the GnuCash Preferences window press the Close button.

Each tab in the GnuCash Preferences window is discussed in its own section below. For a listing of the
tabs, see Chapter 10, Customizing GnuCash.

Note

The presentation of the sections that follows matches the order of the tabs, which are sorted
alphabetically by name, in English. The order of the tabs may be different in other languages.
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Accounting Period

Figure 10.1. The Preferences window, Accounting Period tab

• Start Date: This item sets the accounting period’s start date.

• Relative: Use the specified relative starting date for profit/loss calculations. Also use this date for net
assets calculations. Relative defines start by today or start of current/previous year, quarter, month.

• Absolute: Use the specified absolute starting date for profit/loss calculations. Also use this date for
net assets calculations.

• End Date: This item sets the accounting period’s end date.

• Relative: Use the specified relative ending date for profit/loss calculations. Also use this date for net
assets calculations.

• Absolute: Use the specified absolute ending date for profit/loss calculations. Also use this date for
net assets calculations.

• Summarybar content

• Include grand total: If checked, show in the Summarybar a grand total of all accounts converted to
the default currency.

• Include non-currency totals: if this option is selected, GnuCash will include in the Summarybar a
total for non-currency items (for instance number of shares).
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Accounts

Figure 10.2. The Preferences window, Accounts tab

• Separator Character: The account separator is the character that separates a parent account from its sub-
account, for example Utilities:Electric. The default is a : (Colon), but you can also select / (Slash), \
(Backslash), - (Dash) or . (Period), or any Unicode character that isn’t a letter or a number.

• Reverse Balanced accounts: This option lets you determine whether account balances will display as
positive or negative numbers:

• Income & Expense assigns a positive credit balance to income account balances and a negative debit
balance to expense account balances. See the section called “Types of GnuCash Accounts” for more
information on these account types.

• Credit accounts (default) displays a positive balance for account types that would normally carry a
credit balance (income, credit, liability, equity). See the section called “Types of GnuCash Accounts”
for more information on these account types.

• None shows all credit balances as negative and all debit balances as positive.

• Labels: Select this option if you want column headings in the register to refer to debits and credits instead
of the default informal headings such as withdrawal and deposit.

• Default Currency: This item determines which currency will be selected by default when creating new
accounts.
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• Locale: Use the system locale currency for all newly created accounts.

• Choose: specify the currency to use, independent of your system settings.

• Account Color: This option lets you manage the display of the account color set in the Edit Account
window:

• Show the Account Colors as background: show the accounts color as account name background in
the Accounts Page.

• Show the Account Colors on tabs: show the accounts color as background in the account register tabs.

Business

Figure 10.3. The Preferences window, Business tab

• General

• Enable extra buttons: If checked, extra toolbar buttons for common business functions are shown.

• Open in new window: If checked, each invoice will be opened in its own top level window. If clear,
the invoice will be opened in the current window.
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• Accumulate splits on post: Whether multiple entries in an invoice which transfer to the same account
should be accumulated into a single split by default.

• Invoices

• Report for printing: Allows to select the invoice report to be used for printing.

• Tax Included: Whether tax is included by default in entries on invoices. This setting is inherited by
new customers and vendors.

• Auto pay on posting: If enabled, at post time automatically attempt to pay customer documents with
outstanding pre-payments and counter documents.

Note

Counter documents are documents with opposite sign. For example for an invoice, customer
credit notes and negative invoices are considered counter documents.

The pre-payments and documents obviously have to be against the same customer.

• Bills

• Notify when due: Lets you set whether you want to be notified at GnuCash startup of when a bill
is soon to be due.

• Days in advance: How many days before the due date to warn about bills coming due.

• Tax Included: Whether tax is included by default in entries on bills. This setting is inherited by new
customers and vendors.

• Process payments on posting: If enabled, at post time automatically attempt to pay vendor documents
with outstanding pre-payments and counter documents.

Note

Counter documents are documents with opposite sign. For example for a bill, vendor credit
notes and negative bills are considered counter documents.

The pre-payments and documents obviously have to be against the same vendor.
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Date/Time

Figure 10.4. The Preferences window, Date/Time tab

• Time Format

• Use 24-hour clock: Lets you specify if you want to use 24 or 12 hours time format. That is if 11
o’clock at night should be represented as 11PM or 23:00.

• Date Format: This option controls the appearance of the date (you can see a preview of the date beside
each of the choices). The available choices are:

• US: Use the date format common in the United States.

• UK: Use the date format common in the United Kingdom.

• Europe: Use the date format common in continental Europe.

• ISO: Use the date format specified by the ISO-8601 standard.

• Locale: Use the date format specified by the system locale.

• Date completion: This option lets you manage the case when a date is entered without a year:

• In the current calendar year: (Default) Dates will be completed so that they are within the current
calendar year.

158



Customizing GnuCash

• In a sliding 12-month window starting a configurable number of months before the current month:
Dates will be completed so that they are close to the current date. You can enter the maximum number
of months to go backwards in time when completing dates.

General

Figure 10.5. The Preferences window, General tab

• General

• Display "Tip of the Day" dialog: This option displays or hides the Tip of the Day screen when
GnuCash is started.

• Show splash screen: With this option you can enable or disable the visualization of the startup screen
while GnuCash is starting up.

• Perform account list setup on new file: This option turns off the display of the New Account Hierarchy
Setup assistant when the entry File → New File is selected from the GnuCash menu.

• Set book option on new files to use split "action" field for "Num" field on registers/reports: If selected,
the displayed setting on the New Book Options dialog for the Use Split Action Field for Number
setting will be selected and, if saved, the book option for the new file will be set so that the "Num" field
on registers shows/updates the split-action field and the transaction-num field is shown on the second
line in double line mode (and is not visible in single line mode). Otherwise, the displayed setting on
the dialog will not be selected and, if saved, the book option for the new file will be set so that the
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"Num" field on registers shows/updates the transaction-num field. See the discussion in the section
called “Book Options” about how to set book options including the option for the section called “Use
Split Action Field for Number”. Regardless of the setting of this preference, the user can modify the
initially displayed setting for this option on the New Book Options dialog before saving the options.

Note

If the New Book Options dialog appears in situations where a new book is being set up, the
settings from this preference will determine the default setting for the corresponding check box
on the dialog. However, the OK button on the New Book Options dialog must be pressed for
the setting to be made for the new book; otherwise it will default to not selected.

• Numbers

• Display negative amounts in red: If you turn off this option, GnuCash will display negative numbers
in black.

• Automatic Decimal Point: This option will automatically insert a decimal point into numbers you
type in.

Note

When a calculation is entered in the Amount field, the decimal sign is inserted into every
operand that omits a decimal separator.

• Decimal Places: This field allows you to set the number of decimal places to be used.

• Files

Note

The following options are only relevant for files saved in XML format.

• Compress files: This option determines whether the GnuCash data file will be compressed or not.

• Show auto-save confirmation question: If this option is enabled, GnuCash will show you a
confirmation screen each time the auto-save process is started.

• Auto-save time interval: This field sets the number of minutes between each automatic saving of the
file. Set to 0 to disable the auto-save feature.

• Enable timout on "Save changes on closing" question: If enabled, the Save changes on closing
question will only wait a limited number of seconds for an answer. If the user didn’t answer within
that time, the changes will be saved automatically and the question window closed. You can set the
number of seconds in the Time to wait for answer field.

• Retain log files: In this section you can set your preferences about the log files using the provided
radio buttons.

• Never: Disable the creation of log files.

• For: Enter a specific number of days for which keep the files.

• Forever: Disable the auto deletion of log files; retains the log files forever.

• Search Dialog
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• New search limit: Defaults to "new search" if fewer than this number of items is returned.

Online Banking

Figure 10.6. The Preferences window, Online Banking tab

• QIF Import

• Show documentation: The first time you use the QIF importer you may notice that the importer has
detailed instructions on how to import a file. Once you have become familiar with using the importer,
you might want to turn off this option. Turning off the option gives you less detail in the importer
screens.

• Default transaction status (overridden by the status given by the QIF file): In this section you can set
the default status for imported transactions using the provided self-explainingradio buttons:

• Not cleared (Default)

• Cleared

• Reconciled
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• Generic Importer

• Enable skip transaction action: Enable the SKIP action in the transaction matcher. If enabled, a
transaction whose best match’s score is in the yellow zone (above the Auto-ADD threshold but below
the Auto-CLEAR threshold) will be skipped by default.

• Enable update match action: Enable the UPDATE AND RECONCILE action in the transaction
matcher. If enabled, a transaction whose best match’s score is above the Auto-CLEAR threshold
and has a different date or amount than the matching existing transaction will cause the existing
transaction to be updated and cleared by default.

• Use Bayesian matching: Use Bayesian algorithms to match new transactions with existing accounts.

• Match display threshold: The minimal score a potential match must have to be displayed in the match
list.

• Auto-add threshold: A transaction whose best match’s score is in the red zone (above display
threshold, but below or equal to Auto-add threshold) will be added by default.

• Auto-clear threshold: A transaction whose best match’s score is in the green zone (above or equal to
Auto-clear threshold) will be cleared by default.

• Commercial ATM fees threshold: In some places commercial ATMs (not belonging to a financial
institution) are installed in places like convenience stores. These ATMs add their fee directly to the
amount instead of showing up as a separate transaction or in your monthly banking fees. For example,
you withdraw $100, and you are charged $101.50 plus Interac fees. If you manually entered that $100,
the amounts won’t match. You should set this to whatever is the maximum such fee in your area (in
units of your local currency), so the transaction will be recognized as a match by GnuCash.

• Automatically create new commodities: Enables the automatic creation of new commodities if any
unknown commodity is encountered during import. If not enabled, the user will be asked what to do
with each unknown commodity.

• Online Banking

Note

This section is shown only if GnuCash is compiled with Aqbanking and HBCI support.

• Close log window when finished: Close the log window when the operation is completed.

• Remember PIN: Enable this option if you want GnuCash to remember the PIN you enter for online
banking authentication.

• Verbose debug messages: Enable this option if you want GnuCash to show more information about
the online banking operations.
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Online Quotes

Figure 10.7. The Preferences window, Online Quotes tab

The Online Quotes tab allows you to set options that affect the fetching of online quotes with the perl
module Finance::Quote.

• Alpha Vantage API key: To retrieve online quotes from Alphavantage, this key needs to be set. A key
can be retrieved from the Alpha Vantage website [https://www.alphavantage.co/].

See also:

• the section called “Finance::Quote Sources”,

• “Automatic Updating Exchange Rates” in the guide.
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Printing

Figure 10.8. The Preferences window, Printing tab

The Printing tab allows you to set some options that affect the printing of checks on paper.

• Print date format: Enable this option if you want to print on the check, below the actual date, its format
in 8 point type.

• Print blocking chars: Enable this option to print a series of three asterisks before and after each text
field in the check.

• Default font: Click the button on the left to open a Pick a Font screen in which you can customize the
font that will be used to print checks.
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Register

Figure 10.9. The Preferences window, Register tab

• Actions

• 'Enter' moves to blank transaction: If selected, move the cursor to the blank transaction at the end of
the register after the user presses the Enter key. Otherwise the cursor will be moved down one row.

• Auto-raise lists: If selected, all lists will automatically be expanded when input focus is in the list field.

• Tab order includes Transfer on Memorized Transaction: If selected, when the transaction is auto
filled, pressing the Tab key in the register the cursor’s jump will include the Transfer field.

• Reconciling

• Check cleared transactions: If selected, automatically check off cleared transactions when reconciling.

• Automatic interest transfer: If selected, prior to reconciling an account which charges or pays interest,
prompt the user to enter a transaction for the interest charge or payment. Currently only enabled for
Bank, Credit, Mutual, Asset, Receivable, Payable, and Liability accounts.

• Automatic credit card payment: If selected, after reconciling a credit card statement, prompt the user
to enter a credit card payment.

• Always reconcile to today: If selected, always open the reconcile screen with today’s date for
statement date, regardless of previous reconciliation.
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• Graphics

• Use GnuCash built-in color theme: If selected, the original GnuCash register color theme will be
used. Otherwise the system color theme will be applied to register windows.

• Double mode colors alternate with transactions: If selected, configures the register window to
alternate between the primary and secondary colors with each transaction, instead of each row.

• Draw horizontal lines between rows: If selected, GnuCash will draw a horizontal line between each
row.

• Draw vertical lines between columns: If selected, GnuCash will draw a vertical line between the cells
in each row.

Register Defaults

Figure 10.10. The Preferences window, Register Defaults tab

The Register Defaults tab preferences affect the behavior of the transaction register windows.

• Default Style

Here you can choose from 3 different styles for register windows:

• Basic ledger: Show all transactions on one line. (Two in double line mode.)
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• Auto-split ledger: Automatically expand the current transaction to show all splits. All other
transactions are shown on one line. (Two in double line mode.)

• Transaction journal: All transactions are expanded to show all splits.

• Other Defaults

• Register opens in a new window: If selected, register will be in a separate window instead of in a tab.

• Double line mode: If selected, show two lines of information for each transaction instead of one.

• Only display leaf account names: If selected, only the name of the leaf accounts will be displayed
in the Account selection popup. The default behavior is to display the full account name including
the path in the account tree.

Warning

Enabling this option implies that you use unique leaf account names.

• Number of transactions: How many transactions to show in a register. Set to 0 to show all transactions.

Reports

Figure 10.11. The Preferences window, Reports tab

The Reports tab preferences affect the behavior of GnuCash reports.
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• Default Report Currency: This item determines which currency will be used by default when creating
reports. You can choose:

• Locale: Use the system locale currency for all newly created reports.

• Choose: Use the specified currency for all newly created reports.

• Location

• Report opens in a new window: if you select this option, the reports will open up in a new window,
instead of in a tab.

Scheduled Transactions

Figure 10.12. The Preferences window, Scheduled Transactions tab

The Scheduled Transactions tab preferences affect the behavior of GnuCash for scheduling transactions.
More information about scheduled transactions can be found in the section called “Scheduling
Transactions”.

• Since Last Run Dialog

• Run when data file opened: If selected, the Since Last Run screen will appear when GnuCash opens
the file.

• Show notification window: If selected, a list of scheduled and created transactions will appear when
GnuCash opens the file.
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• Transaction Editor Defaults

• Auto-Create new transactions: If selected, new scheduled transactions will automatically be entered
into the register. If the auto-create option is enabled, you can also check Notify before transactions
are created so that you will be able to confirm creating the transactions.

• Create in advance: The default number of days in advance to create the registered scheduled
transactions.

• Remind in advance: The default number of days in advance to remind about new scheduled
transactions.

Windows

Figure 10.13. The Preferences window, Windows tab

• Window Geometry

• Save window size and position: If selected, next time GnuCash starts it will re-use the window size
and position configured in the last run.

• Tabs

• Show close button on notebook tabs: Adds a small close icon on each tab, to make it easier to close
the various tabs.
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• Bring the most recent tab to the front: If selected, the newly created tab will be shown over the other
tabs.

• Width: The width of tab label expressed in characters.

Note

If the text in the tab is longer than this value (the test is approximate) then the tab label will
have the middle cut and replaced with an ellipsis.

• Tab Position

Position the tabs at the Top (default), Bottom, Left or Right.

• Summary Bar Position

Position the Summary Bar at the Top or at the Bottom (default) of the GnuCash main window.

Book Options
The File → Properties menu item is used to set or modify choices that affect how a specific GnuCash file
(also referred to as a Book) operates. Selecting this menu item brings up the Book Options dialog. This
dialog also appears in situations where you are importing transactions into a new book, with the title New
Book Options. It is automatically raised in these 'new book' situations because these settings can affect
how imported data are converted to GnuCash transactions and so should be considered and set before your
first import (specifically, the the section called “Use Split Action Field for Number” setting).

The settings in this dialog are kept with, and are part of, the file (or Book). This is in contrast to the settings
described in the section called “Setting Preferences”, which are set per user and not stored with the file.
So Book Options settings are shared by all users who use a given file and any changes made by one user
will affect all users of that file.

Tip

Pausing the cursor for a couple of seconds over options in these tabs will display a tooltip with
a more detailed description of the choice.

The Book Options dialog has five buttons that are common to all tabs. The Reset defaults button takes all
items on the visible tab and sets their value to the default setting; it only affects the visible tab. The Help
button opens up a help window to this section. The Cancel button closes the dialog, making no changes to
the saved settings for Book Options. The Apply button is initially insensitive but becomes sensitive when
any setting is set or changed. Selecting it saves the setting(s) for the book but keeps the Book Options dialog
open. Typically, the changes are reflected in the affected areas of GnuCash as soon as the button is pressed,
so it can be used to 'see' the effect of a given option without having to re-open the dialog. The Apply button
is not sensitive on the dialog if it appears during transaction import (that is, 'new book') situations. The
OK button behaves like the Apply button except that it immediately closes the dialog, as well.
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Accounts Book Options Tab
Figure 10.14. The Book Options window, Accounts tab

The Accounts tab of this dialog allows the selection of options that affect how accounting registers
function.

Use Trading Accounts
Check the Use Trading Accounts checkbox to have trading accounts used for transactions involving more
than one currency or commodity.

Day Threshold for Read-Only Transactions
Use the Day Threshold for Read-Only Transactions spin-box to choose the number of days before today,
prior to which, transactions will be read-only and cannot be edited anymore in the registers. This threshold
is marked by a red line in the account register windows. If zero, all transactions can be edited and none
are read-only. This feature is intended to be used to guard against accidental changes to non-current
transactions.

Use Split Action Field for Number

Note

This option is only available in GnuCash version 2.6 or later.

Check the Use Split Action Field for Number checkbox to have the split action field of the anchor split
used for the 'Num' column in registers, reports and import/export functions, where applicable, in place of
the transaction number; the transaction number is then shown as 'T-Num' on reports and on the second line
of registers. This choice has a corresponding effect on business features.

The difference between the two is that with the checkbox not selected, the same 'Num' is displayed for
a given transaction regardless of what register it is viewed in and with the checkbox selected, a different
'Num' can be entered/displayed for a given transaction in each register it is viewed in. In both cases, the
'next number logic' of the 'Num' cell is based on the account of the register the transaction is entered to or
viewed from but in one case it fills the transaction number, in the other, it fills the split action field of the
anchor split. In both cases, both fields are visible and can be viewed and used as free-form text in double-
line mode for any value the user wants.

Warning

Initial setup of GnuCash: It is expected that, after careful consideration of the consequences,
this option will be set when a new GnuCash file is created and not changed thereafter (see next
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warning). For this reason, a preference is provided (see Setting Preferences - General ) that can
establish an initial default setting for new files, so that if you will have more than one file, it is
easier to set them all up consistently. You may wish to set up a test file and experiment with the
two settings to understand the differences before establishing your first real GnuCash file.

Tip

Moving from Quicken: For users that are switching from other personal accounting applications,
such as Quicken, selecting this option may be more consistent with the numbering approach used
there and can preserve the numbering of historical data brought over; this option should be set
before performing the initial import.

Warning

Changing this option for an existing GnuCash file: If you change this option for an existing file,
historical data will not be changed. This means that if you set the option one way, enter (or import)
transactions, then change the option and enter (or import) additional transactions and switch back-
and-forth, you will end up with a file that will appear to have inconsistent treatment of numbers
in registers, reports and exports. This is because the setting of this option at the time of data entry/
import determines where the number data is stored and the setting at the time of data display/
reporting/exporting determines which field is displayed as number.

There is no reason to avoid changing this option for an existing GnuCash file if you understand
the implications. If you elect to make this change, it should probably be done between accounting
periods with the understanding that number data prior to the date the option is changed will be
displayed/reported/exported differently from that after the date.

Warning

If you change this option, and press Apply or OK, open registers and labels on query and sorting
dialogs will be refreshed to reflect the new option immediately. But open reports need to be
individually reloaded by the user to have the change reflected on the report.

Warning

This option is only available in GnuCash version 2.6 or later. If a GnuCash file from an earlier
version is opened in version 2.6 or later, and this feature is not used, this feature will not prevent
the file from being opened in the earlier version of GnuCash. However, if the option is set, the
file will not be able to be opened by the earlier version, even if the option is set back to its original
setting. A warning dialog will be displayed from the earlier version. Do not set this option if you
want to open the file with an earlier version.
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Budgeting Book Options Tab

Figure 10.15. The Book Options window, Budgeting tab

The Budgeting tab allows you to specify the budget to be used for reports when none has otherwise been
specified.

Business Book Options Tab

Figure 10.16. The Book Options window, Business tab
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The Business tab allows you to enter values that are in turn used by the business features of GnuCash:

Company Name The name of the company is used in many
reports.

Company Contact Person The name of the contact person to print on
invoices.

Company Phone, Fax, Email Address The references of your business.

Company Website URL The internet address of the company’s
website.

Company ID The tax ID of your company.

Default Customer TaxTable The default taxtable applicable to your most
common customers.

Default Vendor TaxTable The default taxtable applicable to your most
common vendors.

Fancy Date Format The default date format used for fancy printed
dates (e.g. on invoices).

Reset Defaults Press the button to reset all values to their
defaults.

Note

None of the above values is required to use GnuCash but, if given, will be used throughout the
program. (f.e. in reports, invoices etc...)
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Counters Book Options Tab

Figure 10.17. The Book Options window, Counters tab

The Counters tab allows you to set the 'previous' value for each number indicated: Bill, Customer,
Employee, etc. These counters are used by the Chapter 7, Business Features of GnuCash.

The number entered here will be incremented when the various business features calculate a value for
a corresponding field on a dialog. For example, if you leave the Customer Number field blank on the
New Customer dialog, the customer will be assigned the number in the counter field plus 1. The numbers
displayed in the tab are incremented as these business features are used. (But note that if you have the
Book Options dialog open, you need to close it and re-open it to see the changes; the displayed field values
are not automatically refreshed.)

The corresponding format fields are used to specify printf-style format strings that are used to format the
printing of the number. For example, to put the literal "C - " in front of the customer number, you would
put "C - %li" (without the quotes) in the customer format string field. If the value in the customer number
field was 5, the next customer added would be assigned the number "C - 6". As another example, if you
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wanted the number to be printed with leading zeros and 5 characters wide, you would enter "C - %05li"
and the next customer number would be assigned the number "C - 00006".

Note

For historical reasons GnuCash accepts multiple format specifiers although they all yield the same
end result. You can choose "li", "lli" or I64i".

Changing Style Sheets
GnuCash has four default style sheets for web-page reports. These style sheets can be altered by using the
HTML Style Sheets editor. To access the editor go to Edit → Style Sheets...

Using the Style Sheet Editor you may display/modify the setting of a Style Sheet.

Note

Changing the Style Sheet will change the appearance of all reports that have selected that Style
Sheet. A Reload is required to view the changes, if the report(s) are currently displayed.

To add a new Style Sheet click the New... button in the Style Sheet pane. The New Style Sheet dialog will
appear. Fill in the name field with the name of the new Style Sheet and choose a template. To remove a
Style Sheet select the Style Sheet from the list and click Delete.

Default Style Sheet
The Default Style Sheet has four tabs to alter the appearance of reports utilizing it, Colors, Fonts, General
and Tables.

Colors Tab

• Alternate Table Cell Color: Opens the color picker to choose a color that will be applied to alternate
table rows.

Fonts Tab

• Title: Select the font and size for Titles.

• Account Link: Select the font and size for Account Links.

• Number Cell: Select the font and size for Number Cells.

• Negative Values in Red: Select to have negative values displayed in red.

• Text Cell: Select the font and size for Text Cells.

• Total Number Cell: Select the font and size for Total Number Cells.

• Total Label Cell: Select the font and size for Total Label Cells.

• Centered Label Cell: Select the font and size for Centered Label Cells.

General Tab

• Background Color: Opens the color picker to choose a new background color.

• Background Pixmap: Use the Browse button to select a picture to use as the background in reports.
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• Enable Links: Select this to enable blue hyperlinks in reports.

Tables Tab

• Table cell spacing: Sets the space between table cells

• Table cell padding: Sets the space between table cell edges and contents

• Table border width: Sets the width of the borders on tables.

Easy Style Sheet
The Easy Style Sheet has five tabs to alter the appearance of reports: Colors, Fonts, General, Images and
Tables.

Colors

• Background Color: Opens the color picker to choose a new background color.

• Text Color: Opens the color picker to choose a new text color.

• Text Cell Color: Opens the color picker to choose a new text cell color.

• Link Color: Opens the color picker to choose a new link color.

• Alternate Table Cell Color: Opens the color picker to choose a new color for alternate table rows.

• Subheading/Subtotal Cell Color: Opens the color picker to choose a new color for subheading/subtotal
table rows.

• Sub-subheading/total Cell Color: Opens the color picker to choose a new color for sub-subheading/total
table rows.

• Grand Total Cell Color: Opens the color picker to choose a new color for grand total rows.

Fonts

• Title: Select the font and size for Titles.

• Account Link: Select the font and size for Account Links.

• Number Cell: Select the font and size for Number Cells.

• Negative Values in Red: Select to have negative values displayed in red.

• Number Header: Select the font and size for Number Header table rows.

• Text Cell: Select the font and size for Text Cells.

• Total Number Cell: Select the font and size for Total Number Cells.

• Total Label Cell: Select the font and size for Total Label Cells.

• Centered Label Cell: Select the font and size for Centered Label Cells.

General

• Preparer: Name of the person preparing the report.

• Prepared for: Name of Organization or Company the report is prepared for.
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• Show preparer info: Show the Preparer information in the report.

• Enable Links: Select this to enable blue hyperlinks in reports.

Images

• Background Tile: Use the Browse button to select a picture to use as the background in reports. The
Clear button will clear the selection.

• Heading Banner: Use the Browse button to select a picture to use as the heading in reports. The Clear
button will clear the selection.

• Heading Alignment: Select from pull-down list; Left, Right, Center, to specify the alignment of the
banner at the top of report(s).

• Logo: Use the Browse button to select a picture to use as the logo in reports. The Clear button will
clear the selection.

Tables

• Table cell spacing: Sets the space between table cells

• Table cell padding: Sets the space between table cell edges and contents

• Table border width: Sets the width of the borders on tables.

Footer Style Sheet
The Footer Style Sheet has the same five tabs to alter the appearance of reports as the Easy Style Sheets:
Colors, Fonts, General, Images and Tables.

Colors

• Background Color: Opens the color picker to choose a new background color.

• Text Color: Opens the color picker to choose a new text color.

• Text Cell Color: Opens the color picker to choose a new text cell color.

• Link Color: Opens the color picker to choose a new link color.

• Alternate Table Cell Color: Opens the color picker to choose a new color for alternate table rows.

• Subheading/Subtotal Cell Color: Opens the color picker to choose a new color for subheading/subtotal
table rows.

• Sub-subheading/total Cell Color: Opens the color picker to choose a new color for sub-subheading/total
table rows.

• Grand Total Cell Color: Opens the color picker to choose a new color for grand total rows.

Fonts

• Title: Select the font and size for Titles.

• Account Link: Select the font and size for Account Links.

• Number Cell: Select the font and size for Number Cells.
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• Negative Values in Red: Select to have negative values displayed in red.

• Number Header: Select the font and size for Number Header table rows.

• Text Cell: Select the font and size for Text Cells.

• Total Number Cell: Select the font and size for Total Number Cells.

• Total Label Cell: Select the font and size for Total Label Cells.

• Centered Label Cell: Select the font and size for Centered Label Cells.

General

• Preparer: Name of the person preparing the report.

• Prepared for: Name of Organization or Company the report is prepared for.

• Show preparer info: Show the Preparer information in the report.

• Enable Links: Select this to enable blue hyperlinks in reports.

• Footer: Text to be included in report footer.

Images

• Background Tile: Use the Browse button to select a picture to use as the background in reports. The
Clear button will clear the selection.

• Heading Banner: Use the Browse button to select a picture to use as the heading in reports. The Clear
button will clear the selection.

• Heading Alignment: Select from pull-down list; Left, Right, Center, to specify the alignment of the
banner at the top of report(s).

• Logo: Use the Browse button to select a picture to use as the logo in reports. The Clear button will
clear the selection.

Tables

• Table cell spacing: Sets the space between table cells

• Table cell padding: Sets the space between table cell edges and contents

• Table border width: Sets the width of the borders on tables.

Technicolor Style Sheet
The Technicolor Style Sheet has has five tabs to alter the appearance of reports: Colors, Fonts, General,
Images and Tables.

Colors

• Background Color: Opens the color picker to choose a new background color.

• Text Color: Opens the color picker to choose a new text color.

• Text Cell Color: Opens the color picker to choose a new text cell color.
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• Link Color: Opens the color picker to choose a new link color.

• Alternate Table Cell Color: Opens the color picker to choose a new color for alternate table rows.

• Subheading/Subtotal Cell Color: Opens the color picker to choose a new color for subheading/subtotal
table rows.

• Sub-subheading/total Cell Color: Opens the color picker to choose a new color for sub-subheading/total
table rows.

• Grand Total Cell Color: Opens the color picker to choose a new color for grand total rows.

Fonts

• Title: Select the font and size for Titles.

• Account Link: Select the font and size for Account Links.

• Number Cell: Select the font and size for Number Cells.

• Negative Values in Red: Select to have negative values displayed in red.

• Number Header: Select the font and size for Number Header table rows.

• Text Cell: Select the font and size for Text Cells.

• Total Number Cell: Select the font and size for Total Number Cells.

• Total Label Cell: Select the font and size for Total Label Cells.

• Centered Label Cell: Select the font and size for Centered Label Cells.

General

• Preparer: Name of the person preparing the report.

• Prepared for: Name of Organization or Company the report is prepared for.

• Show preparer info: Show the Preparer information in the report.

• Enable Links: Select this to enable blue hyperlinks in reports.

Images

• Background Tile: Use the Browse button to select a picture to use as the background in reports. The
Clear button will clear the selection.

• Heading Banner: Use the Browse button to select a picture to use as the heading in reports. The Clear
button will clear the selection.

• Heading Alignment: Select from pull-down list; Left, Right, Center, to specify the alignment of the
banner at the top of report(s).

• Logo: Use the Browse button to select a picture to use as the logo in reports. The Clear button will
clear the selection.

Tables

• Table cell spacing: Sets the space between table cells
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• Table cell padding: Sets the space between table cell edges and cell contents

• Table border width: Sets the width of the borders on tables.

Setting Tax Report Options
The tax report can be used to prepare online tax reports in the USA.

Localization

Before it can be used in other regions, one needs to provide a
localized taxtable. See the instructions in the wiki [https://wiki.gnucash.org/wiki/
Translation#How_to_create_localized_Income_Tax_Tables].

The Income Tax Information dialog is used to set Tax Report Options. The settings on accounts in this
dialog are used by the TXF Export function in reports to select the accounts for export. To access this
dialog go to Edit → Tax Report Options.

If the Income Tax features are used, it is strongly recommended that the Tax Info column be made visible
on the accounts tab (click large downward-pointing arrow and select Tax Info check box). The Tax Info
column will display the Form/Schedule and tax category (e.g., Schedule D Dividend, cap gain distrib.)
assigned to an account, if any. Alternatively, it will display the following error messages which can be
corrected through Edit → Tax Report Options

• Tax-related but has no tax code

• Tax entity type not specified

• Tax type "tax_type": invalid code "code" for account type"

• Not tax-related; tax type "tax_type": invalid code "code" for account type

• Invalid code "code" for tax type "tax_type"

• Not tax-related; invalid code "code" for tax type "tax_type"

• No form: code "code", tax type "tax_type"

• Not tax-related; no form: code "code", tax type "tax_type"

• No description: form "form", code "code", tax type "tax_type"

• Not tax-related; no description: form "form", code "code", tax type "tax_type"

• Not tax-related; "form"("copy") "desc" (code "code", tax type "tax_type")

The Income Tax Identity must be set in order to assign codes to individual accounts. Click Edit to set the
identity. The Tax Name is optional. If entered, it will be printed at the top of the report. A Type must be
selected in order to activate the tax category selections. The choices are:

• Individual, Joint, etc. - Files US Form 1040 Tax Return

• Partnership - Files US Form 1065 Tax Return

• Corporation - Files US Form 1120 Tax Return

• S Corporation - Files US Form 1120S Tax Return

• None - No Income Tax Options Provided
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While the Income Tax Entity Type can be changed after tax categories have been assigned to accounts,
you should be cautioned that you will need to manually change each one if you do so, which could be quite
tedious. The tax categories are unique for each Income Tax Entity Type, so changing the type will make
all previously assigned categories invalid. It is assumed (and highly recommended) that each GnuCash
file is for only one tax entity and this is where you specify its type of tax entity. You should not keep,
for example, personal and partnership accounts mixed in one GnuCash file if you plan to use the Income
Tax Reporting features.

A given TXF code can be assigned to multiple accounts. The Tax Schedule Report will combine accounts
by code and generate a detailed TXF record for each account and a summary TXF record for the total as
calculated by the report.

For codes for which the "Payer Name Source" is not grayed, the payer on the TXF record will be based on
what is specified here, either the account name of the account or the account name of the account’s parent
account. This feature is typically used for interest accounts or stocks or mutual funds that pay dividends
where the individual payees are shown on the tax schedule. For example, if the parent account’s name is
the name of your broker and the sub-account’s names are the names of individual stocks that pay dividends
and the name on the 1099-DIV received is that of the broker, in order to match that name, you would
select ’Parent Account’; the total dividends from the broker would be exported and, if you had several
brokers, there would be an amount exported and a subtotal for each broker, along with each brokers name.
Alternatively, if you had a parent account named Directly Held, for example, and below it sub-accounts
for one or more stocks, you would receive a 1099-DIV from the issuer of each stock separately and, in
order to match that name, you would select Current Account; the total dividends from each stock would
be exported and, if you had several stocks, there would be an amount exported and a subtotal for each
stock, along with each stock’s name as the payer.

Some tax Forms/Schedules need to have multiple copies filed under some circumstances (for example,
Schedule C if a taxpayer and spouse have separate businesses). For tax categories on these Forms/
Schedules, the Copy Number is not grayed out and can be used to segregate accounts by copy number.

• Accounts: This pane contains the list of accounts. Select an account to set a TXF category. If no account
is selected nothing is changed. If multiple accounts are selected, all of the accounts will be set to the
selected item.

• Tax Related: Select this check-box to add tax information to an account then select the TXF Category
below. This setting is displayed on the account edit dialogue but cannot be changed from there.

• TXF Categories: Select the desired one. A detailed description appears just below (if available, otherwise
it says No help available), along with the TXF code for the category and information about what line
number on the form or schedule the amounts are included in by tax year (used for detailed sort on report).

• Payer Name Source: Select an option to determine where the text description that is exported along with
the value of the account is derived from, as described above. This is usually the name of a bank, stock,
or mutual fund that pays dividends or interest. Occasionally, it is a description of a deduction.

• Copy Number: A copy number that is exported along with the value of the account. This is used to
segregate amounts between different copies of the same Form/Schedule that may need to be filed (e.g.,
Schedule C(1), Schedule C(2), etc.). This is also used to sort the report.

TXF Export - Known Anomalies and Limitations
TaxCut 1999

• Code: N488 "^ Sched B \ Div. income, cap gain distrib."

• Code: N286 "^ Sched B \ Dividend income"
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These two codes, from the same payer, are not correlated. The user will have to adjust for this after import.

TaxCut 1999, 2000

• Code: N521 " F1040 \ Federal estimated tax, quarterly"

Does not accept the date field and does not import the individual payment amounts, only the total. The
date and individual payment amounts, only matter if you have to compute the penalty. (this may be a
TurboTax enhancement)

• Code: N460 " W-2 \ Salary or wages, self"

• Code: N506 " W-2 \ Salary or wages, spouse"

• and other related codes.

Use Copy Number to separate information from more than one job.

TurboTax 1999, 2000

• Code: N521 " F1040 \ Federal estimated tax, quarterly"

Does not accept the dates outside of the tax year. This is a problem for the last payment that is due Jan 15.
GnuCash changes the the date of the last payment to Dec 31 for the export unless the "Do not use special
date processing" option is selected in the report options display tab. The user will have to adjust for this
after import. The date only matters if you have to compute the penalty.

TXF Tax eXport Format

• Duplicate Codes

Codes can be assigned to multiple accounts and the amounts will be summed for all the accounts generating
one detail TXF record per account and one summary TXF record for the sum. Codes that let you select
"Payer Name Source" will generate a separate summary TXF account with each change in payer. Selecting
the "Print TXF export parameters" option will cause the report to show to which codes this applies (Payer
Name Source option Y) and, for the accounts assigned to those codes, the Name Source each account is set
to and the TXF item number that will be assigned to each. A summary TXF record will be generated for
each change in assigned item line number. These may not be handled the same by TaxCut and TurboTax.

• Code: N673 "Short/Long gain or loss"

Short term or long term gain or loss from the sale of a security; generates TXF output for only the date
sold and sales amount, with the date acquired and cost basis information left blank (to be separately added
in the tax software). The code can be assigned to either a short-, long-, or mixed-term gain/loss income
account and the security sales transaction should be entered as illustrated in Section 8.7, Selling Shares, of
the GnuCash Tutorial and Concepts Guide. The report uses the transaction split of the gain/loss account to
find one or more other splits in the same transaction with negative share quantities. For each of these found,
it generates a detailed TXF output record with the quantity sold, the name of the security, the date sold,
and the sales amount. Note that if, for a given transaction, more than one transaction split is to a gain/loss
income account assigned to code 673, TXF output data will be erroneously repeated. That is because the
report will fetch the same data, and re-output it, for each transaction split set to a gain/loss income account
within the same transaction. For this reason, there should be no more than one gain/loss account entered
per transaction to use this tax reporting code properly. (Note that no amounts are used from GnuCash’s
lot-tracking; a future enhancement is expected to use this data to provide capital gain reporting).

Detailed TXF Category Descriptions
Table 32. Detailed TXF Category Descriptions
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Table 10.1. Detailed TXF Category Descriptions

Tax Form \ TXF Code

Description

Extended TXF Help messages

< help \ H001

Name of Current account is exported.

Categories marked with a “<” or a “^”, require a
Payer identification to be exported. “<” indicates
that the name of this account is exported as this
Payer ID. Typically, this is a bank, stock, or mutual
fund name.

^ help \ H002

Name of Parent account is exported.

Categories marked with a “<” or a “^”, require a
Payer identification to be exported. “^” indicates
that the name of the PARENT of this account is
exported as this Payer ID. Typically, this is a bank,
stock, or mutual fund name.

# help \ H003

Not implemented yet, Do NOT Use!

Categories marked with a “#” not fully implemented
yet! Do not use these codes!

none \ N000

Tax Report Only - No TXF Export

This is a dummy category and only shows up on the
tax report, but is not exported.

Help F1040 \ H256

Form 1040 - the main tax form

Form 1040 is the main form of your tax return.

F1040 \ N261

Alimony received

Amounts received as alimony or separate
maintenance. Note: child support is not considered
alimony.

F1040 \ N257

Other income, misc.

Miscellaneous income such as: a hobby or a farm
you operate mostly for recreation and pleasure,
jury duty pay. Exclude self employment income,
gambling winnings, prizes and awards.

F1040 \ N258

Sick pay or disability pay

Amounts you receive from your employer while you
are sick or injured are part of your salary or wages.
Exclude workers’ compensation, accident or health
insurance policy benefits, if you paid the premiums.

F1040 \ N260

State and local tax refunds

Refund of state or local income tax refund (or credit
or offset) which you deducted or took a credit for
in an earlier year. You should receive a statement,
Form 1099-G. Not reportable if you didn’t itemize
last year.

F1040 \ N262

IRA contribution, self

Contribution to a qualified IRA. If you or your
spouse are covered by a company retirement plan,
this amount could be limited or eliminated.

F1040 \ N263

Keogh deduction, self

Contributions to a Keogh or HR 10 plan of a sole
proprietor or a partnership.

F1040 \ N264

Alimony paid

Amounts payed as alimony or separate
maintenance. Note: child support is not considered
alimony.
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Tax Form \ TXF Code

Description

Extended TXF Help messages

< F1040 \ N265

Early withdrawal penalty

Penalty on Early Withdrawal of Savings from CD’s
or similar instruments. This is reported on Form
1099-INT or Form 1099-OID.

F1040 \ N266

Social Security income, self

The part of any monthly benefit under title II of the
Social Security Act. These will be reported on Form
SSA-1099.

F1040 \ N269

Taxable fringe benefits

Fringe benefits you receive in connection with the
performance of your services are included in your
gross income as compensation. Examples: Accident
or Health Plan, Educational Assistance, Group-
Term Life Insurance, Transportation (company car).

F1040 \ N481

IRA contribution, spouse

Contribution of a working spouse to a qualified IRA.
If you or your spouse are covered by a company
retirement plan, the deductible contribution could be
limited or eliminated.

F1040 \ N482

IRA contrib., non-work spouse

IRA contribution for a non-working spouse.

F1040 \ N483

Social Security inc., spouse

Spouse’s part of any monthly benefit under title II
of the Social Security Act. These will be reported on
Form SSA-1099.

F1040 \ N516

Keogh deduction, spouse

Spouse Contributions to a Keogh or HR 10 plan of
a sole proprietor or a partnership.

F1040 \ N517

SEP-IRA deduction, self

Contributions made to a simplified employee
pension plan (SEP-IRA).

F1040 \ N518

SEP-IRA deduction, spouse

Spouse contributions made to a simplified employee
pension plan (SEP-IRA).

F1040 \ N519

RR retirement income, self

The part of tier I railroad retirement benefits, which
are treated as a social security benefits. These will
be reported on Form RRB-1099.

F1040 \ N520

RR retirement inc., spouse

Spouse’s part of tier I railroad retirement benefits,
which are treated as a social security benefits. These
will be reported on Form RRB-1099.

F1040 \ N521

Federal estimated tax, quarterly

The quarterly payments you made on your estimated
Federal income tax (Form 1040-ES). Include any
overpay from your previous year return that you
applied to your estimated tax. NOTE: If a full year
(Jan 1, YEAR to Dec 31, YEAR) is specified,
GnuCash adjusts the date to Mar 1, YEAR to Feb 28,
YEAR+1. Thus, the payment due Jan 15 is exported
for the correct year.

F1040 \ N607 Contributions made to your medical savings
account that were not reported on your Form W-2.
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Tax Form \ TXF Code

Description

Extended TXF Help messages

Medical savings contribution, self

F1040 \ N608

Medical savings contribution, spouse

Contributions made to your spouse’s medical
savings account that were not reported on their Form
W-2.

F1040 \ N609

SIMPLE contribution, self

Contributions made to your SIMPLE retirement
plan that were not reported on your Form W-2.

F1040 \ N610

SIMPLE contribution, spouse

Contributions made to your spouse’s SIMPLE
retirement plan that were not reported on your
spouse’s Form W-2.

F1040 \ N611

Fed tax withheld, Social Security, self

The amount of federal income taxes withheld from
your part of any monthly benefit under title II of the
Social Security Act.

F1040 \ N612

Fed tax withheld, Social Security, spouse

The amount of federal income taxes withheld from
your spouse’s part of any monthly benefit under title
II of the Social Security Act.

F1040 \ N613

Fed tax withheld, RR retire, self

The amount of federal income taxes withheld from
your part of tier I railroad retirement benefits, which
are treated as a social security benefits.

F1040 \ N614

Fed tax withheld, RR retire, spouse

The amount of federal income taxes withheld from
your spouse’s part of tier I railroad retirement
benefits, which are treated as a social security
benefits.

F1040 \ N636

Student loan interest

The amount of interest you paid this year on
qualified student loans.

Help F1099-G \ H634

Form 1099-G - certain Government payments

Form 1099-G is used to report certain government
payments from federal, state, or local governments.

F1099-G \ N260

State and local tax refunds

Refund of state or local income tax refund (or credit
or offset) which you deducted or took a credit for
in an earlier year. You should receive a statement,
Form 1099-G. Not reportable if you didn’t itemize
last year.

F1099-G \ N479

Unemployment compensation

Total unemployment compensation paid to you this
year. Reported on Form 1099-G.

F1099-G \ N605

Unemployment comp repaid

If you received an overpayment of unemployment
compensation this year or last and you repaid any of
it this year, subtract the amount you repaid from the
total amount you received.

F1099-G \ N606

Fed tax withheld, unemployment comp

The amount of federal income taxes withheld from
your unemployment compensation.

F1099-G \ N672 Qualified state tuition program earnings you
received this year.
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Tax Form \ TXF Code

Description

Extended TXF Help messages

Qualified state tuition earnings

Help F1099-MISC \ H553

Form 1099-MISC - MISCellaneous income

Form 1099-MISC is used to report miscellaneous
income received and direct sales of consumer goods
for resale.

^ F1099-MISC \ N259

Prizes and awards

The amount of prizes and awards that are not for
services performed. Included is the fair market value
of merchandise won on game shows.

^ F1099-MISC \ N557

Other income

The amount of prizes and awards that are not for
services performed. Included is the fair market value
of merchandise won on game shows. Included is
all punitive damages, any damages for nonphysical
injuries or sickness, and any other taxable damages,
Deceased employee’s wages paid to estate or
beneficiary.

^ F1099-MISC \ N555

Rents

Amounts received for all types of rents, such as real
estate rentals for office space, machine rentals, and
pasture rentals.

^ F1099-MISC \ N556

Royalties

The gross royalty payments received from a
publisher or literary agent.

^ F1099-MISC \ N558

Federal tax withheld

The amount of federal income tax withheld (backup
withholding) from 1099-MISC income.

^ F1099-MISC \ N559

Fishing boat proceeds

Your share of all proceeds from the sale of a catch
or the fair market value of a distribution in kind that
you received as a crew member of a fishing boat.

^ F1099-MISC \ N560

Medical/health payments

The amount of payments received as a physician or
other supplier or provider of medical or health care
services. This includes payments made by medical
and health care insurers under health, accident, and
sickness insurance programs.

^ F1099-MISC \ N561

Non employee compensation

The amount of non-employee compensation
received. This includes fees, commissions, prizes
and awards for services performed, other forms of
compensation for services you performed for a trade
or business by which you are not employed. Also
include oil and gas payments for a working interest.

^ F1099-MISC \ N562

Crop insurance proceeds

The amount of crop insurance proceeds as the result
of crop damage.

^ F1099-MISC \ N563

State tax withheld

The amount of state income tax withheld (state
backup withholding) from 1099-MISC income.

Help F1099=MSA \ H629

Form 1099-MSA Medical Savings Account

Form 1099-MSA is used to report medical savings
account distributions.
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Tax Form \ TXF Code

Description

Extended TXF Help messages

F1099-MSA \ N631

MSA gross distribution

The amount you received this year from a Medical
Savings Account. The amount may have been a
direct payment to the medical service provider or
distributed to you.

F1099-MSA \ N632

MSA earnings on excess contrib

The earnings on any excess contributions you
withdrew from an MSA by the due date of your
income tax return. If you withdrew the excess, plus
any earnings, by the due date of your income tax
return, you must include the earnings in your income
in the year you received the distribution even if you
used it to pay qualified medical expenses.

Help F1099-R \ H473

Form 1099-R - Retirement distributions

Form 1099-R is used to report taxable and non-
taxable retirement distributions from retirement,
pension, profit-sharing, or annuity plans. Use a
separate Form 1099-R for each payer.

^ F1099-R \ N475

Total pension gross distribution

The gross amount of a distribution from a qualified
pension or annuity plan. Note: IRA distributions are
not included here.

^ F1099-R \ N476

Total pension taxable distribution

The taxable amount of a distribution from a
qualified pension or annuity plan. Note: IRA
distributions are not included here.

^ F1099-R \ N477

Total IRA gross distribution

The gross amount of a distribution from a qualified
Individual Retirement Arrangement (IRA) plan.

^ F1099-R \ N478

Total IRA taxable distribution

The taxable amount of a distribution from a
qualified Individual Retirement Arrangement (IRA)
plan.

^ F1099-R \ N529

Pension federal tax withheld

The amount of federal income taxes withheld from
your pension distribution.

^ F1099-R \ N530

Pension state tax withheld

The amount of state income taxes withheld from
your pension distribution.

^ F1099-R \ N531

Pension local tax withheld

The amount of local income taxes withheld from
your pension distribution.

^ F1099-R \ N532

IRA federal tax withheld

The amount of federal income taxes withheld from
your IRA distribution.

^ F1099-R \ N533

IRA state tax withheld

The amount of state income taxes withheld from
your IRA distribution.

^ F1099-R \ N534

IRA local tax withheld

The amount of local income taxes withheld from
your IRA distribution.
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Tax Form \ TXF Code

Description

Extended TXF Help messages

^ F1099-R \ N623

SIMPLE total gross distribution

The gross amount of a distribution received from a
qualified SIMPLE pension plan.

^ F1099-R \ N624

SIMPLE total taxable distribution

The taxable amount of a distribution received from a
qualified SIMPLE plan. This amount may be subject
to a federal penalty of up to 25%.

^ F1099-R \ N625

SIMPLE federal tax withheld

The amount of federal income taxes withheld from
a SIMPLE distribution received.

^ F1099-R \ N626

SIMPLE state tax withheld

The amount of state income taxes withheld from a
SIMPLE distribution received.

^ F1099-R \ N627

SIMPLE local tax withheld

The amount of local income taxes withheld from a
SIMPLE distribution received.

Help F2106 \ H380

employee business expenses

Form 2106 is used to deduct employee business
expenses. You must file this form if you were
reimbursed by your employer or claim job-
related travel, transportation, meal, or entertainment
expenses. Use a separate Form 2106 for your
spouse’s expenses.

F2106 \ N381

Education expenses

Cost of tuition, books, supplies, laboratory fees, and
similar items, and certain transportation costs if the
education maintains or improves skills required in
your present work or is required by your employer
or the law to keep your salary, status, or job,
and the requirement serves a business purpose
of your employer. Expenses are not deductible if
they are needed to meet the minimum educational
requirements to qualify you in your work or
business or will lead to qualifying you in a new trade
or business.

F2106 \ N382

Automobile expenses

Total annual expenses for gasoline, oil, repairs,
insurance, tires, license plates, or similar items.

F2106 \ N384

Local transportation expenses

Local transportation expenses are the expenses of
getting from one workplace to another when you
are not traveling away from home. They include
the cost of transportation by air, rail, bus, taxi, and
the cost of using your car. Generally, the cost of
commuting to and from your regular place of work
is not deductible.

F2106 \ N385

Other business expenses

Other job-related expenses, including expenses for
business gifts, trade publications, etc.

F2106 \ N386

Meal/entertainment expenses

Allowable meals and entertainment expense,
including meals while away from your tax
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Tax Form \ TXF Code

Description

Extended TXF Help messages

home overnight and other business meals and
entertainment.

F2106 \ N387

Reimb. business expenses (non-meal/ent.)

Reimbursement for business expenses from your
employer that is NOT included on your Form W-2.
Note: meals and entertainment are NOT included
here.

F2106 \ N388

Reimb. meal/entertainment expenses

Reimbursement for meal and entertainment
expenses from your employer that is NOT included
on your Form W-2.

F2106 \ N389

Job seeking expenses

Fees to employment agencies and other costs to look
for a new job in your present occupation, even if you
do not get a new job.

F2106 \ N390

Special clothing expenses

cost and upkeep of work clothes, if you must wear
them as a condition of your employment, and the
clothes are not suitable for everyday wear. Include
the cost of protective clothing required in your work,
such as safety shoes or boots, safety glasses, hard
hats, and work gloves.

F2106 \ N391

Employee home office expenses

Your use of the business part of your home must
be: exclusive, regular, for your trade or business,
AND The business part of your home must be one
of the following: your principal place of business, a
place where you meet or deal with patients, clients,
or customers in the normal course of your trade
or business, or a separate structure (not attached to
your home) you use in connection with your trade or
business. Additionally, Your business use must be
for the convenience of your employer, and You do
not rent all or part of your home to your employer
and use the rented portion to perform services as an
employee. See IRS Pub 587.

F2106 \ N383

Travel (away from home)

Travel expenses are those incurred while traveling
away from home for your employer. The cost of
getting to and from your business destination (air,
rail, bus, car, etc.), taxi fares, baggage charges,
and cleaning and laundry expenses. Note: meal and
entertainment expenses are not included here.

Help F4137 \ H503

Form 4137 - tips not reported

Form 4137 is used to compute social security and
Medicare tax owed on tips you did not report to your
employer.

F4137 \ N505

Total cash/tips not reported to employer

The amount of tips you did not report to your
employer.

Help F2441 \ H400

Form 2441 - child and dependent credit

Form 2441 is used to claim a credit for child and
dependent care expenses.
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Tax Form \ TXF Code

Description

Extended TXF Help messages

< F2441 \ N401

Qualifying child/dependent care expenses

The total amount you actually paid to the care
provider. Also, include amounts your employer paid
to a third party on your behalf.

< F2441 \ N402

Qualifying household expenses

The cost of services needed to care for the qualifying
person as well as to run the home. They include
the services of a babysitter, cleaning person, cook,
maid, or housekeeper if the services were partly for
the care of the qualifying person.

Help F3903 \ H403

Form 3903 - moving expenses

Form 3903 is used to claim moving expenses.

F3903 \ N406

Transport/storage of goods

The amount you paid to pack, crate and move your
household goods and personal effects. You may
include the cost to store and insure household goods
and personal effects within any period of 30 days
in a row after the items were moved from your old
home.

F3903 \ N407

Travel/lodging, except meals

The amount you paid to travel from your old home
to your new home. This includes transportation and
lodging on the way. Although not all members of
your household must travel together, you may only
include expenses for one trip per person. Do not
include meals.

Help F4684 \ H412

Form 4684 - casualties and thefts

Form 4684 is used to report gains and losses from
casualties and thefts.

F4684 \ N416

FMV after casualty

The fair market value (FMV) is the price at which
the property would change hands between a willing
buyer and seller, each having knowledge of the
relevant facts. The FMV after a theft is zero if the
property is not recovered. The FMV is generally
determined by competent appraisal.

F4684 \ N413

Basis of casualty property

Cost or other basis usually means original cost plus
improvements. Subtract any postponed gain from
the sale of a previous main home. Special rules
apply to property received as a gift or inheritance.
See Pub 551, Basis of Assets, for details.

F4684 \ N414

Insurance/reimbursement

The amount of insurance or other reimbursement
you received expect to receive.

F4684 \ N415

FMV before casualty

The fair market value (FMV) is the price at which
the property would change hands between a willing
buyer and seller, each having knowledge of the
relevant facts. FMV is generally determined by
competent appraisal.

Help F4835 \ H569 Form 4835 is used to report farm rental income
received as a share of crops or livestock produced
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Tax Form \ TXF Code

Description

Extended TXF Help messages

Form 4835 - farm rental income by your tenant if you did not materially participate
in the operation or management of the farm. Use a
different copy of Form 4835 for each farm rented.

F4835 \ N572

Total cooperative distributions

Distributions received from a cooperative. This
includes patronage dividends, non patronage
distributions, per-unit retain allocations, and
redemption of non qualified notices and per unit
retain allocations. Reported on Form 1099-PATR.

F4835 \ N571

Sale of livestock/produce

Income you received from livestock, produce,
grains, and other crops based on production. Under
both the cash and the accrual methods of reporting,
you must report livestock or crop share rentals
received in the year you convert them into money
or its equivalent.

F4835 \ N573

Agricultural program payments

Government payments received for: price support
payments, market gain from the repayment of
a secured Commodity Credit Corporation (CCC)
loan for less than the original loan amount,
diversion payments, cost-share payments (sight
drafts), payments in the form of materials (such as
fertilizer or lime) or services (such as grading or
building dams). Reported on Form 1099-G.

F4835 \ N574

CCC loans reported/election

Generally, you do not report CCC loan proceeds as
income. However, if you pledge part or all of your
production to secure a CCC loan, you may elect to
report the loan proceeds as income in the year you
receive them, instead of the year you sell the crop.

F4835 \ N575

CCC loans forfeited/repaid

The full amount forfeited or repaid with certificates,
even if you reported the loan proceeds as income.
See IRS Pub 225.

F4835 \ N576

Crop insurance proceeds received

You generally include crop insurance proceeds in
the year you receive them. Treat as crop insurance
proceeds the crop disaster payments you receive
from the federal government.

F4835 \ N577

Crop insurance proceeds deferred

If you use the cash method of accounting and
receive crop insurance proceeds in the same tax year
in which the crops are damaged, you can choose
to postpone reporting the proceeds as income until
the following tax year. A statement must also be
attached to your return. See IRS Pub 225.

F4835 \ N578

Other income

Illegal Federal irrigation subsidies, bartering
income, income from discharge of indebtedness,
state gasoline or fuel tax refund, the gain or loss on
the sale of commodity futures contracts, etc.

F4835 \ N579

Car and truck expenses

The business portion of car or truck expenses, such
as, for gasoline, oil, repairs, insurance, tires, license
plates, etc.
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Tax Form \ TXF Code

Description

Extended TXF Help messages

F4835 \ N580

Chemicals

Chemicals used in operating your farm, such as
insect sprays and dusts.

F4835 \ N581

Conservation expenses

Your expenses for soil or water conservation or for
the prevention of erosion of land used in farming.
To take this deduction, your expenses must be
consistent with a plan approved by the Natural
Resources Conservation Service (NRCS) of the
Department of Agriculture.

F4835 \ N582

Custom hire expenses

Amounts you paid for custom hire (machine work)
(the machine operator furnished the equipment).
Do not include amounts paid for rental or lease of
equipment you operated yourself.

F4835 \ N583

Employee benefit programs

Contributions to employee benefit programs, such
as accident and health plans, group-term life
insurance, and dependent care assistance programs.
Do not include contributions that are a incidental
part of a pension or profit-sharing plan.

F4835 \ N584

Feed purchased

The cost of feed for your livestock. Generally, you
cannot currently deduct expenses for feed to be
consumed by your livestock in a later tax year. See
instructions for Schedule F.

F4835 \ N585

Fertilizers and lime

The cost of fertilizer, lime, and other materials
applied to farm land to enrich, neutralize, or
condition it. You can also deduct the cost of
applying these materials. However, see Prepaid
Farm Supplies, in Pub 225, for a rule that may limit
your deduction for these materials.

F4835 \ N586

Freight and trucking

The costs of freight or trucking of produce or
livestock.

F4835 \ N587

Gasoline, fuel, and oil

The costs of gas, fuel, oil, etc. for farm equipment.

F4835 \ N588

Insurance (other than health)

Premiums paid for farm business insurance, such
as: fire, storm, crop, theft and liability protection of
farm assets. Do not include premiums for employee
accident and health insurance.

F4835 \ N589

Interest expense, mortgage

The interest you paid to banks or other financial
institutions for which you received a Form 1098, for
a mortgage on real property used in your farming
business (other than your main home). If you paid
interest on a debt secured by your main home, and
any proceeds from that debt were used in your
farming operation, refer to IRS Pub 225.

F4835 \ N590 The interest you paid for which you did not receive
a Form 1098 (perhaps someone else did, and you are
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Interest expense, other liable too), for a mortgage or other loans for your
farm business.

F4835 \ N591

Labor hired

The amounts you paid for farm labor. Do not include
amounts paid to yourself. Count the cost of boarding
farm labor but not the value of any products they
used from the farm. Count only what you paid
house-hold help to care for farm laborers.

F4835 \ N592

Pension/profit-sharing plans

Enter your deduction for contributions to employee
pension, profit-sharing, or annuity plans. If the plan
included you as a self-employed person, see the
instructions for Schedule C (Form 1040).

F4835 \ N593

Rent/lease vehicles, equip.

The business portion of your rental cost, for rented
or leased vehicles, machinery, or equipment. But
if you leased a vehicle for a term of 30 days or
more, you may have to reduce your deduction by an
inclusion amount. For details, see the instructions
for Schedule C (Form 1040).

F4835 \ N594

Rent/lease land, animals

Amounts paid to rent or lease property such as
pasture or farm land.

F4835 \ N595

Repairs and maintenance

Amounts you paid for repairs and maintenance of
farm buildings, machinery, and equipment. You can
also include what you paid for tools of short life or
minimal cost, such as shovels and rakes.

F4835 \ N596

Seeds and plants purchased

The amounts paid for seeds and plants purchased for
farming.

F4835 \ N597

Storage and warehousing

Amounts paid for storage and warehousing of crops,
grains, etc.

F4835 \ N598

Supplies purchased

Livestock supplies and other supplies, including
bedding, office supplies, etc.

F4835 \ N599

Taxes

Real estate and personal property taxes on farm
business assets; Social security and Medicare taxes
you paid to match what you are required to withhold
from farm employees’ wages and any Federal
unemployment tax paid; Federal highway use tax.

F4835 \ N600

Utilities

Amounts you paid for gas, electricity, water, etc., for
business use on the farm. Do not include personal
utilities. You cannot deduct the base rate (including
taxes) of the first telephone line into your residence,
even if you use it for business.

F4835 \ N601

Vet, breeding, medicine

The costs of veterinary services, medicine and
breeding fees.
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F4835 \ N602

Other farm expenses

Include all ordinary and necessary farm rental
expenses not deducted elsewhere on Form 4835,
such as advertising, office supplies, etc. Do not
include fines or penalties paid to a government for
violating any law.

Help F4952 \ H425

Form 4952 - investment interest

Form 4952 is used to compute the amount of
investment interest expense deductible for the
current year and the amount, if any, to carry forward
to future years.

F4952 \ N426

Investment interest expense

The investment interest paid or accrued during
the tax year, regardless of when you incurred the
indebtedness. Investment interest is interest paid or
accrued on a loan (or part of a loan) that is allocable
to property held for investment.

Help F6252 \ H427

Form 6252 - income from casual sales

Form 6252 is used to report income from casual
sales of real or personal property when you will
receive any payments in a tax year after the year of
sale (i.e., installment sale).

F6252 \ N428

Selling price

Enter the total of any money, face amount of
the installment obligation, and the FMV of other
property that you received or will receive in
exchange for the property sold.

F6252 \ N429

Debt assumed by buyer

Enter only mortgages or other debts the buyer
assumed from the seller or took the property subject
to. Do not include new mortgages the buyer gets
from a bank, the seller, or other sources.

F6252 \ N431

Depreciation allowed

Enter all depreciation or amortization you deducted
or should have deducted from the date of purchase
until the date of sale. Add any section 179 expense
deduction. Several other adjustments are allowed,
See Form 6252 instructions.

F6252 \ N432

Expenses of sale

Enter sales commissions, advertising expenses,
attorney and legal fees, etc., in selling the property.

F6252 \ N434

Payments received this year

Enter all money and the fair market value (FMV)
of any property you received in this tax year.
Include as payments any amount withheld to pay
off a mortgage or other debt, such as broker and
legal fees. Do not include interest whether stated or
unstated.

F6252 \ N435

Payments received prior years

Enter all money and the fair market value (FMV)
of property you received before this tax year from
the sale. Include allocable installment income and
any other deemed payments from prior years. Do not
include interest whether stated or unstated.

Help F8815 \ H441 Form 8815 is used to compute the amount of interest
you may exclude if you cashed series EE U.S.
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Form 8815 - EE U.S. savings bonds sold for
education

savings bonds this year that were issued after 1989
to pay for qualified higher education costs.

F8815 \ N442

Qualified higher education expenses

Qualified higher education expenses include tuition
and fees required for the enrollment or attendance
of the person(s). Do not include expenses for room
and board, or courses involving sports, games, or
hobbies that are not part of a degree or certificate
granting program.

F8815 \ N443

Nontaxable education benefits

Nontaxable educational benefits. These benefits
include: Scholarship or fellowship grants
excludable from income under section 117;
Veterans’ educational assistance benefits;
Employer-provided educational assistance benefits
that are not included in box 1 of your W-2 form(s);
Any other payments (but not gifts, bequests, or
inheritances) for educational expenses that are
exempt from income tax by any U.S. law. Do
not include nontaxable educational benefits paid
directly to, or by, the educational institution.

F8815 \ N444

EE US savings bonds proceeds

Enter the total proceeds (principal and interest) from
all series EE and I U.S. savings bonds issued after
1989 that you cashed during this tax year.

F8815 \ N445

Post-89 EE bond face value

The face value of all post-1989 series EE bonds
cashed this tax year.

Help F8863 \ H639

Form 8863 - Hope and Lifetime Learning education
credits

Form 8863 is used to compute the Hope and
Lifetime Learning education credits. IRS rules are
stringent for these credits. Refer to IRS Publication
970 for more information.

F8863 \ N637

Hope credit

Expenses qualified for the Hope credit are amounts
paid this tax year for tuition and fees required for
the student’s enrollment or attendance at an eligible
educational institution.

F8863 \ N638

Lifetime learning credit

Expenses qualified for the Lifetime Learning credit
are amounts paid this tax year for tuition and fees
required for the student’s enrollment or attendance
at an eligible educational institution.

Help F8829 \ H536

Form 8829 - business use of your home

Form 8829 is used only if you file a Schedule C,
Profit or Loss from Business, and you meet specific
requirements to deduct expenses for the business
use of your home. IRS rules are stringent for this
deduction. Refer to IRS Publication 587.

F8829 \ N537

Deductible mortgage interest

The total amount of mortgage interest that would
be deductible whether or not you used your home
for business (i.e., amounts allowable as itemized
deductions on Schedule A, Form 1040). Form 8829
computes the deductible business portion.
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F8829 \ N538

Real estate taxes

The total amount of real estate taxes that would
be deductible whether or not you used your home
for business (i.e., amounts allowable as itemized
deductions on Schedule A, Form 1040). Form 8829
computes the deductible business portion.

F8829 \ N539

Insurance

The total amount of insurance paid for your home,
in which an area or room is used regularly and
exclusively for business. Form 8829 computes the
deductible business portion.

F8829 \ N540

Repairs and maintenance

The total amount of repairs and maintenance paid
for your home, in which an area or room is used
regularly and exclusively for business. Form 8829
computes the deductible business portion.

F8829 \ N541

Utilities

The total amount of utilities paid for your home,
in which an area or room is used regularly and
exclusively for business. Form 8829 computes the
deductible business portion.

F8829 \ N542

Other expenses

If you rent rather than own your home, include rent
paid for your home, in which an area or room is used
regularly and exclusively for business. Form 8829
computes the deductible business portion.

Help F8839 \ H617

Form 8839 - adoption expenses

Form 8839 is used to report qualified adoption
expenses.

F8839 \ N618

Adoption fees

Adoption fees that are reasonable and necessary,
directly related to, and for the principal purpose of,
the legal adoption of an eligible child.

F8839 \ N619

Court costs

Court costs that are reasonable and necessary,
directly related to, and for the principal purpose of,
the legal adoption of an eligible child.

F8839 \ N620

Attorney fees

Attorney fees that are reasonable and necessary,
directly related to, and for the principal purpose of,
the legal adoption of an eligible child.

F8839 \ N621

Traveling expenses

Traveling expenses (including meals and lodging)
while away from home, directly related to, and for
the principal purpose of, the legal adoption of an
eligible child.

F8839 \ N622

Other expenses

Other expenses that are reasonable and necessary,
directly related to, and for the principal purpose of,
the legal adoption of an eligible child.

Home Sale \ N392

Home Sale worksheets (was F2119)

Home Sale worksheets (replaces Form 2119) are
used to report the sale of your personal residence.
See IRS Pub 523.

Home Sale \ N393

Selling price of old home

The selling price is the total amount you receive for
your home. It includes money, all notes, mortgages,
or other debts assumed by the buyer as part of
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the sale, and the fair market value of any other
property or any services you receive. Reported on
Form 1099-S.

Home Sale \ N394

Expense of sale

Selling expenses include commissions, advertising
fees, legal fees, title insurance, and loan charges
paid by the seller, such as loan placement fees or
"points."

Home Sale \ N396

Fixing-up expenses

Fixing-up expenses are decorating and repair costs
that you paid to sell your old home. For example,
the costs of painting the home, planting flowers, and
replacing broken windows are fixing-up expenses.
Fixing-up expenses must meet all the following
conditions. The expenses: Must be for work done
during the 90-day period ending on the day you sign
the contract of sale with the buyer; Must be paid no
later than 30 days after the date of sale; Cannot be
deductible in arriving at your taxable in-come; Must
not be used in figuring the amount realized; and
Must not be capital expenditures or improvements.

Home Sale \ N397

Cost of new home

The cost of your new home includes costs incurred
within the replacement period (beginning 2 years
before and ending 2 years after the date of sale) for
the following items: Buying or building the home;
Rebuilding the home; and Capital improvements or
additions.

Help Sched A \ H270

Schedule A - itemized deductions

Schedule A is used to report your itemized
deductions.

Sched A \ N271

Subscriptions

Amounts paid for subscriptions to magazines
or services that are directly related to the
production or collection of taxable income.
(example: subscriptions to investment publications,
stock newsletters, etc.).

Sched A \ N272

Gambling losses

Gambling losses, but only to the extent of gambling
winnings reported on Form 1040. Note: not subject
to the 2% AGI of limitation.

Sched A \ N273

Medicine and drugs

Prescription medicines, eyeglasses, contact lenses,
hearing aids. Over-the-counter medicines are not
deductible.

Sched A \ N274

Medical travel and lodging

Lodging expenses while away from home to receive
medical care in a hospital or a medical care facility
related to a hospital. Do not include more than $50
a night for each eligible person. Ambulance service
and other travel costs to get medical care.

Sched A \ N275

State income taxes

State income taxes paid this year for a prior year.
Include any part of a prior year refund that you chose
to have credited to this years state income taxes.
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Sched A \ N276

Real estate taxes

Include taxes (state, local, or foreign) you paid on
real estate you own that was not used for business,
but only if the taxes are based on the assessed value
of the property. Do not include taxes charged for
improvements that tend to increase the value of your
property (for example, an assessment to build a new
sidewalk).

Sched A \ N277

Other taxes

Other taxes paid not included under state and local
income taxes, real estate taxes, or personal property
taxes. You may want to take a credit for the foreign
tax instead of a deduction.

Sched A \ N280

Cash charity contributions

Contributions or gifts by cash or check you
gave to organizations that are religious, charitable,
educational, scientific, or literary in purpose. You
may also deduct what you gave to organizations
that work to prevent cruelty to children or animals.
For donations of $250 or more, you must have a
statement from the charitable organization showing
the amount donated and the value of goods or
services you received.

Sched A \ N281

Tax preparation fees

Fees you paid for preparation of your tax
return, including fees paid for filing your return
electronically.

Sched A \ N282

Investment management fees

Investment interest is interest paid on money you
borrowed that is allocable to property held for
investment. It does not include any interest allocable
to passive activities or to securities that generate tax-
exempt income.

Sched A \ N283

Home mortgage interest (1098)

Home mortgage interest and points reported to you
on Form 1098. The interest could be on a first or
second mortgage, home equity loan, or refinanced
mortgage.

Sched A \ N284

Points paid (no 1098)

Generally, you must deduct points you paid to
refinance a mortgage over the life of the loan. If
you used part of the proceeds to improve your main
home, you may be able to deduct the part of the
points related to the improvement in the year paid.
See Pub. 936 Use this line for points not reported on
Form 1098.

Sched A \ N484

Doctors, dentists, hospitals

Insurance premiums for medical and dental care,
medical doctors, dentists, eye doctors, surgeons, X-
ray, laboratory services, hospital care, etc. See IRS
Pub 502.

Sched A \ N486

Misc., subject to 2% AGI limit

Safety equipment, small tools, and supplies you
needed for your job; Uniforms required by your
employer and which you may not usually wear away
from work; subscriptions to professional journals;
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job search expenses; certain educational expenses.
You may need to file Form 2106.

Sched A \ N485

Non-cash charity contributions

The fair market value of donated property, such as
used clothing or furniture.

Sched A \ N522

State estimated tax, quarterly

State estimated tax payments made this year.

Sched A \ N523

Misc., no 2% AGI limit

Other miscellaneous itemized deductions that are
not reduced by 2% of adjusted gross income,
such as casualty and theft losses from income-
producing, amortizable bond premium on bonds
acquired before October 23, 1986, federal estate
tax on income in respect to a decedent, certain
unrecovered investment in a pension, impairment-
related work expenses of a disabled person.

Sched A \ N535

Personal property taxes

Enter personal property tax you paid, but only if it
is based on value alone. Example: You paid a fee
for the registration of your car. Part of the fee was
based on the car s value and part was based on its
weight. You may deduct only the part of the fee that
is based on the car s value.

Sched A \ N544

Local income taxes

Local income taxes that were not withheld from
your salary, such as local income taxes you paid this
year for a prior year.

Sched A \ N545

Home mortgage interest (no 1098)

Home mortgage interest paid, for which you did not
receive a Form 1098 from the recipient. The interest
could be on a first or second mortgage, home equity
loan, or refinanced mortgage.

Help Sched B \ H285

Schedule B - interest and dividend income

Schedule B is used to report your interest and
dividend income.

^ Sched B \ N286

Dividend income, Ordinary

Ordinary dividends from mutual funds, stocks,
etc., are reported to you on a 1099-DIV. Note:
these are sometimes called short term capital gain
distributions. Do not include (long term) capital gain
distributions or non-taxable dividends here, these go
on Sched D

< Sched B \ N287

Interest income

Taxable interest includes interest you receive from
bank accounts, credit unions, loans you made to
others. There are several categories of interest, be
sure you select the correct one!

< Sched B \ N288

Interest income, US government

Interest on U.S. obligations, such as U.S. Treasury
bills, notes, and bonds issued by any agency of the
United States. This income is exempt from all state
and local income taxes. There are several categories
of interest, be sure you select the correct one!
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< Sched B \ N289

Interest income, State and municipal bond

Interest on bonds or notes of states, counties, cities,
the District of Columbia, or possessions of the
United States is generally free of federal income
tax (but you may pay state income tax). There are
several categories of interest, be sure you select the
correct one!

< Sched B \ N290

Interest income, tax-exempt private activity bond

Interest income from a qualified tax-exempt private
activity bond is not taxable if it meets all
requirements. This income is included on your
Schedule B as non-taxable interest income. There
are several categories of interest, be sure you select
the correct one!

< Sched B \ N487

Dividend income, non-taxable

Some mutual funds pay shareholders non-taxable
dividends. The amount of non-taxable dividends
are indicated on your monthly statements or Form
1099-DIV.

< Sched B \ N489

Interest income, non-taxable

Non-taxable interest income other than from bonds
or notes of states, counties, cities, the District of
Columbia, or a possession of the United States, or
from a qualified private activity bond. There are
several categories of interest, be sure you select the
correct one!

< Sched B \ N490

Interest income, taxed only by fed

Interest income that is taxed on your federal return,
but not on your state income tax return - other than
interest paid on U.S. obligations. There are several
categories of interest, be sure you select the correct
one!

< Sched B \ N491

Interest income, taxed only by state

Interest income that is not taxed on your federal
return, but is taxed on your state income tax return
- other than interest income from state bonds or
notes, the District of Columbia, or a possession of
the United States. There are several categories of
interest, be sure you select the correct one!

< Sched B \ N492

Interest income, OID bonds

Interest income from Original Issue Discount (OID)
bonds will be reported to you on Form 1099-OID.
There are several categories of interest, be sure you
select the correct one!

< Sched B \ N524

Interest income, Seller-financed mortgage

Interest the buyer paid you on a mortgage or other
form of seller financing, for your home or other
property and the buyer used the property as a
personal residence. There are several categories of
interest, be sure you select the correct one!

< Sched B \ N615

Fed tax withheld, dividend income

The amount of federal income taxes withheld from
dividend income. This is usually reported on Form
1099-DIV.
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< Sched B \ N616

Fed tax withheld, interest income

The amount of federal income taxes withheld from
interest income. This is usually reported on Form
1099-INT.

Help Sched C \ H291

Schedule C - self-employment income

Schedule C is used to report income from self-
employment. Use a separate Schedule C to report
income and expenses from different businesses.

Sched C \ N293

Gross receipts or sales

The amount of gross receipts from your trade or
business. Include amounts you received in your
trade or business that were properly shown on
Forms 1099-MISC.

Sched C \ N294

Meals and entertainment

Total business meal and entertainment expenses.
Business meal expenses are deductible only if they
are (a) directly related to or associated with the
active conduct of your trade or business, (b) not
lavish or extravagant, and (c) incurred while you or
your employee is present at the meal.

Sched C \ N296

Returns and allowances

Credits you allow customers for returned
merchandise and any other allowances you make on
sales.

Sched C \ N297

Wages paid

The total amount of salaries and wages for the tax
year. Do not include amounts paid to yourself.

Sched C \ N298

Legal and professional fees

Accountant’s or legal fees for tax advice related to
your business and for preparation of the tax forms
related to your business.

Sched C \ N299

Rent/lease vehicles, equip.

The amount paid to rent or lease vehicles,
machinery, or equipment, for your business. If you
leased a vehicle for a term of 30 days or more, you
may have to reduce your deduction by an amount
called the inclusion amount. See Pub. 463.

Sched C \ N300

Rent/lease other business property

The amounts paid to rent or lease real estate or
property, such as office space in a building.

Sched C \ N301

Supplies (not from Cost of Goods Sold)

The cost of supplies not reported under Cost Of
Goods Sold.

Sched C \ N302

Other business expenses

Other costs not specified on other lines of Schedule
C, such as: Clean-fuel vehicles and refueling
property; Donations to business organizations;
Educational expenses; Environmental cleanup
costs; Impairment-related expenses; Interview
expense allowances; Licenses and regulatory
fees; Moving machinery; Outplacement services;
Penalties and fines you pay for late performance
or nonperformance of a contract; Subscriptions to
trade or professional publications.
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Sched C \ N303

Other business income

The amounts from finance reserve income, scrap
sales, bad debts you recovered, interest (such as on
notes and accounts receivable), state gasoline or fuel
tax refunds you got this year, prizes and awards
related to your trade or business, and other kinds of
miscellaneous business income.

Sched C \ N304

Advertising

The amounts paid for advertising your trade or
business in newspapers, publications, radio or
television. Also include the cost of brochures,
business cards, or other promotional material.

Sched C \ N305

Bad debts from sales/services

Include debts and partial debts from sales or services
that were included in income and are definitely
known to be worthless.

Sched C \ N306

Car and truck expenses

You can deduct the actual expenses of running your
car or truck, or take the standard mileage rate.

Sched C \ N307

Commissions and fees

The amounts of commissions or fees paid to
independent contractors (non employees) for their
services.

Sched C \ N308

Employee benefit programs

Contributions to employee benefit programs that
are not an incidental part of a pension or profit-
sharing plan. Examples are accident and health
plans, group-term life insurance, and dependent care
assistance programs.

Sched C \ N309

Depletion

The amounts for depletion. If you have timber
depletion, attach Form T. See Pub. 535.

Sched C \ N310

Insurance, other than health

Premiums paid for business insurance. Do not
include amounts paid for employee accident and
health insurance. nor amounts credited to a reserve
for self-insurance or premiums paid for a policy
that pays for your lost earnings due to sickness or
disability. See Pub. 535.

Sched C \ N311

Interest expense, mortgage

The interest you paid to banks or other financial
institutions for which you received a Form 1098, for
a mortgage on real property used in your business
(other than your main home).

Sched C \ N312

Interest expense, other

The interest you paid for which you did not receive
a Form 1098 (perhaps someone else did, and you are
liable too), for a mortgage or other loans for your
business.

Sched C \ N313

Office expenses

The cost of consumable office supplies such as
business cards, computer supplies, pencils, pens,
postage stamps, rental of postal box or postage
machines, stationery, Federal Express and UPS
charges, etc.
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Sched C \ N314

Pension/profit sharing plans

You can set up and maintain the following small
business retirement plans for yourself and your
employees, such as: SEP (Simplified Employee
Pension) plans; SIMPLE (Savings Incentive Match
Plan for Employees) plans; Qualified plans
(including Keogh or H.R. 10 plans). You deduct
contributions you make to the plan for yourself on
Form 1040.

Sched C \ N315

Repairs and maintenance

The cost of repairs and maintenance. Include labor,
supplies, and other items that do not add to the value
or increase the life of the property. Do not include
the value of your own labor. Do not include amounts
spent to restore or replace property; they must be
capitalized.

Sched C \ N316

Taxes and licenses

Include the following taxes: State and local sales
taxes imposed on you as the seller of goods or
services; Real estate and personal property taxes
on business assets; Social security and Medicare
taxes paid to match required withholding from your
employees’ wages; Also, Federal unemployment
tax paid; Federal highway use tax.

Sched C \ N317

Travel

Expenses for lodging and transportation connected
with overnight travel for business while away from
your tax home.

Sched C \ N318

Utilities

The costs of electricity, gas, telephone, etc. for your
business property.

Sched C \ N493

Cost of Goods Sold - Purchases

If you are a merchant, use the cost of all merchandise
you bought for sale. If you are a manufacturer or
producer, this includes the cost of all raw materials
or parts purchased for manufacture into a finished
product. You must exclude the cost of merchandise
you withdraw for your personal or family use.

Sched C \ N494

Cost of Goods Sold - Labor

Labor costs are usually an element of cost of goods
sold only in a manufacturing or mining business.
In a manufacturing business, labor costs that are
properly allocable to the cost of goods sold include
both the direct and indirect labor used in fabricating
the raw material into a finished, salable product.

Sched C \ N495

Cost of Goods Sold - Materials/supplies

Materials and supplies, such as hardware and
chemicals, used in manufacturing goods are charged
to cost of goods sold. Those that are not used in
the manufacturing process are treated as deferred
charges. You deduct them as a business expense
when you use them.
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Sched C \ N496

Cost of Goods Sold - Other costs

Other costs incurred in a manufacturing or mining
process that you charge to your cost of goods sold
are containers, freight-in, overhead expenses.

Help Sched D \ H320

Schedule D - capital gains and losses

Schedule D is used to report gains and losses from
the sale of capital assets.

# Sched D \ N321

Short Term gain/loss - security

Short term gain or loss from the sale of a security.
Not yet implemented in GnuCash.

# Sched D \ N323

Long Term gain/loss - security

Long term gain or loss from the sale of a security.
Not yet implemented in GnuCash.

^ Sched D \ N488

Dividend income, capital gain distributions

Sometimes called long term capital gain
distributions. These are from mutual funds, other
regulated investment companies, or real estate
investment trusts. These are reported on your
monthly statements or Form 1099-DIV. Note: short
term capital gain distributions are reported on Sched
B as ordinary dividends

# Sched D \ N673

Short/Long Term gain or loss

Short term or long term gain or loss from the sale
of a security; for use when only the date sold and
net sales amount are available and the date acquired
and cost basis information is not available and will
be separately added in the tax software.

Help Sched E \ H325

Schedule E - rental and royalty income

Schedule E is used to report income or loss from
rental real estate, royalties, and residual interest
in REMIC’s. Use a different copy for each rental
or royalty. Use the Schedule K-1 categories for
partnership rental income and loss amounts.

Sched E \ N326

Rents received

The amounts received as rental income from real
estate (including personal property leased with real
estate) but you were not in the real estate business.
(If you are in the business of renting personal
property, use Schedule C.)

Sched E \ N327

Royalties received

Royalties received from oil, gas, or mineral
properties (not including operating interests);
copyrights; and patents.

Sched E \ N328

Advertising

Amounts paid to advertise rental unit(s) in
newspapers or other media or paid to realtor’s to
obtain tenants.

Sched E \ N329

Auto and travel

The ordinary and necessary amounts of auto and
travel expenses related to your rental activities,
including 50% of meal expenses incurred while
traveling away from home.

Sched E \ N330

Cleaning and maintenance

The amounts paid for cleaning services (carpet,
drapes), cleaning supplies, locks and keys, pest
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control, pool service, and general cost of upkeep of
the rental property.

Sched E \ N331

Commissions

The amounts paid as Commissions to realtor’s or
management companies to collect rent.

Sched E \ N332

Insurance

Insurance premiums paid for fire, theft, liability.

Sched E \ N333

Legal and professional fees

The amounts of fees for tax advice and the
preparation of tax forms related to your rental real
estate or royalty properties.

Sched E \ N334

Mortgage interest expense

Interest paid to banks or other financial institutions
for a mortgage on your rental property, and you
received a Form 1098.

Sched E \ N335

Other interest expense

Interest paid for a mortgage on your rental property,
not paid to banks or other financial institutions or
you did not receive a Form 1098.

Sched E \ N336

Repairs

You may deduct the cost of repairs made to
keep your property in good working condition.
Repairs generally do not add significant value to the
property or extend its life.

Sched E \ N337

Supplies

Miscellaneous items needed to maintain the
property, such as: brooms, cleaning supplies, nails,
paint brushes, etc.

Sched E \ N338

Taxes

The amounts paid for real estate and personal
property taxes. Also include the portion of any
payroll taxes you paid for your employees.

Sched E \ N339

Utilities

The costs of electricity, gas, telephone, etc. for your
rental property.

Sched E \ N341

Other expenses

Other expenses that are not listed on other tax
lines of Schedule E. These might include the
cost of gardening and/or snow removal services,
association dues, bank charges, etc.

Sched E \ N502

Management fees

The amount of fees to a manager or property
management company to oversee your rental or
royalty property.

Help Sched F \ H343

Schedule F - Farm income and expense

Schedule F is used to report farm income and
expense. Use a different copy of Schedule F for each
farm you own.

Sched F \ N344

Labor hired

The amounts you paid for farm labor. Do not include
amounts paid to yourself. Count the cost of boarding
farm labor but not the value of any products they
used from the farm. Count only what you paid
house-hold help to care for farm laborers.
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Sched F \ N345

Repairs and maintenance

Amounts you paid for repairs and maintenance of
farm buildings, machinery, and equipment. You can
also include what you paid for tools of short life or
minimal cost, such as shovels and rakes.

Sched F \ N346

Interest expense, mortgage

The interest you paid to banks or other financial
institutions for which you received a Form 1098, for
a mortgage on real property used in your farming
business (other than your main home). If you paid
interest on a debt secured by your main home, and
any proceeds from that debt were used in your
farming operation, refer to IRS Pub 225.

Sched F \ N347

Interest expense, other

The interest you paid for which you did not receive
a Form 1098 (perhaps someone else did, and you are
liable too), for a mortgage or other loans for your
farm business.

Sched F \ N348

Rent/lease land, animals

Amounts paid to rent or lease property such as
pasture or farm land.

Sched F \ N349

Rent/lease vehicles, equip.

The business portion of your rental cost, for rented
or leased vehicles, machinery, or equipment. But
if you leased a vehicle for a term of 30 days or
more, you may have to reduce your deduction by an
inclusion amount. For details, see the instructions
for Schedule C (Form 1040).

Sched F \ N350

Feed purchased

The cost of feed for your livestock. Generally, you
cannot currently deduct expenses for feed to be
consumed by your livestock in a later tax year. See
instructions for Schedule F.

Sched F \ N351

Seeds and plants purchased

The amounts paid for seeds and plants purchased for
farming.

Sched F \ N352

Fertilizers and lime

The cost of fertilizer, lime, and other materials
applied to farm land to enrich, neutralize, or
condition it. You can also deduct the cost of
applying these materials. However, see Prepaid
Farm Supplies, in Pub 225, for a rule that may limit
your deduction for these materials.

Sched F \ N353

Supplies purchased

Livestock supplies and other supplies, including
bedding, office supplies, etc.

Sched F \ N355

Vet, breeding, and medicine

The costs of veterinary services, medicine and
breeding fees.

Sched F \ N356

Gasoline, fuel, and oil

The costs of gas, fuel, oil, etc. for farm equipment.
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Sched F \ N357

Storage and warehousing

Amounts paid for storage and warehousing of crops,
grains, etc.

Sched F \ N358

Taxes

Real estate and personal property taxes on farm
business assets; Social security and Medicare taxes
you paid to match what you are required to withhold
from farm employees’ wages and any Federal
unemployment tax paid; Federal highway use tax.

Sched F \ N359

Insurance, other than health

Premiums paid for farm business insurance, such
as: fire, storm, crop, theft and liability protection of
farm assets. Do not include premiums for employee
accident and health insurance.

Sched F \ N360

Utilities

Amounts you paid for gas, electricity, water, etc., for
business use on the farm. Do not include personal
utilities. You cannot deduct the base rate (including
taxes) of the first telephone line into your residence,
even if you use it for business.

Sched F \ N361

Freight and trucking

The costs of freight or trucking of produce or
livestock.

Sched F \ N362

Conservation expenses

Your expenses for soil or water conservation or for
the prevention of erosion of land used in farming.
To take this deduction, your expenses must be
consistent with a plan approved by the Natural
Resources Conservation Service (NRCS) of the
Department of Agriculture.

Sched F \ N363

Pension/profit sharing plans

Enter your deduction for contributions to employee
pension, profit-sharing, or annuity plans. If the plan
included you as a self-employed person, see the
instructions for Schedule C (Form 1040).

Sched F \ N364

Employee benefit programs

Contributions to employee benefit programs, such
as accident and health plans, group-term life
insurance, and dependent care assistance programs.
Do not include contributions that are a incidental
part of a pension or profit-sharing plan.

Sched F \ N365

Other farm expenses

Include all ordinary and necessary farm expenses
not deducted elsewhere on Schedule F, such as
advertising, office supplies, etc. Do not include fines
or penalties paid to a government for violating any
law.

Sched F \ N366

Chemicals

Chemicals used in operating your farm, such as
insect sprays and dusts.

Sched F \ N367

Custom hire expenses

Amounts you paid for custom hire (machine work)
(the machine operator furnished the equipment).
Do not include amounts paid for rental or lease of
equipment you operated yourself.

208



Customizing GnuCash

Tax Form \ TXF Code

Description

Extended TXF Help messages

Sched F \ N372

Agricultural program payments

Government payments received for: price support
payments, market gain from the repayment of
a secured Commodity Credit Corporation (CCC)
loan for less than the original loan amount,
diversion payments, cost-share payments (sight
drafts), payments in the form of materials (such as
fertilizer or lime) or services (such as grading or
building dams). Reported on Form 1099-G.

Sched F \ N373

CCC loans reported/election

Generally, you do not report CCC loan proceeds as
income. However, if you pledge part or all of your
production to secure a CCC loan, you may elect to
report the loan proceeds as income in the year you
receive them, instead of the year you sell the crop.

Sched F \ N374

CCC loans forfeited or repaid

The amount forfeited or repaid with certificates,
even if you reported the loan proceeds as income.
See IRS Pub 225.

Sched F \ N375

Crop insurance proceeds received

You generally include crop insurance proceeds in
the year you receive them. Treat as crop insurance
proceeds the crop disaster payments you receive
from the federal government.

Sched F \ N376

Crop insurance proceeds deferred

If you use the cash method of accounting and
receive crop insurance proceeds in the same tax year
in which the crops are damaged, you can choose
to postpone reporting the proceeds as income until
the following tax year. A statement must also be
attached to your return. See IRS Pub 225.

Sched F \ N377

Other farm income

Illegal Federal irrigation subsidies, bartering
income, income from discharge of indebtedness,
state gasoline or fuel tax refund, the gain or loss on
the sale of commodity futures contracts, etc.

Sched F \ N368

Sales livestock/product raised

Amounts you received from the sale of livestock,
produce, grains, and other products you raised.

Sched F \ N369

Resales of livestock/items

Amounts you received from the sales of livestock
and other items you bought specifically for resale.
Do not include sales of livestock held for breeding,
dairy purposes, draft, or sport. These are reported on
Form 4797, Sales of Business Property.

Sched F \ N370

Custom hire income

The income you received for custom hire (machine
work).

Sched F \ N371

Total cooperative distributions

Distributions received from a cooperative. This
includes patronage dividends, non patronage
distributions, per-unit retain allocations, and
redemption of non qualified notices and per unit
retain allocations. Reported on Form 1099-PATR.
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Sched F \ N378

Cost of resale livestock/items

The cost or other basis of the livestock and other
items you actually sold.

Sched F \ N543

Car and truck expenses

The business portion of car or truck expenses, such
as, for gasoline, oil, repairs, insurance, tires, license
plates, etc.

Help Sched H \ H565

Schedule H - Household employees

Schedule H is used to report Federal employment
taxes on cash wages paid this year to household
employees. Federal employment taxes include
social security, Medicare, withheld Federal income,
and Federal unemployment (FUTA) taxes.

^ Sched H \ N567

Cash wages paid

For household employees to whom you paid $1,100
(as of 1999) or more each of cash wages that are
subject to social security and Medicare taxes. To
find out if the wages are subject to these taxes, see
the instructions for Schedule H.

^ Sched H \ N568

Federal tax withheld

Federal income tax withheld from total cash wages
paid to household employees during the year.

Help Sched K-1 \ H446

Schedule K-1 - partnership income, credits,
deductions

Schedule K-1 is used to report your share of a
partnership’s income, credits, deductions, etc. Use a
separate copy of Schedule K-1 for each partnership.

# Sched K-1 \ N448

Ordinary income or loss

Your share of the ordinary income (loss) from the
trade or business activities of the partnership. This
is reported to you on Schedule K-1. (You usually
report this on Schedule E, See instructions for
Schedule K-1)

# Sched K-1 \ N449

Rental real estate income or loss

The income or (loss) from rental real estate activities
engaged in by the partnership. This is reported to
you on Schedule K-1. (You usually report this on
Schedule E, See instructions for Schedule K-1)

# Sched K-1 \ N450

Other rental income or loss

The income or (loss) from rental activities, other
than the rental of real estate. This is reported to
you on Schedule K-1. (You usually report this on
Schedule E, See instructions for Schedule K-1)

Sched K-1 \ N451

Interest income

The amount of interest income the partnership
reported to you on Schedule K-1. (You report this
on Schedule B)

Sched K-1 \ N452

Dividends, ordinary

The amount of dividend income the partnership
reported to you on Schedule K-1. (You report this
on Schedule B)

# Sched K-1 \ N453

Net ST capital gain or loss

The short-term gain or (loss) from sale of assets the
partnership reported to you on K-1. (You report this
on Schedule D)
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# Sched K-1 \ N454

Net LT capital gain or loss

The long-term gain or (loss) from the sale of assets
the partnership reported to you on Schedule K-1.
(You report this on Schedule D)

Sched K-1 \ N455

Guaranteed partner payments

A guaranteed payments the partnership reported to
you on Schedule K-1. (You report this on Schedule
E)

# Sched K-1 \ N456

Net Section 1231 gain or loss

The gain or (loss) from sale of Section 1231 assets
the partnership reported to you on Schedule K-1.
(You report this on Form 4797)

Sched K-1 \ N527

Royalties

The amount of the royalty income the partnership
reported to you on Schedule K-1. (You report this
on Schedule E)

Sched K-1 \ N528

Tax-exempt interest income

The amount of tax-exempt interest income the
partnership reported to you on Schedule K-1. (You
report this on Form 1040)

Help W-2 \ H458

Form W-2 - Wages earned and taxes withheld

Form W-2 is used by your employer to report
the amount of wages and other compensation
you earned as an employee, and the amount of
federal and state taxes withheld and fringe benefits
received. Use a separate copy of Form W-2 for each
employer.

^ W-2 \ N267

Reimbursed moving expenses, self

Qualified moving expense reimbursements paid
directly to you by an employer.

^ W-2 \ N460

Salary or wages, self

The total wages, tips, and other compensation,
before any payroll deductions, you receive from
your employer.

^ W-2 \ N461

Federal tax withheld, self

The amount of Federal income tax withheld from
your wages for the year.

^ W-2 \ N462

Social Security tax withheld, self

The amount of social security taxes withheld from
your wages.

^ W-2 \ N463

Local tax withheld, self

The amount of local taxes withheld from your
wages.

^ W-2 \ N464

State tax withheld, self

The amount of state taxes withheld from your
wages.

^ W-2 \ N465

Dependent care benefits, self

The amount dependent care benefits, including
the fair market value of employer-provided
or employer-sponsored day-care facilities you
received.

^ W-2 \ N480

Medicare tax withheld, self

The amount of Medicare taxes withheld from your
wages.
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^ W-2 \ N506

Salary or wages, spouse

The total wages, tips, and other compensation,
before any payroll deductions, your spouse receives
from your spouse’s employer.

^ W-2 \ N507

Federal tax withheld, spouse

The amount of Federal income tax withheld from
your spouse’s wages for the year.

^ W-2 \ N508

Social Security tax withheld, spouse

The amount of social security taxes withheld from
your spouse’s wages.

^ W-2 \ N509

Local tax withheld, spouse

The amount of local taxes withheld from your
spouse’s wages.

^ W-2 \ N510

Medicare tax withheld, spouse

The amount of Medicare taxes withheld from your
spouse’s wages.

^ W-2 \ N511

State tax withheld, spouse

The amount of state taxes withheld from your
spouse’s wages.

^ W-2 \ N512

Dependent care benefits, spouse

The amount dependent care benefits, including
the fair market value of employer-provided or
employer-sponsored day-care facilities your spouse
received.

^ W-2 \ N546

Reimbursed moving expenses, spouse

Qualified moving expense reimbursements paid
directly to your spouse by your spouse’s employer.

Help W-2G \ H547

Form W-2G - gambling winnings

Form W-2G is used to report certain gambling
winnings.

^ W-2G \ N549

Gross winnings

The amount of gross winnings from gambling.
This may include winnings from horse racing, dog
racing, jai alai, lotteries, keno, bingo, slot machines,
sweepstakes, and wagering pools. If the amount is
large enough, it will be reported on Form W-2G.

^ W-2G \ N550

Federal tax withheld

The amount of federal income taxes withheld from
gross gambling winnings.

^ W-2G \ N551

State tax withheld

The amount of state income taxes withheld from
gross gambling winnings.

Source: https://github.com/Gnucash/gnucash/blob/maint/src/tax/us/txf-help.scm

Reset Warnings...
GnuCash gives warnings when certain operations are attempted, such as removing a transaction or
removing the splits of a transaction. The warning message gives you the option to not give you these
warnings when attempting the operation. Check-boxes labeled Remember and don’t ask me again and
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Remember and don’t ask me again this session allow disabling the warnings. This option permits reseting
the warnings to the default, IE make the warning happen. Warnings may be selectivly enabled.

Changing the Language
The language of the GnuCash user interface is not modifiable directly from the program’s preferences.

The way you can change the language depends on the operating system you are running GnuCash on.

Linux In general you should set the LANGUAGE and LANG environment variables before
starting GnuCash. To do this you need to open a terminal and run the following
command:

LANGUAGE=ll_LL LANG=ll_LL gnucash

ll_LL is the locale you want to run GnuCash with (de_DE for Deutsch, it_IT for
Italian etc.)

Note

On some systems (e.g. Ubuntu) the encoding could be part of the locales
name, like ll_LL.UTF-8. You can use these names as well.

MacOSX If you want to use a different translation from the one that is automatically selected,
you can run the following in Terminal.app:

defaults write $(mdls -name kMDItemCFBundleIdentifier -raw /Applications/
GnuCash.app) AppleLanguages "(de, en)"

Use whatever language codes you want, replacing Deutsch and English. It won’t work
if there isn’t a translation file for the language you want.

If you want to unset it (that is, return to using the system settings), run this:

defaults delete $(mdls -name kMDItemCFBundleIdentifier -raw /Applications/
GnuCash.app)

Windows™ If you are running GnuCash 2.4.0 (or newer) on Windows, you can set the interface
language by editing the file environment with a text editor (e.g. Notepad). By
default this file is installed in c:\Program Files\gnucash\etc\gnucash.
Change this file such that the last few lines are:

# If you wish GnuCash to use a different language, uncomment the two parameters
# below and set LANG to your preferred locale
LANG=ll_LL
LANGUAGE={LANG}

ll_LL is the locale you want to run GnuCash with (de_DE for Deutsch, it_IT for
Italian etc.)

Tip

More and updated information about this topic can be found on the Locale Settings page [https://
wiki.gnucash.org/wiki/Locale_Settings] of the GnuCash wiki.
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Appendix A.  GnuCash Tips and tidbits
GnuCash Version 2.6.20 + Finance::Quote Version 1.47, March 2018

This chapter gives you some background information about Finance::Quote.

Finance::Quote Sources
There are 3 types of sources of which the first - currency - is hardcoded and responsible to fetch ISO
currencies. The other two can be selected in the security editor.

Finance::Quote Sources - Currency source

Table A.1. Currency source for Finance::Quote

GnuCash Name Finance::Quote Name Notes

Currency currency

End of 2017 the provider changed.
Make sure, you updated F::Q to
at least version 1.47 and follow
the instructions at Alphavantage
below.

Quote Sources - Individual sources

Table A.2. Individual sources for quotes

GnuCash Name Finance::Quote Name URL, Notes

Alphavantage, US alphavantage

You need to

1. register at https://
www.alphavantage.co/ and

2. store the key which you got
there in  Edit → Preferences
+Online Quotes .

3. To use him also with gnc-
fq-* commands you should
set an environment variable
ALPHAVANTAGE_API_KEY.
Please consult the manual of
your OS or command shell.

Example A.1. Environment
variable in .bashrc

export ALPHAVANTAGE_API_KEY=##############

Amsterdam Euronext eXchange,
NL

aex

https://www.aex.nl

includes former sources AEX-
“Futures” and -“Options”

American International
Assurance, HK

aiahk https://www.aia.com.hk
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GnuCash Name Finance::Quote Name URL, Notes

Association of Mutual Funds In
India, IN

amfiindia https://www.amfiindia.com

Athens Stock Exchange, GR asegr https://www.ase.gr

Australian Stock Exchange, AU asx

https://www.asx.com.au

Requires at least F::Q 1.41, but
unfortunately the ASX website
is only working sometimes. And
then only with a small no of
stocks in 1 go. From final
comment on:  Price editor
does not find ASX:XRO [https://
bugs.gnucash.org/show_bug.cgi?
id=770132#c12]

BAMOSZ funds, HU bamosz https://www.bamosz.hu

BMO NesbittBurns, CA bmonesbittburns https://bmonesbittburns.com

Bucharest Stock Exchange (Bursa
de Valori Bucuresti), RO

bsero https://www.bvb.ro

Budapest Stock Exchange (BET),
ex-BUX, HU

bse or bet https://www.bet.hu

Citywire Funds, GB citywire https://citywire.co.uk

Colombo Stock Exchange, LK cse https://www.cse.lk

Cominvest Asset Management,
ex-Adig, DE

cominvest

https://www.cominvest-am.de

Obsolete, update: https://
eggert.org/software/
Comdirect.pm

Deka Investments, DE deka https://www.deka.de

DWS, DE dwsfunds https://www.dws.de

Equinox Unit Trusts, ZA za_unittrusts https://www.equinox.co.za

Fidelity Investments, US fidelity_direct https://www.fidelity.com

Fidelity Fixed, US fidelityfixed
https://www.fidelity.com/fixed-
income-bonds/overview

Finance Canada financecanada https://finance.canada.com

Financial Times Funds service,
GB

ftfunds https://funds.ft.com

Finanzpartner, DE finanzpartner https://www.finanzpartner.de

First Trust Portfolios, US ftportfolios_direct https://www.ftportfolios.com

Fund Library, CA fundlibrary

https://www.fundlibrary.com

This module uses an id that
represents the mutual fund on
www.fundlibrary.com. There is
no easy way of fetching the
id except to jump onto the
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GnuCash Name Finance::Quote Name URL, Notes

fundlibrary website, look up the
fund and view the url for clues to
its id number.

GoldMoney spot rates, JE goldmoney https://www.goldmoney.com

HElsinki stock eXchange, FI hex https://www.hex.com

Man Investments, AU maninv
https://
www.maninvestments.com.au

Morningstar, GB mstaruk https://morningstar.co.uk

Morningstar, JP morningstarjp https://www.morningstar.co.jp

Morningstar, SE morningstar https://www.morningstar.se

Motley Fool, US fool https://www.fool.com

New Zealand stock eXchange, NZ nzx https://www.nzx.com

Paris Stock Exchange/
Boursorama, FR

bourso https://www.boursorama.com

Paris Stock Exchange/LeRevenu,
FR

lerevenu https://bourse.lerevenu.com

Platinum Asset Management, AU platinum https://www.platinum.com.au

SIX Swiss Exchange Funds, CH sixfunds
https://www.six-swiss-
exchange.com

SIX Swiss Exchange Shares, CH sixshares
https://www.six-swiss-
exchange.com

Skandinaviska Enskilda Banken
funds, SE

seb_funds

https://www.seb.se

Consult https://taz.vv.sebank.se/
cgi-bin/pts3/pow/Fonder/kurser/
kurslista_body.asp for all
available funds.

Sharenet, ZA za https://www.sharenet.co.za

StockHouse Canada, CA stockhousecanada_fund https://www.stockhouse.ca

TD Waterhouse Funds, CA tdwaterhouse
https://
www.tdassetmanagement.com

TD Efunds, CA tdefunds https://www.tdwaterhouse.ca

TIAA-CREF, US tiaacref https://www.tiaa-cref.org

Toronto Stock eXchange, CA tsx https://www.TMXmoney.com

T. Rowe Price, US troweprice_direct https://www.troweprice.com

Trustnet via tnetuk.pm, GB tnetuk https://www.trustnet.com

Trustnet via trustnet.pm, GB trustnet https://www.trustnet.com

Union Investment, DE unionfunds https://www.union-invest.de

US Treasury Bonds, US usfedbonds https://www.publicdebt.treas.gov

US Govt. Thrift Savings Plan, US tsp https://www.tsp.gov

Vanguard, US vanguard part of AlphaVantage

216

https://www.goldmoney.com
https://www.hex.com
https://www.maninvestments.com.au
https://www.maninvestments.com.au
https://morningstar.co.uk
https://www.morningstar.co.jp
https://www.morningstar.se
https://www.fool.com
https://www.nzx.com
https://www.boursorama.com
https://bourse.lerevenu.com
https://www.platinum.com.au
https://www.six-swiss-exchange.com
https://www.six-swiss-exchange.com
https://www.six-swiss-exchange.com
https://www.six-swiss-exchange.com
https://www.seb.se
https://taz.vv.sebank.se/cgi-bin/pts3/pow/Fonder/kurser/kurslista_body.asp
https://taz.vv.sebank.se/cgi-bin/pts3/pow/Fonder/kurser/kurslista_body.asp
https://taz.vv.sebank.se/cgi-bin/pts3/pow/Fonder/kurser/kurslista_body.asp
https://www.sharenet.co.za
https://www.stockhouse.ca
https://www.tdassetmanagement.com
https://www.tdassetmanagement.com
https://www.tdwaterhouse.ca
https://www.tiaa-cref.org
https://www.TMXmoney.com
https://www.troweprice.com
https://www.trustnet.com
https://www.trustnet.com
https://www.union-invest.de
https://www.publicdebt.treas.gov
https://www.tsp.gov


GnuCash Tips and tidbits

GnuCash Name Finance::Quote Name URL, Notes

VWD, DE (unmaintained) vwd
See https://lists.gnucash.org/
pipermail/gnucash-user/2008-
February/023686.html

Yahoo USA

Yahoo Asia

Yahoo Australia

Yahoo Brasil

Yahoo Europe

Yahoo New Zealand

yahoo

yahoo_asia

yahoo_australia

yahoo_brasil

yahoo_europe

yahoo_nz

CSV interface since 2017-11-01
shut off

Yahoo as JSON, US yahoo_json
https://finance.yahoo.com/
through "JavaScript Object
Notation"

Yahoo as YQL, US yahoo_yql
https://finance.yahoo.com/
through "Yahoo Query Language"

Zuerich Investments (replaced) zifunds
Zürich Invest has been purchased
by Deutsche Bank and integrated
into DWS.

Finance::Quote Sources - Multiple sources
Here the first successful result of a list of sources gets returned.

Table A.3. Multiple sources for quotes

Name

Asia disappeared with Yahoo

Australia (ASX, ...)

Brasil disappeared with Yahoo

Canada (Alphavantage, TSX, ...)

Canada Mutual (Fund Library, StockHouse, ...)

Dutch (AEX, ...)

Europe (asegr,.bsero, hex ...)

Greece (ASE, ...)

Hungary (Bamosz, BET, ...)

India Mutual (AMFI, ...)

Fidelity (Fidelity, ...)

Finland (HEX, ...)

First Trust (First Trust, ...)

France (Boursorama, LeRevenu, ...)

Nasdaq (Alphavantage, Fool, ...)
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Name

New Zealand (NZX, ...)

NYSE (Alphavantage, Fool, ...)

South Africa (Sharenet, ...)

Romania (bsero, ...)

T. Rowe Price

U.K. Funds (citywire, FTfunds, MStar, tnetuk, ...)

U.K. Unit Trusts (trustnet, ...)

USA (Alphavantage, Fool ...)

Sources: src/engine/gnc-commodity.c:gnc_quote_source (commit c0fd3b3, which was adjusted for
Finance::Quote 1.47), GnuCash-Wiki [https://wiki.gnucash.org/wiki/], bugzilla [https://bugs.gnucash.org/
page.cgi?id=browse.html&product=GnuCash], mailing list archive [https://wiki.gnucash.org/wiki/
Mailing_Lists#Mailing_List_Archives].

Yahoo Specifics
Yahoo has offered quotes from many exchanges and markets. Alphavatage will behave similar but without delay.
If you are not asking for US markets, you have to specify where to look. A typical Yahoo symbol has the form
<ISIN><markets suffix>.

Table A.4. Yahoo Codes for Exchanges and Markets

Country Exchange Suffix Delay

Argentina Buenos Aires Stock
Exchange

.BA 30 min

Australia Australian Stock
Exchange

.AX 20 min

Austria Vienna Stock Exchange .VI 15 min

Brazil BOVESPA - Sao Paolo
Stock Exchange

.SA 15 min

Canada Toronto Stock Exchange .TO 15 min

Canada TSX Venture Exchange .V 15 min

Chile Santiago Stock
Exchange

.SN 15 min

China Shanghai Stock
Exchange

.SS 30 min

China Shenzhen Stock
Exchange

.SZ 30 min

Denmark Copenhagen Stock
Exchange

.CO 15 min

France Euronext .NX 15 min

France Paris Stock Exchange .PA 15 min

Germany Berlin Stock Exchange .BE 15 min

Germany Bremen Stock Exchange .BM 15 min
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Country Exchange Suffix Delay

Germany Dusseldorf Stock
Exchange

.DU 15 min

Germany Frankfurt Stock
Exchange

.F 15 min

Germany Hamburg Stock
Exchange

.HM 15 min

Germany Hanover Stock Exchange .HA 15 min

Germany Munich Stock Exchange .MU 15 min

Germany Stuttgart Stock Exchange .SG 15 min

Germany XETRA Stock Exchange .DE 15 min

Greece Athens Stock Exchange .AT 15 min

Hong Kong Hong Kong Stock
Exchange

.HK 15 min

India Bombay Stock Exchange .BO 15 min

India National Stock Exchange
of India

.NS Real-time**

Indonesia Jakarta Stock Exchange .JK 10 min

Israel Tel Aviv Stock
Exchange

.TA 20 min

Italy Milan Stock Exchange .MI 20 min

Japan Nikkei Indices N/A 30 min

Mexico Mexico Stock Exchange .MX 20 min

Netherlands Amsterdam Stock
Exchange

.AS 15 min

New Zealand New Zealand Stock
Exchange

.NZ 20 min

Norway Oslo Stock Exchange .OL 15 min

Russia Moscow Interbank
Currency Exchange
(MICEX)

.ME 15 min

Singapore Singapore Stock
Exchange

.SI 20 min

South Korea Korea Stock Exchange .KS 20 min

South Korea KOSDAQ .KQ 20 min

Spain Barcelona Stock
Exchange

.BC 15 min

Spain Bilbao Stock Exchange .BI 15 min

Spain Madrid Fixed Income
Market

.MF 15 min

Spain Madrid SE C.A.T.S. .MC 15 min

Spain Madrid Stock Exchange .MA 15 min
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Country Exchange Suffix Delay

Sweden Stockholm Stock
Exchange

.ST 15 min

Switzerland Swiss Exchange .SW 30 min

Taiwan Taiwan OTC Exchange .TWO 20 min

Taiwan Taiwan Stock Exchange .TW 20 min

United Kingdom FTSE Indices N/A 15 min

United Kingdom London Stock Exchange .L 20 min

United Kingdom London Stock Exchange .IL 20 min

United States of America BATS Exchange N/A Real-time

United States of America Chicago Board of Trade .CBT 10 min

United States of America Chicago Mercantile
Exchange

.CME 10 min

United States of America Dow Jones Indexes N/A Real-time

United States of America NASDAQ Stock
Exchange

N/A Real-time*

United States of America New York Board of
Trade

.NYB 30 min

United States of America New York Commodities
Exchange

.CMX 30 min

United States of America New York Mercantile
Exchange

.NYM 30 min

United States of America New York Stock
Exchange

N/A Real-time*

United States of America NYSE Mkt N/A Real-time*

United States of America OTC Bulletin Board
Market

N/A Real-time*

United States of America OTC Markets Group N/A 15 min

United States of America S & P Indices N/A Real-time

Source: https://help.yahoo.com/l/us/yahoo/finance/quotes/fitadelay.html queried at 2012-09-22.

TIAA-CREF Specifics
TIAA-CREF Annuities are not listed on any exchange, unlike their mutual funds TIAA-CREF provides unit values
via a cgi on their website. The cgi returns a csv file in the format

          
bogus_symbol1,price1,date1
bogus_symbol2,price2,date2
..etc.
          
        

where bogus_symbol takes on the following values for the various annuities:

220

https://help.yahoo.com/l/us/yahoo/finance/quotes/fitadelay.html


GnuCash Tips and tidbits

Note

The symbols are case-sensitive and changed their capitalization in the last time.

Table A.5. Pseudo-symbols that can be used for TIAA-CREF quotes

Name Symbol bogus

CREF Bond Market Account CREFbond 41081991

CREF Equity Index Account CREFequi 41082540

CREF Global Equities Account CREFglob 41081992

CREF Growth Account CREFgrow 41082544

CREF Inflation-Linked Bond
Account

CREFinfb 41088773

CREF Money Market Account CREFmony 41081993

CREF Social Choice Account CREFsoci 41081994

CREF Stock Account CREFstok 41081995

TIAA Real Estate Account TIAAreal 41091375

TIAA-CREF Bond Fund
(Retirement)

TIDRX 4530828

TIAA-CREF Bond Index Fund
(Retirement)

TBIRX 20739662

TIAA-CREF Bond Plus Fund
(Retirement)

TCBRX 4530816

TIAA-CREF Emerging Markets
Equity Fund (Retirement)

TEMSX 26176543

TIAA-CREF Emerging Markets
Equity Index Fund (Retirement)

TEQSX 26176547

TIAA-CREF Equity Index Fund
(Retirement)

TIQRX 4530786

TIAA-CREF Global Natural
Resources Fund (Retirement)

TNRRX 39444919

TIAA-CREF Growth & Income
Fund (Retirement)

TRGIX 312536

TIAA-CREF High Yield Fund
(Retirement)

TIHRX 4530821

TIAA-CREF Inflation-Linked
Bond Fund (Retirement)

TIKRX 4530829

TIAA-CREF International Equity
Fund (Retirement)

TRERX 302323

TIAA-CREF International Equity
Index Fund (Retirement)

TRIEX 300269

TIAA-CREF Large-Cap Growth
Fund (Retirement)

TILRX 4530785

TIAA-CREF Large-Cap Growth
Index Fund (Retirement)

TRIRX 299525
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Name Symbol bogus

TIAA-CREF Large-Cap Value
Fund (Retirement)

TRLCX 301332

TIAA-CREF Large-Cap Value
Index Fund (Retirement)

TRCVX 304333

TIAA-CREF Lifecycle 2010 Fund
(Retirement)

TCLEX 302817

TIAA-CREF Lifecycle 2015 Fund
(Retirement)

TCLIX 302393

TIAA-CREF Lifecycle 2020 Fund
(Retirement)

TCLTX 307774

TIAA-CREF Lifecycle 2025 Fund
(Retirement)

TCLFX 313994

TIAA-CREF Lifecycle 2030 Fund
(Retirement)

TCLNX 307240

TIAA-CREF Lifecycle 2035 Fund
(Retirement)

TCLRX 309003

TIAA-CREF Lifecycle 2040 Fund
(Retirement)

TCLOX 300959

TIAA-CREF Lifecycle 2045 Fund
(Retirement)

TTFRX 9467597

TIAA-CREF Lifecycle 2050 Fund
(Retirement)

TLFRX 9467596

TIAA-CREF Lifecycle 2055 Fund
(Retirement)

TTRLX 34211330

TIAA-CREF Lifecycle Index
2010 Fund (Retirement)

TLTRX 21066482

TIAA-CREF Lifecycle Index
2015 Fund (Retirement)

TLGRX 21066496

TIAA-CREF Lifecycle Index
2020 Fund (Retirement)

TLWRX 21066479

TIAA-CREF Lifecycle Index
2025 Fund (Retirement)

TLQRX 21066485

TIAA-CREF Lifecycle Index
2030 Fund (Retirement)

TLHRX 21066435

TIAA-CREF Lifecycle Index
2035 Fund (Retirement)

TLYRX 21066475

TIAA-CREF Lifecycle Index
2040 Fund (Retirement)

TLZRX 21066473

TIAA-CREF Lifecycle Index
2045 Fund (Retirement)

TLMRX 21066488

TIAA-CREF Lifecycle Index
2050 Fund (Retirement)

TLLRX 21066490

TIAA-CREF Lifecycle Index
2055 Fund (Retirement)

TTIRX 34211328
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Name Symbol bogus

TIAA-CREF Lifecycle Index
Retirement Income Fund
(Retirement)

TRCIX 21066468

TIAA-CREF Lifecycle
Retirement Income Fund
(Retirement)

TLIRX 9467594

TIAA-CREF Lifestyle
Aggressive Growth Fund
(Retirement)

TSARX 40508431

TIAA-CREF Lifestyle
Conservative Fund (Retirement)

TSCTX 40508433

TIAA-CREF Lifestyle Growth
Fund (Retirement)

TSGRX 40508437

TIAA-CREF Lifestyle Income
Fund (Retirement)

TLSRX 40508427

TIAA-CREF Lifestyle Moderate
Fund (Retirement)

TSMTX 40508460

TIAA-CREF Managed Allocation
Fund (Retirement)

TITRX 4530825

TIAA-CREF Mid-Cap Growth
Fund (Retirement)

TRGMX 305499

TIAA-CREF Mid-Cap Value
Fund (Retirement)

TRVRX 315272

TIAA-CREF Money Market Fund
(Retirement)

TIEXX 4530771

TIAA-CREF Real Estate
Securities Fund (Retirement)

TRRSX 300081

TIAA-CREF S&P 500 Index
Fund (Retirement)

TRSPX 306105

TIAA-CREF Short-Term Bond
Fund (Retirement)

TISRX 4530818

TIAA-CREF Small-Cap Blend
Index Fund (Retirement)

TRBIX 314644

TIAA-CREF Small-Cap Equity
Fund (Retirement)

TRSEX 299968

TIAA-CREF Social Choice
Equity Fund (Retirement)

TRSCX 300078

TIAA-CREF Bond Fund
(Institutional)

TIBDX 307276

TIAA-CREF Bond Index Fund
(Institutional)

TBIIX 20739664

TIAA-CREF Bond Plus Fund
(Institutional)

TIBFX 4530820
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Name Symbol bogus

TIAA-CREF Emerging Markets
Equity Fund (Institutional)

TEMLX 26176540

TIAA-CREF Emerging Markets
Equity Index Fund (Institutional)

TEQLX 26176544

TIAA-CREF Enhanced
International Equity Index Fund
(Institutional)

TFIIX 9467603

TIAA-CREF Enhanced Large-
Cap Growth Index Fund
(Institutional)

TLIIX 9467602

TIAA-CREF Enhanced Large-
Cap Value Index Fund
(Institutional)

TEVIX 9467606

TIAA-CREF Equity Index Fund
(Institutional)

TIEIX 301718

TIAA-CREF Global Natural
Resources Fund (Institutional)

TNRIX 39444916

TIAA-CREF Growth & Income
Fund (Institutional)

TIGRX 314719

TIAA-CREF High Yield Fund
(Institutional)

TIHYX 4530798

TIAA-CREF Inflation-Linked
Bond Fund (Institutional)

TIILX 316693

TIAA-CREF International Equity
Fund (Institutional)

TIIEX 305980

TIAA-CREF International Equity
Index Fund (Institutional)

TCIEX 303673

TIAA-CREF Large-Cap Growth
Fund (Institutional)

TILGX 4530800

TIAA-CREF Large-Cap Growth
Index Fund (Institutional)

TILIX 297809

TIAA-CREF Large-Cap Value
Fund (Institutional)

TRLIX 300692

TIAA-CREF Large-Cap Value
Index Fund (Institutional)

TILVX 302308

TIAA-CREF Lifecycle 2010 Fund
(Institutional)

TCTIX 4912376

TIAA-CREF Lifecycle 2015 Fund
(Institutional)

TCNIX 4912355

TIAA-CREF Lifecycle 2020 Fund
(Institutional)

TCWIX 4912377

TIAA-CREF Lifecycle 2025 Fund
(Institutional)

TCYIX 4912384
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Name Symbol bogus

TIAA-CREF Lifecycle 2030 Fund
(Institutional)

TCRIX 4912364

TIAA-CREF Lifecycle 2035 Fund
(Institutional)

TCIIX 4912375

TIAA-CREF Lifecycle 2040 Fund
(Institutional)

TCOIX 4912387

TIAA-CREF Lifecycle 2045 Fund
(Institutional)

TTFIX 9467607

TIAA-CREF Lifecycle 2050 Fund
(Institutional)

TFTIX 9467601

TIAA-CREF Lifecycle 2055 Fund
(Institutional)

TTRIX 34211329

TIAA-CREF Lifecycle Index
2010 Fund (Institutional)

TLTIX 21066484

TIAA-CREF Lifecycle Index
2015 Fund (Institutional)

TLFIX 21066498

TIAA-CREF Lifecycle Index
2020 Fund (Institutional)

TLWIX 21066480

TIAA-CREF Lifecycle Index
2025 Fund (Institutional)

TLQIX 21066486

TIAA-CREF Lifecycle Index
2030 Fund (Institutional)

TLHIX 21066495

TIAA-CREF Lifecycle Index
2035 Fund (Institutional)

TLYIX 21066477

TIAA-CREF Lifecycle Index
2040 Fund (Institutional)

TLZIX 21066474

TIAA-CREF Lifecycle Index
2045 Fund (Institutional)

TLXIX 21066478

TIAA-CREF Lifecycle Index
2050 Fund (Institutional)

TLLIX 21066492

TIAA-CREF Lifecycle Index
2055 Fund (Institutional)

TTIIX 34211326

TIAA-CREF Lifecycle Index
Retirement Income Fund
(Institutional)

TRILX 21066463

TIAA-CREF Lifecycle
Retirement Income Fund
(Institutional)

TLRIX 9467595

TIAA-CREF Lifestyle
Aggressive Growth Fund
(Institutional)

TSAIX 40508428

TIAA-CREF Lifestyle
Conservative Fund (Institutional)

TCSIX 40508425
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Name Symbol bogus

TIAA-CREF Lifestyle Growth
Fund (Institutional)

TSGGX 40508434

TIAA-CREF Lifestyle Income
Fund (Institutional)

TSITX 40508450

TIAA-CREF Lifestyle Moderate
Fund (Institutional)

TSIMX 40508443

TIAA-CREF Managed Allocation
Fund (Institutional)

TIMIX 4530787

TIAA-CREF Mid-Cap Growth
Fund (Institutional)

TRPWX 297210

TIAA-CREF Mid-Cap Value
Fund (Institutional)

TIMVX 316178

TIAA-CREF Money Market Fund
(Institutional)

TCIXX 313650

TIAA-CREF Real Estate
Securities Fund (Institutional)

TIREX 303475

TIAA-CREF S&P 500 Index
Fund (Institutional)

TISPX 306658

TIAA-CREF Short-Term Bond
Fund (Institutional)

TISIX 4530784

TIAA-CREF Small-Cap Blend
Index Fund (Institutional)

TISBX 309018

TIAA-CREF Small-Cap Equity
Fund (Institutional)

TISEX 301622

TIAA-CREF Social Choice
Equity Fund (Institutional)

TISCX 301897

TIAA-CREF Tax-Exempt Bond
Fund (Institutional)

TITIX 4530819

TIAA-CREF Bond Fund (Retail) TIORX 4530794

TIAA-CREF Bond Index Fund
(Retail)

TBILX 20739663

TIAA-CREF Bond Plus Fund
(Retail)

TCBPX 4530788

TIAA-CREF Emerging Markets
Equity Fund (Retail)

TEMRX 26176542

TIAA-CREF Emerging Markets
Equity Index Fund (Retail)

TEQKX 26176545

TIAA-CREF Equity Index Fund
(Retail)

TINRX 4530797

TIAA-CREF Global Natural
Resources Fund (Retail)

TNRLX 39444917

TIAA-CREF Growth & Income
Fund (Retail)

TIIRX 4530790
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Name Symbol bogus

TIAA-CREF High Yield Fund
(Retail)

TIYRX 4530830

TIAA-CREF Inflation-Linked
Bond Fund (Retail)

TCILX 313727

TIAA-CREF International Equity
Fund (Retail)

TIERX 4530827

TIAA-CREF Large-Cap Growth
Fund (Retail)

TIRTX 4530791

TIAA-CREF Large-Cap Value
Fund (Retail)

TCLCX 302696

TIAA-CREF Lifecycle
Retirement Income Fund (Retail)

TLRRX 9467600

TIAA-CREF Lifestyle
Aggressive Growth Fund (Retail)

TSALX 40508429

TIAA-CREF Lifestyle
Conservative Fund (Retail)

TSCLX 40508432

TIAA-CREF Lifestyle Growth
Fund (Retail)

TSGLX 40508435

TIAA-CREF Lifestyle Income
Fund (Retail)

TSILX 40508438

TIAA-CREF Lifestyle Moderate
Fund (Retail)

TSMLX 40508453

TIAA-CREF Managed Allocation
Fund (Retail)

TIMRX 4530817

TIAA-CREF Mid-Cap Growth
Fund (Retail)

TCMGX 305208

TIAA-CREF Mid-Cap Value
Fund (Retail)

TCMVX 313995

TIAA-CREF Money Market Fund
(Retail)

TIRXX 4530775

TIAA-CREF Real Estate
Securities Fund (Retail)

TCREX 309567

TIAA-CREF Short-Term Bond
Fund (Retail)

TCTRX 4530822

TIAA-CREF Small-Cap Equity
Fund (Retail)

TCSEX 297477

TIAA-CREF Social Choice
Equity Fund (Retail)

TICRX 4530792

TIAA-CREF Tax-Exempt Bond
Fund (Retail)

TIXRX 4530793

TIAA-CREF Bond Fund
(Premier)

TIDPX 21066506

TIAA-CREF Bond Index Fund
(Premier)

TBIPX 21066534
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Name Symbol bogus

TIAA-CREF Bond Plus Fund
(Premier)

TBPPX 21066533

TIAA-CREF Emerging Markets
Equity Fund (Premier)

TEMPX 26176541

TIAA-CREF Emerging Markets
Equity Index Fund (Premier)

TEQPX 26176546

TIAA-CREF Equity Index Fund
(Premier)

TCEPX 21066530

TIAA-CREF Global Natural
Resources Fund (Premier)

TNRPX 39444918

TIAA-CREF Growth & Income
Fund (Premier)

TRPGX 21066461

TIAA-CREF High Yield Fund
(Premier)

TIHPX 21066501

TIAA-CREF Inflation-Linked
Bond Fund (Premier)

TIKPX 21066500

TIAA-CREF International Equity
Fund (Premier)

TREPX 21066466

TIAA-CREF International Equity
Index Fund (Premier)

TRIPX 21066462

TIAA-CREF Large-Cap Growth
Fund (Premier)

TILPX 21066499

TIAA-CREF Large-Cap Value
Fund (Premier)

TRCPX 21066467

TIAA-CREF Lifecycle 2010 Fund
(Premier)

TCTPX 21066521

TIAA-CREF Lifecycle 2015 Fund
(Premier)

TCFPX 21066528

TIAA-CREF Lifecycle 2020 Fund
(Premier)

TCWPX 21066518

TIAA-CREF Lifecycle 2025 Fund
(Premier)

TCQPX 21066522

TIAA-CREF Lifecycle 2030 Fund
(Premier)

TCHPX 21066527

TIAA-CREF Lifecycle 2035 Fund
(Premier)

TCYPX 21066517

TIAA-CREF Lifecycle 2040 Fund
(Premier)

TCZPX 21066516

TIAA-CREF Lifecycle 2045 Fund
(Premier)

TTFPX 21066444

TIAA-CREF Lifecycle 2050 Fund
(Premier)

TCLPX 21066526

TIAA-CREF Lifecycle 2055 Fund
(Premier)

TTRPX 34211331
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Name Symbol bogus

TIAA-CREF Lifecycle Index
2010 Fund (Premier)

TLTPX 21066483

TIAA-CREF Lifecycle Index
2015 Fund (Premier)

TLFPX 21066497

TIAA-CREF Lifecycle Index
2020 Fund (Premier)

TLWPX 21066434

TIAA-CREF Lifecycle Index
2025 Fund (Premier)

TLVPX 21066481

TIAA-CREF Lifecycle Index
2030 Fund (Premier)

TLHPX 21066494

TIAA-CREF Lifecycle Index
2035 Fund (Premier)

TLYPX 21066476

TIAA-CREF Lifecycle Index
2040 Fund (Premier)

TLPRX 21066487

TIAA-CREF Lifecycle Index
2045 Fund (Premier)

TLMPX 21066489

TIAA-CREF Lifecycle Index
2050 Fund (Premier)

TLLPX 21066491

TIAA-CREF Lifecycle Index
2055 Fund (Premier)

TTIPX 34211327

TIAA-CREF Lifecycle Index
Retirement Income Fund
(Premier)

TLIPX 21066493

TIAA-CREF Lifecycle
Retirement Income Fund
(Premier)

TPILX 21066470

TIAA-CREF Lifestyle
Aggressive Growth Fund
(Premier)

TSAPX 40508430

TIAA-CREF Lifestyle
Conservative Fund (Premier)

TLSPX 40508426

TIAA-CREF Lifestyle Growth
Fund (Premier)

TSGPX 40508436

TIAA-CREF Lifestyle Income
Fund (Premier)

TSIPX 40508451

TIAA-CREF Lifestyle Moderate
Fund (Premier)

TSMPX 40508456

TIAA-CREF Mid-Cap Growth
Fund (Premier)

TRGPX 21066464

TIAA-CREF Mid-Cap Value
Fund (Premier)

TRVPX 21066455

TIAA-CREF Money Market Fund
(Premier)

TPPXX 21066469
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Name Symbol bogus

TIAA-CREF Real Estate
Securities Fund (Premier)

TRRPX 21066459

TIAA-CREF Short-Term Bond
Fund (Premier)

TSTPX 21066445

TIAA-CREF Small-Cap Equity
Fund (Premier)

TSRPX 21066446

TIAA-CREF Social Choice
Equity Fund (Premier)

TRPSX 21066460

Source: Comments in https://rt.cpan.org/Ticket/Attachment/1121440/589997/Tiaacref.pm.zip
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Appendix B. GNU Free Documentation
License

Version 1.1, March 2000
Copyright © 2000 Free Software Foundation, Inc.

Free Software Foundation, Inc. 59 Temple Place,
        Suite 330, Boston, MA
        02111-1307  USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it
is not allowed.

0. PREAMBLE
The purpose of this License is to make a manual, textbook, or other written document “free” in the sense of
freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying it,
either commercially or noncommercially. Secondarily, this License preserves for the author and publisher
a way to get credit for their work, while not being considered responsible for modifications made by others.

This License is a kind of “copyleft”, which means that derivative works of the document must themselves
be free in the same sense. It complements the GNU General Public License, which is a copyleft license
designed for free software.

We have designed this License in order to use it for manuals for free software, because free software
needs free documentation: a free program should come with manuals providing the same freedoms that
the software does. But this License is not limited to software manuals; it can be used for any textual work,
regardless of subject matter or whether it is published as a printed book. We recommend this License
principally for works whose purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS
This License applies to any manual or other work that contains a notice placed by the copyright holder
saying it can be distributed under the terms of this License. The “Document”, below, refers to any such
manual or work. Any member of the public is a licensee, and is addressed as “you”.

A “Modified Version” of the Document means any work containing the Document or a portion of it, either
copied verbatim, or with modifications and/or translated into another language.

A “Secondary Section” is a named appendix or a front-matter section of the Document that deals
exclusively with the relationship of the publishers or authors of the Document to the Document’s overall
subject (or to related matters) and contains nothing that could fall directly within that overall subject. (For
example, if the Document is in part a textbook of mathematics, a Secondary Section may not explain any
mathematics.) The relationship could be a matter of historical connection with the subject or with related
matters, or of legal, commercial, philosophical, ethical or political position regarding them.

The “Invariant Sections” are certain  Secondary Sections whose titles are designated, as being those of
Invariant Sections, in the notice that says that the Document is released under this License.

The “Cover Texts” are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover
Texts, in the notice that says that the Document is released under this License.
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A “Transparent” copy of the  Document means a machine-readable copy, represented in a format whose
specification is available to the general public, whose contents can be viewed and edited directly and
straightforwardly with generic text editors or (for images composed of pixels) generic paint programs or
(for drawings) some widely available drawing editor, and that is suitable for input to text formatters or
for automatic translation to a variety of formats suitable for input to text formatters. A copy made in an
otherwise Transparent file format whose markup has been designed to thwart or discourage subsequent
modification by readers is not Transparent. A copy that is not “Transparent” is called “Opaque”.

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input
format, LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming
simple HTML designed for human modification. Opaque formats include PostScript, PDF, proprietary
formats that can be read and edited only by proprietary word processors, SGML or XML for which the
DTD and/or processing tools are not generally available, and the machine-generated HTML produced by
some word processors for output purposes only.

The “Title Page” means, for a printed book, the title page itself, plus such following pages as are needed
to hold, legibly, the material this License requires to appear in the title page. For works in formats which
do not have any title page as such, “Title Page” means the text near the most prominent appearance of the
work’s title, preceding the beginning of the body of the text.

2. VERBATIM COPYING
You may copy and distribute the Document in any medium, either commercially or noncommercially,
provided that this License, the copyright notices, and the license notice saying this License applies to the
Document are reproduced in all copies, and that you add no other conditions whatsoever to those of this
License. You may not use technical measures to obstruct or control the reading or further copying of the
copies you make or distribute. However, you may accept compensation in exchange for copies. If you
distribute a large enough number of copies you must also follow the conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.

3. COPYING IN QUANTITY
If you publish printed copies of the Document numbering more than 100, and the Document’s license
notice requires Cover Texts, you must enclose the copies in covers that carry, clearly and legibly, all these
Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts on the back cover. Both covers
must also clearly and legibly identify you as the publisher of these copies. The front cover must present
the full title with all words of the title equally prominent and visible. You may add other material on the
covers in addition. Copying with changes limited to the covers, as long as they preserve the title of the
Document and satisfy these conditions, can be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed
(as many as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either
include a machine-readable Transparent copy along with each Opaque copy, or state in or with each
Opaque copy a publicly-accessible computer-network location containing a complete Transparent copy
of the Document, free of added material, which the general network-using public has access to download
anonymously at no charge using public-standard network protocols. If you use the latter option, you must
take reasonably prudent steps, when you begin distribution of Opaque copies in quantity, to ensure that this
Transparent copy will remain thus accessible at the stated location until at least one year after the last time
you distribute an Opaque copy (directly or through your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing
any large number of copies, to give them a chance to provide you with an updated version of the Document.
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4. MODIFICATIONS
You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and
3 above, provided that you release the Modified Version under precisely this License, with the Modified
Version filling the role of the Document, thus licensing distribution and modification of the Modified
Version to whoever possesses a copy of it. In addition, you must do these things in the Modified Version:

• A.  Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and
from those of previous versions (which should, if there were any, be listed in the History section of the
Document). You may use the same title as a previous version if the original publisher of that version
gives permission.

• B.  List on the Title Page, as authors, one or more persons or entities responsible for authorship of
the modifications in the Modified Version, together with at least five of the principal authors of the
Document (all of its principal authors, if it has less than five).

• C.  State on the Title Page the name of the publisher of the Modified Version, as the publisher.

• D.  Preserve all the copyright notices of the Document.

• E.  Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

• F.  Include, immediately after the copyright notices, a license notice giving the public permission to
use the Modified Version under the terms of this License, in the form shown in the Addendum below.

• G.  Preserve in that license notice the full lists of  Invariant Sections and required Cover Texts given
in the Document’s license notice.

• H.  Include an unaltered copy of this License.

• I.  Preserve the section entitled “History”, and its title, and add to it an item stating at least the title,
year, new authors, and publisher of the Modified Version as given on the Title Page. If there is no
section entitled “History” in the Document, create one stating the title, year, authors, and publisher of
the Document as given on its Title Page, then add an item describing the Modified Version as stated
in the previous sentence.

• J.  Preserve the network location, if any, given in the Document for public access to a Transparent
copy of the Document, and likewise the network locations given in the Document for previous versions
it was based on. These may be placed in the “History” section. You may omit a network location for
a work that was published at least four years before the Document itself, or if the original publisher of
the version it refers to gives permission.

• K.  In any section entitled “Acknowledgements” or “Dedications”, preserve the section’s title, and
preserve in the section all the substance and tone of each of the contributor acknowledgements and/or
dedications given therein.

• L.  Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles.
Section numbers or the equivalent are not considered part of the section titles.

• M.  Delete any section entitled “Endorsements”. Such a section may not be included in the Modified
Version.

• N.  Do not retitle any existing section as “Endorsements” or to conflict in title with any Invariant
Section.
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If the Modified Version includes new front-matter sections or appendices that qualify as Secondary
Sections and contain no material copied from the Document, you may at your option designate some or
all of these sections as invariant. To do this, add their titles to the list of Invariant Sections in the Modified
Version’s license notice. These titles must be distinct from any other section titles.

You may add a section entitled “Endorsements”, provided it contains nothing but endorsements of your
Modified Version by various parties--for example, statements of peer review or that the text has been
approved by an organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as
a Back-Cover Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of
Front-Cover Text and one of Back-Cover Text may be added by (or through arrangements made by) any
one entity. If the Document already includes a cover text for the same cover, previously added by you or
by arrangement made by the same entity you are acting on behalf of, you may not add another; but you
may replace the old one, on explicit permission from the previous publisher that added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their names
for publicity for or to assert or imply endorsement of any Modified Version .

5. COMBINING DOCUMENTS
You may combine the Document with other documents released under this License, under the terms
defined in section 4 above for modified versions, provided that you include in the combination all of the
Invariant Sections of all of the original documents, unmodified, and list them all as Invariant Sections of
your combined work in its license notice.

The combined work need only contain one copy of this License, and multiple identical Invariant Sections
may be replaced with a single copy. If there are multiple Invariant Sections with the same name but
different contents, make the title of each such section unique by adding at the end of it, in parentheses, the
name of the original author or publisher of that section if known, or else a unique number. Make the same
adjustment to the section titles in the list of Invariant Sections in the license notice of the combined work.

In the combination, you must combine any sections entitled “History” in the various original documents,
forming one section entitled “History”; likewise combine any sections entitled “Acknowledgements”, and
any sections entitled “Dedications”. You must delete all sections entitled “Endorsements.”

6. COLLECTIONS OF DOCUMENTS
You may make a collection consisting of the Document and other documents released under this License,
and replace the individual copies of this License in the various documents with a single copy that is included
in the collection, provided that you follow the rules of this License for verbatim copying of each of the
documents in all other respects.

You may extract a single document from such a collection, and dispbibute it individually under this
License, provided you insert a copy of this License into the extracted document, and follow this License
in all other respects regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT
WORKS

A compilation of the Document or its derivatives with other separate and independent documents or works,
in or on a volume of a storage or distribution medium, does not as a whole count as a Modified Version
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of the Document, provided no compilation copyright is claimed for the compilation. Such a compilation
is called an “aggregate”, and this License does not apply to the other self-contained works thus compiled
with the Document , on account of their being thus compiled, if they are not themselves derivative works
of the Document. If the Cover Text requirement of section 3 is applicable to these copies of the Document,
then if the Document is less than one quarter of the entire aggregate, the Document’s Cover Texts may
be placed on covers that surround only the Document within the aggregate. Otherwise they must appear
on covers around the whole aggregate.

8. TRANSLATION
Translation is considered a kind of modification, so you may distribute translations of the Document under
the terms of section 4. Replacing  Invariant Sections with translations requires special permission from
their copyright holders, but you may include translations of some or all Invariant Sections in addition to
the original versions of these Invariant Sections. You may include a translation of this License provided
that you also include the original English version of this License. In case of a disagreement between the
translation and the original English version of this License, the original English version will prevail.

9. TERMINATION
You may not copy, modify, sublicense, or distribute the Document except as expressly provided for under
this License. Any other attempt to copy, modify, sublicense or distribute the Document is void, and will
automatically terminate your rights under this License. However, parties who have received copies, or
rights, from you under this License will not have their licenses terminated so long as such parties remain
in full compliance.

10. FUTURE REVISIONS OF THIS LICENSE
The Free Software Foundation [http://www.gnu.org/fsf/fsf.html] may publish new, revised versions of the
GNU Free Documentation License from time to time. Such new versions will be similar in spirit to the
present version, but may differ in detail to address new problems or concerns. See http://www.gnu.org/
copyleft/ [http://www.gnu.org/copyleft].

Each version of the License is given a distinguishing version number. If the Document specifies that a
particular numbered version of this License “or any later version” applies to it, you have the option of
following the terms and conditions either of that specified version or of any later version that has been
published (not as a draft) by the Free Software Foundation. If the Document does not specify a version
number of this License, you may choose any version ever published (not as a draft) by the Free Software
Foundation.

Addendum
To use this License in a document you have written, include a copy of the License in the document and
put the following copyright and license notices just after the title page:

Copyright YEAR YOUR NAME.

Permission is granted to copy, distribute and/or modify this document under the terms of
the GNU Free Documentation License, Version 1.1 or any later version published by the
Free Software Foundation; with the Invariant Sections being LIST THEIR TITLES, with
the Front-Cover Texts being LIST, and with the Back-Cover Texts being LIST. A copy
of the license is included in the section entitled “GNU Free Documentation License”.
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If you have no Invariant Sections, write “with no Invariant Sections” instead of saying which ones are
invariant. If you have no Front-Cover Texts, write “no Front-Cover Texts” instead of “Front-Cover Texts
being LIST”; likewise for Back-Cover Texts.

If your document contains nontrivial examples of program code, we recommend releasing these examples
in parallel under your choice of free software license, such as the  GNU General Public License [http://
www.gnu.org/copyleft/gpl.html], to permit their use in free software.
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